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Preface

About MaxLoad® Pro

Congratulations on purchasing MaxLoad Pro, a Windows-based multi-sized
product loading analysis software. You have made an excellent choice!
MaxLoad Pro is extremely powerful and has proven to save millions of
dollars for thousands of companies because of the efficiencies you'll realize in
your business. We're confident that MaxLoad Pro will provide the same
benefit to your company, regardless of your product, package or volume.

For over nine years, TOPS® MaxLoad® technology has been the industry's
premier vehicle/container loading system. MaxLoad®Pro offers a sequenced
loading report, along with a variety of ways to display the load, such as
sequenced 3-dimensional color/number coded load diagrams and placement-
by-placement displays. MaxLoad®Pro also has the ability to construct straight
and mixed pallets. With MaxLoad®Pro, you can accurately plan your
vehicle/container loads in advance, resulting in increased efficiency and better
customer support.

Over the years, we've maintained a steady effort to simplify our software so
that you, the end user, are able to conduct your loading analysis quickly and
efficiently. Just in case you have a problem, we've written this User's Guide
to assist you with every possible issue or question you might have.

If this User's Guide does not answer your questions, or if you should
experience problems while using the MaxLoad®Pro software, please call
TOPS Technical Support or your TOPS sales representative at 972.739.8677.

Preface
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How the User's Guide is Organized

This User's Guide is organized into 10 chapters and four appendices, as
follows:

Chapter 1, Getting Started, discusses system requirements necessary to run
MaxLoad®Pro and instructions on how to install the MaxLoad®Pro software.

Chapter 2, The Basics, presents the basic features and functions of the
MaxLoad“Pro system, such as the Control Center, common features used
throughout the system and opening an existing manifest. This chapter also
outlines MaxLoad®Pro's new features and improvements.

Chapter 3, Defining MaxLoad®Pro Databases, presents the three primary
MaxLoad®Pro databases — SKU, Pallet/Slipsheet and Vehicle. This chapter
walks you through how to define, modify and delete items in each of the three
databases.

Chapter 4, Loading a Truck Manifest, discusses the features you'll use to
define a truck manifest load — the Vehicle, Options, Mixed Pallet and
Comments tabs, the SKU List and the Manifest List. This chapter walks you
through how to define a truck manifest.

Chapter 5, Loading a Pallet Manifest, discusses the features you'll use to
define a pallet manifest load — the Mixed Pallet, Options and Comments tabs,
the SKU List and the Manifest List. This chapter walks you through how to
define a pallet manifest.

Chapter 6, Loading a Tote Manifest, discusses the features you’ll use to
define a tote manifest load. This chapter walks you through how to define a
tote manifest.

Chapter 7, Loading a Single-SKU Manifest, discusses the features you'll use
to define a single-SKU manifest load — the Vehicle, Options and Comments
tabs, the SKU List and the Manifest List. This chapter walks you through
how to define a single-SKU manifest.

Chapter 8, Viewing a Solution, discusses the Manifest View screen, which
provides a range of information about a load. This chapter shows you how to
view a load solution from different angles and with different options, and
presents the different types of information displayed for a load.

Viii
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Chapter 9, Editing a Solution, discusses the Editor screen, which allows you
to fine-tune or completely change a load solution. This chapter walks you
through how to add and remove SKUs and placements from a vehicle; how to
align and center SKUs and placements on a vehicle; how to view the load
from different angles; and how to deal with stacking/loading violations.

Chapter 10, Printing, walks you through all the system's printing functions,
including how to define print parameters, work with the print preview and add
text annotations to a printout.

Chapter 11, Configuration, discusses how to customize MaxLoad®Pro by
turning on and off a range of options and by changing the defaults and/or
properties for each individual field in the system.

Chapter 12, Import/Export Functions, discusses the various import and
export options available in MaxLoad Pro.

Appendix A, Command Line Parameters, provides various command line
options along with syntaxes available for Maxload.exe.

Appendix B, Glossary, provides definitions for a range of terms used in the
MaxLoad“Pro system and the product loading industry.
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New Features in MaxLoad Pro 3.6

L-Shape SKUs: Support L-Shape SKUs like sofas and chairs including
the option to optimize their bundle sizes.

Placement Highlight in 3D View: This viewing option highlights the
selected placement in color and shows other placements as wire frames
only.

SKU Bundles: Designed for thin SKUs like wood planks and metal
sheets, users can set up multiple preferred bundle sizes for loading. Also
works for other SKU types like standard shipcase and drums.

Set Priorities within Stops: Add both stop off and priority to the
manifest list and enable “Stop & Priority”. MaxLoad will load according
to priorities for each stop.

Adjust Weight Distribution: Users can move the entire load towards the
front or back of the vehicle to adjust distribution of weights over the king
pin and axles.

Support Weight Limit: With Weight Limit defined, MaxLoad load the
order within these limits. Violations will be highlighted in red so users can
edit the load manually to comply with weight restrictions.

Support Multiple Pallets: Allow user to select multiple pallets when
doing pallet manifests.

Customize and New Reports: This new function allows users to specify
what data to be included into graphical manifests, load summary and
placement list. New reports include load by layer, color stop off, load by
placement edge and customized load summary and graphics reports.

Air Fill Dunnage: This option highlights in the 3D load solutions area
where dunnage can be added to protect and secure the load during
transport.

Advanced Data Filter: File filter include manifest name, date, user name
and customer name.

Export Load Diagrams: New option to save the selected 3D load
diagram to a graphics file in JPEG, BMP, TIF or other formats.

MaxLoad Pro (V3.6) User's Guide



Chronology of Features in MaxLoad

This section outlines the various releases of the MaxLoad Pro software, along
with the features included in each release.

Version 3.0

Support new vehicle types including side-bay trucks, flatbeds
and ULDs.

Rotate layers when creating unitload patterns for SKUs.

Split editing to provide two views of the same vehicle load
during editing for better visualization.

Edit mixed pallet in vehicle.

Define wheel wells for trucks and corner boxes for sea
containers.

Break drum SKU placement into individual items for editing.

Add descriptive comments for manifests include customer
name, address, ship status, and delivery date.

Improved layer algorithms for mixed pallets to generate more
stable layers by stacking SKUs of similar heights to form
layers.

Custom import for pallet and tote manifests.

Direct export to PDF files without the use of Adobe Acrobat or
other third party PDF tools.

Import SKUs and order data from a secured FTP server.

Specify Date Range for Manifests: New filter to sort manifests
based on the dates they were last saved, within 7, 30, 60, 90 or
180 days.

Implementation of Load Rules: Ability to view and edit
contents of load rules within Max Load. Please contact TOPS
directly to implement this feature.

Preface
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Version 2.7x

R/
L4

K/
L4

R/
L4

Enhanced algorithm options including pinwheel patterns for
unitloads, pyramidal staggering of pipes, improved nested
loading of mixed size rolls and automatically align loads inside
transit vehicles

Imports case sizes and pallet patterns from TOPS Pro.

Support Loading by Percentage, for example, 50% of SKU-A,
30% of SKU-B and 20% of SKU-C.

New Export Options include solution, load list, placement list
and export by placement.

Data Import Wizard which allows easy import of selected SKU
and MFT fields.

More efficient and stable mixed pallets.
Ability to see contents of mixed pallet SKUs in the containers.
Use of Fill Items to for leftover space with selected SKUs,.

Creates partial unitloads to fill leftover spaces on top,
optimizes unitload height for top layers.

Right-click menu in the 3D editor for SKU alignment, snap
placement and to break a placement into individual items.

Use of loading rules to better optimize and control loading of
transit vehicles.

Load by Placement report indicates SKU quantity and
configuration for each step.

Improved Import/Export functionality to allow selected data to
be transported to and from MaxLoad Pro.

More Language Support: Adds support for Simplified Chinese,
Traditional Chinese, Portuguese and Thai.

Xii
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Version 2.6x

Improved stop-off handling

Color coded orders and rules to force orders to be loaded
together

Assign number of units to SKU as piece count

Nest and stagger drums, pipes and rolls in a container

New export options, Export by Placement and Export to XML
New Import options, Import XML, Import Piece count

Split door and side door loading for Rail Cars

Added "Save to Library" feature

Added "Bundle SKUs" feature

MaxLoad Pro self cleans the database for SKUs not used for
days, months, or years

Enhanced reports
Better loading algorithms, load for efficiency and/or by speed

Increased stacking rules for loading along with preferred stack
sizes

Version 2.5x

Improved loading of mixed pallets for increased stability and
stackability

Improved order handling

Improved algorithms

Improved "Maximum Axle Weight" calculations
Added railcars

E-mail reports directly from MaxLoad Pro using the default e-
mail client

Preface
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Load a tote manifest

Load a mixed pallet manifest (a specific collection of SKUs
placed on a pallet)

New global security settings in the Global Settings dialog box

"Calculate All Vehicles" feature automatically loads trucks to
complete a manifest

Right-click feature displays properties information for the
selected SKU

Sort data in a column in ascending, descending, alphabetical,
or numerical order

"Multiple Truck Summary Report™ feature displays a load
report for each truck in the solution

Version 2.x

Added "Multiple View" feature for printouts

Added three new user specified information fields for SKUs
and manifests

"Copy to Clipboard" feature allows the user to copy 3D views
generated in MaxLoad Pro

"Paste-On Graphics" feature allows the user to paste bitmap
images onto the sides of individual SKUs

Added "Colored Outlines™ feature for printouts
Activated user passwords

Added Axle weight calculations

Updated Italian translation

Improved online help. The MaxLoad Pro manual is now
available through online Help

Improved manual editing of truck and mixed pallet manifests

Less cluttered screens. MaxLoad Pro now allows the user to
turn of some columns that they do not use.

Xiv
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Getting Started

Introduction

This chapter covers the following topics to get you up and running on the
MaxLoad Pro system.

R/
A X4

X/

System Requirements/Specifications

m Standard MaxLoad
m  MaxLoad for SQL/Oracle

Installing MaxLoad Pro

Important Notes

Installation Procedure

License Setup

Setup Client Machines for Network License
LAN and WAN Explained

Starting MaxLoad Pro
Registration Information
Add a New User
Viewer Mode

Uninstalling and Moving License

By the end of this chapter, you should be logged into the system and ready
to use the software.

Chapter 1: Getting Started
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System Requirements/Specifications

Standard MaxLoad

To install and run the MaxLoad Pro software, your system needs to meet
the following requirements:

« Platform: All versions of Windows (95, 98, 2000, NT, XP, 2003,
Vista, Windows 7 and Windows 8) — both 32 and 64 bit

s Network: Any network is compatible. MaxLoad Pro is not network-
protocol dependent; it only needs a file server.

% Processor Required: Any processor capable of running the installed
platform. Recommended Pentium 133 MHz or better

+ Hard Disk Space Required: 50 MB
« RAM Required: 64 MB or more recommended
+ Video Required: 800 x 600 at 256 colors recommended

Network Information: MaxLoad Pro is installed from a client to the file
server. MaxLoad Pro and DirectX usually do not take more than 50 MB
space on the file server, depending on the database size. DirectX is copied
to the file server for install on client(s) that do not have DirectX. Most
Windows clients come with DirectX. Individual workstation’s hard disk
space requirements will vary. They will have the support files for DirectX
and DAO installed that their machine lacks and the program will be run
from the network.

The software internally manages concurrent user licensing. No third party
metering of the software is required. Licensing can support an unlimited
number. The software has been tested with up to 30 concurrent users.
Provisions are in place for distinguishing between viewers of
old/completed work and generating new work. Those who access the
software in View Only mode do not count against the concurrent user
limit.

Software Design: The MaxLoad Pro uses 32-bit code. Work is stored as
database records instead of individual files, using DAO (MS Access).
For import/export of data, MaxLoad Pro uses ASCII comma Delimited
text files or csv- comma separated values file and XML, compatible with
most document management systems, spreadsheets, databases and
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mainframes, including Excel, Access, Paradox, AS400, and UNIX
platforms.

MaxLoad for SQL/Oracle

For Microsoft SQL server 2000 and above, Oracle server 9i and above.
Client Requirements

% Processor: Pentium I11 450 MHZ or better

<+ RAM: 128 MB or more

+ Hard Disk Space: 50 MB

+ Video Required: 800 x 600 at 256 colors recommended

+ Operating System: Windows NT /2000 / XP / Vista / Windows7/
Windows8

«+ DirectX: 6.0 or above

+» OLE DB Provider: No additional component required for MS SQL
Server. Oracle client full installation is required to setup the Oracle
OLEDB provider if the database server is Oracle.

% Database component: MDAC 2.8 or above

Please note this is already built into Windows XP and Vista. It only needs
to be installed for earlier version of Windows.

Note: MaxLoad Pro does not require Microsoft .Net platform but can
work on any PC with Microsoft .Net platform.
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Installing MaxLoad Pro

This section will walk you through the installation process and get you
logged into the system. It is recommended that a person in the
Information Technology department installs the software.

Note: If during the installation an error message occurs, please make a
note of the error message and continue with the installation until it is
finished. Then contact TOPS Technical Support for further instructions.

Important Notes

« The following instructions apply to both MaxLoad Pro new
installation as well as upgrade.

% If you are installing or upgrading a network license, please start from
the client machine.

«+ Before you begin, make sure you have administrative rights to install
to your computer and to the network. After setup, user will require full
permissions to access the TOPSAPPS folder and everything inside it.

« After installation, you MUST contact TOPS via phone or email to
complete the license setup. Until the license is setup, your MaxLoad
software will behave like a demo, with access to sample data only.

% Have the serial number of your MaxLoad software available. The
number is marked on the front of the CD, the CD case and on the
Product Registration Card.

Installation Procedure

1. Make sure you have administrative rights to the workstation on which
you wish to install MaxLoad Pro. If installing a network copy, you
will need the same rights on the network drive.

2. Close all other applications on that workstation.

3. Start the installation process by inserting the MaxLoad Pro CD in the
proper drive of the machine. The software setup should run
automatically. If this does not happen, click on the Windows Start
button and select Run.

The Run dialog box appears and prompts you to enter a directory path
and the program to run.
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4. Type D:\SETUP and hit the Enter key on your keyboard (where D: is
the CD drive). If your CD drive is designated with another alphabet
like E or F, please change it accordingly.

5. A window will open for you to select the software you want to install.
Click on “Install MaxLoad Pro”.

Select Software To Install

TO P S The Ultimate Packaging and Distribution Software

ENGINEERING

TOPS Engineering Corparation

275w Campbell Road, Suite 500
Richardson, Texas 75080 LSA
Tel 972.739.8677

Fax 972.733.9478

TOLL FREE: 1.800.889.2441

Wi topseng.com
Sales: sales@topsend com
Support: techi@topsena com

Imstall Maxlnad Pra > Imstall TOPS Pro »»
MarLoad®Pro is a miked cargo load planning, TOP5®Pro helps create optimal package
container loading, freight calculation and cube: design and pallet patterns. It can also be used

optimization software. [t determines the "how to" to calculate package size, package
of loading mixed size products onto tucks, configuration, stacking strength, and truck.
containers, sea vans and rail cars. configuration.

Ezit

6. You will see a welcome message. Continue installation by clicking on
the Next button.

¥§ Select Installation Type x|

S
o2,
S
TOPS

Select which tupe of software vou are instaling. \nPlease
select instlation twpe that matches vour the software that
you have purchazed.

Install Demo License ¥y |

Install to Local PC [Standalone Yersions Only) > I

Install to Server [Metwork Wersions Only) B

7. Click on “Install to Local PC” if you are installing a stand-alone
license. Click on “Install to Server” if you are installing a network
version of MaxLoad Pro. Network version should be installed from a
client machine to the server. You can check the sticker on the front of
the CD case to determine if you have a stand-alone or server copy.
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8.

The Backup Replaced Files dialog box appears.

zl
Backup Replaced Files ’..
SN
TO

Thiz inztallation program can create backup copies of all files replaced during the inztallation.
These files will be uzed when the software iz uninstalled and a rollback iz requested. |
backup copies are not created, you will only be able to uninstall the software and nat rall the
syztem back to a previous state.

[io you want to create backups of the replaced files?

v ‘Yes
= Mo

C:\Marload30NBACKUP Browsze... |

TOPS Installation Wizard

"Backup File Destination Directorny

Cancel |

To create backup copies, click on Yes and specify a location where the
backup files will be saved. Click No if you do not want back up
copies of the installation files. When ready, click on Next to continue
and the Destination Location dialog box appears.

8 Maxload Pro X|
Destination Location .’.
A
TOPS

Setup will install M axload Pra in the following folder.
Ta install into a different folder, click Browse, and select another folder.

You can choose not to install Masload Pro by clicking Cancel to exit Setup.

" D estination Folder

C:\Program Files\TOPSAPPS Browse... |

TOPS Installation ‘wizard

Cancel |

You can use the default location to install MaxLoad Pro or click the
Browse button to specify a new location. Click on Next to continue.

% Stand-alone License — Use the default folder of C:\Program
Files\TOPSAPPS\ or click the Browse button to specify another
folder on your computer.

1.6

MaxLoad Pro (V3.6) User's Guide



% Network License — Click the Browse button to select the mapped
drive of the server from the client machine.
Note that you will need to run NETSETUP or WANSETUP on
each new client machine after installation is complete.

#8 Maxload Pro |
Start Installation ’.’
NN
TOPS

You are now ready to install Masload Pro.

Click. the Mext button to begin the installation or the Back button to reenter the installation
information.

TOPS Irnstallation ‘wizard

< Back Cancel

10. Click Next to start the installation process. MaxLoad Pro will start
copying the files to the specified location. You will see the
progression on screen and the following will appear when installation
is complete.

#8 Maxload Pro x|

Maxload Pra has been successfully installed.

Click the Finish button ko exit this installation.

i Finish> ¢

< Back Cancel

11. Click on Finish to close the dialog box.

When installation is complete, MaxLoad Pro will create the required
shortcuts for the software and place those shortcuts on the desktop and
under Start | Programs | TOPS for Windows Apps Menu.
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You will need to run MaxLoad Pro at this time to finish the License Setup
process as described in the next section.

License Setup

Until the license has been setup, the newly installed MaxLoad software
will behave as a demo — you can only open and view existing analysis but
not perform new calculations. To setup the license, follow these steps and
contact TOPS via email or telephone.

1. Start MaxLoad by going to Start | All Programs, select TOPS Apps
folder and then click on MaxLoad Pro.

You will see the Demonstration Mode Information dialog box as
shown below prompting for your action. If your license has already
been setup, you will go right to the MaxLoad login screen.

Demonstration Mode Information x|

[The currentinstallation does not hewe a functioning license. This nommally occurs when the software
had alreacdy been installed once befors and was notuninstalled before being installed again. Status
code: M2247

If you enter the program now you will be akle to open existing samples. However, you will not be able
0 perform any new work.

If the license from previous installation had been uninstalled anto to the original key disk. select
Option 2. Theninsert the Key diskette and press OK to continue. Contact TOFS for assistance if
old-license is un—recoverahle

1. Continue in WIEW ONLY mode |

2. Us SALE kay disk. |

3.UseE-license I
TOPS Engineering Carporation “oice (972)739-6677
275 4Y. Camphell Rd. Ste 600 Fax (972)739-9478
Richardsan, T 75080 E-tdail infoi@topseng.com

2. Click on the “Use E-License” button and the Reset Authorization
screen appears.
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Reset Authorization |

taxload Pro - Yersion: 3.60 [May 2 2013)

Campany Name |14 axload SOL

Serial Number 1162007 | - 3002011 - [D444333 - |0936355

Key |238867547-0

Yerification Code I

[u]4 | Cancel | Email | Clear I Help

License Information
Mumber of Users |2

Metwork /Stand Alone INetwork

Functionality I5

Note: Until the license is set, the information in the dialog box above
does not reflect the correct serial number or configuration (Number of
Users and Network/Stand Alone).

3. Have the following information ready and call TOPS at 972-739-8677
for license setup:

% Company Name - the company name that you’d like to appear in
all reports from MaxLoad

< Serial number of your MaxLoad Pro license — this is the serial
number in the format of 12345.x as marked on the front face of
your MaxLoad CD, not the serial number shown in this dialog box.

% The Key from the above dialog box.

To setup via email, please send an image of the Reset Authorization
screen or click the Email button for MaxLoad to place the license
information in a text attachment. Email either to tech@topseng.com so
the Verification Code can be emailed to you to complete the process.

Note that the Verification Code is time sensitive and needs to be
entered within 24 hours to complete the license setup process.

4. Upon receipt of new serial number and verification code from TOPS,
enter them into the Reset Authorization dialog box click on the OK
button. Make sure the Company Name is entered “exactly” the way
provided to you.
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If all information is entered correctly, you should see a message saying
“MaxLoad License successfully set”.

Company Name [zl oad

serial Mumber (5008626 - [2001010 - [0444333 - |0624306

Key [1012341120

MaxLoad E3
Yerification [

! E Maxload License successfully set,
L3

License Infe
MNumber of Users I1

Metwark/Stand Alone |Stand.&|one

Functionality IS

5. Click Ok again to close the Reset Authorization dialog box. The
Defaults dialog box appears

pefaults x|
Unitz Im
Languags I.-’-'«merican j
Loga Path |-\ axLoad30NT OPSAPPS M ax2ProGrapl Browse |
[~ Apply to existing users v Apply to new users
ITI Cancel |

6. Select the default settings for MaxLoad:

% Units — Select from the drop list the units of measure

% Language — Select from the drop list the language used for
MaxLoad user interface

% Logo Path - Click the Browse button to specify the location of
your company logo to be used all reports from MaxLoad

% Apply to existing users — Check this box to apply the defaults to
all existing users

% Apply to new users — Check this box to apply the defaults to all
new users from this point on.
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When all selections are made, click on the OK button.

The MaxLoad Login screen appears. The software is now ready for
use. Please refer to the section “Starting MaxLoad Pro” and later
chapters on how to use the software.

Setup Client Machines for Network License

After the license has been properly setup, you can now proceed to setup
MaxLoad access on any client machine.

Note that all users should have Full Control (read and write) access to the
TOPSAPPS directory on the network

1. Make sure you have administrative rights to the workstation you wish
to set up MaxLoad Pro on.

2. Permanently map a network drive to the location on the server, where
you installed MaxLoad Pro.

3. Browse across the mapped network drive to the Max2Pro directory.
Run the NETSETUP.EXE file for a LAN (Local Area Network) install
and WANSETUP for WAN (Wide Area Network) install, respectively.

4. NETSETUP / WANSETUP will verify that there is a valid version of
DirectX installed on the local PC, create a local Maxload2.ini file and
place it in the Windows directory. It then creates the required
shortcuts for the software and place those shortcuts on the desktop and
under Start | Programs | TOPS Apps Menu.

WAN and LAN Explained

A LAN (Local Area Network) install is a network install where the data
and software files are stored on a shared server. Client machines then
connect to the server through shortcuts and run all processing on the client
side. When you run NETSETUP, MaxLoad will copy over the shortcuts,
INI file and all .DLL files needed for the software to run (it will also
check to ensure you have the minimal version of DirectX). Once the
install is done and you click a shortcut, the software will find the .INI file
which tells it where to find its database and executables. These will then
point across the mapped network drive (or UNC path) and the software
will run, with the processing load being entirely on the client side.
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A WAN (Wide Area Network) install differs from a LAN install by
copying also all executables and support files to the local client. This way
when the software runs, there is no lag in starting the executable file. The
only lag then is in reading data from the server. The WAN setup can be
used for customer having multiple locations in different cities, but wants
to maintain a single database. (This may not work for all situations,
depending on the customer’s network bandwidth, it may be too slow).
Another situation well suited for the WAN install is a slow LAN. If the
LAN the customer is using is slow for some reason, they may use a WAN
setup to speed up the responsiveness, even on the local network.
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Starting MaxLoad Pro

To start MaxLoad Pro, double-click on the MaxLoad Pro icon on the
desktop (if you have one), or go to Start | All Programs, go to the TOPS
Apps folder and click on MaxLoad Pro.

The Login screen appears, as pictured below.

Login I
- - Mevs Llser | T
Cargo Load Configuration Software
® Delete | Cancel |
]
a x o a -—]J Rename | Pazzword |
S|
[T Wiewer Mode

Export Department

Traffic Department

MaxLoad ® is 2 registered trade rrark of
TOPS® Engineering Carporation &1 990-1998

Notice the user list in the bottom right section of the screen; this list shows
three users already set up in the system: Export Department, Supervisor
and Traffic Department.

Select the user group you belong to and click on the Login button and the
MaxLoad Pro Control Center appears, as pictured on the next page.

Note: The Supervisor login is password-protected (password is “tops
software”). Log in as a Supervisor only if you’re performing
Configuration functions. For more information, please refer to Chapter
11, Configuration.
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MawLoad - Control Center

’ uck Manifest ‘i&t"ﬁw ‘ iolallﬁaqt

Open Open Open
Hew Hew Hew Hew

For Help Cortact Tops Sotwate [ WO Fowoenisol 2

The MaxLoad Pro Control Center serves as your starting point in the
system. From the Control Center, you can start or create one of four types
of manifests: Truck, Pallet, Tote and Single-SKU.

The MaxLoad Pro Control Center is discussed in Chapter 2, The Basics.
The Truck Manifest is discussed in Chapter 4, Loading a Truck Manifest.
The Pallet Manifest is discussed in Chapter 5, Loading a Pallet Manifest.
The Tote Manifest is discussed in Chapter 6, Loading a Tote Manifest.

The Single-SKU manifest is discussed in Chapter 7, Loading a Single-
SKU Manifest.
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Registration Information

The About MaxLoad Pro information box, pictured below, provides
important information regarding your MaxLoad Pro license. To access
this box, open the Help menu and select About MaxLoad.

About MaxlLoad x|

i axload Wersion 250 400
o Cargo Load Planning System
ﬁ Copyright © 1557-2013
TOPS Software Corporation
275w, Campbell Rd. Ste EOO
Richardzon, T FR020

Reagiztered to: tawload SOL

Serial Mumber: 1234567-3002011-0444333-0936955
rAWF: WP Expired

Current User: Supervizor

Security; File

Cusgtom MHone

[ata Path: Cohkase-AD 0N a52Protdata

[Data Basze Info: plutohSOEL2005: maxload

Yoice [972)733-8677

fbay 22013 Fax [972)739-9478
E-Hail infol@tapzeng. com
Tech Suppart techi@topseng, com
Webszite Wi tOpEend. comm

tawload iz a Registered Trademark of
TOPS Software Corparation Systemn |nfo |

The About MaxLoad information box displays the following information:

+ MaxLoad Pro Version: Shows the version of MaxLoad Pro you are
currently running.

+» Registered to: The name of the company or organization the software
is licensed to. This is the same Company Name that you enter when
you setup the license under the Adjust Authorization function.

% Serial Number: This is the software serial number. It is unique for
every customer. Whenever an issue is reported to technical support,
the serial number is the first thing needed. This allows TOPS tech
support to look up the customer and version information in the
customer database. This number even tells the number of users that
can access the software at one time.

<+ MVP: This field is not used. Please contact TOPS or email
MVP@topseng.com to check your MVP status.
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«+ Current User: Lists the login name of the current user.
« Security: Displays the security method used to install the license.
+« Custom: Reflects if any custom programming was done.

« Data Path: Indicates the location where all the MaxLoad data are
saved.

«» Date: The build date of this executable file.

s TOPS Contact Info: TOPS Engineering Corporation address, phone
number, e-mail address, and website address.

Notice that the About MaxLoad information box contains two buttons:

<+ OK Button: Closes the About MaxLoad Pro information box.

« System Info button: Displays the System Information box, as
pictured below which provides a range of technical system information
and allows you to print, save or email the system information.

1. Dater 743052008 ;I )4 I
2 Dperating Sptern: *Win MT 51 Build Murber 2600

3 Proceszor Intel Pritnt |
4 Memory: 1038471 2(KB] Load 53%

5 Windows directony:  C:AWWINDOWS . |
B Common Filez directony:  C:5Program Files\Common Files

7. Windows Uzer Name: eva ;

8. Computer Mame: PC118 E-Mail |
9. Video Card: VGA

10. Bitz Per Pixel: 16 Resolution: 1680 1050

11, Diirect Werzion:  4.09.00.0904

12, Maxload Serial Mumber:  M3005PS1 2006524, 20

13. Valid Licence: Yes

14. Expinp Date: Mewer

15. Execution Count Left:  MAA

1E. Executable Location: C:A\PROGRA™1YTOPSAPPSY ar2Pro

17. Command line Parms:  -ini=C:\PROGRA™TAT OPSAPPS Y ax2ProtM axloadz. ini
18. Default Printer: Mone

19. Primary Metwork:  none

20, Metwork Login Mame: none

21, 1M1 Pathy CAPROGRA™1A\TOPSAPPS WM ax2Prott axload2. ini

22, App Path:  C:\Program Filesh\TOPSAPPS M axzPro

23, Data Path:  C:\Program FileshTOPSAPPS WM an2PraiDATA

24 Stack Matrix Path:  C:%\Program Files\TOPSAPPS WM aw2PrahDATAMVS tack kM at. mdb
25, Defaults Path:  C:AProgram Files\TOPSAPPS M ax2ProhDATA

26. Language Path:  C:%Program Filesh T OPSAPPS WM aw2ProtLAMGUAGE

27. Graphics Path:  C:A\Program Filesh T OPSAPPS M a22Pro

28. Logo Path: - C:%Program FileshT DPSAPPS M ax2Pro\tops. brmp

29, Custom  Mone
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The System Information box displays the following information:

1.

2.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

Date: Current system time.

Operating System: Machine operating system and build number.
Processor: Processor manufacturer.

Memory: Amount of memory being used.

Windows Directory: Operating system’s default directory, usually
Windows.

Common Files directory: Location of System (Windows) common
files folder.

Windows User Name: Name of the user currently logged into the
Windows system.

Computer Name: Machine name as it appears on the LAN.
Video Card: Style of video adapter.

Bits Per Pixel: Screen color depth and resolution.

DirectX Version: It tells the version of directX being used.

MaxLoad Serial Number: Software serial number.

Valid License: If the user is running a sale or demo license.

Expiry Date: This applies to MaxLoad Pro demo. Reflects the date
MaxLoad Demo will expire. If this is a sales copy, it shows “Never”.

Execution Count Left: This applies to MaxLoad Pro Demo. Reflects
the number of executions left before the demo expires. For a sales
copy, it shows “N/A”

Executable Location: Provides the location while the MaxLoad
executable file is saved.

Command line Parms: Lists any command line option on your copy
of MaxLoad during program startup.

Default Printer: Reports the default printer being used.

Primary Network: Type of the network the user logs into.
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20.

21.

22,

23.

24,

25.

26.

217.

28.

29.

Network Login Name: It is the username that the user logs in under
onto the network.

INI Path: INI path points to the location of the maload2.ini file.
Maxload2.ini file tells the software where to find the data, license, and
other required files.

App Path: Points to the location of the license files.

Data Path: Points to the location of the max2pro\data directory.
Stack Matrix Path: Location of the StackMat.mdb (data directory).
Defaults Path: Location of the Defaults.mdb (data directory).

Language Path: Location of the language directory which stores all
language files.

Graphics Path: Location of the *.wmf file used by XML.
Logo Path: Location where the company logo is saved.

Custom: Show if there is any customization done on your copy of
MaxLoad.

Add a New User to the System

No matter your MaxLoad Pro is stand-alone or network, or regardless of
the number of concurrent users, you can add as many user logins as you
like in MaxLoad Pro. To add your name or department to the list of user
names, follow these instructions:

1.

Login as a Supervisor. The default password is “tops software” and is
case insensitive.

Access User Login from the File menu.
When the Login dialog box appears, click on the New User button.

At the New User dialog box, type in the new user name in the User
Name field.
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User Mame I | ok I
|

Paszword I Cayizs]

Werify Pasaword I

5. The Password and Verify Password are optional fields. Set a
password only if you intend to use MaxLoad Pro in a more secure
way.

6. Inthe Password field, type in the new user’s password.
7. Inthe Verify Password field, type in the new user’s password again.
8. Click on OK.

MaxLoad Pro adds the new user to the system and returns you to the
Login screen. Notice that the user list now displays the name of the new
user.

Viewer Mode

The Viewer Mode checkbox at the login dialog box allows you to start
MaxLoad Pro in “viewer” setting only — where you can only open existing
analyses for viewing but not performing new calculations.

For a network license supporting say, only two simultaneous users, a third
or fourth user can log in using viewer mode to retrieve existing analyses
and print reports.

Please note that in Viewer mode, the Calculate button, as well as the New
button in each Button Window will be grayed out.

Moving or Resetting License

You will need to contact TOPS for a new Verification Code whenever you
are making changes to the operating system on your PC or need to move
MaxLoad to another computer or server.

Each MaxLoad license, stand-alone or network, can only be installed on
one single machine or server. Multiple installations of the same license,
as identified by the unique serial number before the decimal point marked

Chapter 1: Getting Started 1.19



on the software CD, is a violation of the MaxLoad end user license
agreement.
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The Basics

Introduction

This chapter presents the basic features and functions of the MaxLoad Pro

system. This overview will acquaint you with the following topics:
%+ Control Center

Button Windows

Version and Registration Information
Menu Bar

Tool Bar (Standard)

s+ Common Features

Tab System

Graphical Online Drawing (g.0.d.) System
Sort Function

Direct E-mail

+«+ Open an Existing Manifest

m Filter (Manifests)
m  Combine (Manifests)

« Exit MaxLoad Pro
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Control Center

Control Center is the starting point for working in the MaxLoad Pro
Software. This is the first screen that appears after you login to the
software. From the Control Center, as pictured below, you will choose to
either open an existing manifest or create a new manifest.

= MaxLoad - Control Center | _ O] <]
File Edit Yiew Define Tools Layout Help

For Help Contact Tops Engineering NUM v

Truck Manifest Pallet Manifest Tuate Manifest

Note: From anywhere in the system, you can access this screen with this
Menu Bar command: File | Close.

Notice the following components on this screen:

Button Windows: The four button groups provide shortcuts to allow
you to create a new manifest or open an existing manifest.

Version and Registration Information: Displays the version number
and registration information for your copy of MaxLoad Pro.

Menu Bar: Contains seven drop-down menus that allow you to
perform common tasks.

Tool Bar (Standard): Contains shortcuts to various commands in the
form of icons.
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Button Windows

Button windows are designed as shortcut buttons to open existing or create
new manifests. Each contains an Open button and a New button. Note
that the New button will be grayed out if “Viewer Mode” is enabled
during login.

Open Button: The Open button displays the File Open dialog box, which
contains a list of all manifests that have already been defined for a
manifest type.

New Button: The New button displays the Manifest Pick List screen,
which allows you to create a new manifest for the respective manifest

type.

Truck Manifest

Truck Manifest Button Window: The Truck Manifest
button window allows you to load multi-size SKUs into a
vehicle. This window can also be used for single-size
SKUs.

Pallet b anifest

Pallet Manifest Button Window: The Pallet Manifest
button window allows you to perform a mixed-pallet
loading analysis.

Tote Manifest

Tote Manifest Button Window: The Tote Manifest button

window allows you to load mixed items into a tote. -

Single SKU Button Window: The Single SKU button
window allows you to determine the exact quantity of | =rde=skd
single-size SKUs that will be loaded to cube out a vehicle.
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Version and Registration Information

The lower right-hand corner of this screen displays the following
information:

% Version Number and Registration Information: Refer to this
number if and when you call the TOPS Engineering Technical Support
Department.

+« Executions Remaining: If you’re running a demo version of the
software, this tells you how many more times you can execute the
software.

Menu Bar
The Menu Bar provides a number of drop-down menus. These menus

provide options that allow you to perform common tasks, many of which
are duplicated on the Toolbar.

File Edit Wew Define Tools Layouk Help

The Menu Bar is comprised of the following seven menus:

« File Menu: Allows you to create new manifests, open existing
manifests, save manifests and set up print parameters.

< Edit Menu: Allows you to undo or redo your most recent action in
the Editor, as well as copy text and images to the Windows clipboard.

« View Menu: Allows you to view loading solutions in a number of
formats: by placement, by leading edge, by priority. It also allows
you to view the Stacking Violations list to verify that you’ve not
violated any stacking rules.

+«» Define Menu: Allows you to define parameters for a new SKU, Tote,
Pallet, Vehicle or Stack Matrix.

+« Tools Menu: Allows you to revise your system configuration, system
language (MaxLoad Pro is used worldwide) and user list. It also
allows you to import and export work to and from the system.

% Layout Menu: Allows you to work with a number of Align and Snap
tools as you position SKUs onto a pallet.

% Help Menu: Allows you to display Help information for all features
and function in the system.
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This Menu Bar remains consistent throughout the entire MaxLoad Pro
system. Each screen that you work with contains the same seven menus.
However, be aware that depending on the individual screen that you’re
working in, the list of commands (sub-menu choices) changes or becomes
tailored to reflect that individual screen. Menu options that cannot be
accessed at the moment are disabled (“grayed out”).

Toolbar (Standard)

The Toolbar, as pictured below, contains icons that perform individual
MaxLoad Pro commands and offer shortcuts that simplify commands.
Oftentimes, you can click on an icon once to complete a command, rather
than click two or three times using the Menu Bar.

When you place the mouse cursor over the tool button, MaxLoad will
show a small context box telling you the function of the current tool icon.

J@_H 8.0 s 0 =@ O o =

This table outlines the Toolbar icons.

Toolbar Options

Icon Function

New: Displays the Manifest Pick List screen, where you can
begin work on a new manifest.

- = Open: Displays the File Open dialog box, which allows you
— to open an existing manifest.

| I Save: Saves the active manifest.

Import: Imports a generic list of SKUs or order list.

Export: Opens a submenu for the user to export the Solution,
Placement or Load List to a flat text file like CSV.

Cut: Cuts a selected graphic or block of text and moves it to
o % | the Windows clipboard.
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. Copy: Copies a selected graphic or block of text to the
Windows clipboard.

Paste: Pastes a selected graphic or block of text onto a
working area of the screen.

s =

Print: Prints a hard copy of a loading solution.

0 About: Displays software license information.
. Help: Accesses the online help system.

©

[Engish =] | Units: Switches measurement units from English to Metric
and vice versa.

Every icon found in the Toolbar has a corresponding Menu Bar option.
The Toolbar changes depending on the screen in which you’re currently
working. The sample Toolbar shown above is found in the Manifest Pick
List screen. We chose this Toolbar because most of the icons on this
Toolbar are common to other Toolbars. The Manifest View screen and
the Editor screen each have their own Toolbars. Each Toolbar is
described in detail in their respective chapters.
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Common Features

Some features that are used throughout the MaxLoad Pro system are
categorized as the Common Features. The primary common features
include the following:

X/
°e

Tab system

X4

+«¢+ Graphical Online Display (g.0.d.) system

*

Sort function

0

« Direct E-mail

L)

Tab System

MaxLoad Pro uses tabs throughout the system. Tabs allow you to quickly
and easily switch back and forth between different data entry areas or sub-
screens. For example, the Manifest Pick List screen contains four tabs, as
pictured below, which provide five different sub-screens — Vehicle,
Options, Mixed Pallet, Comments and Weights. Similarly, on the Define
SKU screen, three tabs allow you to move easily between Size, Stacking
and Graphics sub-screens.

Wehicle | Options Mirned Pallst Comments wieigh 4 I 4
Available Yehicles Selected Vehicles Wiew
48 Ft. [Marraw] T
48 Ft. Dy Cargo alculate
48 Ft. Dy Wan Hel
50 Ft. Fail Car e
B3 Ft. [Marrow) ~Vehicle Type
53 Ft. Drop Deck & Tk
53 Ft Dy Wan L
53 Fr. Dual Drop Deck  SeaVan
57 Ft. Dy Wan .
B0 Ft. Rail Car " Rail Car
L-11 Air Freight ~ p
L-4 Air Freight RailWagon
LD-4 Air Freight  Multi Zone
LD-5 Air Freight
LTL pul:n e " Double Trailer
-1 &ir Freight © ULD
k-2 Air Freight ;
Truck with Wheel Wwell " SideBay
" Flatbed

Also, notice that all command buttons — in the figure above, View,
Calculate and Help — are available on each tab. To switch between tabs,
simply click on the appropriate tab and the new sub-screen will appear.

Click the left arrow button at the top right corner to show the Vehicle tab
which is not visible if you are at the Weight tab.
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Graphical Online Drawing (g.o.d.) System

The Graphical Online Drawing (g.0.d.) system is referred to throughout
this User’s Guide as the g.o0.d. system. The g.0.d. system provides a 3-
dimensional image of various objects, as pictured below. The g.o.d.
feature is most commonly found in the Define screens (Manifest, SKU,
Pallet and Vehicle), but is also available in the Create Unit Load screen
and the Manifest Pick List Screen.

| o | top [ sike [ Fromt ||

564 (in]

The g.0.d. system helps you define objects by illustrating the
characteristics of the item — length, width, height, etc. — as you define it.
For example, in the Define Manifest screen, the g.o.d. feature displays a
visual of the vehicle you’ve selected for the manifest. This gives you a
visual confirmation of the vehicle before you exit the screen. The g.o.d.
system also shows color choice, if applicable.

Notice that the g.0.d. system contains four buttons at the top of the pane:

« 3D Button: Displays a 3-dimensional view of the item.

« Top Button: Displays the item from the top.

o,

% Side Button: Displays the item from the side.

o,

% Front Button: Displays the item from the front.
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Sort Function

MaxLoad Pro uses a number of lists to display information for a manifest:
SKU List, Manifest List, Solution List, Placement List, Load List, Cut
List, etc. Each of these lists is comprised of columns that contain data.
The sort function allows you to sort the data in these columns.

For numeric data — quantities, weight, cube percentage — you can sort data
in a column in ascending or descending order numerically. For alpha data,
such as a list of SKUs (barrel, bulk frozen yogurt, computer, etc.), you can

sort data in a column in ascending or descending order alphabetically.

To sort data in a column, follow these instructions:

1. For the column you want to sort, click on the column heading. For
example, on the View Screen’s Placement List, if you want to sort data
in the Quantity column, simply click on the Quantity (Qty) heading.

The heading works like a button.

MaxLoad sorts the Quantity column in ascending order, as pictured
below. Notice that the Quantity column reads 1, 2, 3, 3, 12, 15 and so

on.
-| Bef ] - SKL b LIL Crk Priarit Cube % Cube Wit 22 Wak o Frant | = Side § * Flaor
||
1 Computer 2 0 1 19.6 06 % B0.0 0.2 % 553 0 26|
1 Computer 3 0 1 29.4 0.8 % 1200 03 % 426 0 B
1 Computer 3 0 1 29.4 0.8 % 1200 03 % 553 0 0)
1 Computer 12 0 1 117.5) 33 % 480.0 1.0% h32 0 0)
g | T 15 1] 1 3325 94 % 12000 25 216 0 B
138 e EERES IR R E
2. To sort data in the Quantity column in decreasing order, click on the

column heading again and MaxLoad sorts the Quantity column in

descending order, as pictured below. Notice that the Quantity column

now reads 33, 27, 24, 18 and so on.

§Ref] - SkL Oty § UL Cnt Priarity Cube | % Cube gt Zhwigt § % Front) = Side § * Floor
5| M| Steren ) 1] 1 11300 32% E93.0 14% 216 0] 94
3 Deepfreezer 2% 1] 1] 12206 347 %) 945000 197 | 0 1] 0
2| | Fiefrigerator 24 0| 1 9378 238%) 20850 43% 216 i) 0
g | Ty 18 1] 1 3990 11.3% 14400 3.0 % 4485 0| i
g | Ty 15 0] 1 3325 94 % 12000 25 216 i) E5|
1 Camputer 12 i) 1 1175 33X 480.0 1.0% h32] i) 0

138 A0 881 1Re9 327 X
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Direct E-Mail

This function allows you to e-mail any of the print reports or a manifest
directly from MaxLoad Pro via your default e-mail application. To e-mail
a report from MaxLoad, start from the Print Preview Screen and follow
these instructions:

1. Click on E-Mail on the menu bar.

2. Select the between JPEG or PDF formats. The system launches your
default e-mail application and attaches the selected report in the format
selected.

3. Enter the e-mail address where the report will be sent.
4. Send the e-mail.

Note: The e-mail function is built into the Print Preview Screen
throughout the MaxLoad Pro System.

To e-mail a manifest, follow these instructions:
1. Open the manifest to be emailed.

2. Click on Tools menu and select Email MFT. The system launches your
default e-mail application and attaches the selected report as a TXT
file.

Note: MaxLoad Pro works with a MAPI-based e-mail client; for example,
Outlook, MS Internet Mail, etc. To setup a particular email client, simply
access the Internet Options from the Control Panel. Set the desired email
client as the Default Email, under the Programs tab.

Lotus Notes Users: If you are a Lotus Notes user, the procedure is a little
different. Located in your Max2Pro directory (install directory) you will
see a file named setupsmi.exe. Execute this file and it will find Lotus
Notes files and set itself up, accordingly. After this, close and run
MaxLoad Pro and Lotus Notes will be the default mail program. Call
TOPS Technical Support for any configuration help.

There is no need to run setupsmi.exe if you are using a new version of
Lotus Notes which is MAPI-compliant.

2.10

MaxLoad Pro (V3.6) User's Guide



Opening an Existing Manifest

To open an existing manifest, follow these instructions:
1 Use one of two options:

% From the MaxLoad Pro Control Center, click on the Open button
on one of the button windows.

% Or open the File menu and select Open.

The File Open dialog box appears, as pictured below, with a list of all
existing manifests for a selected manifest type. The following figure
displays a list of existing vehicle manifests.

x
IAppIiance Load Find | Fieset | 08 I
Mame | User | Delivery Date | Customer | Status ﬂl
A, i Expart Department TOPS Engineering Resst |
A ad Export Department TOPS Engineering
G r Picked to Pall:  Export Department TOPS Engineering Delete |
L-5hape Load Export Department 01/24/2M3 01/15/2M 3 kK
iz of Shipcase Sizes Expart Department 02/15/2008 08/15/2008 TOPS Engineering
Mixed sizes Traffic Department 11/28/2007 08/15/2008 TOPS Engineering 1]
Misture of Pallets Expart Department 11/28/2007 08/15/2008 TOPS Engineering a
Pirwheel O ptimization Export Department 12/04/2007 08/15/2008 TOPS Engineering Vehicles
Space Even Expart Department 04/22/2008 08/15/2008 TOPS Engineering
Tote Mixed Load Export Department 0841272008 08/15/2008 TOPS Engineering Pallets
‘wooden Crates Expart Department 11/28/2007 08/415/2008 TOPS Engineering a
Totes
SingleSkLs
Filter |
Caombine |
4| | 0|
Filter Options————————— Sttt |
[T Mame I Customer
Tatal: 11 ] s | Date
%Cube [TE0  %Foor [553 zwat [E58 Cleartl | Help |

Note: Remember that manifest names are associated with specific
login names, which you choose during the login process. Therefore, if
you login as Export Department, the Open Manifest dialog box will
display only those manifests that were originally created under the
Export Department login name.

An exception to this is that if the Supervisor has enabled the “Share
MFT” option under Global Configuration, then each user will see one
another’s works. See Chapter 11 for more information.

2 Notice the manifest-type buttons — Vehicles, Pallets, Totes and Single
SKUs, on the right-hand part of the dialog box. Click on the button
that corresponds to the type of manifest you want to open. For
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example, to see a list of existing vehicle manifests, click on the
Vehicles button.

Click on a manifest name to select it. In this example, we’ll select
Appliance Load. MaxLoad Pro automatically inserts the manifest
name in the field at the top of the dialog box.

Click on OK. Note that you can also double click on the manifest
name to open the manifest directly

The Manifest Pick List screen appears, as pictured below, with
information for the selected manifest. Notice that the title bar of the
Manifest Pick List screen shows the name of the selected manifest —
Appliance Load.

= ManLoad - Mainfest Pick List: Appliance Load =0 x|
File Edt View Define Tools Layout Help
N = - -
- - = Engish ¥
ehicle | Opions | MiedPalet | Comments | weirt] ] D | Top | Sice | Front |
Available Vehicles v
AR Fr (Mo 48Ft D
A3 Ft DryVan
50 Ft Rai Car
53 Ft. Narow)]
53Ft Drop Deck.
B3 Ft DryWan
53 Ft. Dual Drop Deck,
57 Ft Drylan
B0 Ft Rai Car
L-11 it Freight
L4 Air Freight
LD-4 Air Freight
LD-6 Air Freight
LTLPup " 110 fin 576 [in)
M-1 Air Freight
-2 it Freight
Truck, with Whes Well £
I | Prior [ | T UL T WP Ordertt | | add>> |
SKU List | Manifest List |=
- E Descrpton B|e 1] O JFvor] Stez Juncvad
Barel Dium Computer 1 C000000)
Bulk Frazen Yogurt Svitl Flavor Yogurt Decpheezer 8 1 0000000)
Case 1 Sample Case 1 Refrigerator 26| 1 0p000000|
Case 2 Sample Case 2 Steren 34| 1 0p000000|
Case 3 Sample Case 3 : Stove 30| 1 0p000000|
Cased Sample Case 4 v EE ] 0000000)
Cae 5 Saniple Case 5 | 17g] 0.0)
Case 5 Tote Tote Manifest Case & —
Chair Chair [L-Shape]
Computer Pentium 200 mhe,
Cookies e 20 Court
Couch Chair (L-Shape]
Crate #1 Sarnple Crate 1
Crate #2 Sample Crate 2
! Crate #3 Sample Crate 3
Crote #4 S ample Ciaiz 4
hiae i e £
For Help Contact Tops Software NUM 7

Note: If option “View On Open” under Tools | Configuration is
enabled, MaxLoad will open the graphical load solution directly
instead of the Manifest Pick List Screen. See Chapter 11 -
Configuration for more information.
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Filter (Manifest)

If you have lots of manifests saved in MaxLoad, the Filter button
allows you to tell MaxLoad to display only the manifests which meet
the conditions selected. You can specify among Manifest Name, User,
Customer Name and a date range when the manifests were last saved.

¥ Marme I
¥ User |ExportDepartment j
™ Custamer | Filter Optiotis
W Date From Date To T Hame I Customer
7120z - Bz v
I [ I W Wzer ¥ Date
C |
ance I Clear 2l |

When the manifest filter is enabled, the filtered field options are
highlighted with a corresponding check mark. You can quickly clear
all filters by clicking on the Clear All button.

Combine (Manifests)

The Combine button allows you to combine two or more manifests
into a single one. To use this function, follow these steps:

1. Open the File Menu and select Open.

2. While holding down the “Ctrl” button on the keyboard, click on the
names of the manifests to be combined.

3. When ready, click on the Combine button.

4. The Combine Manifest Options button appears. Click to specify
whether to combine the manifests by using Priority or by Stop Off
and click on OK.

Combine Manifest Options

" Combine Using Priority

" Combine Using Stop OFf

Ok I Cancel
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5. Enter a name for the new combined manifest which now contains
all the SKUs, corresponding quantities and load priorities or stop
numbers (if applicable) of the individual manifests.

Mew MFT Mame I

Cancel |

Mame for the combined b anifest

The new manifest will be added to the manifest name list in the
File Open dialog box.

When you open the new manifest, you will need to click the
Calculate button to find a new loading solution for the combined
SKUs and quantities.

Exiting MaxLoad Pro

To exit MaxLoad Pro, follow these instructions:
1 Open the File menu and select Exit.

2 If you’ve made any changes since you last saved the active file,
MaxLoad Pro will prompt you to save the file.

3 If you need to save any changes, click on Yes. MaxLoad Pro saves
your changes and closes down the MaxLoad Pro application.
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Defining MaxLoad Databases

Introduction

As you set up the MaxLoad Pro system and prepare to use it in your daily
operations, one of the most critical functions is setting up the various
databases.

Before we begin this chapter, it is important to remember one critical fact:
A computer does not think like a human. Therefore, it's imperative that all
inputs and measurements be precise. For example, think of a space as tiny
as 1/16 of an inch. While you and | may think nothing of such a small
number, and certainly would not think it could affect the way a truck is
loaded, MaxLoad Pro thinks otherwise.

For a computer, everything is “black and white.” An object will either fit
or itwon’t. Let’s take a truck that is 99” wide. Suppose you want to place
three refrigerators side by side across the nose of the truck; each
refrigerator is 33*%®” wide. A quick calculation shows that 3 x 33"
equals 99%¢ which is greater than 99”.

Therefore, MaxLoad Pro will not place these refrigerators side by side. If
you ever run across a situation like this, double-check the dimensions of
both your truck and your SKU. Are they exact dimensions? Also,
remember that humans may tolerate a “fudge factor.” Perhaps the person
loading the truck will make these refrigerators fit. MaxLoad Pro,
however, will not.

When you define databases in the MaxLoad Pro system, you'll always
start with the Define Menu, located on the Menu Bar. You can use either
the mouse or the Tab key to move around within each screen.

This chapter walks you through how to define databases and stack matrix:

L X4

Stock Keeping Unit (SKU) including creating unitload and bundle
% Stack Matrix

Pallet/Slipsheet

Vehicle

Tote

*0

L X4

R/
°

X4

You can also use the Import function to import existing data into
MaxLoad Pro. This will be covered in Chapter 12.
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Stock Keeping Unit (SKU) Database

The Define SKU screen allows you to define a new SKU or modify an
existing SKU. In this screen, you enter SKU parameters and save it to the
SKU database. Start from the Menu Bar and open the Define menu and
select SKU. The Define SKU screen appears, as pictured below.

Size I Stacking | Graphics | | i) I Top I Side I Front I

SkU Stple ISh\pcase j Close
SKU Number | = Sawe

Mew
Dezcription I

Delete

Fird

Calor _ Magimum Alowed Prefered  Create UL

Wert Wert
Overhang el Erl Cost

Length lin) |0.00 0 r IS
Bundle
Width in) (0,00 o r o
Help
Height (in) {000 a Ird -
(Ib]

Wieight

b ID uli]
Fiece Count |1
I jV

F arnily

' No Preference

5.00 fin)

The Define SKU Screen is comprised of the following components:

% Size Tab: Allows you to define the dimensions of the SKU.

+«» Stacking Tab: Allows you to define loading parameters for the SKU.
s Graphics Tab: Allows you to assign graphics on the SKU.

+ g.0.d. Window: Displays a 3-dimensional graphic image of the SKU.

% Close Button: Closes the Define SKU screen and returns you to the
previous screen.

s Save Button: Allows you to save changes to an existing or a new
SKU.

% New Button: Allows you to define/create a new SKU.
+«» Delete Button: Allows you to delete a SKU from the database.

% Create UL Button: Allows you to create a unitload for a shipcase or a
drum SKU. A unitload is a collection of single-sized items loaded
onto a pallet.

3.2
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Cost Button: Activates the Costing function. For more information,
contact TOPS Technical Support.

X/
°e

Bundle Button: Creates preferred bundle sizes for thin, flat SKUs like
sheetrock, wood planks, metal sheets. This will be discussed further
later in the chapter.

+« Help Button: Clicks this button to access the on-line help information
in this topic.

Note: The Tab key allows you to easily move forward to the next field.
To move backward to a previous field, use the Shift and Tab keys
simultaneously.

Size Tab (Define SKU)

The Size tab allows you to define the dimensions of a SKU. This is where
you will name the SKU and enter the required dimensions for the SKU.
You will also start to define specific loading parameters in this screen.

+ SKU Style: MaxLoad Pro allows you to define five types of SKU’s:

m PalletLoad: A PalletLoad is a SKU that represents an entire
unitload. It’s beneficial to define a SKU as a unitload any time
you want to show a single object loaded onto a pallet or slipsheet.

For example, you might receive a complete palletload of product
from a supplier. Rather then referring to the palletload as 50 cases
of peanut butter, you can refer to it as one pallet of peanut butter.
If you do want to show 50 cases of peanut butter loaded onto a
pallet — and have some say in the pallet pattern used when building
the unitload — define the SKU as a shipcase or drum, then create a
unitload for the SKU.

56 in]

The above examples show PalletLoad SKUs on pallet with and
without overhang and on a slip sheet. The dimensions entered
represent the dimension for the overall palletload include the
pallet.
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m Shipcase: A rectangular or square object to be referred to as an
individual item.

m Drum: A cylindrical object to be referred to as a single item.

m Tote SKU: A Tote SKU can only be created by saving a Tote
Manifest via the File | Save Manifest as SKU function, as indicated
by the dimension and weight fields being grayed out. You can,
however, define the orientation of the Tote SKU using this menu.

m Pallet SKU: Similar to the Tote SKU, the Pallet SKU can only be
created by saving a Mixed Pallet Manifest via the File | Save
Manifest as SKU function. However, you can define the
orientation of the Pallet SKU in this dialog box.

m L Shape: Any L-shape object like chair, sofa or similarly shaped
items.

SKU Number: The SKU Number field is alphanumeric and holds up
to 32 characters. Each SKU must have a unique number or name.
SKU numbers are sorted numerically and/or alphabetically in a
database within MaxLoad Pro. To display and access a list of existing
SKU'’s, click on the down arrow to the right of the field. If you select
a SKU from the predefined list, the information for that SKU will
automatically fill in the screen.

SKU Description: The Description field is also alphanumeric. This
field holds up to 50 characters and allows you to give your SKU a
more easily recognizable name. This field is optional and does not
need to be filled in if you feel the SKU number provides an adequate
description.

Note: The SKU Number and Description fields are found in the
Sizing, Stacking and Graphics tabs. Changes or additions on one tab
are automatically transferred to the other tabs. This also means that
you can begin defining a SKU from any of the three tabs.

Pallet: The Pallet field is only available when you’re defining a
PalletLoad. You can choose from multiple pallet/slipsheet styles from
the drop down list. MaxLoad Pro will draw a single block to represent
a unitload on top of the pallet. If the pallet or slipsheet is not present
in the list, you can define a new one in the Define Pallet screen

Dimensions: You’re required to enter values for Length, Width,
Height and Weight for the SKU you’re defining. You must enter
values in each field. The Weight field is optional and can be set to
zero. Be aware that if you choose to do this, MaxLoad Pro will not
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calculate accurate weight values — total weight, weight efficiency and
estimated axle weights — for your load.

Many industries have different opinions on how to define length,
width or height. As a rule of thumb, the packaging industry defines
height as the dimension that runs through the case flaps. In other
words, if SKU height is set vertical, the case flaps will always face up
or down.

Extending this definition, length is defined as the largest dimension of
the remaining two dimensions. Width would then be the last
dimension undefined. Keep in mind that this is a general rule used in
the packaging industry; your industry may be different.

« Diameter: When you are defining a drum style SKU the length width
dimensions get replaced by diameter. Here you enter the width of the
cylindrical SKU.

s Maximum Overhang: Maximum Overhang represents the distance
the SKU can overhang the SKU placed beneath it. The overhang can
be defined by the length, width, and diameter of the SKU/load. In case
of Maximum Overhang by Height, it refers to the distance this
dimension can overhang when placed on its side.

+« Allowed Vert: This field allows you to choose the way the SKU is
loaded into a transit container. The Allowed Vertical checkboxes tell
MaxLoad Pro which dimension is allowed vertical when loading.
Check the appropriate box to designate that dimension as vertical.
You can check any combination of dimensions to be vertical, or you
can designate only one dimension to be allowed vertical.

For example, in many cases, packaging for certain liquids is marked
“This End Up T.” This end is usually the top of the shipcase — where
the case flaps are located — and therefore you’ll notice that the
dimension designated vertical is the height.

If your product displays this characteristic, height would be the only
dimension allowed vertical. If an item has no critical dimensions —
and is not marked with a “This End Up T ” warning — you can
designate other dimensions (length, width or both) to be allowed
vertical.

%

% Preferred Vert: This field is defined as the dimension that must be
vertical when loading on the floor, if there is such a restriction for your
product. This column contains four radio buttons — labeled Length,
Width, Height or No Preference — one of which must be selected.
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MaxLoad Pro gives you these choices because most boxes usually
have one dimension that is stronger than the other two. When the
SKU is not being loaded on the floor, MaxLoad Pro will first attempt
to load an SKU with its preferred dimension vertical. If this is not
possible, it will use any of the other Allowed Vertical dimensions.

You’re not required to commit to a Preferred Vertical dimension.
Simply select No Preference. Therefore, whenever an SKU is placed
on the floor, MaxLoad Pro will evaluate any dimension allowed
vertical when determining the most efficient placement.

Note: The contents of the Preferred Vertical field are mutually
exclusive, meaning that you can only choose one Preferred Vertical
dimension (or No Preference) from the available Allowed Vertical
dimensions.

Further, you cannot choose a dimension as Preferred Vertical if that
dimension has not been designated as Allowed Vertical (the Preferred
Vertical fields will be grayed out). If you select one dimension as
Allowed Vertical, that dimension will automatically be selected as
Preferred Vertical.

Piece Count: This field reflects the quantity of items going into the
SKU. Piece Count will be used in the Manifest List to reflect the total
piece count of items for the specific SKU.

Color: MaxLoad Pro uses the standard (48-color) Windows Color
Selection dialog box, which allows you to select a custom color for
each SKU. However, MaxLoad Pro also allows you to override the
designated color of the SKU when it is drawn. You can check the color
currently used for an SKU by looking at the color box located in the
lower portion of the Size tab.

To change the color of an SKU, follow these instructions:
1. Click on the color box. The Color Selection dialog box appears.
2. Click on acolor to select it.

3. If the color is correct, click on OK. The Color Selection dialog box
closes. MaxLoad Pro assigns the selected color to the SKU.
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Family. (Not implemented) This field allows you to specify if the
SKU is categorized as Frozen, Cooled, Dry and Unknown. MaxLoad
uses this information to make sure SKU’s of the same family will be
are loaded together at specific locations.

X/
°e

Height Base: For a L-shape SKU, this represents the height of the seat
portion of the SKU.

X/
L X4

Width Base: For a L-shape SKU, this represents the thickness of the
back portion of the SKU.

X/
L X4

Slope: Check this option when the L-shape SKU has a slope side.

Width
Base

L-shape
with Slope

<4—Height
Base

Stacking Tab (Define SKU)

Size Stacking |  Graphics |
SKL Style |Shipcase j Cloze I
SKLU Mumber ICUmputel j Save |
Diescription IPentium 200 mhz. Mew
Delete |
II; gztltgi el Pl ((: Muszt Be Stacked On Floor m
Must Mot Be Stacked On Floor Cast |

& BestFit

Load Into Vehicle " Prefer On Floor
™ Load By Length " Prefer On Tap
™ Load By Width 5
tack Code ] -
* Best Fit _New [aal |

- Mo stacking on tops Max Stack Height  [On Base) 100

Bundle

of side loadeditems |\ ook Height  [On Side] [100
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The Stacking tab allows you to define parameters for stacking the SKU
within a vehicle or onto a pallet.

Chapter 3: Defining MaxLoad Pro Databases 3.7



% Conveyance Options: MaxLoad Pro gives you two options for
loading a SKU into a vehicle:

m Unitize: This option is available only after you’ve created a
unitload for the SKU you’re defining. Once you’ve created a
unitload, this box will automatically initialize. When you check
this box, the SKU will automatically appear with the UL column
checked in the Manifest List on the Define Manifest screen. If this
box remains unchecked, the UL column will appear unchecked in
the Define Manifest screen. In this case, remember that you can
always check the column when you define the manifest.

m Put on Mixed Pallet: This option behaves like the Unitize option.
If you initialize this box, its corresponding column (MP) will
appear checked in the Manifest List in the Manifest Pick List
screen. This means the SKUs that do not make a full unitload will
be placed onto a mixed pallet, instead of being loaded directly to
the floor of the vehicle.

Note: The conveyance options are not available if you are defining a
PalletLoad style SKU.

¢ Load Into Vehicle: MaxLoad Pro gives you options as to how an item
may be loaded into a vehicle. For example, certain SKU’s can be
loaded only by a forklift from one direction and this can be defined
within MaxLoad.

You have three choices on how to load a SKU into a vehicle.

m By Length: Loads the length of the SKU parallel with the length
of the trailer.

m By Width: Loads the width of the SKU parallel to the length of
the trailer.

m Best Fit: Shows no preference; loads the SKU using the best
orientation in relation to other items being loaded.

X/

% No stacking on tops of sided loaded items: Check this option if you
want this SKU not to be loaded on top of SKUs that are loaded on
their sides.

+ Dead Stacking Rules: Dead Stacking Rules are guidelines for how
MaxLoad Pro will load SKU’s into a vehicle when they're not placed
on a pallet (sometimes referred to as floor-loading).

m Must Be Stacked On Floor: MaxLoad Pro will disregard any
solutions in which the SKU is not placed on the floor.
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m  Must Not Be Stacked On Floor: MaxLoad Pro disregards any
solutions in which the SKU is placed on the floor.

m Best Fit: MaxLoad Pro disregards the two options above and
places the SKU where it's most efficient in relation to other items
in the load.

m  Prefer On Floor: MaxLoad Pro will place the SKU on the floor if
given the choice of either placing it on the floor or on top of
another SKU.

m Prefer On Top: MaxLoad Pro will place the SKU on top of
another SKU if given the choice of either placing on the floor or on
top of another SKU.

+ Stack Code: Defines the stacking relations among different SKUs.
The code establishes parameters that a class of SKUs would use. This
field contains 10 characters. Whenever you add a new SKU to the
database, you'll need to assign a new or existing stack code to the
SKU. Most likely, you'll have one stack code that represents a group
of SKU’s. However, if each product you ship is unique in regard to
how it can be stacked, you may want to define a unique stack code for
each individual SKU.

MaxLoad Pro treats all SKUs with the same stack code in the same
manner regarding; (1) which SKUs can be loaded on top of other
SKUs and (2) which SKU’s can be placed under other SKUs.

For example, your company ships five different types of lampshades,
all identical except for color. In this case, you'd group these five
SKUs together using the same stack code. However, if you
manufacture another type of lampshade made of paper machete, you'd
assign a stack code different from the other five lampshades because
the paper machete would change the stacking characteristics.

For SKUs that have no stacking restrictions, we recommend that you
use the default stack code “All/All.” When you define a SKU and
click on OK to save it, the stack code will automatically appear in the
Stack Matrix. We'll discuss the stack matrix in greater detail later in
this chapter.

If you can't find a stack code that suits your needs, you can define a
new stack code. To define a new stack code for the stack matrix,
follow these instructions:

1. Click on the New button found just the left of the Stack Code field.
The Define New Stack Code dialog box appears.
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Stack Code I

Cancel

Default Value
This can stack on others =
Other can stack on this res -

In the Stack Code field, enter a new stack code. You can key in
any alpha/numeric combination up to 10 characters long.

In the Default Value field, specify — Yes or No — whether other
SKU's can be placed under or on top of this SKU. Use these
guidelines:

m This can stack on others: Can this SKU stack on top of other
SKUs? |If so, select Yes. If this SKU cannot stack on top of
other SKUs, for example. when it is very heavy, select no.

m  Other can stack on this: Can other SKUs stack on top of this
SKU? If so, select Yes. If no other SKUs can be stacked on
top of this SKU (as in the case of the paper machete
lampshade), select no.

Keep in mind that you're deciding how this SKU relates to all other
SKU's. You may find it necessary to make changes in the stack
matrix if an SKU relates differently to other SKUs on a case-by-
case basis.

If all your stack code information is correct, click on OK.
MaxLoad Pro saves the new stack code to the SKU database.

Default Stack Codes

MaxLoad has provided several default stack codes to provide quick
classification of stack relations among different SKUS:

All/All:  Assigned to SKUs which can be stacked on top of all
items and all items can be stacked on top of it (current SKU being
define).

All/None: Assigned to SKUs which can be stacked on top of all
items but nothing can be stacked on top of it.

None/All: Assigned to SKUs which cannot be stacked on top of
any items but all other items can be stacked on top of it.
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m  None/None: Assigned to SKUs which cannot be stacked on top of
anything and nothing can be stacked on top of it.

Note: When stacking same SKUs, MaxLoad will refer to Maximum
Stack Height instead of the Stack Code for load solutions.

% Maximum Stack Height (On Base): Defines the number of layers
high the same SKU can be safely loaded on its base. Use this option
when the case flap is facing the ceiling.

« Maximum Stack Height (On Side): Defines the number of layers
high the same SKU can be loaded on its side. This field compliments
the stack code.

For example, when you defined a SKU for Computer Monitors, you
also defined a stack code that tells MaxLoad that Computer Monitors
can be stacked on top of one another. However, the stacking strength
of the bottom Computer Monitor dictates that you can only stack this
SKU four layers high. In this case, enter “4” for four layers in the
Maximum Stack Height on Base field.

% Maximum Stack Weight: Defines the maximum weight that can be
placed on an individual SKU. This field is defined in units of measure
(either English or Metric) representing weight, and also compliments
the stack code. Even though the stack code allows one item to be
placed on top of another item, this field will override the stack code to
limit the weight of a placement on top of a particular SKU. By the
nature of this calculation, a stack of SKUs will always be limited to the
maximum stack weight of the product on the bottom of the stack.

Note: When building a stack of like SKU’s, Maximum Stack Height
takes precedence over Maximum Stack Weight. That is, when
building a placement of like SKUs, MaxLoad Pro will only take the
defined Maximum Stack Height into consideration when determining
how to build the placement. However, if there is space for a different
SKU to be placed on top of the stack, MaxLoad Pro will then consider
the Maximum Stack Weight to determine the new placement.

Maximum Stack Height also takes precedence over the stack matrix.
For example: 1 define a SKU and assign it a new stack code. In the
stack matrix, | say that this SKU cannot stack on top of itself.
However, if when defining my SKU I also say that the SKU can stack
three layers high; this parameter will take precedence over the stack
matrix, which says that | cannot stack this SKU on top of itself. This
rule was made in an effort to help users limit the number of stack
codes within the stack matrix.
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For example, my Computer Monitors weigh 30 pounds each. | define
the maximum stack height of a computer to be five units tall and the
maximum stack weight to be 100 pounds. Is a stack of five computers
a legal placement? Yes — regardless of the fact that the bottom
computer will be supporting 120 pounds.

Another example, suppose I've stacked three computers on top of one
another, meaning that the bottom SKU (computer) is supporting 60
pounds. | notice that there is room to load a 60-pound box of stereos
on top of the computers. Is this stack of three computers and one
stereo a legal placement? No! Why not? Because the maximum stack
weight of 100 pounds will be violated when the stereo is loaded.

Label: The Label feature allows you to designate another name for a
SKU, as opposed to being limited to the SKU Number. For example,
perhaps the SKU Number of a box of parts is “8315,” but the SKU is
commonly referred to as “Coils.” The custom label allows you to
assign the SKU both names, while at the same time giving you the
control over which name is used when printing.

To initiate this feature, simply type in a string to use as the label. The
string should be alpha/numeric and can contain up to 20 characters.

Stack Limit: (Not Implemented) This parameter determines how
many total SKUs can be in a stack.

Location: (Not Implemented) This parameter determines where inside
the vehicle the SKUs will be placed.

Stack Matrix

The Stack Matrix allows you to define the stacking relationships between
the various stack codes, which are assigned to SKU’s in the Define SKU
screen. The stackability matrix is a square matrix contains one row and
one column for each stack code.

To access the stackability matrix, open the Define menu and select Stack
Matrix. The Stack Rules screen appears, along with the stackability
matrix.
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= MaxLoad - Stack Rules M=l B3
File Edit Wiew Define Tools Layout Help

_I 0K | Eancell Deletel Add | ez | Na | Fiebuild | ISort: Code-Agsceding j

Default Heawy Light T1 o
Default 0 Yes No
Heaww |Yes : Yes Yes
Light D 0 : :
T1 Yes : Yes Yes
Can Heavy stack on Light? : No [ [NuM[ W_//I,

Note: Always start with category at columns, then go left to find the
corresponding category along rows. At the current intersected cell, the
entry “No” means “Heavy” cannot be stacked on tops of “Light”.

Notice that the Stack Rules screen contains the following:

+ OK Button: Clicks to accept all changes made to the stack matrix
during the current visit and returns you to the Define SKU screen.

+« Cancel: Clicks to cancel all changes made to the stack matrix during
the current visit and returns you to the Define SKU screen.

+ Delete Button: Uses to delete a stack code by first highlighting the
row or column header and click on the Delete button.

+« Add Button: Allows you to add a new stack code through the Define
New Stack Code dialog box.

+ Yes Button: Allows you to change all values to Yes for a particular
row or column.

+« No Button: Allows you to change all values to No for a particular
row or column.

+ Rebuild Button: Searches the SKU database for any stack codes that
have not been added to the Stack Matrix. MaxLoad Pro updates the
Stack Matrix with the new stack codes.

X/
L X4

Sort Field: Allows you to sort the Stack Codes in ascending order
(alphabetically), descending order (alphabetically), or by insertion
order.

When you define a SKU, the stack matrix initializes automatically. To
work with the Stack Rules Screen, use these guidelines:

m  When you enter a new stack code, MaxLoad Pro adds a new row
and column to the matrix. Each entry in the matrix is a box
marked with a “Yes” or “No.” The Yes/No indicate whether a
SKU with the stack code for the corresponding column can be
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loaded on top of a SKU with the stack code for the corresponding
row.

m The stack codes across the top of the matrix (columns) are
considered the “top” SKU, while the stack codes along the side of
the matrix (rows) are considered the “bottom” SKU.

m  Click on column and row headers to highlight the entire row or
column (or both).

m Use the gray scroll bar or the arrow keys to move around the stack
matrix.

m To change a single Yes/No value inside individual cell, simply
click on it.

Graphics Tab (Define SKU)

Size | Stacking £ GRERRIES
SKLU Style IShipcase j Cloze I
SKU Murber [TV =] Save |
Diezcription ISunound Sound Plus Mew |
Delete |
Create LIL
Top graphic I | —I
Cozt |
Side graphic I |
Bundle |
Front graphic I |
Sk Info 1 I
sKUlrfo2 |
SKUIrfa3 |
[” Consumable

The Graphics tab allows you to place some graphics on the SKU.

+« Top Graphic: This option allows you to place a graphic on the top of

a SKU. Click on _I button to browse to a location from where you
can pick a bmp image to be placed as a graphic on the top of the SKU.

% Side Graphic: This option lets you place a graphic on the side view
of the SKU.
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Front Graphic: This option is used to place a graphic on the front
view of the SKU. The Front Graphic option is not available for
Palletloads.

« SKU Info: SKU Info fields are some useful fields which the user can
use to write notes about a SKU. These get placed in the SKU List and
the Manifest List and is only available in the Manifest report.

X/
L X4

Consumable: You can check this box to specify if the SKU is
perishable.

General Tab (Create Unitload)

The General and Options Tab described in this and following section can

be found upon clicking the ﬂl button in the Define SKU dialog
box.

When MaxLoad Pro loads a shipcase or drum onto a pallet or slipsheet,
this is known as creating a unitload. First, you must either create a SKU
or select an existing SKU from the drop down list.

General | otens | | D I Top I Side I Frant I
Pallst IGMA Motched = oK I
Cancel
tdaximum Height Incl Pallet — (in] E5.00 —I
Calculate |
Maximum Weight Incl Pallst  In)  [3333
Masinun Lengh Ovetheng ) [100 5]
Masimum Width Overhang  (in)  |1.00
Layer Rotate Laper Potate
-_DK
14 | IS
BOE 7§ [
™| Length Clampable 12 = 26 ]
™ “width Clempablz 1 = I8
Rotate Alt
R R 4|
il 23 Clear Fotat |
Casze Dim Len Yifid Hat Wit Pat Tupe | Cases/Laper Lavers/LIL Cases/UL o o cornolee
& o o=
Hat 48.00} 40,00 57.00) 1265|2BLK. 20) 4 0 7 | 21 l
Hgt 48.00 40.00) 57.00) 1265[4BLE 20 4 80 5 IS i) ol
Hat 48.00 40.00) 57.00| 1265 3BLE 20 4 a0 5 Layer Rotate
Hat 4800 40,00 57.00) 1265 [3BLK 2 4 [ 4 1o
Hat 48.00 40.00) 57.00| 1208/ 2BLE 19 4 7E| 4 r 18 ] 2 N
Hat 48.00 40.00) 57.00) 1205 3BLE 19 4 7H| 3 vl 17 IS 4 IS
Hgt 48.00 40.00) 57.00| 1205 3BLK 19 4 76 2 16 0
Hat 48.00} 40,00 57.00) 1205|3BLK 19 4 76 r r r
Hat 42,00 40.00] 57.00] 1205[3BLE 19 4 e 1 R
<
FarHelp Contact Tops Software I A

The General tab allows you to select the type of pallet or slip sheet to be
used when creating a unitload, as well as to define the absolute maximum
size of the unitload and a number of loading options.

« Pallet: The Pallet field requires you to select a specific pallet to be
used in creating the unitload. To see a list of available pallets, click on
the down arrow to the right of the field.
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We ship MaxLoad Pro with a list of standard pallets for you to choose
from. However, if you don't see a pallet that suits your needs, you can
always define one.

Note: If you wish to bundle this SKU, but not display it on a pallet,
choose None as the pallet style. MaxLoad Pro will display a grouping
of SKU’s in a specific pattern, but will not display a pallet. You're
still required to enter height, weight and any overhang parameters.

Also, keep in mind that even though you've chosen None as the pallet,
you're still required to define area (length and width) parameters for
this unitload. Therefore, if you define None as a 48-inch by 40-inch
area, MaxLoad Pro will generate answers that reflect a grouping of
products in an area roughly the size of 48-inches by 40-inches in
length and width.

Maximum Height, Weight and Overhang: Maximum Height and
Maximum Weight are self-explanatory. These fields allow you to
assign the maximum height of the unitload, as well as the maximum
allowable weight. These height and weight values include the pallet.

The Maximum Length and Width Overhang fields represent the
maximum distance a SKU is allowed to overhang the edge of the pallet
along the length and width dimensions. You're required to enter a
value for both the length and width. If no overhang is allowed, set
these fields to zero.

Rotate: Click the Rotate button opens the Layer Parameters dialog
box which allows you to rotate selected layers on the unitload.
Unitload with rotated layers provides better stability but may yield
weaker load due to lack to corner support.

To rotate layers, place a check mark against the layer or click the
Rotate Alt button to rotate alternate layers. Click OK to confirm.
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Options Tab (Create Unitload)

General
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Cancel
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Calculate
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The Options tab allows you to select pattern styles to be used when
building the unitload, as well as the loading orientation of the unitload
within the vehicle and stacking rules for the unitload.

« Pattern Styles: The Pattern Styles options tell MaxLoad Pro which

pallet patterns to consider when calculating a unitload.

When it

generates solutions, MaxLoad Pro will analyze any pallet patterns that
have been selected. The table on the next page outlines the various
pallet patterns.

Pallet Patterns

Pattern Style Is Designed Like This

Staggered Applicable to Drum SKUs, this pattern allows
more d(ums to be packed per layer through
staggering.

1 Block Block pattern or column stack

2 Block Bi-Block pattern

3 Block Tri-Block pattern

4 Block Pinwheel pattern

5 Block Penta-Block pattern

5 Block Plus Penta-Block Plus pattern

Soldiered Pattern that spreads the boxes to allow other
boxes to be slid down in between.
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Diagonal Diagonal pattern

Multi-Dimension | Each layer can have a different dimension

vertical

Multi-Surface Loads pallet top-to-bottom, front-to-back, and

side-to-side with multi-dimensions allowed.
Very complex and usually recommended in
rear loading circumstances.

Multi-Layer Puts cases onto the pallet with the last layer

with different dimensions vertical.

« Load Into Vehicle: This option determines the orientation of a
unitload when it's loaded into a vehicle:

Load by Length: The length of the unitload is loaded parallel to
the length of the vehicle.

Load by Width: The width of the unitload is loaded parallel to
the length of the vehicle.

Best Fit: The unitload is loaded using the most efficient
orientation, with no consideration of any limiting parameters.

Stack Rules: Stack rules for a unitload work like the stack rules for an
individual SKU. There are three options:

Must Be Stacked on Floor: MaxLoad Pro will disregard any
solutions in which the unitload is not placed on the floor.

Must Not be Stacked on Floor: MaxLoad Pro disregards any
solutions in which the unitload is placed on the floor.

Best Fit: MaxLoad Pro disregards the two options above and
places the unitload where it's most efficient in relation to other
unitloads.

Stack Code: It's important to remember that the stacking rules defined
for the unitload take precedence over the individual stacking rules of
the SKU’s that make up the unitload. Due to outside factors such as
corner posts, padding, etc., SKU’s are generally considered to be
stronger when loaded as part of a unitload.

You can assign a Stack Code to a unitload just as you can an
individual SKU. Stack Codes will appear in the Stack Matrix along
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with all other Stack Codes that were defined when defining an SKU.
You can choose an existing stack code, or define a new one.

% Max Stack Height: Max Stack Height (UL’s) defines the maximum
number of stacks this unitload can accommodate when it's loaded on
itself; that is, the unitload you're defining plus any unitloads stacked
on top of it. For example, if you can safely load only one other
unitload on top of the unitload you're defining, Max Stack Height
would be two. However, if you can safely stack two other unitloads
on top of this unitload, Max Stack Height would be three.

« Max Stack Weight: Max Stack Weight (IL’s) defines the maximum
amount of weight that can be placed on top of the unitload. This value
is defined separately from the Max Stack Weight of the SKU.
However, when it comes to these values, you'll need to decide which
takes precedence: the individual SKU or the associated unitload.
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Unitload Solution

After you've completed the General and Options tabs, you're ready for
MaxLoad Pro to generate the unitload solutions. To generate unitload
solutions, follow these instructions:

1. Click on the Calculate button. The Create Unitload (UL) screen
redisplays with a list of possible solutions displayed in the bottom
portion of the screen. MaxLoad Pro calculates these solutions based
on the pallet patterns selected in the unitload parameters.

. MaxLoad - Create UL: -- Case 3 Pattern 1 of 48 gl x|

File Edit View Define Tools Layout Help
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Hat 48.00) 40,001 57.00 1205 3BLK. 19 4 7| 95.0 %] 753:
Hat A8.00) 40.00 57.00 1205 3BLK 19| 4 7| 95.0 %] 753iv|
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Each unitload solution includes the following information:

+«+ The case dimension designated as vertical

*,

% The length, width, height and weight of the unitload
+«+ The type of pattern used to build the unitload

¢ Number of cases per layer

+«+ Number of layers per unitload

¢ Number of cases per unitload

+«+ Area and cubic efficiency of the unitload
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The g.0.d. window in the upper right portion of the screen displays a
graphic of the selected unitload solution. Use the down (¥) arrow or
gray scroll bar to the right of the solution list to see the next solution.
As you scroll through the list, notice that the g.0.d. window changes to
reflect the different possible solutions. Additionally, notice that the
information on the title bar changes to reflect the solution that you're
currently viewing.

MaxLoad Pro allows you to view the unitload diagram in a number of
ways. All options are accessed through the view buttons on top of the
g.0.d. window.

In each view for the selected solution, you can rotate the unitload
using the arrow keys after clicking anywhere inside the g.0.d. window.

View Options

Option | View of the Unitload

3D Shows a 3-dimensional view of the unitload

Top Shows a top view of the unitload (view from above the
unitload looking down)

Side Shows a side view of the unitload

Front Shows a front view of the unitload

2. Select the pallet pattern that best suits your needs.

3. To rotate layers in the unitload, click on the Rotate button to open the
Layer Parameters dialog box.
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m Rotate: Clicks the corresponding box in the Rotate Column to
rotate the corresponding layer.

m Rotate Alt: Clicks this button to quickly rotate alternate layers of
the unitload, instead of checking off individual layers.

m Clear Rotate: Clicks this button to clear all layer rotation.

4. Click OK to save layer rotation or click on Cancel to cancel. Rotated
layers will apply to all unitload patterns.

5. Click OK again to save the selected pallet pattern and accompanied
layer rotation, if applicable.

MaxLoad Pro saves the selected pallet pattern to this particular SKU.
Therefore, when you select the SKU in the Define Manifest screen and
click on the Use Unitloads box, MaxLoad Pro draws the SKU in the
vehicle using the selected pallet pattern.

To change the pallet pattern in the future, follow the steps outlined
above to save another unitload pattern.
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Creating a Unitload vs. Defining a Palletload SKU

By now, you may have noticed that MaxLoad Pro allows you to create a
unitload as well as define a palletload. What’s the difference? While
defining, you must have noticed that the two have quite distinct features.

When you create a unitload, MaxLoad Pro loads individual shipcases or
drums onto a pallet/slipsheet with other identical SKU’s. In doing so,
MaxLoad Pro considers the pallet style, dimensions/weight of the SKU,
whether or not the SKU can overhang the edge of the pallet, as well as
various pallet patterns. Multiple shipcases can be loaded together to create
a unitload. This option is available when you define a SKU. However,
only shipcases or drums can be combined to create a unitload.

Defined Palletload SKU Created Unitload

Whereas, when you define a palletload, you're defining the outside
dimensions of the unitload, without considering the individual shipcases
that combine to create a unitload. As with creating a unitload, you must
choose a pallet style. However, the dimension you enter will be the
absolute dimensions of all of the SKU’s when loaded onto a
pallet/slipsheet. The result is a block drawn onto a pallet. A SKU already
defined as a palletload cannot be loaded with other objects to create a
unitload.

Reason why we make the above distinction is that, many of our customers
don't want to concern themselves with the pallet patterns that make up a
unitload. Perhaps they receive pre-built unitloads and have no control
over how a unitload is built. When these companies pick a unitload for
shipping, they usually refer to an entire unitload as one object, rather than
by the quantity of individual SKU’s that combine to create a unitload.
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Define a SKU

To define a SKU, start from the Define SKU screen and follow these
instructions:

1. Click on the Size tab, if necessary, to activate it.

2. From the SKU Style drop-down list, select SKU Style.

Size I Stacking | Graphics |
SKU Style IShipcase j Cloze
SKU Nurnber |E?2?ESBE?? ﬂ Save
Description IMaHInad User Guide New
Delete
Firad

Calar - b aximum Allowed Prefered | Create UL

Wert Wert
Owerhang Cost

Length [in] (10.00 0.00 [ IS

. Bundle
Width fin) |3.50 0.00 rs c Help
Height (in] IH-':“:' 0.00 v (o
‘wigight (k] |1.|:“:| ¥ Mo Preference
Piece Count |1
Farmily I vl

3. Enter information in the following Size tab fields:

% SKU Style: When the SKU screen appears, your first decision is
which type of SKU you want to define. The five types of SKUs
that can be defined using MaxLoad Pro are palletload, shipcase,
drum, tote SKU, and pallet SKU.

«» SKU Number: Enter a SKU number.

«»+ Description: Enter a description for the new SKU. This field is
optional; you can leave it blank.

«» Pallet: Select a pallet. This field is available only if your selected
SKU style is a PalletLoad.

Note: MaxLoad Pro allows you to choose from a large database of
both pallets and slipsheets. If you cannot find the pallet you’re
looking for, you can define a new one.
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% Color: Click on the Color field to display the Color Selection
dialog box. Select a color for the new SKU.

% Length: Enter the absolute length of the SKU.
+« Width: Enter the absolute width of the SKU.
% Height: Enter the absolute height of the SKU.

+« Diameter: Enter the diameter of the drum. This field is only
available if your selected SKU style is a drum.

For example, if you are defining a Palletload style SKU, using a
GMA Notched pallet (48” by 40”) with one inch of overhang
along both the length and width, enter a length of 50 inches and a
width of 42 inches (48” by 40” plus an inch of overhang on both
sides of the pallet).

% Weight: Enter the weight of the SKU
+ Piece Count: Enter the quantity of items loaded in this SKU.

% Maximum Overhang Length: Enter the maximum number of
inches the SKU can overhang the SKU placed beneath it along its
length.

« Maximum Overhang Width: Enter the maximum number of
inches the SKU can overhang the SKU placed beneath it along its
width.

% Maximum Overhang Height: Enter the maximum number of
inches the SKU can overhang the SKU placed beneath it when it is
placed on its side.

« Maximum Overhang Diameter: Enter the maximum overhang
along the diameter of the drum. This field is only available if a
Drum style SKU is being defined.

«» Allowed Vertical: Select the dimension(s) that will be allowed as
the vertical orientation.

< Preferred Vertical: Select the dimension that will serve as the
preferred vertical orientation. If there’s no preference, select No
Preference.
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4. Click on the Stacking tab to activate it. The Stacking tab appears, as

pictured here.

Size footacking " Graphics |
Sk Style IShipcase j Cloze I
SKU Mumber  |97273328677 4 Save |
Dezcription IMaxLoad Jser Guide Mew

[elate

Create UL

¥ Uritize . " Must Be Stacked On Floor —l
V' Put On Mixed Pallet " Must Mot Be Stacked Or Floor Cost |
¥ Best Fit
{” Prefer On Floor ﬂl
” Prefer On Top

Load Into Yehicle
" Load By Length
" Load By wWidth
{* Best Fit

r Mo stacking on tops

Stack Code Mew IAII;’AII bt I

Max Stack Height  [On Baze] {100

of zide loaded items Mas Stack Height  (On Side] [100 Loc§t|0n
& Light
Max Stack ‘weight  [Ib) ID  Medium
Label [ " Heavy

5. Enter information in the following Stacking tab fields:

Unitize: Check this box to tell MaxLoad Pro to use this SKU as a
unitload, whenever possible. This option is available only after
you’ve created a unitload for the SKU.

Put On Mixed Pallet:
mixed pallet.

Check the box to place the SKU on a

Load into Vehicle: Select an option for loading shipcases into a
vehicle — Load by Length, Load by Width or Best Fit.

No stacking on tops of side loaded items: Check the box if this
shipcase should not be loaded on top of items loaded on their side.

Dead Stacking Rules: Select an option for loading shipcases on
the floor — Must Be Stacked On Floor, Must Not Be Stacked On
Floor, Best Fit, Prefer On Floor or Prefer On Top..

Stack Code: Select an existing stack code or define a new one.

Maximum Stack Height (On Base): Enter a maximum stacking
height when the SKU is stacked on its base.

Maximum Stack Height (On Side): Enter a maximum stacking
height when the SKU is stacked on its side. This is not available
for PalletLoad style SKU’s, as they can not be loaded on side.
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Maximum Stack Weight: Enter a maximum stacking weight of
the SKU.

X/
°e

Location: Check — Light, Medium, or Heavy- depending on
which SKUs can stack on top of the SKU being defined and which
cannot.

« Label: Enter an optional label for the SKU.

6. Click on the Graphics tab to activate it. The Graphics tab appears, as
pictured here.

Size | Stacking  §BrEpHES
Sk Style IShipcase j Cloze I
SKU Mumber  |97273328677 4 Save |
Dezcription IMaxLoad Jser Guide M
[elate |
Create UL
Top graphic I | —l
Cost |
Side graphic I |
Bundle |
Front graphic I |
SEU Info 1 I
SKUInfa2 |
kU3 |
[" Consumable

7. Enter information in the following Graphics tab fields:

% Top Graphic: Use the Browse function to select a graphic for the
top of the SKU.

X/
°e

Side Graphic: Use the Browse function to select a graphic for the
side of the SKU.

s Front Graphic: Use the Browse function to select a graphic for
the front of the SKU

8. If all your graphics parameters are correct, click on the Save button.
MaxLoad Pro saves the new SKU to the SKU database.
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Create a Unitload

To create a unitload, start from the Define SKU screen and follow these
instructions:

1. Click on the Create UL button. The Create Unitload (UL) screen
appears. Notice that this screen has two tabs: General and Options tab.

= MaxlLoad - Create UL: - Dlll

File Edit View Define Tools Layout Help

%5 - XD OO =

General I Optiohs | | 3D I Top I Side I Front I
Palet  [Gha Notched 4| oK |
Maximum Height Incl Pallet —— [in] |55 0o
Maximum /eight Incl Pallet  (Ib) |9999 4'
taximum Length Overhang (i) I‘I .00 ﬂl
b amimum YWidth Overhang [in] I'I .00

™| Lenath Clampatie
= w/idth Clampablz 55,00 [in

| =)
CaseDim [ Len [ wid T Hat T “wat T ParTeoe | Casesdlaver | Lavers/UL | Cases/UL | AresBff [ CubicEff |

For Help Caontact Tops Engineering ML &

2. At the General tab, enter the following information.

% Pallet: Select a pallet from the drop down list. If you don't see a
pallet you want, you can define a new one.

X/
°e

Maximum Height Incl Pallet: Enter the maximum height of the
unitload, including the height of the pallet.

X/
°e

Maximum Weight Incl Pallet: Enter the maximum weight of the
unitload, including the weight of the pallet.

X/
°e

Maximum Length Overhang: Enter the maximum number of
inches the unitload can overhang the pallet along the length of the
pallet.
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Maximum Width Overhang: Enter the maximum number of
inches the unitload can overhang the pallet along the width of the
pallet.

3. Click on the Options tab to enter the following information.

General Ophioks I
— Pattem Styles — Load Into Wehicle oK
V¥ Staggered " Load By Length 4|
¥ Elockl ~ Load By width
I Black2 9 il Calculate |
I Block3 —Stack Rules
[ Blockd
™ Blocks € Must be Stacked on Floor
™ ElockS Plus £ Muszt Not be Stacked on Floor
) & BestFit

[ Soldiered
V' Diaganal Stack Code New [anal =]
[ Multi Dim _
I Muli Suface tax Stack Height [ULs] ID
™ Multi Laper Max Stack Weight [l IU.UU

Pattern Styles: Select the pattern styles you want MaxLoad Pro
to look at during the unitload building process.

Load Into Vehicle: Select an option — Load by Length, Load by
Width or Best Fit — to specify the orientation (if any) of the
unitload when it's loaded into a vehicle.

Stack Rules: Select an option — Must be Stacked on Floor, Must
Not be Stacked on Floor or Best Fit — to specify any stack rules for
this unitload when it's being loaded into a vehicle.

Stack Code: Select an existing stack code or define a new one.

Maximum Stack Height: Enter a maximum stacking height for
the unitload.

Maximum Stack Weight: Enter a maximum stacking weight for
the unitload.

4. If all of your unitload parameters are correct, click on the Calculate
button.

5. Select the pallet configuration you’d like for the SKU and click on OK
to save the pattern and back to the Size tab of the Define SKU screen.

6. Click the Save button to save the SKU and the unitload to the SKU
database.
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Modify an Existing SKU
To modify an existing SKU, follow these instructions:

1. Click on the down (v) arrow to the right of the SKU Number field.
The drop-down list displays a list of existing SKU'’s.

2. Select the SKU you want to modify. The Define SKU screen
redisplays with information for the selected SKU.

3. Modify information on the screen as necessary.
4. 1f your SKU parameters are correct, click on the Save button.

If you want to modify the SKU and give it a different name, simply
type over the existing description (using standard windows
conventions), and click on the Save button.

MaxLoad Pro saves the modified SKU record to the SKU database.

Delete a SKU from the Database
To delete a SKU from the database, follow these instructions:

1. Click on the down (v) arrow to the right of the SKU Number field.
The drop-down list displays a list of existing SKU’s.

2. Select the SKU you want to delete. he Define SKU screen redisplays
with information for the selected SKU.

3. Click on the Delete button on the middle portion of the screen. A
dialog box appears with the name of the selected SKU and asks “Are
you sure you want to continue?”

4. To delete the SKU, click on the Yes button. MaxLoad Pro deletes the
selected SKU from the SKU database.
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Create SKU Bundle

In addition to creating unitloads, MaxLoad also allows you to define
bundles. Bundles provide a more flexible ways of loading SKUs in
different preferred configurations for better use of the loading space. This
function is available to Shipcase and Drum SKUs. For L-shape SKUSs,
please see the next section.

SKUs will not be loaded as bundles if the options Use Unitloads and/or
Use Mixed Pallets are enabled.

Important: To wuse bundles, you will need to add the line
“DoBundle=True” to the Loadrules.ini file. Please contact TOPS Help
Desk for more information.

To define bundle for SKU, follow these steps:
1. Go to Define Menu and select SKU.

2. Enter the SKU information including SKU Number, dimension and
weight as shown below. You can also select an existing SKU by
clicking the drop down arrow in the SKU Number field.

Size I Stacking | Graphics | | 3D I Tap I Side I Front

SEU Style IShipcase j Cloze
SKU Number Iﬂat panel j Save

Mew
Drescription I

Delete:

Find

Color I Masimurn Alowed Prefered  Create UL
Overhang Vet Wert Cost

50,00 0.00 r -

] Bundle

w00 [omo i

) I Help 1,50 fin
)

)

Length [in]

Width fin

Height fin) |1-50 0.00 ~ ‘sl S
Weight [ IW * Mo Prefersnce 40.00 (in]

PFiece Count l‘\—

Fanily Iﬁ

3. Click on the Bundle button to open the Bundle Preferences dialog box
as shown below. You can set up to three (3) bundle sizes for the SKU.
MaxLoad will load them based on the quantity and space available.
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Bundle Preferences

~Bundle Size
Wertical Orientation Length ‘width Height Allow Partial tin Count

1 |Height =] |Load By Length x| |1 ® |1 X |3s INone -
2 [wigh 7] leadBylengnx] 2 % Jm K[ [Mone =
3 IHeighl j ILUadByLenglhj IU = ID X ID INUne =

100

—Pallet

Height i[5 Style [Biock Stringer (2]
—Slack

Top n o

Len (in] IU

wid M o

+« Bundle Size: Define the property of the SKU bundle:

Vertical — The dimension of the SKU to be loaded vertical inside

the transit vehicle.

Orientation — Define which dimension of the bundle will be

loaded parallel to the side of the vehicle.

Length x Width x Height — Enter the SKU quantities along each
dimension of the bundle. Referencing the example in the dialog
box, the 1 x 1 x 36 bundle will have one SKU along the length and
width of the bundle but 36 SKUs along the vertical dimension.
This configuration is illustrated in the container on the left below.
Note that it shows two bundles with 36 SKUs each placed on a
pallet.

The second bundle preference 2 x 25 x 1 (with SKU width vertical)
will load the SKUs as illustrated in the container on the right
above. It shows only one (1) bundle with 2 SKUs along the length
and 25 along the width but stack only one high. Note that this is
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one single bundle of 50 SKUs. The pallet selected will be sized to
carry all SKUs for the bundle.

Allow Partial — Click the drop down arrow to specify if partial
bundle is allowed and if so, along which dimension.

Min Count — When partial bundle is allowed, enter the minimum
number of SKUs for the partial bundle along the specified

dimension.

Bundle Size
’7 Vertical Orientation Length ‘width Height Allow Partial tir Count
1

|Height =] |LoadByLength x| |3 X |4 X |5 IWidth - 2

The container here shows a load

with a preference which allows

partial bundles. The smaller bundle P
on the right comprises of only 2
SKUs along the width to take
advantage of the tighter space. -
Any SKUs not enough to make a —
bundle will be floor loaded. -

+« Pallet — Specify the pallet, if any, to be used to carry the bundle.
Height — Specify the height of the pallet used for the bundle.

Pallet Style — Select from the drop list the pallet style to be used
for the bundle. The size of the pallet will be the same as the
footprint of the bundle.

« Slack — Define extra space around the bundle to accommodate
clamp or similar tools for maneuvering. If slacks are added to the
bundle length and width, the pallet will be sized accordingly to
include these slacks.
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D

efine Bundle for L-Shape SKU

To define bundle for L-shape SKUSs, click the Bundle button after entering
the dimensions to open the L Shape Bundle Screen as show below.

SKU Siyle ILShape =l Close
SKU Mumber |Loveseat =l Save

Description

Sze | Slacking | Graphies | \ B | Top [ siee [ Fon

I New

Delete

Firidl

Color Maimurn &lowed FPrefered  Create UL
et

Ovethang  Vert Cost

K/
A X4

X/

X/

Length i [so00  [ooo r ~ 42.00 (in]
Bundle
Width i) [¢000 [non r e ’:
Help
Height (in] [42.00 0.00 i~ »
W/eight k) [#0.00 @ Mo Preference _—
40,00
Piece Count 1 fin]
Family l— L Shape Bundle
Height Base fin)[20
Width Base i) 12 I Mo Bundie Bundle Width
|
I™ Slope Length (i) IBD '
Width (in) |52 Optimize: —
8 -+ SKU Bundle
Height [in] |42— Height } Height
—
SKU Width

No Bundle — Click this box to disable bundles for the SKU. If
checked, the SKU will be loaded as a single item and MaxLoad will
use the overall dimension (60x40x42 in this example) of the SKU to
calculate the space occupied by this unit. The space above the seat will
not be treated as loadable space.

Note: Using bundles for L-Shape SKUs is not controlled by the load
rules. This No Bundle option will dictate whether L-Shape SKUs will
be loaded as bundles.

Optimize — Click the Optimize button to have MaxLoad calculate the
bundle size which will be displayed in the dimension fields.

To use an alternate bundle size, enter the dimensions directly along the
Length, Width and Height fields.

» OK - Click OK to use the bundle dimension as entered. Make sure to

click on Save at the Define SKU dialog box to save all set parameters.
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Pallet/Slipsheet Database

The Define Pallet screen allows you to enter parameters for a new pallet or
slipsheet and save it to the pallet database. Start from the Menu Bar and
Open the Define menu and select Pallet. The Define Pallet screen appears.

w . MaxLoad - Define Pallet: GMA Notched ) [m] ]
File Edit View Define Tools Layout Help
%o s XBDW =00 =
e ql
Desciiption |G/ Hotched = [[oee | | Ell | Top | Sie | Font |
Style: INulched Stringer j Save

Slipshest
Length [in] |4E I~ Autosize M
\width fin) |4u = Length sk Deletz
. - = width Tiaty
Height [in) |5 B e Help
weighl (b [ teawidhll [P0 oo [

r~ Construction A
eckboan
® gl Tatal Deckboards

' Double Face Dok bomd Thick
! Heversable eckboard Thickness [inl
Inside Deckboard Width [in

=

=

r—Alignment

" Flush Outside Deckboard ‘wWidth [in] &

" Single Wing Center Deckboard “Width [in] 4

" Double Wing Stringer width W |2

aifset (i) |00 Num Of Stringers z
Loading Priority 0

This screen is comprised of the following components:

s Description:  Enter a description of the pallet or slipsheet you're
defining. Use any combination of letters and numbers. The maximum
length of the description is 32 characters (including any spaces in
between words).

X/
°e

Style: Style field allows you to select a pallet style. Click on the down
arrow to display a list of pallet styles. If you select Slipsheet, the
Slipsheet section of the screen is activated. If you select None,
MaxLoad Pro allows you to create a pallet without labeling it as one of
the existing styles.

The various styles of pallets that can be defined in the MaxLoad Pro
software are:

m None: Use this pallet style if you do not want a pallet to be
displayed in the unitload or mixed pallet view.

m Stringer: This is most commonly used pallet style, in United
States. In a stringer pallet boards of stringers are used between the
top and bottom deck boards. The length and width of pallet is the
length and width of the stringer boards, respectively.
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Notched Stringer: Like a regular stringer, but non reversible and
has notches cut in the side to allow for 4 way entry.

Block: This is a 4-way entry pallets. Blocks of solid wood,
plywood, or plastic to support the unit load

Block Stringer: A stringer pallet is called so because it uses
"stringers,” which support the unit load. The stringers are the
boards, typically 2 x 4's or 3 x 4's, sandwiched between the top and
bottom deck boards.

Euro Pallet: Usually 800mm x 1200mm. This pallet is a
standardized block pallet introduced by the European railroads
after World War 1.

Slip Sheet: Sheet of corrugated slipped under the bottom layer of
a load.

Chep: Pallet style by the pallet manufacturer Chep.

Dimensions: Enter the length, width, height and weight of the pallet
or slipsheet you're defining. For example, a standard GMA (Grocery
Manufacturers Association) pallet, commonly used in the U.S.
marketplace, measures 48” in length by 40” in width, is generally 5” to
6” in height and weighs 65 pounds.

You can define these dimensions either in English or Metric units by
selecting the type of units in the Toolbar.

Constructions: Select the pallet construction style:

Single Face: The deck boards are positioned only on top of the
pallet.

Double Face: The deck boards are positioned on both sides (top
and bottom) of the pallet.

Reversible: The pallet is identical on both sides. A notched pallet
cannot be reversed.

Note: If you choose Slipsheet, Euro Pallet, or a None style of a pallet,
the construction selection is not available.
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% Alignment: Alignment refers to how you position the stringer in
relation to the deck boards.

m  Flush: Aligns the stringer flush to the outside edges of the deck
boards.

Note: Single Wing and Double Wing are options that allow you to
offset the stringers on a double-faced pallet.

m Single Wing: Represents a pallet design that has offset deck
boards on the top, but flush deck boards on the bottom.

m  Double Wing: Represents a double faced pallet design that has
both top and bottom deck boards offset from the stringers.

m  Offset: If you select Flush, the Offset field will be grayed out. If
you select Single or Double Wing, the Offset field will be activated
and you'll need to enter the Offset amount. Offset is the distance
that the stringers will be offset from the edge of the pallet.

% Slipsheet: The Slipsheet section of the screen is activated only if
you've selected Slipsheet as the pallet style. You can add tabs to the
length, width or to both sides of the slipsheet. If you choose to define
tabs as part of your slipsheet, you're required to define a tab width.

You also have the option to autosize the slipsheet. When you activate
the Autosize feature, MaxLoad Pro will automatically cut the size of
the slipsheet down to the outside dimensions of the unitload.

For example, you choose a 48” by 40” slipsheet. Let’s also assume
that once you've created a unitload for your SKU, the outside
dimensions of the unitload equal 47” by 34.” MaxLoad Pro will
automatically trim the dimensions of the slipsheet to 47 by 34.” If
you deactivate this feature, MaxLoad Pro will use the outside
dimensions of the unitload as previously defined (in this instance 48”
by 40™).

« Deck Boards: Deck boards are the flat surface of the pallet on which
you place a product when you create a unitload. MaxLoad Pro
requires you to define the number of inside deck boards, the deck
board thickness, inside deck board width, outside deck board width,
stringer width and center deck board width. You'll enter all values,
except for the number of inside deck boards, in either inches or
millimeters.

Note: If you choose Slipsheet as the pallet style, the deck boards
section of the screen is not activated.
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Loading Priority: When you specify multiple pallet styles to be used
in a truck manifest, MaxLoad will use this value to determine which
pallet to use unless the SKU does not fit on the preferred pallet.
Enter 1 as the first preferred pallet, 2 as second and so on.

Color: To change the color of a pallet/slipsheet, click on the color box
and select the color of your choice for the pallet or slipsheet.
MaxLoad Pro then assigns the selected color to the pallet/slipsheet.

g.0.d. Window: Displays a 3-dimensional graphic image of the pallet.

Close Button: Closes the Define Pallet screen and returns you to the
previous screen.

Save Button: Allows you to save changes to an existing or a new
pallet.

New Button: Allows you to create a new pallet.

Delete Button: Allows you to delete the current pallet from the
database.

Note: The Tab key allows you to easily move forward to the next field.
To move backwards to a previous field, press the Tab key while holding
down the Shift key on the keyboard.

Define a New Pallet

To define a new pallet, start from the Define Pallet screen and follow these
instructions:

1.

Click on the New button. The Define Pallet screen redisplays with
some default values in the dimension fields and the cursor positioned
in the Description field.

Enter information in the following fields:
% Description: Enter a description of the new pallet.

« Style: Use the down-arrow (v) to view a list of pallet styles.
Select a pallet style.

X4

Length: Enter the length of the pallet in inches or millimeters.

L)

>

Width: Enter the width of the pallet in inches or millimeters.

R/
%

7
L X4

Height: Enter the height of the pallet in inches or millimeters.
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% Weight: Enter the weight of the pallet in pounds or kilograms.

+«+ Construction: Select a type of construction — Single Face, Double
Face or Reversible.

« Alignment: Select a type of alignment — Flush, Single Wing,
Double Wing — or key in an Offset value.

«+ Total Deck Boards: Enter the total number of deck boards in the
pallet.

«+ Deck Board Thickness: Enter the thickness of the deck board in
inches or millimeters.

% Inside Deck Board Width: Enter the width of the inside deck
board in inches or millimeters.

« Qutside Deck Board Width: Enter the width of the outside deck
board in inches or millimeters.

«+ Center Deck Board Width: Enter the width of the center deck
board in inches or millimeters.

« Stringer Width: Enter the width of the stringer in inches or
millimeters.

+« Num of Stringers: Enter the number of stringers on the pallet.

3. If all your pallet parameters are correct, click on the Save button.
MaxLoad Pro saves the new pallet to the pallet database.

Define a New Slipsheet

To define a new slipsheet, start from the Define Pallet Screen and follow
these instructions:

1. Click on the New button. The Define Pallet screen redisplays with
some default values in the dimension fields and the cursor positioned
in the Description field.

2. Enter information in the following fields:
% Description: Enter a description of the new slipsheet.
«» Style: Select Slipsheet.

% Length: Enter the length of the slipsheet in inches or millimeters.
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% Width: Enter the width of the slipsheet in inches or millimeters.
+« Height: Enter the height of the slipsheet in inches or millimeters.
% Weight: Enter the weight of the slipsheet in pounds or kilograms.

« Autosize: Check the box to automatically size the slipsheet to the
unitload dimensions.

« Length Tab: Check the box to put a tab along the length of the
slipsheet.

« Width Tab: Check the box to put a tab along the width of the
slipsheet.

+ Both Sides: Check the box to put a tab along both sides of the
slipsheet. You must also check the Length and Width Tab in order
to add tabs on all four sides of the sheet.

% Tab Width (in): Enter the width of the tab in inches or
millimeters.

«» Color: Click on the color box and select the color for the
slipsheet.

If all your slipsheet parameters are correct, click on the Save button.
MaxLoad Pro saves the new slipsheet to the pallet database.

Modify an Existing Pallet/Slipsheet

To modify an existing pallet/slipsheet, follow these instructions:

1.

Click on the down arrow to the right of the Description field. The
drop-down list displays a list of existing pallets/slipsheets.

Select the pallet/slipsheet you want to modify. The Define Pallet
screen refreshes with information for the selected pallet/slipsheet.

Modify information on the screen as necessary.

If your pallet/slipsheet parameters are correct, click on the Save
button.

If you want modify the pallet/slipsheet and give it a different name,
simply type over the existing description (using standard windows
conventions), and click on the Save button.
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MaxLoad Pro saves the modified pallet/slipsheet record to the pallet
database.

Delete a Pallet/Slipsheet from the Database
To delete a pallet/slipsheet from the database, follow these instructions:

1. Use the Description drop-down list to select the pallet/slipsheet you
want to delete.

2. Click on the Delete button on the middle portion of the screen. A
dialog box appears with the name of the selected pallet/slipsheet and
asks “Do you want to delete this record?”

3. To delete the pallet/slipsheet, click on the Yes button. MaxLoad Pro
will remove the selected pallet/slipsheet from the pallet database.
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Vehicle Database

Start from the Menu Bar, open the Define menu, and select Vehicle. The
Define Vehicle Screen appears.

. MaxLoad - Define Yehicle: [_ O] %]
File Edit Yiew Define Tools Lavout Help

| &S = @ O =
j L ; H @ _;_ Englizsh b
Size I Axles | MuliZone | Advanced | | an I Top I ik I Front I
Description I j Close I
Type I Truck j Save |
Lengh (i) [200 oo [ _ e |
wiidth fin) |E0 Delete |
Height fim [0 Cost |
Max weight (k] [39933 Help
Drop Off
Floor Ceiling 00w
— . 200 i
Distance ta Drop Off (i) |0.00 (in) |0 (]
Drop O Depth [Front] fim] [0.00 [in) |0
Distance to Drop OFFf [in) |0.00 fin] |0
Drop Off Depth [Rear] [in] II] ao fin) |0

Note the following about the Define Vehicle screen:

% Size Tab: Allows you to define the dimensions of the container.

+ Axles Tab: Allows you to define parameters for the container’s axles
% MultiZone Tab: Allows you to define a multi-zone vehicle.

+« Advanced Tab: Allows you to define size and location of corner
boxes which are common in sea vans or containers.

+ (g.0.d.) Window: Displays a 3-dimensional graphic image of the
container.

++ Close button: Closes the Define Vehicle Screen and returns you to the
previous screen.

+« Save button: Allows you to save changes to an existing or new
container.

+« New button: Allows you to create a new vehicle.
% Delete button: Allows you to delete a vehicle from the database.

+« Cost button: Allows you to add costing information for the trailer.
For more information on using the Cost function, please contact TOPS
Technical Support.
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Size Tab (Define Vehicle)
The Size tab allows you to enter the inside dimensions of vehicle.

+«»+ Description: Enter a description (name) of the vehicle to define a new
vehicle. You can enter a total of 32 characters in this field, including
any spaces between words.

To select an existing vehicle, make sure you have specified the correct
vehicle type (see below), then select the vehicle name from the drop
down list by clicking the down arrow (¥). Once you have selected an
existing vehicle, all parameters defined previously for this vehicle will
be displayed.

« Type: Select the type of vehicle to be defined or modified. The
various types of vehicles available in MaxLoad Pro are truck, sea van,
rail car, rail wagon, multi zone, double trailer, ULD, sidebay, flatbed
trucks and tractors.

When defining a new manifest, MaxLoad Pro allows you to filter the
vehicle database to display only one type of vehicle type. Any vehicle
defined as a truck type will be added to the truck type list on the
Manifest Pick List screen. The same principle applies to other
container types.

% Dimensions: You are required to enter the dimensions — length, width
and height — of the vehicle you’re defining. These values represent the
inside (loadable) dimensions of the vehicle. Chapter 4, Loading a
Truck Manifest, discusses how to limit the maximum height of the
cargo regardless of the inside dimensions of the vehicle. This comes
in handy when you’re evaluating refrigerated or frozen loads that need
room for air circulation.

+« Maximum weight: This refers to the maximum cargo weight allowed
in the vehicle. This weight is usually found by subtracting the tare
(empty) weight of the vehicle — both trailer and power unit — from the
maximum over-the-road weight (80,000 pounds in most states, with
some restrictions). The maximum weight is usually around 45,000
pounds for most vehicles in the United States; however, laws vary
from state to state and country to country.
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s Drop Off: These fields allow you to define a drop deck (goose neck)
trailer, as the one shown here.

Referring to the figure below these are the different Drop Off parameters:

Size ] Aides |

Description |

Length  (in) |E50 Color

width CRET
Height (i [150
Max Weight (lb) [39933
Dirop Off

Floor
Distance to Drop Off finl [10000 A
Drop Off Degth Fron (] 000 B
Distance to Diop Off i #8000 C
Drop Off Degth Fearl (] [2000 D)

m (A /E) Distance to Drop Off: The distance from the front wall of
the trailer to the drop off point at floor and ceiling level
respectively.

m (B/F) Drop Off Depth (Front): The drop off depth in the front of
the vehicle at floor and ceiling level respectively.

m (C/G) Distance to Drop Off: The distance from the front wall of
the trailer to the drop off point for the rear end drop off, at floor
and ceiling level respectively.

m (D /H) Drop Off Depth (Rear): The drop off depth in the rear of
the vehicle, for floor and ceiling respectively.

Note: Drop deck is not calculated for Single SKU manifests.

%+ Color: The Color dialog box allows you to define a custom color for
the vehicle. To change the color of a vehicle, click on the color box,
and make a color selection.

Size Tab — Special Vehicles

For special vehicle types as described below, you will find different Size
tab parameters.
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°e

Double Trailer: Double trailers composes of two vehicles connected
together. Select from the existing vehicle database using the drop
down list ('w) the vehicle to use for the first and second trailer.

Size I Brles | Multi Zone | Advanced | | a0 I Top I Side I Front I

Description I j Close I
Type IDoubIa Trailer j G
Trailer m

First JLTL Pup =]

Delete

Second ILTL Pup j Cost
Help

107 fin

98 (i

+« SideBay: Sidebay trucks are commonly used for deliveries in the
beverage industry and these are the parameters:

Sies I Auxles | Advanced | | ) 1 Top I Side 1 e 1
Description iSide Bays 2 ;j | Close ;
Type iSldeBay _v_j Save
Length (i [500.00 o [ New
‘width (i) ;1 (00.00 Delete
Height (i) ;1 0000 L

0zl
Max Weight (Ib) ;45000
Mum of Bays 10 vi
Eatiiy (i [120.000 Bay Depth fin]  [50.000
Short Bays 32,5 Short Bay Height [in] 90.00

m  Number of Bays: Selects from the drop down list (¥) the number
of bays inside the truck, from 2 up to 32 bays.

m Bay Width: Enters the width of easy bay for the vehicle. The
default value is the total length of the truck divided by the number
of bays on each side. In this preceding example, the default bay
width is 600 inches divided by 5 (number of bays on each side)
which equals 120 inches.

m Bay Depth: This is the depth of each bay, defaulted to half the
width dimension of the truck.

m Short Bays: Specifies the bays which have shorter loadable height
than the rest. You can enter multiple short bays by separating the
bay numbers with a comma. For example, entering 2,5 as in the
example will set bay locations 2 and 5 to short bays.

m Short Bay Height: Enters the loadable height of the short bays.
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xles Tab (Define Vehicle)

The Axles Tab allows you to enter parameters that are essential to
calculating axle weights for a loaded container.

Size Axles I Multi Zone | Advanced I
Description o Close
Type Truck Save |
AxleCount IU— ¢ King Pin New |
Taewg (B [0 | O Fontdde Delete |

Lozt |
Distance From Wwigt M of dsles

King Pin W o mw Jo
Aile 1 o O - T CI N
Anle 2 o om o [ =]
Axle 3 I O U B I R
Wheel el
Distance From Front — (in] IW el fin]0.000

width [in] W

Height linl|0.000

R/
L4

%

Axle Count: Enter the number of axles for the vehicle. You can enter
a maximum of three axles in this field. MaxLoad Pro will calculate
the estimated weight carried by each axle tare weight: Enter the tare
weight of the vehicle — the weight of the vehicle when it is empty.
Consult your transportation provider for this information.

Tare Weight: Specify the tare weight of the vehicle.

King Pin/Front Axle: Specify the type of front reaction point (weight
bearing point) for the vehicle. This field does not affect the estimated
axle weight calculation for the front reaction point. That is, you’ll get
the same answer, assuming you define either the first axle or the king
pin in the identical location. This option is primarily used to draw the
vehicle accurately.

Dist from front: Enter the distance from the front of the vehicle to the
various positions of the king pin and axles. If you select Front Axle in
the King Pin/Front Axle option, the King Pin field changes to Front
Axle. Contact your transportation provider for more information on
this subject.

Woagt: Enter the tare weight of the king pin and axles. If you select
Front Axle in the King Pin/Front Axle option, the King Pin field
changes to Front Axle. Contact your transportation provider for more
information on this subject.
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Axles Tab — Special

% Truck Wheel Well

Vehicles

Size Aules | MulliZore | Advanced |
Deescription Truck with ‘Wheel Well
Type Truck Save I
AuleCount IE— % King Pin e
Taewgt (0] [T | € Frontaxe Dekte |

Cost
Distance Fram Wit urn of Axles
King Pin R
Adle 1 i o om o [ ]
Ble 2 i o om0 [ =]
fue 3 i o w0 [ =]
‘wiheel wWell
Distance From Front — [in] IM Lzt fin] lw
Width finl [30.000
Height (in] IW

| 3D I Top I Side I Front I
100 (in] )
100 fin]

m Distance From Front: Specifies the distance from the front of the
vehicle location of the wheel wells.

m Height: Enters the height of the wheel well.

s Width: Enter the width of the wheel well

s Height: Enter the height of the wheel well.

+ Rail Car and Rail Wagon

Split Thickness [ir]

—

Digtance From Front

Droor Wwidth

[in]
fir)

150

A

® [ Tt [ s | Fow | L ® | T | sk | Fot |
€0 [in 300 [in)
B0 [in]
F Fiail Car
Riail Car .
& Split Railcar ¢ Side Cargo Door ¢ Split Railcar * Side Cargo Door

m Split Railcar (Split Thickness): If Split Railcar is selected, enter
the split thickness of the side cargo door (the thickness of the wall
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in the center of an open rail car). Enter this value in inches or
millimeters, depending on the Units selected.

Distance From Front: If Side Cargo Door is selected, enter the
distance between the side cargo door and the front of the vehicle.
Enter this value in inches or millimeters, depending on the Units
selected.

Door Width: For Side Cargo Door, enter the width of the side
cargo door. Enter this value in inches or millimeters, depending on
the Units selected.

Advanced Tab (Define Vehicle)

The Advanced Tab allows you to specify corner boxes commonly found in
sea van or containers. You can define up to four identical areas along the
top area of the vehicle that will be unavailable for loading.

s+ Corner Boxes: Corner boxes of dimension 12 inches by 12 inches are
commonly found at the four corners of sea vans.

“width

Height
Dist from front
Location 1

Location 2

i) [2000

(in] |226.000

Size | Bales | MuliZane Advanced [ D [ Top [| Side | Fiont |
Descriplion e
Carner Bos
o i 12000 &I
(in) 12000
(i) |12.000

100 [in]

240 (in)

100 (in]

Length: Enters the length of the corner box along the length of
the vehicle.

Width: Enters the width of the corner box along the width of the
vehicle.

Height: Enters the height of the corner box along the height of the
vehicle.

Distance from Front (Location 1): Enters the distance from the
front of the vehicle for the location of the first set of corner boxes.
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m Distance from Front (Location 2): Enters the distance from the
front of the vehicle for the location of the second set of corner
boxes.

Note: Enter the same distance for location 1 and 2 will give only 2 corner
boxes; and combining the use of corner boxes with wheel well will allow
you a define areas along both the top and bottom of the vehicle to be
blocked off for loading.

240 (i)

Modify an Existing Vehicle

To modify an existing vehicle, follow these instructions:

1.

Click on the down arrow ('¥) to the right of the Description field. The
drop-down list displays a list of existing vehicles.

Select the vehicle you want to modify. The Define Vehicle screen
redisplays with information for the selected vehicle.

Modify information on the screen as necessary.
If your vehicle parameters are correct, click on the Save button.

If you want modify the vehicle and give it a different name, simply
type over the existing description (using standard windows
conventions), and click on the Save button.

MaxLoad Pro saves the modified vehicle record to the vehicle
database.

Delete a Vehicle from the Database

To delete a vehicle from the database, follow these instructions:
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Use the Description drop-down list to select the vehicle you want to
delete.

Click on the Delete button on the middle portion of the screen. A
dialog box appears with the name of the selected vehicle and asks “Are
you sure you want to continue?”

To delete the vehicle, click on the Yes button. MaxLoad Pro deletes
the selected vehicle from the vehicle database.

Tote Database

Start from the Menu Bar and open the Define menu and select Tote. The
Define Tote Screen appears, as pictured below.

=. MaxLoad - Define Tote: [_[T[x]

File Edit VYiew Define Tools Layout Help

“wheight foz) 000 (Eallr Load Into Yehicle

Descriplion | =] Cose | | e | Font |
Save |
Mew
LD 0.0 Slack
Lenath g [200 a0 000 _ Delte |
Width fin)  |0.00 0.00 0.00 Help |

Height I [ .00

¥ Load By Length
MaxWeight [oz) |10 - © Load By Width

" BestFit

Stack Rul

Stack Cod
' Must Be Stacked On Flaor ok soce, New -

€ Must Mot Be Stacked On Flaor | Max Stack Height  Cases |0

 BestFit Max Stack Weight  [oz] g

Note the following about the Define Tote screen:

R/
L X4

Description: Enter a description (name) of the tote. You can enter a
total of 32 characters in this field, including any spaces between
words. To select an existing tote to check or modify its parameters,
click the down-arrow (') to select the tote from the list.

Dimensions: For a new tote, you are required to enter values for
Length, Width, and Height for the tote you’re defining. Enter inside
and outside dimensions along with slack.

m |.D.: Refers to the inside measurement/dimension of tote

m  O.D.: Refers to the outside measurement of tote.
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m Slack: Refers to the space taken up by packing material and will
be available for loading.

Note: The packaging industry defines height as the dimension that
runs through the case flaps. If tote height is set as the vertical
dimension, the case flaps will always be facing up or down.
Extending this definition, length is defined as the largest dimension of
the remaining two dimensions. Width would then be the last
dimension undefined. Keep in mind that this is a general rule used in
the packaging industry; your industry may be different.

« Weight: This is the weight of the empty tote.
% Max Weight: The maximum weight the tote can hold with SKUs in it.

Note: Weight fields are optional and can be set to zero. Be aware that
if you choose to do so, MaxLoad Pro will not calculate accurate
weight values — total weight, weight efficiency and estimated axle
weights — for your load.

+«+ Color: The Color dialog box allows you to define a custom color for
the tote. To change the color of a tote, click on the color box and make
a color selection.

% Load Into Vehicle: MaxLoad Pro gives you options as to how a tote
may be loaded into a vehicle. For example, certain totes can be loaded
only by a forklift from one direction.

You have three choices as to how a tote is loaded into the vehicle:

m By Length: Loads the length of the tote parallel with the length of
the container.

m By Width: Loads the width of the tote parallel to the length of the
container.

m Best Fit: Shows no preference; loads the tote using the best
orientation in relation to other items being loaded.

+« Stack Rules: Stack Rules are guidelines for how MaxLoad Pro will
load totes into a container when they're not placed on a pallet
(sometimes referred to a floor-loading).

= Must Be Stacked on Floor: MaxLoad Pro will disregard any
solutions in which the tote is not placed on the floor.

= Must Not be Stacked on Floor: MaxLoad Pro will disregard any
solutions in which the tote is placed on the floor.
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= Best Fit: MaxLoad Pro will disregard the two options above and
place the tote where it is most efficient in relation to other items in
the load.

Stack Code: The Stack Code designates the stackability for a class of
totes. This field contains 10 characters. Whenever you add a new tote
to the database, you'll need to assign a new or existing stack code to
the tote. Most likely, you'll have one stack code that represents a
group of totes. However, if each product you ship is unigue in regard
to how it can be stacked, you may want to define a unique stack code
for each individual tote.

MaxLoad Pro treats all totes with the same stack code in the same
manner regarding (1) which totes can be loaded on top of other totes
and (2) which totes can be placed under other totes.

For example, your company ships five different types of lampshades,
all identical except for color. In this case, you'd group these five
SKU’s together using the same stack code. However, if you
manufacture another type of lampshade made of paper machete, you'd
assign a stack code different from the other five lampshades because
the paper machete would change the stacking characteristics.

The totes that have no stacking restrictions, we recommend that you
use the default stack code “All/All.” When you define a tote and click
on OK to save it, the stack code will automatically appear in the Stack
Matrix.

If you can't find a stack code that suits your needs, you can define a
new stack code. To define a new stack code for the stack matrix,
follow these instructions:

1. Click on the New button located to the left of the Stack Code field.
The Define New Stack Code dialog box appears.

Define Mew Stack Code
Stack Code I—
Cancel |
Default ¥ alue
This can stack on others et -
Other can stack on this es -

2. In the Stack Code field, enter a new stack code. You can key in
any alpha/numeric combination up to 10 characters long.
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3. In the Default Value field, specify — Yes or No — whether other
totes can be placed under or on top of this tote. Use these
guidelines:

m This can stack on others: Can this tote stack on top of other
totes? If so, select Yes, else select No.

m  Other can stack on this: Can other totes stack on top of this
tote? If so, select Yes. If no other totes can be stacked on top
of this tote (as in the case of the paper machete lampshade),
select no.

Keep in mind that you're deciding how this tote relates to all other
totes. You may find it necessary to make changes in the stack
matrix if a tote relates differently to other totes on a case-by-case
basis.

4. If all your stack code information is correct, click on OK.
MaxLoad Pro saves the new stack code to the tote database.

+ Max Stack Height Cases: The Maximum Stack Height is defined as
the number of layers high MaxLoad Pro can safely stack a tote on top
of itself.

% Max Stack Weight (units): The Maximum Stack Weight is defined as
the maximum weight that can be placed on an individual tote. This
field is defined in units (either English or Metric) representing weight,
and also compliments the stack code. Even though the stack code
allows one item to be placed on top of another item, this field will
override the stack code to limit the weight of a placement on top of a
particular tote. By the nature of this calculation, a stack of totes will
always be limited to the maximum stack weight of the product on the
bottom of the stack.

Note: When building a stack of like totes, Maximum Stack Height
takes precedence over Maximum Stack Weight. That is, when
building a placement of like totes, MaxLoad Pro will only take the
defined Maximum Stack Height into consideration when determining
how to build the placement. However, if there is space for a different
tote to be placed on top of the stack, MaxLoad Pro will then consider
the Maximum Stack Weight to determine the new placement.

Maximum Stack Height also takes precedence over the stack matrix.
For example, we define a tote and assign it a new stack code. In the
stack matrix, we specify that this tote cannot stack on top of itself.
However, if when defining the tote we also say that the tote can stack
three layers high, this parameter will take precedence over the stack
matrix, which says that the tote cannot stack on itself. This rule was
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made in an effort to help users limit the number of stack codes within
the stack matrix.

Let’s see another example, my Computer Monitors weigh 30 pounds
each. | define the maximum stack height of a computer to be five
units tall and the maximum stack weight to be 100 pounds. Is a stack
of five computers a legal placement? Yes — regardless of the fact that
the bottom computer will be supporting 120 pounds.

Further if | stack three computers on top of one another, meaning that
the bottom tote (computer) is supporting 60 pounds. | notice that there
is room to load a 60-pound box of stereos on top of the computers. Is
this stack of three computers and one stereo a legal placement? No!
Why not? Because the maximum stack weight of 100 pounds will be
violated when the stereo is loaded.

g.0.d Window: Displays a 3-dimensional graphic image of the tote.

Close button: Closes the Define Tote screen and returns you to the
previous screen.

Save button: Allows you to save changes to an existing or a new tote.
New button: Allows you to create a new tote.

Delete button: Allows you to delete a tote from the database.

Modify an Existing Tote

To modify an existing tote, follow these instructions:

1.

Click on the down arrow to the right of the Description field. The
drop-down list displays a list of existing totes.

Select the tote you want to modify. The Define Tote Screen redisplays
with information for the selected tote.

Modify information on the screen as necessary.
If your tote parameters are correct, click on the Save button.

If you want to modify the tote and give it a different name, simply type
over the existing description (using standard windows conventions),
and click on the Save button. MaxLoad Pro saves the modified tote
record to the tote database.
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Delete a Tote from the Database
To delete a tote from the database, follow these instructions:

1. Use the Description drop-down list to select the tote you want to
delete.

2. Click on the Delete button on the middle portion of the screen. A
dialog box appears with the name of the selected tote and asks “Are
you sure you want to continue?”

3. To delete the tote, click on the Yes button. MaxLoad Pro deletes the
selected tote from the tote database.
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Using Multiple Databases

MaxLoad Pro saves all data, including SKUs, vehicles, manifests and
more within the program in a Microsoft Access database file in the
..\TOPSAPPS\Max2Pro\Data\ folder. However, you are not limited to
just one database when using MaxLoad. Sometimes, it makes sense to
create separate database, for example, to hold data for different customers
or departments. Follow these steps to add two (2) database within
MaxLoad Pro:

Note: Please consult your company’s IT department if you are not familiar
with the use of Windows Explorer or functions related to file operation.

1. Install MaxLoad Pro.

2. Open Windows Explorer by clicking the mouse’s right bottom and
select “Explore”.

3. Browse to the location where MaxLoad Pro was installed. The default
location is in the C:\Program Files\TOPSAPPS\Max2Pro\ folder.

4. Make two copies of the “Data” folder.

5. Rename the “Copy of Data” folder to “Companyl” (or any name of
your choice).

6. Rename the “Copy (2) of Data” folder to “Company2” (or any name of
your choice).

7. Open Maxload2.ini (in the C:\Program Files\TOPSAPPS\Max2Pro\
folder) in Windows Notepad by double clicking on the file. Add two
new “DBPATH=" statements as highlighted in the dialog box below.

B Maxload2.ini - Notepad _ O]

File Edit Format ‘iew Help
[MaxToad]

| »

TWProgram File
LanguagePath=C:%Program Files\TOPSAPPSYMaxZProtLANGUAGE
craphicsrath=C:“Program Files\TOPSAPPSYMax2Pro
Logorath=C:nProgram Filesh\TOPSAPPSYMax2Praothtops. bmp
version=2. 71
User=Export Department

[Display]
windowsize=0,0, 800,600
Maximized=TRUE

B

8. Go to File | Save in Windows Notepad to save and close the file.
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9. If you have a MaxLoad shortcut on the desktop, right click on the

i,

e

shortcut KEEEEE] and select “Properties”.

10. In the MaxLoad Properties dialog box as shown below, go to the
Target field and add the following “-MultiDb=on” switch like
...\TOPSAPPS\Max2Pro\Maxload.exe -MultiDb=on”.  This switch
enables the multiple database function within MaxLoad.

Maxload Pro Properties 7 x|

General Shortout | Eompatibilityl Securityl

s

% Maxload Pro

Target type: Application

Target location: Max2Pro

Target: ITEIF'S.-’-‘«F'F'S'\Mar:2F'r0kMa>:Inad.e:<e buliDib=on

Start in: IC:\TDF’S.&F‘F‘S\MaQF‘ID

Shortcut key: INone

Rur: INormaI window j

Cornment: I

Find Target. .. | Ehangelcnn...l Advanced... |

(] I Cancel | Apply |

11. Click on OK to save the MaxLoad Properties.

12. Run MaxLoad Pro by using the MaxLoad shortcut that you’ve just
edited. You will see a screen similar to the following, prompting you
to select the database from the three available. Select the database
you’d like to use and click on OK.
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Maxload Databases |

Select the database pou want to uge

C:\Program Files\TOPSAPPS WM ax2ProbCompanyl ;I
C:sProgrann FileshTOPSAPPS W aw2ProbCompary?

C:4Program Files\TOPSAPPS WM aw2ProtDaT A

Cancel |

13. Login and now you should be working with the specific data saved in
the selected database.

Note: Since the new database is created from copies of the original
database, the contents will be identical. Delete the SKUs and manifests
that you don’t need and import new data as required.
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Loading a Truck Manifest

Introduction

This chapter explains how to use MaxLoad Pro to load a truck manifest
with multi-size cases or multiple SKUs into a container, the most
commonly used function in MaxLoad Pro.

Note: If you are loading single-SKUs into a container, you can use either
the Truck Manifest or the Single SKU Manifest. The difference between
the two for single SKU loading is provided at the end of this chapter.

For more information on Single-SKU Manifest, please refer to the next
chapter.

This chapter walks you through the process you’d most likely follow when
building a load with multi-size cases, including the following topics:

« Truck Manifest Pick List Screen

Vehicle Tab

Options Tab

Algorithm Options

Truck Weight Limit
Mixed Pallet Tab
Comments Tab

Weight Tab

SKU Addition and Update
SKU List

Manifest List

+«+ Changing the Display of the SKU and Manifest List
% Defining a Truck Manifest

+« Truck Manifest versus Single SKU Manifest for Single SKU Loads
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Truck Manifest Pick List Screen

Once you’ve logged into MaxLoad Pro, the first screen that appears is the
Control Center. To start a new truck manifest, start from the Control
Center and click on the New button under the Truck Manifest icon.

The Truck Manifest Pick List screen appears, as pictured below.

ol
File Edt View ools Layout  Help
LS -XBM=00F o
L o o
Vehicle | Opions | MiedPalt | Commens | Weit LLb]] D | Top [ Side | Fiort
Available Vehicles Selected Vehicles
View
A FL Nanow] 5 Ft Dy Caigo
48FE Dy Van Calculate
50 Ft Rai Car T
53Ft [Marrow) £
53 Ft Drop Deck Vehicle Type:
53 Ft Diy V. & Tk
53 Ft, Dual Diop Deck, et
57 Ft Dy Van € SeaVan
B0 Ft Rai Car
L1 & Freight € Rail Car
L4 i Freight
LD-4 it Freight £ Railwagon
LD-5 i Freight © MuitiZone e
LTLP i
VAT i Freight € Double Trailer 110 fn
14-2 i Freight ~u
Truck it Wheel Well
© SideBay %
© Flatbed
[case 2 | oy | | Prior [ | T uL T MP Ordert | | Add>r |
SKU List | Manifest List [=
B ] Descrplion -1 B Tv | Frio Didert] % Cube | Zwal | Sizz [onival
[ Banel i Compu a 1| W[ O 0 667 174 0)00000o|
[ Buk. Fiozen Yogut vor Yogurt Decph @ O[O o m0x 04 ohoopooo|
1 Fiefigerator = I I o 58  ard [,
Stereo 7 I I B o 334 157 0)o0000g)
u [Tl stove I = o s4x s34 0)00000o|
Cased Sample Case 4 v I = o 235 ax ohoopooo|
Cawes Sample Case 5 | 176] 267 65ax 0.
Case 5 Tole Tote Manifest. Case 5
Chair Chair [LShape]
Computer Penfium 200 mhe
Cookies reo 20 Court
Couch Chair (L Shape]
Crate 1 Sample Ciate 1
[T Crate 2 Sample Crate 2 i}
Far Help Contact Tops Software NUM [ Vi

With the Truck Manifest Pick List screen displayed, you’re ready to begin
defining the components of a new manifest. This screen is the basis for
collecting data for building a new manifest. The Truck Manifest Pick List
screen is comprised of the following components:

+ Vehicle Tab: Allows you to select the type of vehicle and the specific
vehicles to be used for the manifest

% Options Tab: Allows you to fine-tune your load parameters to get
optimum results.

% Mixed Pallet Tab: Work performed under the Mixed Pallet tab
allows you to select and set defaults for loading mixed pallets.

% Comments Tab: Allows you to enter comments and customer
information for the manifest.

% Weight Tab: Allows you set weight limits for the different axles for
different regions.
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g.o.d. Window: The graphics section on the upper right hand side of
the screen displays a 3-dimensional graphical image of the vehicle.

% SKU Input: Allows you to enter SKU, quantity and other load
parameters in the manifest list.
% SKU List: Displays a list of all available SKUs (shipcases, drums,

etc.) in the database. All SKUs in this list are available for loading
into a vehicle, onto a pallet or into a tote.

+« Manifest List: Displays a running list of all SKUs to be loaded into
the vehicle. As you select SKUs from the SKU List, they will
automatically appear in the Manifest List. You will define specifics
about the load in this list.

« View Button: Allows you to view a load without recalculating it.
This feature works only if you’ve previously built a load and is used
primarily after you’ve made changes to a load in the Editor screen.

X/
L X4

Calculate Button: Allows you to calculate a load.

Vehicle Tab (Truck Manifest)

The Vehicle tab, allows you to select the type of transit vehicle (Truck,
Sea Van, Rail Car, etc.) for a manifest.

"ehicle | Dptionz I Mixed Pallet I Comrients Wwheigh 4 I 4 I
Avwallable Wehicles Selected Vehicles Wiem
43 Ft. [Marrow] T
43 Ft. Dy Cango SlleklElE
43 Ft. Dy Yan Hel
50 Ft. Rail Car Elp |
53 Ft. [Marraw) —Wehicle Type
B3FL Drop Deck & Truck
B3 Ft. Dy Wan ue
53 Ft. Dual Drop Deck " SeaVan
57 Ft. Dy ¥an .
B0 Ft. Rail Car " Rail Car
L-17 Air Freight  Ra
L-4 &t Freight ey
LD-4 Air Freight  Multi Zone
LD -5 Air Freight
LTL pul:j = " Double Trailer
t-1 Auir Freight LD
b2 &ir Freight )
Truck, with wheel wiel = SideBay
" Flathed
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The Vehicle tab contains the following components/fields:

K/
£ %4

*

*

Vehicle Type: Displays the various kinds of vehicles defined in
MaxLoad Pro. You can narrow down the list of available vehicles by
choosing a Vehicle Type. This action will filter the Awvailable
Vehicles list to display only one type of vehicle.

Available Vehicles: Displays the list of all vehicles available in the
database for the Vehicle Type specified. In order to build a load, you
will need to either choose an existing vehicle or define a new one
through the Define menu.

Double click on a vehicle in Available Vehicles list to move it to the
Selected Vehicles list. Also notice that as a vehicle name is
highlighted, a representation of that vehicle displays in the g.o.d.
(graphical on-line drawing) window.

MaxLoad Pro allows you to use multiple vehicles at one time. To do
so, select more than one vehicle to be analyzed when calculating a
manifest. Simply follow the procedure described above to select
multiple vehicles.

Selected Vehicles: This section displays the vehicles selected from
the Available Vehicles list, for a particular manifest. You can have
multiple vehicles selected for each truck manifest.

When MaxLoad Pro calculates solutions for a manifest, it uses only
those vehicles listed in the Selected Vehicles list. To remove a vehicle
from this list, double-click on the vehicle you wish to remove, in the
Selected Vehicle list. This will remove the vehicle from the Selected
Vehicles list and place it back in the Available Vehicles list.

A representation of the selected vehicle will appear in the g.o.d.
window. If you select multiple vehicles, the highlighted vehicle will
appear in the g.o.d. window.

View Button: The View Button is active if you’ve opened an existing
analysis or a new analysis has been calculated. It opens the Manifest
View screen.

Calculate Button: The Calculate button will instruct MaxLoad Pro to
find loading solutions based on the parameters entered in the analysis.
When the calculation is complete, MaxLoad Pro opens the Manifest
View screen.
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Options Tab (Truck Manifest)

The Options tab, allows you to further customize your manifest by setting
various loading parameters.

Wehicle Options | Mixed Pallet I Commets I weigh 4 I ’I
[~ Use Ur.'uitLoads %" Load By Priarity Wiew
[ Use Mixed Pallets
" Load By Stop Off Caleulate

[ keep Same Orders Together :: Sl Frery Alarith
[ keep Like SKUs Together StopiRZore gonthms
[~ Load By 5K Ratio

Minirurn Ceiling Clearance [in] IEI
b awirnum Wertical Gap [in] I3

Bl

b arimunn Pricrity Overlap [in] {333
I & Wvertiang (il |0
Davs Range ID

The Options tab contains the following fields:

% Use Unit Loads: Check the box to turn on the Unitload (UL) column
in the Manifest List. When you turn on this column, you can designate
a SKU to be loaded onto a pallet as a completed unitload which is
represented by a checked box ([x).

In order for MaxLoad Pro to actually load the SKUs as unitloads, a
unitload pattern needs to be pre-defined for the selected SKU using the
“Create UL” function under the Define | SKU function. If no pattern
has been defined, the check box under the UL column in the Manifest
List will remain blank despite clicking on the box to change its state.

Note: A unitload differs from a mixed pallet. A unitload is comprised
of identical SKUs, while a mixed pallet is comprised of multiple kinds
of SKUs.

% Use Mixed Pallets: Check the box to turn on the Mixed Pallets (MP)
column in the Manifest List. Mixed Pallets are pallet loads consisting
of multiple kinds of SKUs.

Unitloads are labeled with SKU names while Mixed Pallets are labeled
with MP-N where N is the mixed pallet number.

X/

% Load By Priority: When a SKU is assigned a high priority number, it
will be loaded before a SKU with a lower priority number. Priority 1
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will be loaded before priority 2, which will be loaded in front of
priority 3.

Note: Load By Priority and Load By Stop Off determine which
column is displayed in the Manifest List: Priority or Stop-Off. You
can select either Load By Priority option or Load By Stop Off, but not
both.

% Load By Stop Off: When you load by stop-off, the loading method is
just the opposite: Stop-off 1 is loaded after stop-off 2, and therefore
closest to the rear door; stop-off 2 is loaded after stop-off 3, etc.

+ Stop & Priority: MaxLoad Pro also supports priorities within each
stop. Check this option to enforce this functionality.

The following two options (Keep Same Orders Together and Keep Like
SKUs Together) work in conjunction with the stop-offs and priorities. In
other words, if you build a load with two stop-offs, MaxLoad Pro will
keep like SKUs or orders together within the individual stop-off number.

Bear in mind that using either of these options could potentially result in
less cubic utilization. While we can’t definitely say how these options
will affect a load, it’s safe to say that these options will affect MaxLoad
Pro’s calculations, thus making it possible that the load will be affected
negatively.

% Keep Same Orders Together: Check the box to keep the same
orders together when loading. This field is directly linked to the
Order# field in the Manifest List. When you key in an order number,
MaxLoad Pro gives you the option to group SKUs from the same order
together. If you do not choose to input order numbers, this field will
be meaningless; activating the checkbox will not affect the placement
of SKUs within your manifest.

X/

% Keep Like SKUs Together: This option is very similar to the Keep
Same Orders Together option. Activating this option tells MaxLoad
Pro to load all products with the same SKU number together. The
Keep Like SKUs Together option takes precedence over the Keep
Orders Together checkbox, thus answering the question of what
happens when both boxes are checked.

X/

% Load by SKU Ratio: This option loads the container with the
specified ratio of SKUs in the Manifest List. When this option is
checked, enter the ratio of the respective SKUs in the Qty column.

For example, to load the container with SKUs A, B and C in the ratio
of 2:3:1, enter in the Qty column 2, 3 and 1 for SKU-A, SKU-B and
SKU-C respectively.
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Note: When this option is checked, all SKUs in the Manifest List will
be loaded in the ratio specified in the Qty column. You will not get a
solution if MaxLoad cannot load all SKUs in the lowest multiple of the
specified ratios.

s Minimum Ceiling Clearance: Minimum ceiling clearance is the
minimum amount of air space allowed between the top of the cargo
and the ceiling of the vehicle. This option was designed with
refrigeration and frozen shipments in mind, which require “breathing”
space for freight so that a consistent temperature will remain
throughout the vehicle. You can also use this to accommodate the
distance needed to maneuver forklifts when loading the vehicle.

Enter a number that represents the minimum amount of empty space
required above the cargo. Keep in mind that this space starts at the
point above the tallest SKU in the load. If your cargo does not require
a clearance between it and the top of the transit vehicle, you can tab
through this option and go with the default of zero inches.

% Maximum Vertical Gap: This option lets you control which spaces
MaxLoad Pro joins together for the purpose of loading other items on
top.

In the process of loading SKUs and pallets into a transit vehicle,
MaxLoad Pro accumulates a list of “leftover” spaces. Whenever
possible, MaxLoad Pro will combine neighboring leftover spaces to
make bigger spaces. ldeally, these neighboring spaces present a level
surface. If they do not present a level surface, you can enter a value in
this field that artificially “joins” the two uneven surfaces together, thus
creating a larger level surface.

If the difference in height of the two spaces is less than or equal to this
value (in English or Metric units), MaxLoad Pro joins together the
offending gap, assuming that you will pad or brace the shorter space to
bring it up to the height of the taller space.

« Maximum Priority Overlap: MaxLoad Pro uses this option to
determine the placement of the next priority or stop-off. This field
allows you to define the distance inside the container that MaxLoad
Pro will “mix” items of a different priority or stop-off. This field
determines how far forward into another priority or stop-off the front
of an item with a lower priority number will be placed.

For example, if maximum priority overlap set to 30 inches, MaxLoad
Pro will place the next priority on top of the previous priority, with the
front of the lower priority protruding past the end of the higher priority
freight by a maximum of 30 inches.
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Some shippers cannot mix stop-offs and will build a physical bulkhead
of plywood bracing between SKUs of two separate stop-offs. In this
case, you would key in a value of zero in this field, which tells
MaxLoad Pro to place the next stop-off on the floor, regardless of the
fact that there is enough room to load on top.

+ Maximum Overhang: This option is not implemented.

X/
°e

Days Range: This option is not implemented.

SKUs in the pick list can be assigned a date and items within the Days
Range will be loaded on a transit vehicle and the rest of them goes to
the next truck for the next number of days set in the Days Range field.

X/
L X4

Algorithms Button: This button displays the Algorithm Options
dialog box which allows you to determine how MaxLoad Pro will load
a manifest. For more information, please refer to the next section.

Algorithm Options

The Algorithm Options dialog box, allows you to determine how
MaxLoad Pro will load a manifest.

Algorithm Dptions B

Algorithms ————— 0K |
_Cored |

¥ Load Front to Back
V¥ Space Evenly Carcel
v Load Floor to Ceiling
I Flatbed
[ Layers

Optimize

¥ Left to Right O ptimization ™ Firsvhesl Optimization for Pallsts

Speed -jL Space I'ID Set

Staggered———————— Unitload Options

& MNore I~ Smart Pallet Flacemsnt
" Tight [™ Dptimize Top Pallet Height
™ Spiead [T &llow Loose Fil

" Pyramid = &llaw Partial L

[ Keep Order on Same Truck

The Algorithm Options dialog box contains the following features:
Algorithms

s Load Front to Back: Check the box to load the manifest as high as
possible and as far forward as possible. This option is useful if you
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put together a quote for a customer and want to show the amount of
empty floor space available in the vehicle.

Loading front to back may use only half the available floor space,
thereby placing most of the loaded weight on the vehicle’s drive axles.
The overall cubic efficiency of the trailer will likely be very similar,
but the difference will be in the placement of the unused cubic space
(above the freight with the Load Front to Back option, behind the
freight with the Load Floor to Ceiling option).

This option loads the container, starting at the front edge of the
container and working towards the opposite edge, stacking mixed or
identical SKUs or pallet loads.

+«+ Space Evenly: Check the box to spread a load over the entire surface
area of the container in order to make a more secure load.

Whenever the cubic measurement of the cargo is less than the
available cubic capacity of the load — remember that you define
parameters of height and weight to define the cubic capacity — an
artificial “ceiling” will be created. This lowers the maximum height of
the load and forcing it to be spread as equally as possible over the
surface area of the vehicle.

+« Load Floor to Ceiling: Check the box to distribute the load evenly
across the entire floor space of the transit vehicle, thus balancing the
load more evenly between its axles. This algorithm option minimizes
unused floor space, making for a more stable load.

+ Flatbed: Check the box to distribute the load as if loading a flatbed
truck. Loading starts from the center and spread outwards. The height
of the SKUs will also be even out to create a stable load.

« Layers: The Layers option is only available for Pallet Manifest and is
checked by default. This enables MaxLoad to build the mixed pallets
with the goal to create stable layers.

Optimize

« Left-to-Right Optimization: Check the box to have MaxLoad Pro
look for the best combination of two placements in order to maximize
the space across the width (i.e. left-to-right) of the vehicle

When this box is checked, MaxLoad Pro will attempt to find some
combination of two placements to optimize the width of the vehicle. If
the box is not checked, MaxLoad Pro will strive to place the largest
placement possible in the vehicle, but will not necessarily attempt to
maximize the space across the width of the trailer.
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It’s important to understand that this algorithm does not always
provide the best solution, even though the logic behind the algorithm
would suggest that it would. Why? Because of the physical
dimensions of the SKUs being loaded into a vehicle, there simply may
not be a combination of two placements that can maximize the width.

Note: When you select multiple algorithms, MaxLoad Pro will
display at least one solution for each algorithm chosen. Additionally,
whenever Left-to-Right Optimization is turned on, MaxLoad Pro will
calculate two solutions for each algorithm chosen; that is, Front to
Back, Floor to Ceiling and Space Evenly.

Pinwheel Optimization for Pallets: Check the box to have MaxLoad
Pro load pallets in a pinwheel pattern in a container.

Speed-Space Tab: Move the sliding bar to optimize the calculation
for speed (flush left) or for efficiency (flush right).

The For Speed option tells MaxLoad Pro to calculate solutions as
quickly as possible.

The For Space option tells MaxLoad Pro to take more time and
calculate the most space-efficient solutions.

In addition to using the sliding bar, you can also enter a number
between 1 (speed) and 200 (space) in the box and click the Set button.

When you click OK, in the Algorithms dialog box, MaxLoad Pro
saves your algorithm options to memory and returns you to the Truck
Manifest Pick List Screen.

The next time you calculate solutions for this manifest, MaxLoad will
display a progress dialog box, as pictured below.

48 Ft. Dry Cargo: Space Evenly L/R

Oty |1 13
Cubic Eff |94-98°/+
Cutlist Crt |2859

T35 Sligg

Solution Count

Truck, I-I
Time Elapsed IDD:D-I

Notice the following about this dialog box:
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m The dialog box displays a running count of the following
parameters for the current calculation: quantity, cubic efficiency,
cut list count, solution count, truck number and time elapsed.

m A Stop button allows you to stop the calculation at any time and
gives you the best solution found so far.

Staggered

The staggered pattern is used to load round shape SKUSs, like drums, pipes,
etc. into a container. MaxLoad Pro gives the following options to load
cylindrical SKUs into a container.

+« None: This option assumes that cylindrical objects are rectangular
SKUs and loads them in a linear fashion as a shipcase.

« Tight: Loads as many cylindrical SKUs as possible along the width.
s Spread: This is to spread the round SKUs during loading.

« Pyramid: This is for loading the cylindrical SKUs lying in length
orientation in the truck, stacking in a pyramid shape.

Unitload Options

These options control how the unitloads will be loaded inside the transit
vehicle.

+« Smart Pallet Placement: Check this box to have MaxLoad Pro place
stable unitloads and mixed pallets on the floor of the container and
then load the uneven palletloads as part of the top layer.

% Optimize Height for Top Layer: Checking this option gives the
software the ability to load partial unitloads, thus more efficiently
utilizing the container space.

For Example, suppose you are loading a 48 Ft. Dry Van with 60 inches
high unitloads. A 48 Ft. Dry Van is 110 inches in height and you have
set a Minimum Ceiling Clearance of 10 Inches. This leaves behind 40
inches of wasted space. Now, with checking the “Optimize Height for
Top Layer”, MaxLoad Pro will create unitloads with height in the
range of 40 inches for the top layer, thus utilizing the container
overhead space.

Pallets created under this algorithm will be labeled with SKU name.
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% Allow Loose fill on sides: Checking this option allows MaxLoad Pro
to load the selected SKUs as fill items. The SKUs which are left
behind as they do not form a complete unitload can be used as fill
items, to fill the empty available space in the container.

s Allow Partial Unitloads: Check this option to place same SKUs not
enough to make a full unitload on their own pallets (instead of as loose
items) but not mixing them together with other SKUs to create mixed
pallets. Pallet loads created under this algorithm will be labeled “PUL-
N”.

Keep Order on Same Truck

When this option is checked, MaxLoad Pro will keep SKUs with the same
order number on the same truck.

Mixed Pallet Tab (Truck Manifest)

The Mixed Pallet tab, allows you to select the pallet to be used and set
defaults for loading SKUs onto the mixed-pallet. In order for MaxLoad
Pro to use the information you enter on this tab, you must first activate the
MP column in the Manifest List by checking the “Use Mixed Pallets”
option under the Options tab.

YWehicle I Options Mixed Pallst | Comments | Weigh 4 I 'I
Vi
Fallet Pallet Marne | &l
[ Black Stinger (48" = 40 Calzulate I
[ CHEP [#wistralia)
T Help |
[ Clamp Load (50"« 407 L

[ EvraPallet
EurcPallet [1200 « 800)
O EwroPallet (800 « 1200)

] GMA [Metic Block) x|
b aximum Height Incl Pallet [im)|65.00
b azimum ‘weight Incl Pallet IO

b s L b Dverh W A Load Inta Yehicle
aximurn Length Overhang fing|0. £ Load By Length
Magimurn Width Overhang [in|0.00  Load By width
{+ BestFit
b aximumm Vertical Gap (i) 0-00 st

Note: The work you do in this tab is not to be confused with the work you
do when you click on the Pallet Manifest icon in the Control Center
screen. The Pallet Manifest asks MaxLoad Pro to load the SKUs in the
Manifest List onto selected pallet(s). Here, you ask MaxLoad to place the
SKUs on the same type of pallet which then be loaded into the selected
vehicle(s).
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The Mixed Pallet tab contains the following fields.

« Pallet: Allows you to select from various types of pallets and
slipsheets already defined in the Pallet database. Click on the check
box the pallet you’d like to use. Selected pallets are shown with the M
marks. You can select multiple pallets but MaxLoad will start using
the one with the largest available footprint unless the load fails certain
parameter requirements including maximum height or overhang.

We ship MaxLoad Pro pre-loaded with a range of popular pallet styles.
However, if you can't find a pallet or slipsheet that you want to use for
this manifest, you can always define a new one.

For more information, please refer to Chapter 3, Defining MaxLoad
Pro Databases.

s Maximum Height Incl. Pallet: Enter a value representing the
maximum height the mixed-pallet is allowed to be. Reminder: the
height value includes the pallet height.

< Maximum Weight Incl. Pallet: Enter the maximum allowable
weight of the mixed-pallet. Reminder: the weight value includes the
pallet weight.

s Maximum Length and Width Overhang: These values represent
the maximum distance a SKU can hang over the edge of the pallet.
The overhang dimension is illustrated below.

Ovetarg —TE PR B Overhang

For the purposes of building a stable load, we recommend that you
limit the maximum overhang to at least one-half the length of the
smallest SKU to be used in this manifest. This will ensure that no
SKU will have the majority of its mass hanging off the edge of the
pallet.

When MaxLoad Pro builds a mixed-pallet load, it will use as much of
the “available” space on the pallet as possible. The amount of usable
space is determined by the pallet size, the amount of overhang
allowed, and the maximum height allowed to build a load.
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In effect, MaxLoad Pro uses this information to build invisible “walls”
representing the absolute parameters of the mixed-pallet load. In fact,
when viewing a load you'll notice that the usable area is shaded a
different color to differentiate it from the background of the diagram.

% Maximum Vertical Gap: Enter the maximum distance that MaxLoad
Pro will artificially raise an SKU when it is placed next to a taller
SKU. By raising the height of the SKU, MaxLoad Pro combines two
separate “spaces” (level surface) on top of each individual SKU into
one larger space on top of both SKUs. The larger space gives
MaxLoad Pro more freedom when determining which SKU to load
next.

+« Load into vehicle: Select from one of the options as how the mixed
pallets will be loaded into the vehicle:

m By Length: Select this option to load the mixed pallets such that
they are placed with the pallet length along the length of the
vehicle.

m By Width: Select this option to load the mixed pallets such that
they are placed with the pallet width along the length of the
vehicle.

m Best Fit: Select this option to load the mixed pallets in the
vehicles where it is most efficient in relation to the other items in
the manifest.
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Comments Tab (Truck Manifest)

The Comments tab, allows you to enter different information or comments
regarding the truck manifest.

Yehicle Optiors I Mixed Pallet Comments | Wwieigh 4 I 'I

|
Customer I oy

Calculate

[ W |
Address :I |

LI Delivery D ate
Status [oK =] | 47242013 -|

MFT Comments 1 I
MFT Comments 2 I
MFT Comments 3 I

The Comments tab contains the following fields.

+«» Customer: If desired, enter the name of the customer for the current
Truck Manifest. This information will appear in the File Open Dialog
box as well as in the Load and Load Front/Back reports.

% Address: If desired, enter the address of the customer for the current
Truck Manifest. This information will appear in the File Open Dialog
box as well as in the Load and Load Front/Back reports.

% Status: Select a status among Error, Fixed, Open and Shipped from
the drop-list. This status information will be included in the File Open
Dialog Box.

+« Delivery Date: For reference, enter the promised delivery date for the
order, represented as Truck Manifest in MaxLoad Pro. You can click
to drop-arrow to select the date from the calendar or use the up/down
arrow key to select the month, day and year after the parameter is
highlighted.

» MFT Comments 1. Enter comments regarding the truck manifest.
Comment 1 appears in the title section of all printouts.

» MFT Comments 2 & MFT Comments 3: Enter comments regarding
the truck manifest to appear on Load and Load Front/Back view
printouts only. Comments 2 appear in the header section while
Comments 3 appear in the footer section above the customer
information.
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Weight Tab (Truck Manifest)

To set up weight limits for king pin and axles based on different regions of
the country.

Optiohs I Mised Pallet I Comments *afeight | 1 I 'I
v “wheight Lirnit [~ COG Dewviation e |
Fiegion I j Calculate |
King Fin (Ib] ID
Ales (Ib) ID
— Tractor Weight Tractar
Steer fxle Weight (IE] IU I j

Dirive fuxle (k] ID

— COG Deviatian

Length [in] ID Width — [in) ||:|
kax Height  (in] ID
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Weight Limit: Check this box to activate the weight limit option,
which allows you to set up weight limits for the kingpin and axles
based on different regions of the country.

Region: Use the drop-down list to select a region of the country. If no
regions are available from the drop list, click on the Edit Regions
button to create new regions.

King Pin: Enter the weight limit for the king pin — based on
regulations in the selected region — in pounds or kilograms, depending
on the Units selected.

Axles: Enter the weight limit for the axles based on regulations in the
selected region.

Edit Regions Button: The Edit Region allows you to set up new
regions, edit or delete existing regions.

To create a new region, start from the Region dialog box and follow
these instructions

1. Click on the Edit Regions button and the Region dialog box
appears, as pictured here.
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2. Click on the New button.
3. Enter information in the following fields:
m Region: Enter the name of the new region e.g. Texas.
»  King Pin: Enter the weight limit for the king pin.
m Axles: Enter the weight limit for the axles.
m Steer Axle: Enter the weight limit for the tractor steer axle.
m Drive Axle: Enter the weight limit for the tractor drive axle.

4. If all the new region information is correct, click on the Save
button. MaxLoad Pro saves the new region to the database.

To edit a region, start from the Region dialog box and follow these
instructions:

1. Use the Region drop-down list to select the region you want to
edit.

2. Edit king pin, trailer axle, tractor steer and drive axle weights as
necessary.

3. If all the updated weights are correct, click on the Save button.

To delete a region, start from the Region dialog box and follow these
instructions:

1. Use the Region drop-down list to select the region you want to
delete.

2. Click on the Delete button

Chapter 4: Loading a Truck Manifest 417



SKU List (Truck Manifest)

The SKU List, as pictured below, displays a list of all SKUs (shipcases,
drums, etc.) in the SKU database. This includes SKUs defined using the
Define SKU function as well as SKUs imported with the import function.
All SKUs in this list are available for loading into a vehicle, onto a pallet
or into a tote. SKUs will automatically appear in this list as they are
defined.

When you click on a SKU, a blue bar highlights it. The gray vertical
scroll bar to the right of the box scrolls through the list and allows you to
view more SKUSs.

SKU List

SEL Description Dims Wglk .
Refrigerator hodel 363-2 3282365 [in] |87 [Ib]
™ Surround Sound Plus 42w 32w28.5 [in] 80 (6]
Large Dium Large Dium Sample 3030450 [in) |60 [b]
Tizzue Paper A00 Sheet 20 Ct. 22381638116 1)
Stove 5 Burner w3 7ud [in] | B00 (6]
Hand T owels 500 Sheet Rale 20:1 6424 [in] |5 [b]
Crate #1 Sample Crate 1 E1=61=45 [in] |5 (b]
Cormputer Pentium 200 mkz. Mu2Tw2E fin] |40 (5]
Steren Sunmound Sound 290712 [in) |21 [b]
Cazed Sample Cage 4 2921417 5 [in] 14 [Ib]
Lamps Model 1524 24421536 [in] [1211b)
Crate #5 Sample Crate 5 7185105 [in] |12 [lb]
Caze 2 Sample Caze 2 1921316 [in] |11 [Ib]
Pallet #5 UL Example 5 4848250 [in] (105 [Ib]
Pallet #2 UL Example 2 | Blwd2=E0 [in] (102 [Ib) _|;‘

4 »

This SKU List contains useful information about all the SKUs. All of this
information is designed to help you make quick and easy decisions about
the items you’re shipping.

« SKU Type: This column contains graphical icons representing the
SKU Type: palletload, shipcase, drum, tote or mixed pallet.

- SKL [iescription
DrumskU=2 : Barrel Dru_m
Bulk Frozen rogurt| Swirl Flavor Yogurt
} Caze 1 Sample Caze 1
Shipocoee KU
P { Caze 2 Sample Caze 2
Tote SKU — Caze b Tote Tote Manifest: Caze &
Computer Pentium 200 mhz.
Drum 55 Gallon D) 55 Gallon Drum Sample
Faillet SkU — &= Electronics ixed Pallet Manifest:
Hand Towels 500 Sheet Role
Pallet #1 UL Example 1
Falletlocd U {3_ Palet #2 UL E kample 2
Large Drum Large Diium Sample

R

% SKU: This column contains the SKU Number, as defined in the
Define SKU screen. This serves as the unique identifier for each of the
product items in the database.
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Description: This column displays the full description of the SKU.
As with the SKU column, contents of this column appear exactly as
they are defined in the Define SKU screen.

« Dims: This column displays the dimensions of each individual SKU.
The dimensions will appear either in English or Metric units,
depending on which units are selected in the Toolbar.

X/
°e

Woagt: This column displays the defined weight of the SKU. As with
the dimensions column, this column will either appear in English or
Metric units, depending on which units are selected in the Toolbar.

« SKU Info 1, SKU Info 2, & SKU Info 3: These fields display the
information saved under the Graphics tab while defining the SKU.

Manifest List (Truck Manifest)

The Manifest List, displays a running list of all the selected SKUs to be
loaded into the container. As you select SKUs from the SKU List (by
double clicking the SKU), they automatically appear in the Manifest List.
The Manifest List allows you to define specifics about the load; it contains
both input fields and checkboxes that help tailor this load to your
particular needs.

Manifest List (]
- Sk [ty Phica UL ME | Orderft] % Cube Wt
Barral 1 1 O %] 0.9 % 0.0 %]
Caze 1 1 1 O 4 0.1 % 0.0 %]
Computes 1 1 O = 0.3 01%
Tatal 1.4 % 0.1 ﬂ

Let’s take a look at the Manifest List.

« SKU Type: This column contains graphical icons representing the
SKU Type: palletload, shipcase, drum, tote SKU or Pallet SKU.

< SKU: This is the SKU Number, as defined in the Define SKU screen.

X/
°e

Qty: The Quantity column displays the number of a specific SKU or
palletloads to be loaded in the container(s).

If a palletload SKU is added to the Manifest List, the quantity will
represent the number of palletloads but not the number of individual
cartons on this palletload, which in turn will be displayed under the
Piece Count column as described later.
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Note: If the option “Load by SKU Ratio” under the Options tab is
checked, the Qty column will represent the ratios of quantities of all
the respective SKUs in the Manifest List.

SO/Prior: This column serves a dual purpose, allowing you to build a
load using either Priority Numbers or Stop-Offs in the calculations.
The Manifest List shows one field or the other — Stop-Offs or Priority
—at all times. To specify loading method to use, go to the Options tab
and select one or the other. If you don't need to use either loading
method, simply leave all numbers in this column the same; that is, all a
stop off or priority of “1”.

The Stop-Off function allows you to consider the loading sequence
when various drop-shipments need to be made. If you enter "1" in this
column, MaxLoad Pro will place this item at the end of the trailer,
where it can be easily reached at the first stop. A stop-off value of “2”
places the item further forward in the vehicle, accessible at the second
stop-off.

If there's not enough room to load the entire stop-off onto the vehicle,
MaxLoad Pro will remove all SKUs that made up the stop-off, and
will place all SKUs for the stop-off onto the Cut List. MaxLoad Pro
will not partially load a stop-off.

However, there is one exception to this functionality: If the first stop-
off will not fit into the selected vehicle, MaxLoad Pro will break up
the stop-off in an effort to load something. While we understand that
this functionality does sacrifice cubic utilization, our customers have
indicated that this is the preferred way to handle this situation.

The Priority function allows you to define the relative importance of a
particular SKU when loading into a vehicle. All SKUs with a priority
of “1” will be loaded before SKUs with a priority of “2,” which are
loaded before SKUs with a priority of “3,” and so on. This means that
all SKUs with a Priority of “1” will generally be loaded before (and
therefore in the front of the vehicle) SKUs with a lower priority value.

If there's not enough room to load all SKUs with a particular priority
value, MaxLoad Pro will load as much of the priority as possible,
leaving the remaining SKUs to be placed on the Cut List. In other
words, priorities can be split-up, unlike stop-offs.

UL: Allows you to place an SKU onto a unitload “on the fly.” If
you've previously created a unitload for a particular SKU, you can
simply activate this checkbox and move on to the next field. MaxLoad
Pro will load these SKUs using the pallet pattern you selected in the
Create Unitload screen when you defined the SKU. If you've not
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created a unitload for this SKU, the field will be grayed out, meaning
that you cannot activate this field. In this case, you'll need to create a
unitload in the Define SKU screen, then come back and activate the
field.

For more information, please refer to Chapter 3, Defining MaxLoad
Pro Databases.

Checking this box does not guarantee that all SKUs will be loaded as
part of a unitload. How it is loaded will depend on the number of
SKUs that make up a complete unitload as defined in the Create
Unitload screen.

For example, suppose you've created a unitload that consists of 44
cases of peanut butter. If you want to load 88 cases of peanut butter,
MaxLoad Pro will load all cases onto two complete unitloads.
However, if your order calls for 70 cases of peanut butter, MaxLoad
Pro will load one complete unitload (44 cases), and will either load the
remaining 26 cases on the floor or as part of a mixed-pallet (if the
Mixed Pallet column is checked).

The Unitload functionality allows you to either floor load a selected
SKU or load it as a unitload. You may find that this feature comes in
handy when you have products destined for two customers, but one
requires SKUs to be shipped on pallets, while the other does not.

If you want to do this, simply select the SKU twice from the SKU List
box. This action will create two separate line items in the Manifest
List. Enter a quantity to be loaded as part of a unitload, then check the
UL box. Do the same for the second line item of the SKU, but this
time do not check the UL box. This will designate this group of SKU
to be floor-loaded.

You'll notice that this field may already be activated when you select a
SKU from the SKU List. This occurs when you activate the “Unitize”
field when you define a SKU. Remember, that you'll need to check
this box even if only one SKU is to be shipped as part of a unitload.
The column must be displayed in order to activate the UL field.

Note: UL and MP columns appear in the Manifest List only if the
“Use Unitloads” and /or “Use Mixed Pallets” options are checked
under the Options tab, respectively.

X/

% MP: MP stands for Mixed Pallet i.e. a palletload consisting of multiple
kinds of SKUs. Creating a mixed-pallet on the fly allows you to
choose a pallet type and have MaxLoad Pro load SKUs onto that pallet
using either default parameters or the options you select through the
Mixed-Pallet tab.
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MaxLoad Pro builds a default mixed pallet by layers, meaning that it
will first look for full layers of SKUs before mixing and matching
those layers. MaxLoad Pro will not build a default mixed pallet using
a column-building method. Why not? The results of this method are
not always considered to be very stable.

When you check the MP box, you assign all SKUs in this row to either
a unitload (if the UL box is checked) or to a mixed pallet. When the
MP box is checked, this particular SKU will not be floor-loaded.
(unless you are using the Fill Item option) Using the scenario in the
Unitload section, if 26 cases of peanut butter remain, all 26 cases
would be loaded onto a mixed pallet when this column is checked.

MaxLoad Pro builds a default mixed pallet by first looking to see if a
unitload has been created for the SKU in question. It will also
determine if any parameters are similar — pallet, overhang, maximum
height, etc. If a unitload has been created and the parameters are the
same, MaxLoad Pro will build full layers based on the patterns used
when creating the unitload. Once full layers have been built, the
remaining items will be loaded loosely on top of the mixed-pallet.

Example: Suppose we've created a unitload that consists of four layers
of peanut butter cases; each layer consists of 11 cases. Taking into
consideration the remaining 26 cases that are to be placed onto a
mixed pallet, and assuming all parameters are the same, MaxLoad Pro
will load two layers of peanut butter (using the same pallet pattern as
the complete unitload), comprising 22 cases. Then MaxLoad Pro will
load the remaining four cases loosely on top of the mixed pallet.

If any parameters have changed, this loading philosophy is thrown
“out the window,” and MaxLoad Pro will determine the most efficient
way to load the mixed pallet, taking into consideration the new loading
parameters.

Order #: You have the option of assigning an order number to each
SKU or group of SKUs that you ship. This column simply provides
information that may be useful to your logistics staff. Information
keyed into this field will be available on certain printouts, which in
turn can be used when loading the vehicle or pallet.

On the Options tab, you can then tell MaxLoad Pro to keep items
within the same order together. If you do not use order numbers, you
can uncheck the “Keep Same Orders Together” option under the
Options tab.

% Cube: This field specifies the total volume of the specified quantity
of that particular SKU, UL, or MP will occupy in the container. You
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can use this number to get an “estimate” of how many vehicles you
will need.

% 9% Wgt: This field specifies the total weight of the specified quantity
of that particular SKU, UL, or MP will weight with respect to the
container.

« SKU Info 1, SKU Info 2, & SKU Info 3: These fields display the
information saved under the Graphics tab while defining the SKU.

« Extral & Extra2: Not implemented.

s Site 1, Site 2, Site 3 & Site 4: These fields display cost related
parameters, please contact TOPS for more information.

s Point Value: This field displays cost related parameters, please
contact TOPS for more information.

% Piece Count: This field displays the total number of items which is
contained within a given SKU, if a piece count has been provided
during the SKU definition process. For example, if you have told
MaxLoad SKU Shampoo has a piece count of 24 (meaning each box
of SKU Shampoo contains 24 bottles of shampoo), then when you
enter a quantity of 50 for SKU Shampoo, the Piece Count column will
give a number of 1200.

« Fill Item: When checked, this option instructs MaxLoad Pro to use
the referenced SKU as fill items, meaning this SKU will be used to fill
all available empty space in the container after the other SKUs (non
fill items) are loaded.

Add the SKU to be used as fill item to the Manifest List in the usual
manner and enter the quantity. If there is still available space, increase
the quantity of the fill item or select a second SKU as fill item.

However, if you specify more fill items than required to fill the void
space, they will be placed in the CutList BUT the Next Truck button
will not be available.

%

% Cube: This field specifies the total volume of the specified quantity of
that particular SKU, UL, or MP.

%

% Woagt: This field specifies the total weight of the specified quantity of
that particular SKU, UL, or MP.
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Adding or Updating SKUs to the Manifest List

You can add SKUs to the Manifest List by double clicking the SKU in the
SKU list or use the SKU input list shown below to add the SKU
information.

Type in the first few characters of the SKU Number in the field below will
quickly bring you to the SKU in the list for selection. Enter the quantity
and other information including priority, UL, MP (if enabled) and order
number, then click on the Add>> button to add the SKU to the Manifest
List.

[[stereo | oy | | Prior | | ¥ UL T MP Ordert Add >> | |

To update existing SKU information in the Manifest List, highlight the
SKU in the list. Make any corresponding changes and click on the
Update>> button.

[[case | aty [s0 | Prior [1 | ¥ uL " MP Ordert Update >> | |

To quickly enable Use Unitload or Use Mixed Pallets for all SKUs in the
Manifest List, click the right mouse button to access the context menu as
shown below and select the corresponding option.

5K [ty § Prior § L MP §Orderft] % Cube % wigt Cube
Chair 5 0 H ] 166 % 0.5 % £3180.0000
Caze 1 1 11 H [=] Properties .0 % 5500000
Caze 1 10 11 H ] Check &ll L |3 % BR56.00000)
Caze 1 1 11 H [=] Lincheck all LIL .0 % 5500000
Caze 2 30 11 H ] l].S %] 395200000
Case 4 50 11 H ] % .8 %/ 10657 5000
Steren 1 11 H [=] = .1 %] 5916.00000)
Steren 1 1| H [=] 1.1 %[ 531600000
| |

Changing the Display of the SKU and Manifest List

s List Items: You can control what type of SKU data or Manifest
information will be displayed in the SKU or Manifest List via the Edit
| Properties menu function by following these steps:

1. Activate the SKU List or the Manifest List by clicking and
highlight any one of the SKU item in the list.

2. Go to the Edit Menu in the menu bar and select Properties, which
opens the Properties dialog box.
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Properties
] - oK
7 s Lo |
I Ot Cancel
= 5o 4'
¥ Ficr
NI
¥ P
[~ Tote
[v Ordertt
¥ % Cube

v % wigt
Properties

¥ -
o -

¥ | sKu

¥ Description
v Dims

Cancel |

v SKU Info 1

[ SKU Info 2

™ SKU Info 3

[ Estral

[~ Esta2

[” Piece Count

v wigt v Fill ltem

[ SKU Infad [~ Site1

[~ 5KU Info 2 [V Site 2

[~ SKU Info 3 [~ Site 3

[~ Site 4

[ Paint Value

V¥ Cube v it

3. Click the box to remove or add items that you would like to be
included in the SKU List and Manifest List respectively.

Note: A short cut to access the Properties dialog box is to click the right
mouse button while the mouse cursor rests inside the respective area.

« Sort Order: The SKU and Manifest List appears in ascending or
descending order, first numerically then alphabetically, with respect to
the selected SKU field. To sort on a particular filed, simply click on
the corresponding column heading (SKU, Description, Dims, Wgt, or
SKU Info) in the SKU List. To sort the list in the reverse order, click
on the same column heading again.

For the Manifest List, you can only sort on SKU, Qty, Prior(ity)/SO or
Order #.

+« Column Width: You can adjust the width of each column in the SKU
or Manifest List to accommodate all the information in each column.
To expand a column, follow these instructions:

1. Position the mouse pointer on the edge of the column heading you
want to expand. For example, if you want to expand the
Description column, place the mouse pointer (arrow) at the divider
line between the Description and Dims columns, as pictured
below.

The mouse pointer changes shape from a single arrow to a double-
ended arrow, as pictured below.
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Descrigtion (f{iﬁ Dims.

Yanilla lce Cream 137 3x24 1
kil 20w 0xd5 q
1 B0=G0x60 H

2. With the cursor as a double-ended arrow, now click on the left
mouse button and drag the column to the desired width. You can
either expand or contract the width of the column.

3. Once the column is expanded to the desired width, release the left
mouse button. The double arrow disappears, replaced with the
standard mouse pointer. When you release the mouse button, the
new column width will be set.

o,

% View Size of the Lists: The position of the SKU and Manifest List is
fixed and always displays in the lower portion of the screen.
Regardless of the manifest or the tab selected, the SKU List and
Manifest List will always appear. However, you can adjust the view
size of the two lists using these methods.

O sku List | © Manifest List Lo
- sk Description Digal]- Skl Gty § Prior § UL JOrdertt] = Cube AT
Tote #3 Sku Tote Manifest: Cookie/Chipd 45:40:=40 [ir Computer 304 11 O 238 % 3
Tailet Tizsue Estra Soft Brand 24:410:19.5 : Case 3 300) 11 0O 17.6 %] 1:
Bulk Frozen ‘Y'ogurt) S wirl Flavar Yogurt 1010212 [ir Case 2 168] 11 B .2 g
Saltines Lows Fat 20 Ct. 24:19.5416 [J{Caze 28 11 0O 8.6 %] lf
Case 5 Tate Tote Manifest Case 5 20.31=20.31 Bulk Frozen Yogul 300 1 O 16.9 %) [
Potato Chips Snack Size B0 Ct. 241610 [ir B26] 95.1 %) 27
Bairel Dirum 353540 [ir
Cookies Oreno 20 Count 10x9.5x11 [ir
Heawp 353540 [ir
Casel Sample Caze 1 2319:15 [ir qp o
Case 5 Sample Case 5 191512 [ir
Crate #2 Sample Crate 2 Bowa2x39 [ir
Pallet #1 UL Example 1 49241255 [ir
Pallet §2 UL Example 2 5042460 [ir »
. | r - | »

m  Split View @: By placing the mouse cursor on the vertical bar
dividing the two lists, the cursor will change to a4k. Now click on
the left mouse button to move the dividing bar to adjust the size of
the views for the two lists.

s Full Width View ®&©: By clicking on the title bars of the two
lists, the List will change its size to display all selected fields for
the List as illustrated below.
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SKU List Manifest List |
- SkL Deescription Dirnis Wit ~ Sk Oty Jf Priocd UL _J0Or
Tate #3 Sku Tote Manifest: Cookie/Chipd 45:40:40 [in] 0 () Computer 30 1 0O
Toilet Tiszue Extra Soft Brand 24x10419.5 [in] 0.06 [Ib) ! Caze 3 300 1 O
Bulk. Frozen ‘Yogurt| Swirl Flavaor ogurt 1010412 [in] 0.08 [Ib) Case 2 168 11
S allines Law Fat 20 Ct. 2419.5:16 [in] 0.25 [Ib] ] Case 1 28 1 0O
Case 5 Tote Tote Manifest: Caze 5 20.31%20.31=215.65 [in]_|0.5(lb] Bulk Frozen Yogul 300 11 O
Potato Chips Snack Size 50 Ct 241610 [in] 0750k 826
Barrel Dirurn 3536w 0 [in] 1 (k)
Cookies Oreo 20 Count 1095411 [in] 11lb]
Heawy 35x35x40 [in] 1 [lb)
£ Case 1 Sample Caze 1 23x19x15 [in] 10 [Ib)
Case 5 Sample Case 5 1915412 [in] 10(lb]
il Crate #2 Sample Crate 2 B5x32x39 [in] 10 [lb)
Pallst #1 UL E=ample 1 494755 [in] 101 [Ib)
Pallet #2 UL Example 2 S0xd2%60 [in] 102 [Ib)
Pallet #3 UL Example 3 48x40x55 [in] 103 [Ib] LI LI—I _;I
SKU List Manifest List | =
- SKU - - SEL Oty § Priord UL JOrdertt] % Cube % wiat_| Piece Count]|_Fil lem
Tote #3 Sku Tate b Computer 30 1 O 238 % 35% 30) ]
Toilet Tissue Extra £ [|Case 3 300) 1 0 17.6 %] 13.2% o000 O
Bulk Frozen v'ogurt| Swirl F fCase 2 168) 1 E 3.2 %] 5.4 %] 168 O
Saltines Lows Fe ’_' Case 1 28 1 O 8.6 % 0.8 % 28] O
Case & Tote Tote b Bulk Frozen Yogug  300) 1 O 169 % 0.1 %] 300 |5
Potato Chips Snack 826 981 % 231 %] 826
EBarrel Do
Cookies Oren 2
Heawy
4 Case 1 Sampk
& Case 5 Sampl
Crate #2 Sampk
Pallst #1 UL Ex
Pallet #2 UL Ext w
4 | »

m Full Screen View @: By clicking on the full screen icon El to
the right of the Manifest List title bar, this will bring both lists to
full screen size. This will give you a better view to add SKUs to
the Manifest List. To restore the Tab view and the g.o.d. graphics

window, click the restore icon il to the right of the Manifest List

tit

le bar.
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Defining a Truck Manifest

To define a truck manifest, start from the Control Center and follow these
instructions:

1.

Under the Truck Manifest box, click on the New button. The Manifest
Pick List Screen appears.

Double click on the vehicle from the list of Available Vehicles. The
selected vehicle(s) display in the Selected Vehicles list.

Select the SKUs to be loaded from the SKU List by double clicking
the SKUSs.

In the Manifest List, enter a quantity and specify other parameters like
stop-off/priority, order number, etc.

On the Options tab, designate which SKUs are to be loaded as part of a
unitload or together on a mixed-pallet.

If everything is correct, click on the Calculate button. MaxLoad Pro
calculates solutions based on your input.

Select the truck manifest solution from the Sol List that best meets
your needs.

From the Menu Bar, open the File menu and select Save As and the
File Save As dialog box appears.

In the blank line at the top of the box, replace the word “Untitled” with
the name of this truck manifest and click Save.

Note: Chapter 8, Viewing a Solution, describes in detail the options you
have once a manifest has been calculated. Chapter 9, Editing a Solution,
discusses how to use the Editor to customize a solution. Refer to those
chapters for more details.
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Truck Manifest versus Single SKU
Manifest for Single SKU Loads

If you're loading only single-SKUs into a container, you can use either the
Truck Manifest or the Single-SKU Manifest as described on chapter 7.
The major differences between the two functions are briefed as below:

+ Quantity Specification: In Single-SKU Manifest, it is not necessary
to enter a quantity for the SKU to be loaded. MaxLoad Pro will cube
out the vehicle using as many of the specified SKU as possible. You
can however, tell MaxLoad Pro whether to load as SKU as floor loads
or unitloads.

With Truck Manifest, you must provide a quantity for the SKU in
order for MaxLoad Pro to find a load solution. If the solution calls for
more than one vehicle, adjust the quantity accordingly.

« Load Editing: There is no edit function for Single-SKU loads. You
can select the different loading pattern styles (under the Options Tabs)
only but with Truck Manifest, you have full 3D drag-and-drop edit
capabilities.

+« Algorithm Fine Tuning: With Single-SKU loads, SKUs can only be
loaded as unitloads or straight floor loads. But with Truck Manifest,
the single SKUs can be loaded in combination of unitloads, partial
unitloads (Optimize Height for Top Layer) or loose items.

+ Ceiling Clearance Requirement: With Truck Manifest, you can
specify a minimum ceiling clearance to accommodate forklift or other
maneuvers but with Single-SKU, your work around is to reduce the
loadable height of the vehicle.
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Loading a Pallet Manifest

Introduction

This chapter explains how to use MaxLoad Pro to load a pallet manifest.
This chapter walks you through the process you’d most likely follow when
building a palletload, including the following topics:

«+ Pallet Manifest Pick List Screen

Mixed Pallet Tab
Options Tab
Algorithm Options
Comments Tab
SKU List
Manifest List

% Defining a Pallet Manifest

++ Printing a Pallet Manifest
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Pallet Manifest Pick List Screen

Start from the Control Center and click on the New button under the Pallet
Manifest icon. The Pallet Manifest Pick List Screen appears as show here.

. MaxLoad - Mainfest Pick List: Untitled

File Edit Wiew Define Tools Layout Help

&S| - xn-maom

Mixed Pallet I Options | Comments | D I Top I Side I Front ]
Paliet Pallet Name M
[ EwrcPallet Calculate
[ EurcPaliet (1200 % G00) Hel
[ EwrcPlet (800 1200) —F
[ GMa [Metric Black)
[ GMa iMotched)
GMA Motched
[ tore (48" 5 407) [
Maximum Height |ncl Pallet [m]l55 ]
Maximum *Weight Incl Pallet [Ih]lBSSB
taximum Length Overhang [|n]|1 oo
Marimum Width Dverhang [m]|1 oo
Q Prior [T UL 7 MP Order# i
| oy | | | | |
SKU List | Manifest List [=
B SkU Diescription Diirns ﬂ 2 Skl Pricr § Oiderd]  Cube
Crate H4 Sample Crate 4 453241 [in]
Crate H5 Sample Crate § 71x51%55 [in]
danny-1 Mired Pallet Manifest: Untitled 49. 53440254, 35 (in]
danny-2 Mixed Pallet M anifest: Untitied 484054, 35 [in]
Deepfreszer Arctic Plus Model 72u31%35 [in]
Drum 55 Gallon Dirurn 55 Gallon Drum Sample 24%24x36 [in]
Farofa 15.748x11.811x3.937 [in)
flat panels E0xd0x1 5 [in]
Hand T owels 500 Sheet Role 20x16x24 [in]
Lamps todel 1524 2482136 [in] LI

For Help Contact Tops Software

| [NUM Supervizor v

This screen is comprised of the following components:

R/
A X4

X/
L X4

X/
L X4

X/
L X4

X/
L X4

Mixed Pallet Tab: Allows you to select the pallet(s) and enter the
overall allowable height, weight, and overhang factors for the load.

Options Tab: Allows you to enter parameters for loading the pallet(s).

Comments Tab: Allows you to enter comments regarding the pallet
manifest, which appear on the printed reports.

g.o.d. Window: Displays a 3-dimensional graphic image of the pallet.

SKU Input: Allows you to enter SKU, quantity and other load
parameters in the manifest list.

SKU List:
pallet.

Displays a list of all SKUs available for loading onto a

Manifest List: Running list of selected SKUs to be loaded onto
pallet(s). Here you even define the specifics about the load, like
priority, quantity, etc.
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% View Button: Allows you to view a load without recalculating it.
This feature works only if you have previously built a load and is used
primarily after you have made changes to the load in the Editor screen.

+« Calculate Button: Allows you to calculate a pallet manifest.

% Algorithms Button: Allows you to select the algorithms when
creating the pallet manifest.

Mixed Pallet Tab (Pallet Manifest)

The Mixed Pallet tab, pictured below, allows you to select a pallet and
enter the overall height, weight and overhang data for the load.

Mixed Pallzt | Optians I Commgnts I

i

Pallet Pallet Name | $|
O EuroPallet Calculate |
EvroPallet (1200« 300)

O EwroPallet (300« 1200] &l
[ GM& [Metric Block)

O GMa Matched)
GkA Matched

[ More (48" 407 hd|
Maimum Height Inel Pallet [in)55.00
b amimumm Weight Incl Pallet [Ib)|3939
taximum Length Owerhang [in]{0.00

M aximum Width Dverhang [in]ID-UU

The Mixed Pallet tab contains the following fields:

< Pallet: Allows you to select from various types of pallets and
slipsheets already defined in the Pallet database. You can select
multiple pallets for the manifest and evaluate which one works the best
for you.

We ship MaxLoad Pro pre-loaded with a range of popular pallet styles.
However, if you can't find a pallet or slipsheet that you want to use for
this manifest, you can define a new one as described in Chapter 3.

Note: Similar to using multiple vehicle types in Truck Manifests, turn
off CalcAllTrucks if you want to see solutions for each selected pallet

types.

< Maximum Height Incl. Pallet: Enter the maximum height of the
mixed pallet load. Remember to include the height of the pallet in this
value. MaxLoad Pro will not calculate any solution that violates this
maximum height.
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Theoretically, there's no limit to the height to which MaxLoad Pro can
build a mixed pallet. The only limit is the value that you enter into this
field. Most mixed pallets are built to a height of 40-70 inches.

Maximum Weight Incl. Pallet: MaxLoad Pro will not calculate any
solutions that violate the defined maximum weight for the mixed
pallet. As with the Maximum Height field, remember that this value
includes the weight of the pallet too. You can verify the defined
weight through the Define Pallet screen. For more information, please
refer to Chapter 3, Defining MaxLoad Pro Databases.

Again, there's no theoretical limit to the amount of weight you can
enter in this field. However, you may want to check with the pallet
manufacturer or shipping personnel to determine the maximum weight
your pallet can handle.

Maximum Length and Width Overhang: These values represent
the maximum distance a SKU can hang over the edge of the pallet.
The overhang dimension is illustrated below.

et TR R o Overlng

For the purposes of building a stable load, we recommend that you
limit the maximum overhang to at least one-half the length of the
smallest SKU to be used in this manifest. This will ensure that no
SKU will have the majority of its mass hanging off the edge of the
pallet.

When MaxLoad Pro builds a mixed-pallet load, it will use as much of
the “available” space on the pallet as possible. The amount of usable
space is determined by the pallet size, the amount of overhang
allowed, and the maximum height allowed to build a load.

In effect, MaxLoad Pro uses this information to build invisible “walls”
representing the absolute parameters of the mixed-pallet load. In fact,
when viewing a load you'll notice that the usable area is shaded a
different color to differentiate it from the background of the diagram.
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Options Tab (Pallet Manifest)

The Options tab, pictured below, allows you to further customize your
mixed pallet manifest by setting various loading parameters. To access
this screen, use the mouse to click on the Options tab button found at the
top of the Mixed Pallet Manifest Pick List screen.

Note options not available to the Pallet Manifest will be grayed out.

Mixed Pallet Dptions | Comments I
I~ lze Urj'uitLDads (% Load By Priarity ity
™| Use Mixed Pallets
" Load By Stop OIff Calculate

[ keep Same Orders Together ; Stop & Priority Algorith
[ Keep Like SkUs Together Stop & Zone gonthms
[~ Load By SEU Ratio

b amirurn Wertical Gap (i) |3

b aimurn Pririty Overlap (i) {10000

b awirnum Dxwerhang [ira] ID

g

The Options tab contains the following fields:

% Load By Priority: When a SKU is assigned a high-priority number,
MaxLoad Pro loads it before loading a SKU with a lower priority.
MaxLoad Pro loads priority 1 before priority 2, which is loaded before
priority 3.

% Load By Stop Off: When you load by stop off, the loading method is
just the opposite of Load By Priority. Stop off 1 is loaded after stop
off 2, and therefore closest to the rear door; stop off 2 is loaded after
stop o-ff 3, etc.

Note: The following two options (Keep Same Orders Together and
Keep Like SKUs Together) work in conjunction with stop-offs and
priorities. In other words, if you build a load with two stop-offs,
MaxLoad Pro will keep like SKUs or orders together within the
individual stop-off or priority number.

Bear in mind that checking either one of these boxes could potentially
result in loss of cubic utilization. While we can't definitively say how
these options will affect a load, it's safe to say that these options will
affect MaxLoad Pro's calculations, thus making it possible that the
load will be affected negatively.
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Stop & Priority: Check this option when you want to add priority to
each Stop Off.

Keep Same Orders Together: This option is linked directly to the
Order # field in the Manifest List. When you key in an order number,
MaxLoad Pro gives you the option to group SKUs from the same order
together when loading. If you do not choose to input order numbers,
this field will be meaningless, and activating the checkbox will not
affect the placement of SKUs within your manifest.

Keep Like SKUs Together: This option is very similar to the Keep
Same Orders Together option. Activating this option tells MaxLoad
Pro to load all products with the same SKU number together. The
Keep Like SKUs Together checkbox takes precedence over the Keep
Orders Together checkbox, thus answering the question of what
happens when both boxes are checked.

Load by SKU Ratio: This option loads the pallet with the specified
ratio of SKUs in the Manifest List. When this option is checked, enter
the ratio of the respective SKUs in the Qty column.

For example, to load on the same pallet with SKUs A, B and C in the
ratio of 2:3:1, enter in the Qty column 2, 3 and 1 for SKU-A, SKU-B
and SKU-C respectively.

Note: When this option is checked, all SKUs in the Manifest List will
be loaded in the ratio specified in the Qty column. You will not get a
solution if MaxLoad cannot load all SKUs in the lowest multiple of the
specified ratios.

Maximum Vertical Gap: This option allows you to control which
spaces MaxLoad Pro joins together for the purpose of loading other
items on top.

In the process of loading SKUs onto a mixed pallet, MaxLoad Pro
accumulates a list of “leftover” spaces. Whenever possible, MaxLoad
Pro combines neighboring leftover spaces to make larger spaces.
Ideally, these neighboring spaces present a level surface. If they do
not present a level surface, you can enter a value in this field that
artificially “joins” the two uneven surfaces together, thus creating a
larger level surface.

If the difference in height of the two spaces is less than or equal to this
value (in English or Metric units), MaxLoad Pro joins together the
offending gap, assuming that you will pad or brace the shorter space to
bring it up to the height of the taller space.
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% Maximum Priority Overlap: MaxLoad Pro uses this option to
determine the placement of the next priority or stop-off. This field
allows you to define the distance on the pallet that MaxLoad Pro will
“mix” items of a different priority or stop-off. This field determines
how far forward into another priority or stop-off the front of an item
with a lower priority number will be placed.

For instance, if the value in this field is 30 inches, MaxLoad Pro will
place the next priority on top of the previous priority, with the front of
the lower priority protruding over the top of the higher priority by a
maximum of 3 inches. This would leave a 3 inch gap between the two
loading of two priorities

+« Algorithms Button: This button displays the Algorithm Options
dialog box, which allows you to determine how MaxLoad Pro will
load a manifest

Algorithm Options

The Algorithm Options dialog box, allows you to determine how
MaxLoad Pro will load a manifest. The sliding calculation bar allows you
to calculate loads based on speed or efficiency. MaxLoad also features a
progress bar and dialog box that display how your load is being configured
while it is calculating.

=
Algorthms ———————————————

¥ Load Frant to Back
v Space Evenly Cancel |
v Load Floor to Ceiling
I Flatbed
V¥ Layers

Optimize

v Left ko Right Dptimization ™ Pirwhesl Optimization for Pallets

IIIIIIIIIIII
Speed -J— Space |1D Cet

Staggered———————— Uritload Optionz

* Mone I™| Smart Fallet Flacement
" Tight I | lptimize Top Pallet Height
" Spread I™| &llov Loz Fil

™ Pyramid ™| &llove Partial LIL

[ Keep Order on Same Truck

The Algorithm Options dialog box contains the following features:
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Algorithms

+« Load Front to Back: Loads a pallet starting at one edge of the pallet
and working toward the opposite edge, stacking mixed or identical-
sized SKUs in columns.

% Space Evenly: Essentially spreads a load over the entire surface area
of the pallet in order to make a more secure unitload. Whenever the
cargo’s cubic measurement is less than the unitload’s available cubic
capacity — remember that you define parameters of height, weight and
overhang to define the cubic capacity — MaxLoad Pro creates an
artificial “ceiling.” This lowers the maximum height of the load,
forcing it to be spread as equally as possible over the surface area of
the pallet.

 Load Floor to Ceiling: MaxLoad Pro first takes the largest, strongest
SKU it can find, starting at the base of the pallet and builds the load
upwards. It always loads the larger boxes first, with smaller boxes on
top. This loading method may result in mixed layers of products,
depending on the quantities chosen and other parameters (e.g. stacking
strength).

% Flatbed: Not applicable for Pallet Manifest.

« Layers: The Layers algorithm will be checked automatically by
default for Pallet Manifest. When Enabled, MaxLoad Pro will group
SKUs of similar heights to form stable layers for the entire pallet.

Optimize

% Pinwheel Optimization for Pallets: This feature is not available for
loading pallet.

«» Left-to-Right Optimization: Check the box to optimize the manifest
load from left to right.

Looks for the best combination of two placements in order to
maximize the space across the width of the pallet. When you use this
option, MaxLoad Pro attempts to find some combination of two
placements to optimize the width of the pallet. If the box is not
checked, MaxLoad Pro will strive to place the largest placement
possible in the pallet, but won’t necessarily attempt to maximize the
space across the width of the pallet.

It’s important to understand that this algorithm does not always
provide the best solution, even though the logic behind the algorithm
would suggest that it would. Why not? Because of the physical
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dimensions of the SKUs being loaded onto a pallet, there simply may
not be a combination of two placements that can maximize the width.

X/
°e

Speed-Space Tab: Move the sliding bar to optimize calculation for
speed (flush left) or for efficiency (flush right)

The For Speed option tells MaxLoad Pro to calculate solutions as
quickly as possible.

The For Space option tells MaxLoad Pro to take more time and
calculate the most space-efficient solutions.

In addition to using the sliding bar, you can also enter a number
between 1 (speed) and 200 (space) in the box and click the Set button.

When you click OK, in the Algorithms dialog box, MaxLoad Pro
saves your algorithm options to memory and returns you to the Pallet
Manifest Pick List Screen.

The next time you calculate solutions for this manifest, MaxLoad will
display a progress dialog box.

Note: When you select multiple algorithms, MaxLoad Pro will
display at least one solution for each selected algorithm. Also,
whenever Left to Right Optimization is turned on, MaxLoad Pro will
calculate two solutions for each selected algorithm.

cocuate
Oty E
Cubic Eff 50%
CutList Cnt E
Solution Count I'IE— Stop
Truck |1—
Time Elapzed IW

Notice the following about the Progress Dialog Box :

m The dialog box displays a running count of the following
parameters for the current calculation: quantity, cubic efficiency,
cut list count, solution count, container number and time elapsed.

m A Stop button allows you to stop the calculation at any time and
gives you the best solution found so far.
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Staggered

This algorithm is used to load round shape SKUs. Due to the
cylindrical shape, MaxLoad Pro gives the following options to load the
SKUs onto a pallet.

¢ None: This option assumes that cylindrical objects are rectangular
SKUs and loads them in a linear fashion as a shipcase

s Tight: Loads as many cylindrical SKUs as possible along the
width.

s Spread: This to spread the round SKUs during loading

« Pyramid: This is for loading the cylindrical SKUs on their side, in
horizontal orientation, stacking in a pyramid shape.

Unitload Options

These are available for Truck Manifest only and are grayed out for
Pallet Manifest. Refer to Chapter 4, Truck Manifest for more details.

Comments Tab (Pallet Manifest)

The Comments tab provides the same fields as in the Truck Manifest. For
more information, please refer to Chapter 4, Loading a Truck Manifest on
page 4.15.

SKU List (Pallet Manifest)

The SKU List, displays a list of all SKUs available in the SKU database.
For more information, please refer to Chapter 4, Loading a Truck
Manifest, on page 4.18.

Manifest List (Pallet Manifest)

The Manifest List displays the SKUs onto the pallet. As you select SKUS,
by double clicking in the SKU List, they automatically appear in the
Manifest List. For more information, please refer Chapter 4, Loading a
Truck Manifest, on page 4.19.
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Defining a Pallet Manifest

To define a new pallet manifest, start from the Control Center and follow
these instructions:

1.

10.

11.

Under the Pallet Manifest box, click on the New button. The Manifest
Pick List Screen appears

Select the pallet(s) from Pallet list to be used for the manifest by
clicking against the pallet types you’d like to evaluate.

Note: Uncheck the CalcAllTrucks option under the Tools>
Configuration>Global menu in order to evaluate one pallet load at a
time. You will need to login as Supervisor (password = tops software)
in order to access the Global menu.

Enter values for maximum height, weight and overhang. The
maximum height and weight values include the pallet. Maximum
overhang must be defined for both the length and width of the pallet.

Select the SKUs to be loaded from the SKU List by double clicking
the item. The selected SKUs display in the Manifest List.

In the Manifest List, enter a quantity and stop-off/priority number for
each SKU. You can designate which loading method (i.e. by stop-off
or priority) to use under the Options tab.

In the Manifest List, key in an order number, if applicable.

If everything is correct, click on the Calculate button.

Select the solution that that best meets your needs from the Sol List.
From the Menu Bar, open the File menu and select Save As.

In the blank line at the top of the box, replace the word “Untitled” with
the name of this mixed pallet manifest.

Check the Save As SKU box, if you want to save the manifest as a
SKU to be used in a Truck Manifest and click on OK. The Save
Manifest as SKU dialog box appears, as pictured below.
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Save Manifest as SKU

SKL

I arifest

[Untitied

Weight (5] |2EI1 .0
QK I Cancel |

12. In the blank SKU field, give the mixed pallet manifest a SKU name
and click OK. MaxLoad Pro saves the new mixed pallet manifest/
SKU to memory and returns you to the View Screen.

Note: Chapter 8, Viewing a Solution, describes in detail the options you
have once a manifest has been calculated. Chapter 9, Editing a Solution,
discusses how to use the Editor to customize a solution. Refer to those
chapters for more details.

Printing a Pallet Manifest

To see a report of the new mixed pallet manifest, open the File menu and
select one of the Print Preview options.

In the Mixed Pallet analysis, the normal Print and Print Preview functions
are available. Further, if you’re working with a Truck analysis in which
one or more mixed pallet SKUs are loaded onto a vehicle, you can print
reports for those mixed pallet SKUs that are part of the truck manifest.
From the Truck analysis, follow these instructions:

1. Open the File Menu, select Print Preview, then select Unitload. The
Print Preview window displays a report for the first mixed pallet SKU
loaded onto the vehicle.

2. If the truck manifest includes more than one mixed pallet SKU, click
on the Next Page button. The Print Preview window displays a report
for the next mixed pallet SKU in the manifest.

5.12

MaxLoad Pro (V3.6) User’'s Guide



Loading a Tote Manifest

Introduction

A tote manifest is a specific collection of SKUs placed into a shipcase.
For example, suppose you ship snack products to a small grocery store on
a routine basis. This shipment always includes cases of cookies, potato
chips and saltines.

The tote manifest allows you to place these various items, or SKUs, into a
tote (shipcase) and load it onto a vehicle. MaxLoad Pro allows you to
create this tote manifest, save it to the SKU database and use it as a SKU
in a vehicle analysis.

This chapter walks you through the process you’d follow when building a
tote, including the following topics:

«» Tote Manifest Pick List Screen

Tote tab

Options tab
Algorithm Options
Comments tab
SKU list

Manifest list

+«» Defining a Tote Manifest

+«+ Printing a Tote Manifest
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Tote Manifest Pick List Screen

Start from the Control Center and click on the New button under the Tote
Manifest icon. The Tote Manifest Pick List screen appears.

. ManLoad - Mainfest Pick List: Untitled o [=] 3
File Edit W“iew Define Tools Layout Help
|12 5 00 3
Tote | Optiaons I Comments I | 3D I Top I Side I Front I
Tote List Selected Totes Yiew
20420215 Tate2 4540x40 Tote
Big Tote Calculate
Help
40 [in)
40 [in] 45 {in)
| oy | | Priar | | muL moMP ordent Add >
SKU List | Manifest List [=
B SKU Description Dims_ | [ SkU g T rrio fordert]  Site7 | Site 2 Laint Va_l1
[{Fotato Chips Snack Gize 50 Ot 241 0 ] | | [ 1 | |
L Refrigerator Maodel 363-2 32629465 [in]
L Saltines Low Fat 20 Ct 2419 516 [in]
Stereo Surround 5 ound 29:1 7412 [in]
[|Stove 5 Bumer 4153742 [ir]
testl Drum 0.39x0.390.39 [i
test2 0.73x0.7340.79 [i
L Tissue Paper 500 Sheet 20 Ct, 22.38x16.38x17.
Toilet Tissue Extia Soft Brand 24x10419.5 [in]
Tote B3 Sku Tate Manifest: Cooke/Chip/Cracker |45x40xd0(in) |
1010 2043229 (in) =
[x EED
Far Help Contact Tops Software HLIM 7

X/
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X/
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X/
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X/
L X4

X/
L X4

This screen is comprised of the following components:

% Tote Tab: Lists the available totes/shipcases that can be used for a

% Options Tab: Allows you to enter parameters for loading the totes.
Comments Tab: Enter comments regarding the tote manifest.

g.o.d. Window: Displays a 3-dimensional graphic image of the tote.
SKU List: Displays a list of all SKUs available in the SKU database.
Manifest List: A running list of selected SKUs for a tote manifest.
View Button: Allows you to view a load without recalculating it.

¢+ Calculate Button: Allows you to calculate a tote manifest.
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Tote Tab (Tote Manifest)

The Tote tab, pictured below, allows you to select a shipcase to be used

with the tote.
Tote | Options I Comments I
Tate List Selected Totes :
20420215 Tote? iz |
454 0x40 Tote
Big Tate Calculate |
Help |

The Tote tab contains the following features:

« Tote List: Displays a list of available shipcases in the tote database.
In order to build a load, you will need to either choose an existing tote
or define a new one through the Define menu.

Double click on a tote in Tote List to move it to the Selected Totes list.
Also notice that as a tote name is highlighted, a representation of that
tote appears in the g.o.d. (graphical on-line drawing) window.

MaxLoad Pro allows you to load multiple totes at one time. To do so,
select more than one tote to be analyzed when calculating a manifest.
Simply follow the procedure described above to select multiple totes.

+» Selected Totes: Displays the totes selected from the Tote List, for a
particular manifest.

When Maxload Pro calculates solutions for a manifest, it uses only the
totes listed in the Selected Totes list. To remove a tote from this list,
double click on the tote in question, in the Selected Tote list. This will
remove the tote from the Selected Tote list and place it back in the
Tote List. A representation of the selected tote will appear in the
g.0.d. window.
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Options Tab (Tote Manifest)

The Options tab, pictured below, allows you to further customize your tote
manifest by setting various loading parameters. To access this screen, use
the mouse to click on the Options tab button found at the top of the Tote
Manifest Pick List screen.

[T Use UrjitLoads & Load By Friarity e
[T Use Mized Pallets

™ Keep Same Orders Together .
[ Keep Like SkUs Together ! Stop & Zone el
[~ Load By SKU Ratio

tinimumn Ceiling Clearance [ir] IEI
b amimum Wertical Gap i) I3

b aximnurn Pricrity Overlap (i) {1000

b airum Overhang [iﬂ]ll:|

Tate Dptians | Comments I

" Load By Stop Off
' Stop & Priority

Caleulate

Bl

The Options tab contains the following fields, though these might not be
very relevant for a tote manifest:

+« Load By Priority: When a SKU is assigned a high priority number, it

%

will be loaded before an SKU with a lower priority number. Priority 1
will be loaded before priority 2, which will be loaded in front of
priority 3.

Note: Load By Priority and Load By Stop Off options determine
which column is displayed in the Manifest List: Priority or Stop-Off.
You can select either Load By Priority option or Load By Stop Off,
but not both.

Load By Stop Off: When you load by stop-off, the loading method is
just the opposite: Stop-off 1 is loaded after stop-off 2, stop-off 2 is
loaded after stop-off 3, etc.

Note: The following two options (Keep Same Orders Together and
Keep Like SKUs Together) work in conjunction with stop-offs and
priorities. In other words, if you build a load with two stop-offs,
MaxLoad Pro will keep like SKUs or orders together within the
individual stop-off or priority number.

Bear in mind that checking either one of these options could
potentially result in the loss of cubic utilization. While we can't
definitely say how these options will affect a load, it's safe to say that
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these options will affect MaxLoad Pro's calculations, thus making it
possible that the load will be affected negatively. Load By Stop Off
for totes works in conjunction with the Load Front to Back algorithm.

+ Stop & Priority: Check this option when you want to add priority to
each Stop Off.

« Keep Same Orders Together: This option is linked directly to the
Order # field in the Manifest List. When you key in an order number,
MaxLoad Pro gives you the option to group SKUs from the same
order together when loading. If you do not choose to input order
numbers, this field will be meaningless, and activating the checkbox
will not affect the placement of SKUs within your manifest.

% Keep Like SKUs Together: This option is very similar to the Keep
Same Orders Together option. Activating this option tells MaxLoad
Pro to load all products with the same SKU number together. The
Keep Like SKUs Together option takes precedence over the Keep
Same Orders Together checkbox, thus answering the question of what
happens when both boxes are checked.

X/

% Load by SKU Ratio: Selection of this option directs MaxLoad Pro to
load a tote with a given ratio of SKUs instead of quantities.

For example, you can instruct MaxLoad to load a container with
double the quantity of SKU-A than SKU-B; or have the quantity of
three selected SKUs in the ratio of 3:2:1.

% Minimum Ceiling Clearance: This feature is available only for
Truck Manifest analysis. For more information, please refer Chapter
4, Loading a Tote Manifest

+« Maximum Vertical Gap: This option lets you control which spaces
MaxLoad Pro joins together for the purpose of loading other items on
top.

In the process of loading SKUs into a tote, MaxLoad Pro accumulates
a list of “leftover” spaces. Whenever possible, MaxLoad Pro
combines neighboring leftover spaces to make larger spaces. ldeally,
these neighboring spaces present a level surface. If they do not
present a level surface, you can enter a value in this field that
artificially “joins” the two uneven surfaces together, thus creating a
larger level surface.

If the difference in height of the two spaces is less than or equal to this
value (in English or Metric units), MaxLoad Pro joins together the
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X/

offending gap, assuming that you will pad or brace the shorter space to
bring it up to the height of the taller space.

Maximum Priority/Stop-Off Overlap: MaxLoad Pro uses this
option to determine the placement of the next priority or stop-off. This
field allows you to define the distance inside the tote that MaxLoad
Pro will “mix” items of a different priorities or stop-offs. This field
determines how far forward into another priority or stop-off the front
of an item with a lower priority number will be placed.

For instance, if the value in this field is 30 inches, MaxLoad Pro will
place the next priority on top of the previous priority, with the front of
the lower priority protruding over the top of the higher priority by a
maximum of 30 inches.

Algorithms Button: This button displays the Algorithm Options
dialog box, which allows you to determine how MaxLoad Pro will
load a manifest.

Algorithm Options

The Algorithm Options dialog box, allows you to determine how
MaxLoad Pro will load a manifest. The sliding calculation bar allows you

to

calculate loads based on speed or efficiency. MaxLoad Pro also

features a progress bar and dialog box that display how your load is being
configured while it is calculating.

Algorithm Options B

Algorithmz ———————————— ok

v Load Front to Back -
V¥ Space Evenly Carcel |
[ Load Floor to Ceiling
I Flatbed

¥ Layers

Optimize

v Left to Right Optimization [” Pirwheel Optimization far Pallsts

Speed -w Space I'ID Set

Staggered———————— Unitload Options

&+ None I~ | Smart Pallet Flacement
™ Tight [ Optimize Top Pallet Height
" Spread [T Al Loose Fil

" Pyramid ™ &llavs Partial LIL

™ Keep Order on Same Truck,
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The Algorithm Options dialog box contains the following features:

Algorithms

7

% Load Front to Back: Loads a tote, starting at one edge of the tote and
working toward the opposite edge, stacking mixed or identical-sized
SKUs in columns.

X/
X4

Space Evenly: Essentially spreads a load over the entire surface area
of the tote.

)

X/

% Load Floor to Ceiling: MaxLoad first takes the largest, heaviest
SKU it can find, starting at the base of the tote and moving upwards.
MaxLoad Pro always loads larger SKUs first, with smaller SKUs on
top. This loading method may result in mixed layers of products,
depending on quantities chosen and other parameters (e.g., stacking
rules).

% Layers: Available to pallet manifests only and is grayed out for Tote
Manifest, this will load SKUs with similar heights to form stable
layers.

Optimize

+« Pinwheel Optimization for Pallets: This feature is not available for
loading totes

K/

«» Left-to-Right Optimization: Check the box to optimize the manifest
load from left to right.

Looks for the best combination of two placements in order to
maximize the space across the width of the tote. When you use this
option, MaxLoad Pro attempts to find some combination of two
placements to optimize the width of the tote. If the box is not checked,
MaxLoad Pro will strive to place the largest placement possible in the
tote, but won’t necessarily attempt to maximize the space across the
width of the tote.

It’s important to understand that this algorithm does not always
provide the best solution, even though the logic behind the algorithm
would suggest that it would. Why not? Because of the physical
dimensions of the SKUs being loaded into a tote, there simply may not
be a combination of two placements that can maximize the width.

% Speed-Space Tab: Move the sliding bar to optimize calculation for
speed (flush left) or for efficiency (flush right).
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The For Speed option tells MaxLoad Pro to calculate solutions as
quickly as possible.

The For Space option tells MaxLoad Pro to take more time and
calculate the most space-efficient solutions.

In addition to using the sliding bar, you can also enter a number
between 1 (speed) and 200 (space) in the box and click the Set button.

When you click OK, in the Algorithms dialog box, MaxLoad Pro
saves your algorithm options to memory and returns you to the Tote
Manifest Pick List Screen.

The next time you calculate solutions for this manifest, MaxLoad will
display a progress dialog box, as pictured on the next page.

Note: When you select multiple algorithms, MaxLoad Pro will
display at least one solution for each selected algorithm. Also,
whenever Left to Right Optimization is turned on, MaxLoad Pro will
calculate two solutions for each selected algorithm.

cacuate
ity |12—
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Notice the following about the Progress Dialog Box :

m The dialog box displays a running count of the following
parameters for the current calculation: quantity, cubic efficiency,
cut list count, solution count, container number and time elapsed.

m A Stop button allows you to stop the calculation at any time and
gives you the best solution found so far.
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Staggered

This algorithm is used to load round shape SKUs. Due to the cylindrical
shape, MaxLoad Pro gives the following options to load the SKUs in a
container.

¢ None: This option assumes that cylindrical objects as rectangular
SKUs and loads them in a linear fashion as a shipcase

% Tight: Loads as many cylindrical SKUs as possible along the width.
% Spread: This to spread the round SKUs during loading

% Pyramid: This is for loading the cylindrical SKUs on their side, in
horizontal orientation, stacking in a pyramid shape.

Unitload Options

These are available for Truck Manifest and are not applicable for Tote
Manifests.

Comments Tab (Tote Manifest)

The Comments tab provides the same fields as in the Truck and Pallet
Manifest. For more information, please refer to Chapter 4, Loading a
Truck Manifest.

SKU List (Tote Manifest)

The SKU List, displays a list of all SKUs available in the SKU database.
For more information, please refer to Chapter 4, Loading a Truck
Manifest, on page 4.18.

Manifest List (Tote Manifest)

The Manifest List displays the SKUs onto the pallet. As you select SKUS,
by double clicking in the SKU List, they automatically appear in the
Manifest List. For more information, please refer Chapter 4, Loading a
Truck Manifest, on page 4.19.
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Defining a Tote Manifest

To create a new tote manifest, start from the Control Center and follow
these instructions:

1.

Under the Tote Manifest box, click on the New button. The Manifest
Pick List Screen appears

From the Tote List, select the tote (shipcase) that you want to use to
create the new tote manifest. You’ll place your SKUs into this tote
(shipcase). To select a tote from the Tote List, double-click on it. The
selected tote appears in the Selected Totes list.

From the SKU List, select the specific SKUs that will be placed into
the tote. To select a SKU, double-click on it. The selected SKUs
appear in the Manifest List.

Define the quantity of each SKU, in the Manifest List, that will be
placed into the tote. When you’re finished defining SKU quantities,
click on the Calculate button.

MaxLoad Pro calculates various solutions for the tote manifest and
displays the first of the solution from the Sol List in the View Screen

Select the tote manifest solution from the Sol List that best meets your
needs.

From the Menu Bar, open the File menu and select Save As. The File
Save As dialog box appears.

In the blank line at the top of the box, replace the word “Untitled” with
the name of this Tote manifest.

Check the Save As SKU box, if you want to save the manifest as SKU
to be used in a Truck Manifest and click OK. The Save Manifest as
SKU dialog box appears, as pictured below.
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Save Manifest as SKU %] I

SKL

t anifest

[Uniitled

Weight 121} |55.EIIZI
0k, | Cancel |

9. In the blank SKU field, give the tote manifest a SKU name and click
OK.

MaxLoad Pro saves the new tote manifest/SKU to the SKU database
and returns you to the View Screen.

Printing a Tote Manifest

To see a report of the tote manifest, open the File menu and select one of
the Print Preview options.  Also, suppose you’re working with a truck
manifest that has one or more tote SKUs loaded onto a vehicle. From the
truck analysis, you can print reports for those tote SKUs that are part of
the truck manifest. From the truck analysis, follow these instructions:

1. Open the File Menu, select Print Preview, then select Totes. The Print
Preview window displays a report for the first tote SKU loaded onto
the vehicle.

2. If the truck manifest includes more than one tote SKU, click on the
Next Page button. The Print Preview window displays a report for the
next tote SKU in the manifest.
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Loading a Single-SKU
Manifest

Introduction

This chapter explains how to load a single-sized case manifest using
MaxLoad Pro. All you have to do is to pick a transit vehicle and the SKU
to be loaded, MaxLoad will show you the different ways to cube out the
vehicle with the selected SKU.

The topics outlined in the chapter are as follows:

% Single-SKU Manifest Pick List Screen

Vehicle Tab

Options Tab

Comments Tab

SKU Addition and Update
SKU List

Manifest List

+«» Defining a Single-SKU Manifest
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Single-SKU Manifest Pick List Screen

Once you’ve logged into MaxLoad Pro, the first screen that appears is the
Control Center. This screen, described in detail in Chapter 2, The Basics,
contains icons representing each of the various types of problems you can
solve using MaxLoad Pro. To start a new Single-SKU Manifest, start
from the Control Center and follow these instructions:

Click on the New button under the Single SKU icon.

System Response: The Single-SKU Manifest Pick List screen appears, as
pictured on the next page.

Once the Single-SKU Manifest Pick List screen is displayed, you’re ready
to begin defining the components of a new manifest. This screen is the
basis for collecting data for building a new manifest.

= MaxLoad - Mainfest Pick List: Untitled =] ]

File Edit View Define Tools Leyout Help

IREEIEEET Y G
\

Wehicle I Options | Comments | 30 I Top I Side I Front ]
Aovailable Yehicles Selected Vehicles Yiew
48 Ft. [Narow) Calcul
48 Ft Dry Cango sloulsie
48 Ft Dy Van Hel
50 F1. Rai Car &
53 FL. [Narow] ~Wehicle Type
53Ft Drop Deck & Tiuck
53 F1. DiyVan e
53 Ft. Dual Drop Deck " SeaVan
57 Ft. Dy Yan .
BOFt Fial Car © Rail Car
L-17 Air Freight P
L4 Air Freight ? Fiall /2 gon
LD-4 Air Freight MulliZone 4
LD5 4i Freight B Dol o] 102 i B
hTWLEuE: " oubile Traier
o1 Al  ULD 592
-2 it Freight ) frl
Truck with Wheel el  GideBay
" Flatbed
| oy | | Prior | | CuL T WP Ordert Add >> |
SKU List | Manifest List |=
SKU Descriplion A SKL j T
[-{Eanel Dium |
[ Bulk Frozen Yogurt Swirl Flavor Y ogurt .
Case 1 Sample Case 1
Case 2 Sample Case 2
Case 2 Sample Case 3
(|Cass 4 Sample Case 4
Case 5 Sample Caze 5§
Case b Tote Tate Manifest: Case &
o T =]
For Help Contact Tops Enginesring MU A

The Single-SKU Manifest Pick List Screen is comprised of the following

components:

+ Vehicle Tab: Allows you to select the type of transit vehicle to be
used for a manifest.
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% Options Tab: Allows you to define the pattern in which the SKU will
get loaded in the transit vehicle.

s Comments Tab: Allows you to enter comments to be displayed on
the Single-SKU printouts.

% g.0.d. Window: Displays a 3-dimensional graphic image of the
selected transit vehicle.

% SKU List: Displays a list of all SKUs (PalletLoads, Shipcases,
Drums, Tote SKUs, and Pallet SKUs) available in the SKU database.

% Manifest List: Displays the single SKU selected to be loaded into the
transit vehicle, particular to a manifest. As you select the SKU from
the SKU List it automatically appears in the Manifest List.

Note: For Truck Manifest, Pallet Manifest, and Tote Manifest the
Manifest List can contain more than one SKU.

« View Button: Allows you to view a previously calculated load,
without recalculating it. This feature works only if you’ve previously
calculated a load and is used primarily after you’ve made changes to a
load in the Editor screen.

+« Calculate Button: Allows you to calculate a load/manifest.
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Vehicle Tab (Single-SKU Manifest)

The Vehicle tab, allows you to select the type of transit vehicle (Truck,
Sea Van, Rail Car, etc.) for a manifest.

Yehicle | Ophiohz I Comments I

Awailsble Yehiclez Selected Wehicles i
48 Ft. [Marmow) Caleulat
48 Ft. Dy Cargo ElELELE
48 Ft. D Yan Hel
50 Ft. Rail Car =R |
53 Ft. [Narmow) —Yehicle Type
53 Ft. Drop Deck & Truck
53 Ft. Dy Wan s
53 Ft. Dual Drop Deck, = SeaVan
A7 Ft. Dy Wan .
B0 Ft. Rl Car " Rail Car
L-11 Air Freight :
L-4 &ir Freight S
LD-4 Air Freight ) MuliZone
LD-5 Air Freight
LTL p,_:::, =a £ Double Trailer
-1 &ir Freight UL
k-2 dir Freight )
Truck, with 'Wheel ‘Well ) SideBay

£ Flatbed

The Vehicle tab contains the following components/fields:

« Vehicle Type: Displays the various kinds of vehicles defined in
MaxLoad Pro. You can narrow down the list of available vehicles by
choosing a Vehicle Type. This action will filter the Awvailable
Vehicles list to display only one type of vehicle.

« Auvailable Vehicles: Displays the list of all vehicles available in the
database for the Vehicle Type specified. In order to build a load, you
will need to either choose an existing vehicle or define a new one
through the Define menu.

Double click on a vehicle in Available Vehicles list to move it to the
Selected Vehicles list.  Also notice that as a vehicle name is
highlighted, a representation of that vehicle displays in the g.o.d.
(graphical on-line drawing) window.

K/

+ Selected Vehicles: Displays the vehicle selected from the Available
Vehicles list, for a particular manifest.

When MaxLoad Pro calculates solutions for the Single-SKU manifest,
it uses only the vehicle listed in the Selected Vehicles list. To select
another vehicle, simply double-click a different vehicle under the
Available Vehicle list, the current selection will be update to reflect
the new selection.
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A representation of the selected vehicle will appear in the g.o.d.
window.

X/
°e

View Button: The View Button is active if you’ve opened an existing
analysis or a new analysis has been calculated. It opens the Manifest
View screen.

+« Calculate Button: The Calculate button will instruct MaxLoad Pro to
find loading solutions based on the parameters entered in the analysis.
When the calculation is complete, MaxLoad Pro opens the Manifest
View screen.

Options Tab (Single-SKU Manifest)

The Options tab, as pictured below, allows you to further customize your
manifest by defining pattern styles for the load.

Wehicls Optians | Comments I

Block2 [ tulti Layer Calculate
¥ Elock3 [ kulti D

[™ Blockd [T Multi Surface
[~ ElockS

™ Elocks Plus

[~ Soldiered

[ Diagonal

[¥ Fepeater

tinimwnn Celing Clearance [in]lD

MaxLoad Pro allows you to analyze a number of pattern styles when
loading a SKU into a vehicle. When loading SKUs into a vehicle,
MaxLoad Pro will attempt to calculate at least one solution for every
pattern style you’ve chosen. Keep in mind, however, that MaxLoad Pro
may not find a solution that utilizes every pallet pattern chosen. This is
especially true for some of the less common pattern styles, such as
Soldiered, Multi Layer, Multi Dim, etc. The characteristics of the SKU
will ultimately determine whether or not a pattern style can be used to
develop a solution.

— Pattern Styles i
iew
Al | V' Black [ Staggered _l
i _ Caleuate|

Below are images of two unitloads, displayed in plan view for each pattern
type. Each image uses the depth dimension as the vertical dimension.

« Blockl: The Blockl pattern is also known as column stack pattern.
It is simple pattern with all of the shipcases stacked in the same
orientation.
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°e

Block2: A bi-block pattern is formed by the shipcases stacked in two
different orientations. Also known as an interlock pattern, when used
in conjunction with layer rotation.

]
|
(=1=1=]

-
="

Block3: In a tri-block pattern the SKU blocks are stacked in three
different orientations

Block4: A Block4 pattern, is made up of four blocks of shipcases that
form a pinwheel-like figure

[ I
—T=lll =]

Block5: A penta-block pattern is made up of five blocks of shipcases.
Four blocks of shipcases form a pinwheel configuration; the fifth
block of shipcase is positioned in the middle.

Block5 Plus: The Block5 Plus pattern has another Block5 pattern in
the middle of the configuration. Four blocks of shipcases form a
pinwheel configuration; a separate 5-block configuration of shipcases
is positioned in the middle.

e

Soldiered: In a Soldiered pattern the cases are spaced apart so that other
cases can be turned on their sides and fit into the space.
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% Diagonal: The diagonal pattern has alternating blocks of shipcases that
form a diagonal configuration.

|

eannnk

53

%

Staggered: The staggered pattern is used to load round containers onto a
pallet. As you can see, the round containers mean the configuration will
have a staggered, rather than linear, pattern.

-t

»_{;}_‘:._ - l‘b"(
»"Tj\f::%_,{‘tj}*
=; { >
o%e%e%

s Multi Layer: In the two unitloads pictured on next page, the top layer is
lifted to show that different layers have different patterns. With a multi-
layer pattern, MaxLoad Pro configures the unitload with the vertical
dimension specified by the user, with the exception of the top layer. (The
top layer is not affected by stacking strength).

>

o
A

Multi Dim: In a Multi Dim pattern, each layer has a different vertical
dimension.

% Multi Surface: The figure below shows a multi-surface pattern. With
this pattern, MaxLoad Pro turns the pallet on its side, loads the pallet,
configures the pattern, then turns the pallet upright again. In the figure
below, the arrows indicate the side on which MaxLoad Pro loaded the
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pallet. To use a multi-surface pattern, it's necessary to select at least two
dimensions as vertical dimensions. When you use a multi-surface pattern,
MaxLoad Pro automatically calculates other multi-patterns
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Comments Tab (Single-SKU Manifest)

The Comments tab provides the same fields as in the Truck, Pallet and
Tote Manifest. For more information, please refer to Chapter 4, Loading a
Truck Manifest, on page 4.16.

Adding or Updating SKUs to the Manifest List

You can add SKUs to the Manifest List by double clicking the SKU in the
SKU list or use the SKU input list shown below to add the SKU
information.

Type in the first few characters of the SKU Number in the field below will
quickly bring you to the SKU in the list for selection. Enter any quantity
(it will not be used but we will need a number here) and whether it is
loaded as UL, then click on the Add>> button to add the SKU to the
Manifest List.

[[computer | ay [1 | Prior | | T uL T WP Ordertt | | add>> | |

SKU List (Single-SKU Manifest)

The SKU List, displays a list of all SKUs available in the SKU database.
For more information, please refer to Chapter 4, Loading a Truck
Manifest, on page 4.18.

Manifest List (Single-SKU Manifest)

The Manifest List displays the SKUs onto the pallet. As you select SKUSs,
by double clicking in the SKU List, they automatically appear in the
Manifest List. For more information, please refer Chapter 4, Loading a
Truck Manifest, on page 4.19.
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Defining a Single-SKU Manifest

To define a Single-SKU Manifest, start from the Control Center and
follow these instructions:

1.

Under the Single-SKU Manifest box, click the New button or go to the
File Menu, select New and then Single SKU Load from the submenu.
The Manifest Pick List Screen appears

Select a vehicle from the list of Available Vehicles by double clicking
on the vehicle. The selected vehicle displays in the Selected Vehicles
list.

Select the SKU to be loaded from the SKU List by double clicking on
the SKU. The selected SKU displays in the Manifest List pane.

If a unitload pattern has been defined previously for the selected SKU,
the UL option in the Manifest List will be enabled (XI); MaxLoad will
fill the vehicle with the selected SKU in unitloads.

To cube out the vehicle with floor-loaded SKUs (not unitloads), click
on the UL icon to remove the cross mark.

If everything is correct, click on the Calculate button.

MaxLoad Pro calculates solutions based on your input and displays
them in the solution view screen.
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Viewing a Solution

Introduction

This chapter discusses the various ways in which you can view a
completed manifest. You will learn ways to progressively load or unload
the vehicle to see how the load is constructed. This chapter will also
discuss in detail the various text reports that are available after calculating
a solution.

Though the process of building the various types of manifests is
dramatically different, the options provided when viewing a solution are
generally quite similar. The majority of what we discuss in this chapter
applies to the solutions calculated when building all four manifest types
(truck, pallet, tote, single SKU). Any differences will be highlighted.

The various topics outlined in this chapter are as follows:

o,

«* Manifest View Screen

Toolbar

View Buttons

Other View Options
Additional Viewing Options
Action Buttons

Load Statistics

Tabs

o Sol List
Placement List
Load List

Cut List

Cost

Air Bag / Dunnage

OO0O0OO0O0

% Viewing Items on the Cut List

R/

< SKU Information
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Manifest View Screen

To view a load, follow these instructions:

1. Key in all of the necessary parameters in the Manifest Pick List screen
and click on the Calculate button.

If the load has been previously calculated, open the manifest from the
File menu and click on the View button. The software will redraw
what has already been calculated and saved rather than recalculating
the solution.

The View screen appears. The MaxLoad Pro Manifest View screen,
as pictured below, contains the primary results of your loaded
manifest. This screen includes both the loading diagram and all
information associated with the manifest.

= MaxLoad - ¥iew Screen: Appliance Load Solution 1 of 1 [Truck 1 /2] =] 3|

Fle Edt View Define Toos Layout Help

&=

FieCaloulate | Dalets Mext

Prey Tk @QHest Truck
Go'to container] Weight

wat 15632 (b)
Bz

C®- @ < <® > > 30 s

English d

FickLst Edic ‘

Tar'wiat 0]
Total Wwigt 15632 (Ib)
KingPin 5171 [Ib)
Al B233)
fle2  1223(b)

(

Cube 3102 (13)
88 %

End Gap(0] 2 fin)
End Giap(45) Z fin]
End Gap(50] 2 fin]
COG : 2204 47 4 53 fin]

48 Ft Dy Cargo

54 nex] imio 03% w3
155 06 eng 02w g
Sollit || Placepentlal | Losdlst | Cutlit Cost | AiBags Dunage|

For Help Contact Tops Software R I

24| [

The Menu Bar is essentially the same in this screen as it was in the
Manifest Pick List screen, but notice the following differences:

o,

% Toolbar @: Icons, lists, and buttons below the Menu bar.

« Action Buttons @: Buttons used to recalculate load, go to a next or
different truck.

« Load Statistics ©: Brief load statistics displayed under the view
Buttons
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% Solution Tabs @: A series of tabs/buttons, located at the bottom of
the screen, displaying a number of lists with information about the
load.

+ g.0.d. Window ©: Displays a 3-dimensional graphic image of the
container or pallet

Toolbar (View Screen)

The Toolbar on the View Screen is significantly different from the
Toolbar on the Manifest Pick List screen. It consists of various icons,
lists, and buttons that are designed to make it easier to perform certain
functions. Items in the Toolbar are described in detail below:

Icon Function

New: Displays the Manifest Pick List, where you
can start a new manifest file.

Open: Displays the File Open dialog box, which
allows you to open an existing manifest.

fr
H Save: Saves the active manifest.

— Print: Prints a hard copy of the active manifest.

Split Edit: Displays the Split Editor screen, where
you can edit the solution in two different views of the
solution.

View: Clicks the drop down arrow to select the view
Q - of the vehicle or pallet in the g.o.d. window.

Help: Clicks to open the on-line help
documentation.

Remove All: Completely unloads the vehicle or
|‘% pallet. MaxLoad Pro automatically transfers all SKUs
in the load to the Cut List.
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Remove Placement: Removes one placement,
section or stop-off/priority from the vehicle or pallet,

Remove SKU: Removes one SKU from the vehicle
of pallet.

Reject: Grayed out in the View screen but available
in Edit mode, this function rejects the current
placement and asks MaxLoad Pro to try the next
placement.

Put SKU: Adds one SKU to the vehicle or pallet.

>

Put Placement: Add one placement, section or stop-
off/priority to the vehicle or pallet, depending on the
selection under the View Menu | View by option
(placement, leading edge or priority).

>|

Put All: Completely loads the vehicle or pallet.

Labels: Turns SKU labels on and off.

Outline: Turns on the wire frame view for SKU
placements.

Violations: Displays a report highlighting all current
stacking violations.

IEninsh vI

Units: Switches measurement units from English to
Metric and vice versa.

Pick List: Displays the Manifest Pick List screen,
where you can change the parameters of the manifest.

Edit

FickList |

Edit: Displays the Editor screen, where you can edit
the solution.
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View Button Q N

The View buttons allow you to view the loaded container, pallet, or tote
from different angles: Top, Side, Front and 3D Front or Back Views.
Click the drop down arrow to select the desired view from the list.

+« 3D Front View: Displays a standard 3D view of the diagram.
% 3D Back View: Displays the 3D back view of the current load.

« Top View: Displays the load from the top, looking down into the
diagram.

+« Side View: Displays the load from the right side of the diagram.

% Front View: Displays the load looking forward from the rear of the
diagram.

Other View Options

% Rotate: In addition to the standard views described above, you also
have the option of viewing the load diagram from additional angles.
Any conceivable angle is possible.

To rotate the diagram, follow these instructions:

1. Use the mouse to click anywhere on the diagram portion of the
screen. This action makes the diagram portion of the screen active,
thus making it available to be rotated.

2. Use the arrow keys on your keyboard to rotate the diagram to the
desired position for viewing. All four arrow keys are available to
you, allowing you to rotate the diagram to view from the front,
rear, top, bottom, right side, and left side (and any angle in
between) of the vehicle.

When rotating the solution diagram, it will appear as if the diagram is
stationary, and you are moving. For instance, when using the “up”
arrow (1), it will appear as if you are being raised up and over the
diagram, allowing you to see the top of the solution. When you click
the “right” arrow ( — ), it will appear as if you are moving around the
solution to the right. The same is true of the other two arrow keys
(down and left).

% Zoom In and Out: MaxLoad Pro also allows you to “zoom in” and
“zoom out” of a solution diagram. Zooming in gives you a more
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detailed view of the load. Zooming out gives you a “big picture”
perspective.

To “zoom in” or “zoom out” on the vehicle diagram, follow these
instructions:

1. Click on the diagram window to make it active.

2. Press on the “T” key on your keyboard to “zoom in.” Press on the
“Y” key to “zoom out.” Continue to press on the respective key
until the diagram is sized to your liking.

Additional Viewing Options

Three more viewing options are available via the View Menu in the Menu
Bar: By Placement, By Leading Edge, or By Priority/Stop-Off. These
options work in conjunction with the placement arrow buttons (§| & El)

to put or remove placements according to the viewing options described
below:

% View by Placement: Allows you to load or unload a manifest “by
placement.” A placement is a group of like SKUs loaded with the
same dimension vertical and with the same dimension parallel to the
vehicle or pallet.

X/

% View by Leading Edge: Allows you to view the load one section at a
time. MaxLoad Pro will load the first placement of cargo, as defined
above. Other SKUs will be loaded around the first placement, but will
not extend beyond the leading edge of the first placement. Once the
first section of SKUs are loaded, another placement is loaded as far
forward as possible up against the leading edge of the prior section,
and up against the left wall of the vehicle, or left edge of the pallet.

« View by Priority/Stop-Off: Allows you to view the load one priority
or stop-off at a time. Remember that you can build a load by priority
or stop off when defining your manifest in the Manifest Pick List
screen.

Action Buttons (View Screen)

There are several action buttons beneath the Tool Bar which allow you to
recalculate the solution for the current vehicle or, if the load requires more
than one vehicle, allows you to go to the next one.

o,

% ReCalculate: Allows you to re-calculate the load solution for the
SKUSs, using the same vehicle or select a new one. MaxLoad Pro will
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prompt you to select another vehicle if the option “Show next vehicle
dialog” (found under Tools | Configuration) is enabled. Else, it will
use the same vehicle to re-calculate the load. This button serves the
same function as clicking on the PickList button to return to the
manifest screen to select another vehicle and click Calculate again.

+»+ Delete Next: If the solution calls for the use of two or more vehicles,
this button will be active and allows you to delete the solution for the
next vehicle. You will see the following message:

All solutions For wehicles Following vehicle 1 will be deleted.

Ok I Cancel |

Click OK to confirm deletion of the load in the next vehicle.

« Prev Truck: If available, click to view the solution for the previous
truck.

« Next Truck: If available, click to view the solution for the next truck.
If the solution had been deleted with the “Delete Next” button as
described earlier, you will be prompted to select a vehicle to load the
items in the Cut List if the “Show next vehicle dialog” (found under
Tools | Configuration) is enabled. Else, it will use the same vehicle to
calculate the solution.

« Go to container: If your Manifest contains multiple vehicles, for
example, 10 vehicles, this button allows you to quickly go to the
designated vehicle instead of clicking the Next Truck button many

times.
Go to container
Container |2 vl
] I Cancel |

< Weight: Access the weight distribution dialog box where you can
move the entire load towards the front or back of the trailer. Click the
* button to move the entire load one inch towards the tail of the
trailer and > one inch towards the front. Clicking the - or I buttons
to move the entire loads to the end of front of the trailer respectively.
Note that all weight information will be updated accordingly.

To save the redistributed load, click the EXIT button.
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Load Statistics (View Screen)

Load Statistics, as pictured below, are displayed on the left side of the
Manifest View screen, just below the Action Buttons.

gt 13572 [Ib)
8%

Tare'wfgt O[b)
Tatal'wgt 13572 (Ib)
King Pin 8529 [Ib]
Bule 1 5043 [Ib]
Ble 2 01b)

Cube 2537 [ft3]
2z

End Gapl0") 106 fin]
End Gapl45") 106 fin)
End Gapl50" 106 fin]
COG : 197 % 47 1 54 fin]

Following are some of the fields available under the load statistics section:
% Woagt: Total weight and percentage weight of the load.

« TareWogt: The weight of empty container.

% TotalWgt: Sum total of Wgt. and Tare Wgt.

+ King Pin, Axle 1 and 2: Total load weight on king pin and each axle.
% Cube: The percentage volume of the container filled with product

+« End Gap: The distance between the last loaded SKU from the end of
the container.

+ COG: Center of Gravity.
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Note: For Single SKU the information provided in the Load Statistics is
the SKU and Container’s length, width, height and weight information.

Tabs (View Screen)

The List Tabs, at the bottom of the View Screen, allow you to see various
statistics regarding the load that you are viewing.

You can specify what statistics to display via the right click Properties
menu. To access this function, place the mouse cursor within the statistics
area and click the right mouse button. At the pop-up menu, select
Properties. Remove the check marks against the fields you want removed
from the solutions.

Sol List

The Sol List or the Solution List, as pictured below, appears whenever
multiple solutions are calculated for the manifest, depending upon
multiple container sizes or loading algorithms.

:
4G Ft Dy Van Space Evenly 1000 22575  B3% 12500 27,
48 Ft Dry Van L/R Space Even 1000] 22578  B3x| 126000 27

0
48 Ft. Dy Wan L/R Floor to Ceiling 1000] 2257.8 B3%| 125000 2783 0
48 Ft. Dy Wan Load Floor ta Ceiling 1000] 2257.8 B3%| 125000 2783 0
B3 Ft. Dy Wan Load Flaar ta Ceiling 1000] 2257.9 57%| 125000 2783 0
53 Ft. Dy Wan L/R Floor to Ceiling 1000  2957.8 57%| 125000 278% 0
53 Ft. D Wan Space Evenly 1000] 22575 A7 X%|  12500) 278 % 0|
B3 Ft. Dy Wan L/F Space Even 1000]  2257.9 57% 125000 2783 0

MaxLoad Pro even calculates multiple solutions when performing a
Single-SKU loading analysis. For more information, please refer to
Chapter 7, Loading a Single-SKU Manifest.

« Truck / Tote: Lists the selected containers for a particular manifest
% Algorithm: Displays the loading algorithm for the solution.

+« Qty: The count of SKUs loaded in to the container or on the pallet
% Cube: The total volume of the loaded SKUs

+ %Cube: The percentage of the container or pallet’s volume that
loaded SKUs occupy

< Wagt: Total weight of the product
% %WoQgt: The percentage of the maximum weight that the SKUs weighs

#+ CutList Cnt: The total number of the SKUs which could not be
loaded in to the container or pallet
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Use the scroll bar to scroll through the list. Also, you can use the mouse
to highlight a different solution. Notice that each time you select a
different solution, the manifest solution diagram redraws to reflect the
selected solution.

Placement List

The Placement List, as pictured below, displays the information for each
SKU, accordingly to the placement sequence of the load.

JFef] - SkU Oty § UL Crat Pririty Cube I % Cube | ‘it Zwigt ) Front] # Side § # Floor
g1 36 i 1 7800 227 %) 25800 E.0 %] i i 0
5| | Stove 28 0| 1 10324 233 % 1400000 29.2% 168 0| 1]
4| | Stereo 32 0 1 1096 31% B7200 14% 168 0 24
1| 8 | Computer 20 0 1 19558 G56% 80000 17% 168 74 a
4| |Stereo 2 i 1 E.5) 0.2 %] 42.0) 0.1 %] 284 i 84
3\ B8 | R efrigerator 12 0| 1 418458 11.9% 10440 2.2 %] 455 0| 1]
E I 2 0 1 443 13% 1600 0.3 % 455 0 E5|

e

S

Ref / No: Reference number or the Placement number for the SKU

X3

*

Color: The color assigned to the SKU

e

S

SKU: SKU Number

X3

*

Qty: Quantity of SKUs loaded for that particular placement in the
load.

>

L)

*

ULCnt: Unitload count (if applicable) is the number of whole
unitloads for the corresponding SKU for that placement in the load.

L)

>

L)

*

Priority/Stop-Off number: Displays the priority or stop-off assigned
to that SKU in the Manifest List.

L)

>

L)

*

Cube: The volume of that particular SKU placement.

L)

X4

%Cube: The percentage of the total volume of that container that total
volume occupied by that particular SKU placement.

L)

e

S

Woagt: Weight of each SKU times Qty for the placement weight.

L)

*

%WGgt: The percentage of total weight limit (for the vehicle) taken up
by the SKU placement.

0

Y

*

XFront, XSide, & XFloor: The location the SKU placement from the
front, side, and floor of the container or pallet

If you have the Outline option f enabled by depressing the Outline icon,
highlighting each placement is the list will show the selected placement in
color while the rest of the SKUs in wire frames. This allows you to easily
view selected placement with respect to the rest of the placements.
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=_MaxLoad - ¥iew Screen: Appliance Load Solution 1 of 1 [Truck 1 / 2] ] |
Fle Edt Wew Define Tools Layout Help

Y & -
= — g' @ [« € < > > Sl 0\> 7y A Engish = PickList Edit
ReCalculate | Delete Newt 96 fin)
Prev Tuck | Hest Truek
Gotocortainer | Weight
wat 15832 (k)
3%
Tars'wiat 0b) 110
Totalwgt 15832 (1) )
King i 3171 (K]
Adel 5293 ()
Ada2 122 ()
Cube 023
%
End Gapl] 2 (i)
End Gapd5) 2 (i)
End BapiB0] 2 (]
06 - 220 47 ¢ 63 fn)
48Ft Dy Carao
| EEI | ] Toe oo Fow T o Tcwe] wa | owa [Rron] =ode [<rka] ~
2 [Desph T of A t2zne| 347 aesnn 137 o Gl q
[T Fetigacto 2] i G aaa| oama oosadl 4ax o1 B [
[]
W 4/ [Steren 33 0| 1 113.0] 3.2 % E33.0] 1.4 % 216 0] 94
AW [Steieo 1 o 1 s 014 o] oo sy 0 s
1 [Computer E o 1 esa] usw] tend| osw] s o ey
o[ W[ Tv 18 o 1 g9 viaa] 1sann]  aow] g o [
1 [Computer 12 o 1 rizs ase] amd| 0w s o [
1 [Computer E o 1 endl naw] tonn] naw| =g g i
1 [Compurer E i FIEEY: I I T o =
R EIEE IR IR B ﬂ =l
Sol Lt Placement List Load List i List Cost | AinBag/Dunnage
For Help Cortact Taps Software N HLIH Supervior %

Note: You can print this report through the File | Print | Placement List
Menu. This report can even be exported through the Tools menu

Load List

The Load List, as pictured below, provides a summary of all SKUs in the
current vehicle load, totaled for each SKU on one line. The information
(column headings) provided in Load List is identical to that provided in
the Placement List. Like Placement List this list can also be printed or

exported.
-f - Sl [ty Friarity Cube § % Cube § Wit gt

22 | Computer 20 1 1959 5E% 500.0) 1.7 %

Deepfreazer 3 1 1356 39% 10800 227
B8 | Refrigerator 12 1 4189 11.9% 1044.0 22%
M| Stereo 34 1 1164 33% 7140 165%
| Stove 28 1 10324 23.3% 1400000 292%
M| T 35 1 423  23.9% 30400 B3 %

Total 135 271l F79%| 20648 43 %]

Cut List

The Cut List is the list of SKUs that did not fit into the selected container
or the pallet, when CalcAllTrucks feature is turned off. The information
(column headings) displayed in this list is identical to that of the Load List
(with the addition of a Unitload Count column).
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Skl [ty § LIL Cnt Priarity Cube J % Cube gt gt
Deepfreezer 25 0 1 113020 321% 876000 182%
8 | Refrigerator 14 0 1 4887 138% 12180 25 %
| Stove 2 0 1 737 21 % 10000 21 %)
Total 4 16927 481 %] 10968] 2293

If you do not want any SKUs to appear in the CutList, enable the
CalcAllTrucks feature in the Global Configuration Settings (under Tools |
Configuration Menu). For more information on Calculate All Trucks
feature, please refer to Chapter 11, Configuration.

Cut List can also be printed through the File menu.

Note: Cut List is not available for Single-SKU manifests.

Cost

The Cost tab is not implemented at this time.

Air Bag / Dunnage

To ensure transit loads are secure during transport, dunnage materials like
air bags can be added in between SKUs to minimize or prevent product
damage.

This function, when enabled, highlights spaces among SKU placements
meeting the specified dimension criteria.

At the Solutions view, click on the Air Bag / Dunnage tab at the bottom to
bring up Air Bag/Dunnage Dimension dialog box as shown below.

Air Bag / Dunnage Dimension ﬂ

min Length I 10 o I
Cancel
min Width I 0 —l

mmin Height I 10

Enter the minimum value along the three dimensions to highlight any void
space for dunnage. Any space meeting the criteria will be highlighted in
the g.0.d. window with their respective dimensions and locations detailed
in the table.
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= MaxLoad - View Screen: Appliance Load Solution 1 of 1 [Truck 1 / 2] -0l x|
File Edit Wiew Define Tools Layout Help

i E=E @@ e < <® > >0 7

ReCalculate Delete Next

Fiev Tiuck Mext Truck

IEninsh - | PickList

Go to container “Weight
wigh 15469 [Ib]
2%

Taiewgt 0[]
Total'wigt 15483 (Ib]
King Fin 3151 {Ib]
Axle 1 5129(lh)
Hile 2 1183 (h)

Cube  3053(f3)
87 %

End Gapll']  2(in)
EndGapl45] 2(in]
End Gap(E0] 2(in]
COG : 217 % 47 % 63 (in]

48 Ft. Diy Cargo

Muriber 1 Nl 71 =2 T2 72 Length “fidth Height

2 386.000f 93,500 23.000 532.000f 105500 58,000 146.000 23.000( 12.000)
3 386 000 93,500 58.000 532 000f 105 500f 96.000 146.000 38.000f 12.000]
4 403.000] 93,500 0.000) 532.000] 105.500] 23,000 128.000 29.000f 12.000)
2| 552.000( 26.000 31.000 573.999] 52.000) 9E.000 20.999 E5.000f 26.000)
Sol List Flacement List I Load List Cut List Cost Air Bag / Dunnage
Far Help Contact Tops Software MUM Supervisor &

Viewing Items on the Cut List

Once a solution has been calculated, if MaxLoad Pro determines that the
entire manifest will not fit in the selected vehicle, you have the option to
take items from the Cut List and load them into another vehicles. This
assumes you are not using the CalcAllTrucks feature which will place
remaining items in the next vehicle of same truck type.

To determine if the entire manifest fits into the vehicle, simply look at the
Cut List. If there are any SKUs in the Cut List, then the entire manifest
did not fit. If the Cut List is empty, then everything in this manifest fits on
the selected vehicle. Another way to determine if all SKUs fit is to check
the Next Truck button, which is located under the View buttons. If the
Next Truck button is “grayed out,” then all SKUs fit into one container. If
the Next Truck button is activated, then this manifest requires additional
vehicles.

To view items on the Cut List and load them into another container, follow
these instructions:

1. Click on the Next Truck button. The New Truck dialog box appears, as
pictured below.
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Note: In situations where you chose to analyze more than one loading
algorithm or selected more than one vehicle to calculate, MaxLoad Pro
will warn you that “All solutions other than the one currently being
viewed will be deleted.” If this is acceptable, click on OK. If deleting
the additional solutions is not acceptable, click on the Cancel button.

Next Truck

Available Vehicles Selected Vehicles
45 Ft. [Marrow] 43 Ft. Dry Carga Cancel |
48 Ft. Dy an ;

50 Ft. Rail Car —Vehicle Type

53 Ft. [Marmow) % Truck

53 Ft. Drop Deck (... e

53 Ft. Dip Van Sea'fan

53 Ft. Dual Drop Deck " Fail Car

57 Ft. Dy an -

ED Ft. Rail Car . Rl Wagon
L-11 Air Freight " Muli Zone
II:[? ?Lffglghlh " Double Trailer

-4 Air Freight
LD-5 At Freight C U
LTL Pup " SideBay
b4-1 &ir Freight '

M-2 &t Freight Flatbed
Truck with Wheel Well
[ Don't Shaw This Again

You will next be asked to select another vehicle from a Next Truck
dialog box. You can either select the same vehicle or choose a new
one.

Note: If you only load one type of vehicle and do not want to see this
dialog box to select another vehicle, you can turn it off by checking the
“Don’t Show This Again” option in the dialog box or through the
Tools | Configuration menu (disable “Show next vehicle dialog”). For
more information, please refer to Chapter 11, Configuration.

Click on OK. MaxLoad Pro draws a new solution with the items
previously on the Cut List. MaxLoad Pro updates the Cut List to
reflect that fewer items (if any) remain to be loaded as part of this
manifest. If the Cut List still contains freight, repeat this procedure
until all items from the manifest have been loaded onto a vehicle.

Note: If at any time you wish to see the previous vehicle in the sequence,
click on the Prev (Previous) Truck button. The previous solution will
appear.

During the process of loading items from the Cut List, the page title will
list container or pallet — first, second, etc. — you’re currently viewing.
This will prevent you from “getting lost” when viewing multiple vehicles
in sequence.
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SKU Information

MaxLoad Pro provides a right-click function that displays properties
information for a selected SKU. To display SKU information, start from
the View Screen and follow these instructions:

1. Position the mouse pointer over the SKU for which you want to
display information and right-click on the SKU. A pop-up menu
appears.

2. Click on Properties. The Properties window appears, as pictured here.

x|
Mame |Refrigerator Ordertt 0
Length [32.00 [in) “Width [29.00 [in) Height |65.00 [in)
Weight |37.00 [Ib) Priority 1 Stop 0
Load Int Best Fit
oad Inta [Best Fi oI

Stack Rules  [Best Fit
Stack Code  [all2al

SKUInfa1 |
SkUlnfa2 |
SKUlnfa 3 |
SKUMame | Irpart Manif... | Dimensions
Lavers |1

0K |

As you can see, the Properties window displays a range of basic
properties for the selected SKU: name, length, width, height, etc.

3. Additional SKU properties are also found in the Status Bar at the
bottom of the screen.

Fallet #2, Bottom = 0, Top = B0, Left = 50, Right = 92, Front = 0, Back = 400 [in]

4. You can edit the selected SKU via the Define | SKU menu by clicking
on the Edit button. Note that any changes made in SKU properties
will only be reflected in the manifest after a recalculation.
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Editing a Solution

Introduction

MaxLoad Pro Editor can be used to edit a solution built by MaxLoad Pro,
manually build a load starting with an empty container or a pallet, and
manually edit a partially-built manifest.

Note: MaxLoad Pro does not allow you to edit Single-SKU manifest.
The various topics outlined in this chapter are:
+«+ Editor Screen

Split Edit Screen

Toolbar

Cut List

Orientation Box

View Buttons/View Options
Load Statistics

Snap Buttons

Status Bar

SKU Information

+« Editing a Load

Placing a SKU
Moving a SKU
Removing a SKU
Breaking a Placement

% Editing Mixed Pallets in the Vehicle
% Stacking/Loading Violations

+«+ Saving the Edited Load
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Editor Screen

To work with the Editor, start from the Manifest View screen and click on
the Edit button on the Tool Bar to access the Edit Screen as shown here.

= MaxLoad - Edit Screen: Appliance Load Solution 1 of 1 [Truck 1 /2]

~=lolx|

Flz Edt View Define Tools Layout Help

J%HEJ&'“é <<o‘®‘> >> %l‘%_’ (Y |Enghsh ~ ‘ PickList Hm
VWEECRYRERHNE 9C| = || » | | |

CutList ‘ gt 16692 (Ib] King Fin - 9171 [Ib] End Gap(457] 2 [in]
G 1 N T Bz Ael 5293 () Cube  3102(3) End Gap(50] 2 fin)
Tarewigt 0[] A2 12296 8% COG: 220547 4 53 (n)
Total Wat 16832 (b)
Fietigeratar 10 q 1 End Gapl_ 21
2]
|1
v
4N
4 | » 48 Ft. Diy Carga
72,00 31.00 7 35.00 35000 (1o % k0p0z0
For Help Contact Tops Software 6 NUM Supervisor 4

The Editor Screen is divided into two separate sections, a Cut List on the
left and 3D load diagram solution on the right. To return to the Manifest
View screen, click the View icon button on the Tool Bar.

K/

« Toolbar @: Contains a number of icons and buttons that allow you to
execute routine editing commands.

X/
L X4

Cut List @: List of SKUs that did not fit into the selected container
or on a selected pallet.

+ Orientation Box ©: Displays a 3-dimensional image of a selected
SKU. The Orientation Box allows you to change both the orientation
and dimension vertical of the SKU.

+« Load Statistics @: Displays a different statistics for a load.
+« Snap Buttons ©: Assists you in manually placing SKUs by forcing a

SKU you are moving as far as it can go in the direction you’ve
selected on the Snap button.

X/
L X4

Status Bar @: Displays constraint messages, which let you know
you’ve violated a stacking or placement rule for an SKU.
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Split Edit Screen

When you click on the Split Edit = icon on the Tool Bar, you will see a
very similar edit screen except that there are two 3D views of the same
load diagram, one on top of the other. You can change one of the displays

to a different view so you can have two perspective of the same load
during editing.

To change either view, you need to first click on the view pane you are

changing and then go to the View icon # -0 the Tool Bar to select a

different view. The Flip button in each view pane allows you quickly
change the 3D view from front to back or vice versa.

= MaxLoad - Edit Screen: Appliance Load Solution 1 of 1 [Truck 1 /2]

=10l x|
Flle Edit View Define Tools Layout Help
~ 4
N H=E®@c ¢« <|[® > > AW 240 | T | wwe| w
oo vy O4 0 o
URUVESES 37 & 5L 3P HH S T
CutList [ wat 15632080 KinaPin 3171 (Ib) End Gapl45) 2 (in]
T B Toe] UL e | o [ T 3% el 5203 (b] Cube  F02(3) End GaplE0) 2 (in)
Tare Wal D lb] o2 1229(b] 8% COG . 220 % 47 # 53 (in)
e pilec2ed 2 0 1 Total Wot 15632 (Ib]
Ficlrigerator 10 i 1 Crd Gagll 21
ot 15632 (b] KinaPin 3171 (Ib) End Gap45) 2 (in]
Bx el 5203 (b] Cube  F02(K3) End GaplE0) 2 (in)
Tare wigt 0 (Ib] Bele?  1229(h) 88% COG : 220 % 47 3 53 (in]
Total Wet 15632 (Ib)
End Ganl0l _2inl
Snap On
{Snap |
Nae[A
<[>
|
< | |
For Help Contact Taps Saftware HUM Supervisor 4

The load is edited in exactly the same way as in the regular edit screen but
now you can initiate the edit from either view. Any changes to the load
will be updated in both views simultaneously.

To exit Split Edit screen back to the Manifest View, click on the View

button on the Tool Bar or click the PickList icon button to return to the
Manifest Pick List screen.
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Toolbar (Editor Screen)

The Toolbar contains a number of icons and buttons that act as shortcuts
for executing routine edit commands. Most commands also have a
corresponding menu option in the Menu Bar.

The following table outlines the various Toolbar options.

Icon

Function

New: Displays the Manifest Pick List Screen, where you
can start a new manifest.

Open: Displays the Open Manifest dialog box, which
allows you to select and open an existing manifest.

Save: Saves the active manifest.

Print: Prints the active manifest

Split Edit: To access the Split Edit screen. This option is
grayed out when you are in the Editor screen.

View: Clicks the drop down arrow to select the view of the
vehicle or pallet in the g.0.d. window.

Help: Clicks to open the on-line help documentation.

Unload Vehicle: Completely unloads the container or
pallet. MaxLoad Pro automatically transfers all SKUs in
the load to the Cut List.

<

Unload Placement: Unloads the next placement of SKUs.

Unload SKU: Removes a selected SKU from the container
or pallet.

Icon

Function
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Reject: Rejects a computer-chosen placement and instructs
the computer to try another one. You can perform this
action repeatedly until you find a suitable placement. This
button is grayed out when the last placement has been
loaded.

Load SKU: Adds a selected SKU to the container or pallet.

D

Load Placement: Loads the next placement of SKUs.

>

Load Vehicle: Completely loads the container or pallet. If
you’ve partially edited the load, MaxLoad Pro will
determine the rest of the load mathematically, based on the
placement of existing SKUSs.

Labels: Turns SKU labels on and off.

Outline: Turns on the wire frame view for SKU
placements.

Violations: Displays a report highlighting all current
stacking violations.

I English - I

Units: Switches measurement units from English to Metric
and vice versa.

PickList

Pick List: Displays the Manifest Pick List screen, where
you can change the parameters of the manifest.

Wiew

View: Returns to the Manifest Solution view screen.

Rotate Right: Rotates the orientation box to the right.

Rotate Left: Rotates the orientation box to the left.
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Icon Function

Rotate Down: Rotates the orientation box downward.

M| M

Rotate Up: Rotates the orientation box upward.

Align Up: Aligns selected SKUs flush up in the container or

EE on the pallet or tote.

vy Align Down: Aligns selected SKUs flush down in the
[o]m} container or on the pallet or tote.

e Align Left: Aligns selected SKUs flush left in the container
Oa or on the pallet or tote.

O Align Right:  Aligns selected SKUs flush right in the
-0 container or on the pallet or tote.

Center Horizontally: Centers selected SKUs horizontally in
I:H the container or on the pallet or tote.

v

Center Vertically: Centers selected SKUs vertically in the
container or on the pallet or tote.

Undo: Allows you to cancel the previous edit command.

)| U | HH

J

Redo: Allows you to override the undo command.

./ :

SKU: Displays the SKU List dialog box, which allows you
to select one or more SKUs to add to the load.

Quantity: Displays the SKU Quantity dialog box, which
allows you to specify the number of SKUs to add to the load.

Oty

Note: Although the Toolbar in the Editor screen looks similar to the
Toolbar in the Manifest View screen, the Load Buttons behave differently.
In the Manifest View screen, you can use the Load Buttons to view the
load “by placement,” “leading edge” or “stop-off/priority.” In the Editor
screen, the Load Buttons allow you to view the load “by placement” only.
You cannot use the Load Buttons to view the load in any other manner.
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The Reject button is also active in the Editor screen so you can reject the
current placement suggested by MaxLoad Pro. You can keep hitting the
reject button until you are satisfied with the current SKU placement.

Cut List (Editor Screen)

The Cut List, is a listing of all SKUs that did not fit into the selected
transit container or a pallet. The Cut List contains an icon representing the
SKU shape, SKU Name, Quantity, Unitload Count, etc.

Cut List || e 15393 (Ib) King Pin - 9171 [Ih) End Gap[457] 15 [in)
SEL el UL Crt [ Pt 2E Aulel 5293 (b) Cube 3070 (3] End GaplE0Y 15 [in]
Axle2  930(Ib) 8% COG: 214 x 47 x 53 i)

Tarewgt 0[lb]
Total wat 15393 (Ib]
Refrigerator 10 0 End Gao(0 15 in)

Splitter Bal  ————

Drag this corner to size
the orientation box

4] | i
72.00 % 31,00 % 35.00 350,00 (5

48 Ft. Dy Cargo
w00z

When you click on a SKU in the Cut List, the information will be
highlighted with a blue highlight bar. Below the Cut List, at the bottom of
the screen, you’ll see a field that displays the dimensions and weight of
the selected SKU as in the figure above.

Items in this list are stored in text form in alphabetical order. As you’re
editing, when you select an SKU from the Cut List to add to the load, the
SKU will appear to scale in the 3-dimensional shape it was defined in the
orientation box. As you remove a SKU from the diagram and drag it to
the Cut List, MaxLoad Pro transforms the SKU from the 3-dimensional
shape to text form and moves it into the Cut List.

There is a splitter bar between the Cut List and the Solution View, you can
adjust the width of the Cut List by placing the mouse cursor on the splitter
bar. When the cursor changes its shape, click on the left mouse button to
size the Cut List.
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Editing the Cut List

You can add and remove items to the Cut List for placement into the
edited load or modify the quantity for any SKU currently in the Cut List.
To modify the Cut List, follow these instructions:

1. Right-click over the Cut List. A small box appears, as pictured below,
with options — SKU List, Remove SKU, Quantity and Create Mixed

Pallet.
Cut List
Skl Citu§ UL Crt | Pricrity

Cornputer 3 0 1
Decplreczer 2 0 1
R efrigerator 13 i) 1
Steren 22 I 1
T Skl Lisk i 1

Remowe SKL

Qby

Create Mixed Pallet

2. To add SKU items to the Cut List, select SKU List. The SKU List
dialog box appears, as pictured below.

SKU List

Select SKU

Barrel a
Bulk. Frozen vogurt

Caze 1

Caze 2

Case 3

Caze 4

Caze b

Case B Tote

Computer

Cookies

Crate #1

Deepfreezer

Hand Towels ﬂ

3. Select the SKU you want to add to the Cut List and click on OK. The
SKU Quantity dialog box appears, as pictured on the next page. The
dialog box displays the name of the selected SKU item.

SKU Qty E
Deepfreezer |-|

Cancel |
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4. Enter the quantity desired and click on OK.

5. To change the quantity of an existing SKU item in the Cut List,
highlight the SKU item in the list.

6. Right-click over the Cut List.

7. Select the Quantity option. The SKU Quantity dialog box appears, as
pictured above. The dialog box displays the name of the selected SKU
item.

8. Enter the new quantity for the selected SKU.

9. Click on OK. The Cut List redisplays with the updated quantity of the
selected SKU.

10. To remove a SKU item from the Cut List, click on the SKU which
becomes highlighted.

11. Right-Click over the highlighted SKU and select the Remove SKU
option. The selected SKU will be removed from the Cut List.

Note: Unitized SKU cannot be removed from the Cut List in this
manner. You will have to do this in the Manifest List.

Create Mixed Pallet from the Cut List

You can manually create mixed pallets using the SKUs in the Cut List and
place them inside the truck. To create mixed pallets in this manner, follow
these steps.

1. Right-click over the Cut List and select Create Mixed Pallet in the
pop-up dialog box. The Select Pallet dialog box will open.

Select Pallet |

Block Stringer (48" = 40"
CHEP [fwstralia)

Clamp Load (50"« 40
EuroPallet

EuraPallet [1200 = 800)

EwroPallet (800 = 1200)
G4 [Metric Block)
Gha [Motched)

GMa Motched

Mone [48" « 407
Slipsheet (48" = 40")

Cancel |

2. Select the pallet style you will use for the mixed pallet and click OK.
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3. The Mixed Pallet Edit screen will open.

4. Create the mixed pallet by dragging and dropping SKUs onto the

pallet area as described in the next section.

ManLoad - Ldit Screen: Apphance Load Solution | of 1 [Pallet 1 /2] mm
Fio Edk Vew Drfre Tock Loyt Hep
k= E®-0 < <[® > >3 i [ I | o |[m]
— -
VWEERRBRHNT D~ | BN
e ]| we i m COG : 5x 192 2 e
: T T (T % Erel GacllT] 00l
m = e ;égm ::Eﬂg‘r: HE:::
ot 1 Flip Snap On
v 1 1]
860000
[voop ]
LGP
=]
PR
(GHA Notched
FE0x 170x 1200 210078 kBpHcl
Fux Hek Cortact Tops Scltwars. [ WM B

5. When done, click on the Truck icon button on the Tool Bar.

6. A new SKU with name MP-1 will be added to the Cut List.

7. To place this mixed pallet into the truck, highlight MP-1 on the Cut
List. When the mixed pallet appears in the orientation box, click, drag

and drop the pallet inside the truck.

ManLoad - Ldit Screen: Apphance Load Solution 1 of 1 [Truck 1 /2]
Fis Edt Vew Define Toos Layout Hep

N R=E®-@ 1k ¢ < ® > > 3| 24
VWEECRERBHE OC| = || o | w |
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Wg 13858
nx

Tae'wigh 00
Toal wigh 12858 [b]

Eref Gaoi1 130

Cube RS
1

EndGapld5) 128 )
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06 : 167 2 47 2 52 Il

i
45000 % £2000: 45,000 433,000 fez)

Fur Help Contant Tops Soltwan

T
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3|
|

|1
W
L
&P Day Canger
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&ltlA

MaxLoad Pro (V3.6) User's Guide



8. You now have a mixed pallet created on-the-fly placed inside the truck.
You can edit this pallet again by clicking on it (inside the truck).

After editing the mixed pallet, click on the Truck button on the Tool
Bar to place the edited pallet back inside the truck.

Orientation Box (Editor Screen)
The Orientation Box displays a 3-dimensional representation of the SKU

you have chosen from the Cut List. This box appears in the upper left-
hand corner of the Editor Screen, only after you have selected a SKU.

To activate the Orientation Box, select an SKU from the Cut List. To
remove it, sSimply press the [Esc] button on your keyboard.

The Orientation Box allows you to perform the following tasks:

% Change the Vertical Dimension of the SKU: To change the vertical
dimension of the SKU, click on the face of the SKU that you want to
position against the floor (that is, the new base of the SKU). The
figure below shows a visual illustration.

Clicking Here ... Changes the Vertical Dimension of the
SKU Like This

+ Change the Orientation of the SKU: To change the orientation of
the SKU, click on the face of the SKU that currently faces up.

Chapter 9: Editing a Solution 9.11



MaxLoad Pro rotates the SKU 90 degrees. The figure below shows a
visual illustration.

Clicking Here ... Changes the Orientation of the SKU
Like This

If you need to change both the vertical dimension and the orientation of a
SKU, it’s easy to change the vertical dimension first, and then change the
orientation.

Helpful Hint: Make any changes necessary to the vertical dimension and
the orientation of the SKU before you drag the SKU into the vehicle.
Once the SKU has been placed into the vehicle, you cannot make changes
to the loading orientation. If you need to change the loading orientation of
a SKU once it has been placed, you must first drag the SKU to the Cut
List, then select the SKU again, following the procedure outlined above.

If the SKU is too small, it will be difficult to click on its face change the
orientation via this box. In such a case, resize the box by dragging its
lower right hand corner or use the rotation icons on the Tool Bar.

View Options (Editor Screen)

To change the view of the editing load, click on the down arrow of the

View icon ®® -on the Tool Bar and select a different view from the drop
list. The Flip button also allows you quickly change the 3D view from
front to back or vice versa.

The different view may come in handy during the edit process. For
example, if you’re using the 3D view and can’t see a SKU that you want
to remove, simply choose another view that will help you get a clear
picture of that SKU.

In addition to the standard views — Top, Side, Front and 3D — you can also
view the load diagram from other angles. Following are some other view
options available in the Editor Screen:
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< Zoom In or Out: To “zoom in” or “zoom out” on the load diagram,
follow these instructions:

1. Click on the diagram window to make it active.

2. Press the “T” key on your keyboard to “zoom in.” and the “Y” key
to “zoom out.” Continually click on the respective key until the
diagram is sized to your liking.

% Rotate the Load Diagram: You can rotate the diagram to view it
from any angle, giving you 360-degree freedom to view the diagram
from any conceivable angle.

To rotate the load diagram, follow these instructions:

1. Click anywhere in the diagram portion of the screen. This makes
the diagram “active,” thus allowing it to be rotated.

2. Use the arrow keys on your keyboard to rotate the diagram to the
desired position. All four arrow keys are available to you,
allowing you to rotate the diagram to view from the front, rear, top,
bottom, right side and left side of the vehicle.

Note: You can edit a load from any angle. Once you’ve rotated the
diagram to the preferred viewing angle, you can proceed with editing.

Load Statistics (Editor Screen)
Load Statistics is displayed above the 3D truck graphics. It displays some

of the important information for the loaded container like cargo weight,
cube, tare weight, weight and cube efficiency, end gaps and COG, etc.

Wt 13066 () King Pin 8304 [Ib] End Gap[45] 128 [in]

7% Adde1 4136 (k) Cube 2461 [f3) End Gap(E0] 12 [in)
Tare Wat 0] Ade2 26 (H) 0% COG: 172 x 46 % 51 [in]
Tatal gt 13065 (Ib)

End Gao(0' 79 (in

Snap Buttons (Editor Screen)

The Snap buttons, as pictured below, assist you in manually placing SKUs
by forcing a SKU you are moving as far as it can go in the direction
you’ve selected the Snap button.

KIT|A
«|<|=

A
-
N
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When the Snap feature is on, MaxLoad Pro automatically places objects as
far as possible in the selected direction, regardless of where you initially
place the object in the container or pallet. When the Snap feature is off, an
object will remain where you initially place it.

To turn the Snap feature on, click on the center button. The center button
displays a green check mark; all snap buttons become activated.

To turn the Snap feature off, click on the center button again. The center
button displays a red “X”” mark; all snap buttons become deactivated.

Note: The Snap feature can even be accessed from the Menu Bar, from
the Layout menu option.

Status Bar (Editor Screen)

The status bar is located at the bottom of the Editor screen. When you
select a SKU that has already been placed in a solution, the status bar
displays the SKU number, along with the quantity of SKUs in the selected
placement. Below is the SKU information for the first placement inside
the vehicle for the Appliance Load Manifest.

1: Deepfreezer - Stack Code AllZAN, Priority 1, 27 Pleces [72.00 = 31.00 % 3500 [in] 350.00 (k)]

The status bar also displays constraint messages, which let you know
when you’ve violated a stacking or placement rule after you’ve finished
moving an SKU. Once you release a SKU or group of SKUs at its new
placement, the status bar will turn red if you’ve violated a stacking rule.
The error message will display until you click the mouse on another SKU.

Note: Keep in mind that the Editor will allow you to violate any
previously defined orientation or vertical dimension parameters. However,
the status bar at the bottom of the screen will warn you of any loading
violations that have occurred during the edit process. To view existing

violations in the current load, clip on the button in the tool bar.

SKU Information

MaxLoad Pro provides a right-click function that displays properties
information for any selected SKU. This function is available for truck,
pallet and tote manifests but not available for a single SKU manifest. To
display SKU information, start from the View or Edit Screen of a truck,
pallet or tote manifest and follow these instructions:
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1. Position the pointer over the SKU for which you want to display
information.

2. Right-click on the SKU. A dialog box as shown below appears.

Properties

Break Placement
Edlit:

Expork 3

Align Rear

Align Rear Left
Align Left

Align Front Left
Align Fronk

Align Frank Right
Align Right

Align Rear Right
Align Center

Note: The above dialog box with all functions available appears if
you’re right-clicking in the Edit screen. If you right-click the SKU in
the View Screen, only the Properties option is available.

3. To export the current view of the load solution (in the View or Edit
screen), select Export in the right click menu. Specify the format of
the output graphics and enter a filename at the Save As dialog box.
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Editing a Load

Before you begin the edit process, it’s important to understand how the
Editor is designed to work. In most cases (though not all), MaxLoad Pro
loads a SKU together with other identical SKUs to form a large placement.

A placement is defined as a block of identical SKUs loaded with the same
dimension vertical and oriented in the same direction in the container.
MaxLoad Pro loads the largest placement possible of a SKU before
loading smaller placements or single SKUs. MaxLoad Pro uses this
method of loading because of the ease of loading and unloading.

Therefore, considering how MaxLoad Pro groups like SKUs together
while loading, understand that, in order to select an individual SKU (or
layer or column of SKUs), you must first select the entire placement of the
SKU in question.

Note: To edit a load diagram, you must first create a new manifest or open
an existing manifest. In this section, any reference to SKU also applies to
unitload unless otherwise noted.

Placing a SKU
Discussed below are some ways of placing SKUs in the Editor:
% Placing a SKU into a container or on a pallet:

1. Select a SKU from the Cut List. The Orientation Box displays to
the right of the Cut List with a 3-dimensional image of the selected
SKU. Notice that the mouse pointer is attached to a miniature box.

2. Make changes to the vertical dimension and/or the orientation of
the SKU.

3. Once you’ve made changes to the loading parameters, hold down
the left-click button on your mouse and drag the SKU to the
desired position in the vehicle. When you’re satisfied with the
placement of the SKU, release the mouse button.

MaxLoad Pro adds the selected SKU to the load. If the SKU is too
large for the desired space, you’ll hear a beep, and nothing will be
drawn. The SKU will remain in the Orientation Box.

4. If the selected SKU is too big to fit into the space, you may want to
specify another dimension vertical, change the orientation of the
SKU or make changes to both parameters.
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5. Repeat steps 1-3. Keep in mind that there may be instances where
the object simply will not fit in the intended space.

Note: The Status bar will turn red whenever a stacking code is
violated.

+ Building a Placement:
1. Load the first SKU in the container or on the pallet..

2. Hold down the Shift key and click on the side of the SKU where
you want to place another SKU. See the graphic below for an
illustration of this procedure.

To add a second SKU to | To add a third SKU to the | To add a second row of SKUs
the right of the SKU, first two SKUs (2), click (3), click here...
click here... here...

To add another layer of | To add another two-layer You now have a two-layer
SKUs (4), click here... row of SKUs (5), click placement; each layer has
here... three rows of three SKUs (6).

3. As you can see by the graphic, you can add another row, column or
layer to the placement using the Shift/Click combination. You can
achieve these results by clicking anywhere on the face of the SKU
group to which you want to add another row, column or layer.

For example, in frame number 5, you can get the result displayed
in frame number 6 by clicking on the designated face of any of the
six SKUs in that row.
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4.

If you don’t want to add an entire row, column or layer to the
placement, re-select the SKU from the Cut List, and then place the
SKU in the desired location (just as you would if you were starting
a new placement). You are not required to use the Shift key to
begin a new placement.

Moving a SKU

Discussed below are some ways of moving SKUs in the Editor Screen.

+ Moving a SKU within a container or on a pallet:

1.

2.

3.

Position the mouse pointer over the SKU that you want to move.

Left-click on the SKU and move it to the desired position. You’ll
see an outline of the SKU as you begin to move it, though the SKU
will remain in its original place. Continue depressing the mouse
button until you reach the new location for the SKU.

When you’ve moved the SKU to the desired position, release the
mouse button. MaxLoad re-draws the SKU in the new location.

% Moving one SKU on top of another SKU:

1.

2.

Position the mouse pointer over the SKU you want to move.

Left-click on the SKU and begin dragging it to its new position on
top of the second SKU. An outline of the SKU will appear

Using the outline of the SKU as a reference point, move the SKU
to the desired position.

Release the mouse to release the SKU in its new position.
MaxLoad Pro re-draws the SKU in the new location.
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4

+ Moving a SKU using the Top View: This view is useful especially
when want to move a SKU on another. As this view provides a unique
perspective on the placement of a SKU, allowing you to ensure that
the SKU is placed in the intended position.

1. Click on the Top button. The 3-dimensional view of the load
redisplays to show you a view from the top of the container or
pallet.

2. Select the SKU you want to move, then left-click and drag the
SKU anywhere within the space provided. MaxLoad Pro re-draws
the object in the new location.

+ Moving a SKU from above the floor to a new position on the floor:
1. Position the mouse pointer over the SKU you want to move.

2. Left-click on the object and begin dragging it to its new position
on the floor. An outline of the SKU will appear and move with
your mouse.

3. Using the outline of the object as a reference point, move the
object to the desired position, as pictured below.

4. Release the mouse to release the SKU in its new position.
MaxLoad Pro re-draws the SKU in the new location.
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If there’s not enough room to place the SKU release it in its new position,
the Editor will try to find an eligible placement as close as possible to the
intended placement. If the Editor cannot find a suitable placement, it will
return the SKU to its original placement (that is, where it was before you
attempted the move).

% Temporarily moving SKUs out of the way while Editing:
1. Relocate the SKU within the vehicle.

2. Drag the SKU or group of SKUs to the Cut List, where it will be
stored in text form.

Note: The placement group will be broken down into individual
items when moved back to the Cut List.

Relocate the SKU to the empty space under the load diagram. Be
sure to drag the SKU completely off the vehicle; make sure no part
of the SKU remains touching the vehicle.

Note: If the Snap feature is turned on, the SKU will move in the
direction programmed by the Snap.

Removing a SKU
% Removing a SKU off the pallet or a container:
1. Select the SKU to be removed and drag it off the g.o.d. window.

MaxLoad Pro takes the SKU off the container or pallet and add it
to the Cut List, thus increasing the cut list quantity.

o,

% Removing a Layer/Column SKUs from a larger Placement:

1. Remove the entire placement to the Cut List. The figure on the
next page shows a placement being moved off of the vehicle.
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2. Return the individual SKUs back onto the vehicle, placing the
desired layer, column or row in its new position.

3. Remember the “shortcut” method of building a placement.

Breaking a Placement

You can break a placement of shipcases as well as drums. To break a
placement into its individual items, follow these instructions:

1. Right click on the placement block. A pop-up menu appears
2. Select Break Placement in the pop-up dialog box.

MaxLoad Pro re-draws the solution with the selected SKU broken into
individual items. Note that the each SKU now has its own label,
versus only one label for the entire placement.

Note: You cannot break a single unitload into individual SKUs.

Align Rear Left
Align Left

4 Align Frant Left

Align Front

Align Front Right

Align Right

Align Rear Right

Align Center

48 Ft. Dy Cargo 48 Ft. Dy Cargo
w0 wlz0 w0 w0 z0
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Editing Mixed Pallets in the Vehicle

MaxLoad Pro allows you to edit a mixed pallet inside a loaded vehicle or
create a new mixed pallet from the Cut List as described in an earlier
section. The following steps illustrate how to move SKUs from one
mixed pallet and place them on another mixed pallet on the same vehicle.

Note that the edit function is available to mixed pallets only, unitloads are
not editable.

1. At the vehicle editor screen, place the mouse cursor over the mixed
pallet you want to edit and click the right mouse button. A pop-up
menu appears.

= Maul oad - Edit Soreens Test-pallet edit Solutian | of 4 [Sea Van 1 /1] I [= 1)
Fio Edt Viw Defim Tooks Loyt Hel

k= E®Q ¢ < ®>>3AWL i [T | rww | ]
VWECHTEBRRHHS (9| = || o

Cud Lt | we 122w Erd Gagl45] 76|
ax Cae 4% ) Erd GaglEF] 91 ]
£ 13 COG - 7% 21 28 v

1 :
Tae Wi 0]
Total'wig 1302 [

ol G| 7% bk

28w

MP-3, Bottom = . Top » 53, Left » 48, Right = 82, Fiont » 37, Back » 145 fin] ML Saperdue

2. Select Edit. Note that you can select Properties to view the contents of
the mixed pallet.

A new editor screen containing just the mixed pallet opens. Note that
you can go to this same screen directly by double clicking the mixed
pallet inside the vehicle.
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Mand pad - Fiit Screene Test-pallet edit Sobutian | of 1 [Paliet 1 /1]

I k= E® Ol < <®>>30 L0 I
UWEECTFEBERHES (D] = | o | = |
Cud Last. || wa |(»0I|b| . ) COG - 25x19x29(n)
[T felwelmaly| iricotr) 036
Cutwe ‘3'.'.”’ End GagiE] 00 jn)
Flip | Snap On |
53,00 ]}
| |
11: MP-3 - Stack Code ALIAL Priosty 1, 59 Pieces (42003 160 /ol

3. The Mixed Pallet editor works the same way as the vehicle load editor.
You can click, drag and move selected SKUs to a different location on

the pallet or remove them altogether from the pallet by bringing them
to the Cut List.

Here, the entire top layer has been removed and placed in the Cut List.

Manl nad - Fiit Screene Test-pallet edit Sobutian | of | [Paliet 1 /1]

Fia Edt View Defrm Took Layosd Hep T
N2 =E®-0k < <[®> >3 £ 0 |F= 3 |
VWeEEFHRBEEMHE D€ | = || = | = |

Cut Lt wigt 137 &) COG 32 % M 33 )
= 1% EndGagllt]  0.3n)
e —— |II bam B0 Endesto] D0iel
Flip | SnnnOn|
:m(l[.q

S| I

& Cookies - Sanck Code ALAL Priceity 1. 11.00 find 1.00 (&)

4. Click the Truck button on the Tool Bar to bring the edited mixed pallet

back to the vehicle edit screen. The SKUs from the mixed pallet are
now in the Cut List.
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5. You can add the items on the Cut List as floor items by dragging and

dropping them into the truck in the vehicle edit screen.

6. Double click on another mixed pallet if you want

to place the SKUs on
the Cut List to a different pallet. You might want to turn off the Snap

function in order for the SKUs to be centered on the pallet.

7. To create a new mixed pallet for the SKUs on th
the mouse button within the Cut List area and
Pallet in the pop-up dialog.
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8. Select the pallet you’d like to use and a new editor screen containing
the specified pallet opens.

Place the SKUs onto the pallet as desired and click on the Truck
button when done.
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10. Back at the Vehicle Edit screen, you will see a new SKU MP-5 on the
Cut List. This is the new mixed pallet you’d just created. You can see

the pallet in the Orientation box if you highlight it on the Cut List as
shown below.
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11. To place this new pallet inside the truck, just drag and drop it inside
the vehicle.
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12. When you are done with editing, click the View button to go back to
the Manifest View screen, or click the PicList button to go all the way
back to the PicList screen.

Note: Unlike editing for vehicle loads, you cannot add SKUs or quantity
to the Cut List when editing mixed pallets.

Stacking/Loading Violations

The MaxLoad Pro Editor allows you to override stacking rules during the
edit process. In other words, though you may have designated that peanut
butter cannot be stacked on top of cotton balls, the Editor will allow you
to place a case of peanut butter on top of a case of cotton balls.

However, when you release the object in its new position, you’ll notice
that the status bar turns bright red, alerting you of the stacking violation.
The status bar will remain red until you select another object to edit. In
addition to the status bar, you can also access a report that provides a
cumulative listing of all stacking violations. To display this Stacking

Violation Report, click on the Stacking Violations icon I in the Toolbar.

Clicking on the stacking violation icon will display the stacking violation
messages. Each message tells you when you’ve violated certain load
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parameters of the container, the stacking rules of the SKU that you
recently moved, or if a SKU is affected by the SKU that you recently
moved.

The common stacking violations are as follows:

% (SKU Number) must be stacked on floor

% (SKU Number) must not be stacked on floor

¢ (SKU Number) violates stacked (Stack Code) of (other SKU Number)

¢ (SKU Number) is carrying (X lbs/kg). Its maximum weight allowed is
(X Ibs./kg.)

% (SKU Number) is allowed only (length, width, height) orientation

+ (SKU Number) is stacked (X units) high. Its maximum stack height is
(X units)

s Maximum vehicle weight has been exceeded
% Minimum ceiling clearance has been exceeded

Example: | want to load a grandfather clock into a sea van. The
grandfather clock must be stacked on floor. However, the only place | can
see to stack the grandfather clock is on top of a desk. When | drag the
clock to the desk and release the mouse button, the status bar turns red,
announcing that I’ve violated the “Must be Stacked on Floor” rule. It is
now up to you to correct this violation.

The Edit Stacking Violations screen appears, as pictured below, with all
the stacking violations found within the load.

Edit 5tacking Yiolationz

Refrigerator iz not allowed to be stacked with 'width vertizal
Refrigerator iz not allowed to be stacked with width vertizal
Riefrigeratar vinlates stackcode Cownputer of Fragile.

Steren iz not allowed to be stacked with Lengh wertical

This list identifies which stacking rules have been violated, thus allowing
you to go back and correct the load. This list is included with the
Placement List when it comes time to print the manifest.
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Saving the Edited Load

To save the edited manifest, click on the Save icon H on the Tool Bar.
As an option, you can open the File menu and select Save. If you’re
saving the solution for the first time, MaxLoad Pro asks you to name the
manifest.

MaxLoad Pro saves your changes as part of the manifest file. To view the
edited changes later, remember to click on the View button rather than the
Calculate button. Clicking on the Calculate button will recalculate the
entire load based on the parameters you’ve assigned. Clicking on the
View button simply calls up the manifest that you last saved, preserving
any changes that were previously made.

Note: For MaxLoad Pro to replicate the edited load and make it available
in the Solution List, save the edited load to library by clicking the “Save
To Lib” checkbox in the Save As dialog box.
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Printing

Introduction

This chapter presents the various options available when you’re ready to
print in MaxLoad Pro. MaxLoad Pro allows you to print various
databases and multiple reports, each giving specific information regarding
the load. You can preview your work before printing, which allows you to
make adjustments before actually sending your work to the printer.

As with viewing and editing, printing is a standard function that does not
change regardless of the type of manifest. We’ve attempted to make the
print process as generic as possible; thus, this chapter covers printing in a
generic manner. Whenever we reference printing a truck manifest, the
same principles apply to a pallet manifest, single-SKU manifest or tote.

The various topics outlines in this chapter are:
+¢+ Printer Setup

= Print to File/Create PDF Documents

o,

% Printing Options

= Reports/Solutions
= Report Types
= Databases

s Print Preview
= Report Exports
«+ Annotate Printouts

= Adding Text
= Adding Arrows
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Printer Setup

The first step to printing in MaxLoad Pro is to find which is your default
printer and where it is printing. This information is available through the
Print Setup Dialog Box.

Click on Print Setup under the File menu. The Print Setup dialog box

appears.
Print Setup K E
 Printer
M ame: Properties... |

Statuz: Ready
Type: hp Lazerlet 1012
where:  DOT4_002

Comnment:
— Paper Orientation
Size: ILetter j & Portrait
Source: I,i\utc. Select j " Landscape
Help | MHebwork... | ok I Cancel |

This dialog box allows you to set a default printer and other print
parameters, which are inherent to your Windows operating system.

Select the local or network printer and click OK. The software prints the
selected report or database.
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Print to a File/Create PDF Documents

Printing to a file is useful if you want to share your calculations with other
users electronically or if you have a document to be printed by a
commercial printing service that uses higher-resolution printers. In that
case, you can print the document to a file, and then take that file to the
commercial printer.

To create PDF documents from MaxLoad Pro you should have a licensed
copy of Adobe Writer installed. The Adobe Writer or Distiller should be
the selected default printer, in the Print Setup dialog box.

From version 3.X onwards, you can create PDF outputs directly from
MaxLoad Pro without the presence of Adobe Writer or other third party
PDF writer. Start at the Print Preview Screen, then go to the Export Menu
and select Export PDF. You will be prompted to enter the location where
the PDF output will be saved.

Printing Options

MaxLoad Pro allows you to print a number of diagram views, reports, and
databases.

Reports/Solutions

You can print a report/solution at any time, provided you’ve already
opened an existing manifest. To print a new manifest, you first have to
calculate the load before printing. Regardless of the type of report you
wish to print — the same procedures will apply.

Depending on the manifest, there are two ways a solution can be printed.

< Print: Print feature from the File menu is used when you have a
manifest that fits in one container or on one pallet.

To print a solution, follow these instructions:

1. From the Menu Bar, open the File menu and select Print A
submenu appears with a list of print options — Load, Manifest,
Summary, etc.

2. Select the type of report or diagram view you want to print. For
example, to print the load diagram, select Load.
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The Print Parameters dialog box appears.

Print Parameters
— Print Wiew(s) ————— oK

v 3D Frant -
I~ 30 Back Cancel |
[~ Top
" Side
[ Frant
J¥# | Calor Stop Off

— Color
% Black & white

© Calar [Solid)
" Color (Outiine)
— Load Summary
¥ st

W oty

v Frimrity

[ Description
[ Ordert

I™ Filltern
[~ Pieces

3. Select the view you want to use in your printout — 3D Back, Top,
etc. You can select more than one view option. Each view will be
printed on a subsequent page.

4. Select the print color: Black & White, Color (Solid), or Color
(Outline).

5. Click on OK.

6. At the Print dialog box, select the printer and click OK.
The software prints the selected report.

< Multi Print: Multi Print option is useful in analyses which have big
manifests going in more than one container or on more than one pallet.
Similar to the Print option this option can also be accessed from the
File menu.

To multi print, follow these instructions:

1. From the Menu Bar, open the File menu and select Multi Print.
The Multi Print Parameters dialog box appears.
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Multi Print B

r— Print
¥ Load I~ Uritt.oad ILI
¥ Load Front/Back View [ Placement List Cancel |
[~ Manifest [~ Load List Select Al |
[~ Summary ™ Cut List Clear Al |
¥ Load By Placemer [ Truck Summary
[" LoadByLeadingEdge [ Totes
[ Load Summary [ Load By Placement Edge
[ Mized Pallsts
—I;'_r.int\!iew[s] Container
Colaor [Dutline:
€ Color ESoIid] | @Al
€ Black & White ® B

Select the report to print.

Note: You can select more than one report. Each report will be
printed on a subsequent page.

Click Select All button to select all reports and Clear All button to
undo report selection.

Select the print type: Black & White, Color Solid, or Color Outline.

Select the containers. Select All for all containers for that manifest
or Current to print report for a selected container and click on OK.

The Print dialog box appears. Select the printer and click OK. The
software prints the selected report(s).
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Report Types

The views allow you to view the load at various stages of the loading
process, while the reports display relevant information regarding the active
manifest. The various printing options that you can preview or print from
the File menu is as listed below:

% Load: Prints the load diagrams of the current solution. Select from
among 3D front, 3D back, top, side and front views.

‘ Manfast Gresory Ovelee iul ap. O Tiga, M 101, 2893 Pagenerd
. . [T AT Dry Chrga {Tesc®) 1 21) Clarg
’ ’ ’ UrusedFloor 8.5 (s Cang

C00 - -

\Waiga: Kaeg Pin - 1053 08, Adte 1. 1736 B3, A 2. 17408, B gt

1 6

1 3

2 m

2 1

2 LrT)

] re

] 1

] &8

ottt : TOPS EAQI Y
Asdewss - 375 W Camoted R, Rchandson T T5080

ey

If “Color Stop Off” option is checked, the SKUs will be colored
accordingly to stop off number as shown nexr.

’ Maniiesi Grocery i dei isiop-0f) age 1 of
" Venich 48 FL Doy Cargo (Trucks 1 1 0}
’*‘ e Fisr; 46 4 frp

0

1

250

"

144

%

T

¥

iy

Cuslemir - TOPS Engissaring
Adkaness - 2750 Camptell Fil. Rimasssen TX 75080

FreeT==r T
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X/
°e

Load Front/Back View: Prints a report with both the front and
back view of the loaded container or pallet. Select from options of
Top-Bottom direction or Left-Right direction as illustrated below.

’ Manifest Grocesy O der js1oq Oy Tus, Mar 19, 2013 Fage 1af1
’. Vehicle 40 P Dry Cargo (Truck) {111 Cango Cube. 454 (13170 %
’ ’ ’, Unused Floor, 48,5 iy g;l-;u '?'5\:0:'175;5:;::.‘“{“‘?’3 " Vol B
hﬁ“ Waight  King Fin - 1953 (6), Adn 1 1736 (8), Awie 2+ 174 gb), e o Lis

Front

Customer: TOPS Engingsfing
Address | 278 W Camobell R, Fichardson TX 78080

~— =
’ Manitest Grocery Order {stap Ot} Tus, Mar 14, 2013 Page 1af1
’ . Veticle 4071, Dry Cargn (Truck) {1117 Cargo Cube. 2454 (10 170 %
’ ’ ‘ Unused Fioor. 5.5 (i E;I':" ?5‘:0""”-’;5:; :_‘n"“-’"" * Load Summary
i L o0z Sk o aty
\h" Wight - King Pin - 1863 0, Adn 1+ 1736 (8), Axie 2= 174 0l Sk i 7
y Han Towsls 1 6
ront Rk Pallit #1 1 i
Pallut #2 2 2

CutList
o) Oty

Custorner , TOPS Engingering
Address - 374 W Cammball R, Richardson T 76050

T e
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% Manifest: Prints the manifest pick list and associated options
selected for each SKU specified via the Properties function via the
right click short cut menu.

Grocay Ouder (s1op-Off) Mar1, 2013 Pagelefi
Vehiche (Truck) | 40 F1. Dry Cargo Capacity. 3520 (0
‘ Dimensions. 4858 % 01687 (7} W Weight 48000000 0ty
oD Banh O0ers T 0geser NG
Minimum Ceiing Clearance: 0 zep Like SKJs Together He
" vertical Gap. Load By Stop O
" Friorey Overiap: 0 Loading Algorithen Load Front & Rack
" rveitsang [ Epace Evenly
Left fo Right Optimization
- sHU Oy S0 UL WP Orderd % Cube % Wit Piece Comt Fill Remn
Tollol Titsua 50 i @ O 120 T T T 50 O
Cookies 75 1@ o 132 13% 0% L] a
Hard Towels 600 10 @ 132 TE®  06% & O
it #1 3 1 145 54%  06% 3 O
Palet #2 2 2 145 41% 04 % 2 =)
Fetalo Chips 200 ? o 145 176% 03% w0 O
Gannes 155 2 o a 145 191 % o % 155 =]
Tissue Pape 75 3 o 145 7% 9% 7 o
TR 3 =

< Summary: Prints a summary of the load. If there are stop offs or
priorities in your load, the SKUs are grouped by stops or priorities
in the summary.

Load Sumanany: Grocary Of e (step 01T Mar19, 2013 Page 1of1
Wehicle (Truck) (1 71). 48 FL Dry Cargo Capacity. 520009
Dirnsions 485 8% D6ET M WRight: 45000000 b}
SHe Palit Valug Frefgin Cost Unin Com Tatal Cost
sl 0.000 0 0 0
Sme 2 0.000 0 0 ]
Mo, SKU Onder# Oy ULCol Stop Cubeift®) % Cube  Wel k) % Wl
1 Hand Towels 132 60 [ 1 16687 T6% 000 06%
1 Pamte 148 3 ] 1 T@IE3 s4% 3030 0E%
1 Cookes 133 74 a 1 a5 13% 150 03%
I8 0 [CEE N TRTEH e 1an
5 Palet#3 145 1 o I O5E1 4% 040 4%
B Polalo Chips 145 200 a 2 4magn 139% ET0.0 14%
7 Satnes 145 " [ T Y i 0%
7 Sahnes 145 e 12 1 T6ET  01%  MED 1T%
w0 VEOLG I0ABY WOLTS  RS3IN
1 Toilet Tissue 1 2 o 3 542 02% o1 00%
1 Toilet Treswe 14 40 3 3 14EET 1% 1976 04%
8 Tissus Papte 125 5 [ 3 om0l 7i% 400 09%
125 3 42496 1205% GAT.TS 135 %
620 n T 6503%  3018S 6M N
Frepy e E=
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% Load By Placement: Prints a report of the vehicle/pallet being
loaded one placement at a time. This report indicates SKUs, SKU
quantities, and the load configuration for each step.

+ Load By Layer: Auvailable only for pallet manifests and with
solutions based on layer construction, it prints the pallet load
showing each successive layer.
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% Load By Leading Edge: Prints the load showing each successive
leading edge. It shows less steps when compared to the Load by
Placement report.

|5 g T eiary G o T E CRILE
OO Tred T 7T W Dy o vy R
fntie @i s e 40000 )

+ Load By Stop-Off: Prints a diagram of the container/pallet being
loaded one stop off at a time.

Lo e o Gy o o i

L L
[ b8 1087 )

T Toew T
T2 MR
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% UnitLoads: Have the option to print each individual unitload
and/or mixed pallets inside the vehicle. The 3D diagram of the

pallet load report provides the following details

For Unitload:

g Mok o - G ocony Ou e istop OFT) Tue, Mar 18, 2013
Pallst’ (GMA Nitthed 4
o

S8 Mumber. Potato Chips
Descripsan Saack Sie S0 C1
Tyoe: Shipcase

Unimiasd Sunienarg

e SKU number and description

e Properties of SKU including length, width, height, weight

and loading preference
e Pallet used for the unitload

e TiHi information: Cases per layer, number of layers on the
pallet and total number of cases on the pallet.

e Dimension and weight of the unitload
e Areaand cubic efficiency for the unitload
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For Mixed Pallet:

Mok o - G ocony Ou e istop OFT) | Tue, Mar 18, 2013
[
Pallst GMA Notthad 4R

TME-4
Fallid GIMA Notehed 4Sx80us

ILergth 4775 b
Width 2000 jnp

|Height 30,00 g

|Weight 100 b}

Lot Surnersaey

Mo, Oty KU
1 20 Cookes

Hal
287
28
55

e Type of pallet used

e Length, width, height and weight of the pallet load

e A summary of the contents on the pallet including SKU,
quantity and SKU dimension
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s Placement List: Prints a text report broken down by placement
inside the vehicle. It contains the same information found under
the Placement List in the Solution View.

Placement List: Grocerv Ouded (ston OFM) Mar19, 2013 Page 1 of1
Wehiche (Trock) (1 /13 40 FL Dry Cango Capaciy. »HOMNY
‘ Dirmsersions: 48 x B x Q1BET () Max Weight 28000 000 (k)

Oy UL Col Sop Long Wide High Vet X Front X Side X Floor
40 4 3 1 2 2 Hat L] o 0
b1 3 1 1 Hgt 0 [ 0

n 3 1 2 1 Hal 0 &
1 3 1 1 1 gt @ 1] 0
8 3 1 1 1 Mt b @ 0
7 3 1 1 1 Hgt w 48 38
2m 2 b ] ] 7 wat 1 ] 0
2 [ b 1 2 1 Hat ) ] 0
1 s 1 1 1 Hat 0 o 0
Low Fat0ct 12 s 1 1 1 Hat 0 0 Ex ]
Low Fat 20 C1. b 2 2 1 1 T Hgt il 4 o
Low Fat 20C1 o6 @ 2 2 2 2 Hat 0 o 0
Low Fat 2001 12 1 2 1 1 1 Mgt m o 0
500 Sheet Role 40 2 1 1 2 1 Hat 410 o 0
LA Examale 1 2 [ 1 1 2 1 Hat 450 o 0
w el 1 1 o 1 1 1 1 Hat 430 o 55
€ 0 1 1 1 1 1 Hat 43 0 0
] 1 1 1 1 1 Hgt 4m 4 0
n 1 1 1 1 Hal “m 48 5

Tatal 5] W

Data includes:

e Placement Number

e SKU Number and Description

e SKU Quantity in the placement

e Number of unitload or mixed pallet within the replacement
e The Stop for the placement

e Configuration of the placement

e Orientation of the placement, i.e. which dimension is
loaded vertically

e Position of placement from the front, side and floor of the
vehicle
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% Load List: Prints a breakdown of the solution by SKU Number. It
contains the same information found under the Load List in the
Solution View including:

?:::0' Load List: Grocery Order (ston-Of Waris, 2013 Page 1 o1
" S T B B S B v

e Placement Number

e SKU Number

e SKU Quantity in the placement

e The Stop for the placement

e Total cube usage of each placement

e Percentage cube usage for each placement

e Total weight of each placement

e Percentage weight for each placement
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«» Cut List: Prints a list of SKU’s that were not able to be loaded
onto the vehicle/pallet.

Cut List: Grocery Order (stop-Off) Mar20, 2013 Page 10of1

." wehicle (Truck) - 48 Ft. Dry Carga Capacity. 3620 (13)
A

.’A Limensions: 48 %8 x 91667 () Max Weight: 48000.000 (k)
No.

SKU Order#t Qty UL Cnt Stop Cube (ft3) % Cube Wt (i) % Wt
496  12% 1130 02%
2722 08% 654 01%

36083 103% 8120 17%

14667 42% 1975 04%

9 MP-1 Fl 1
10 MP-2 7 1
7 aper 145 72 6
8

3
3
Tissue P 3
Tailet Tissue 124 48 3 3

135 1 57678 1639% 19808  25%

Placement Number

SKU Number

Order number

SKU Quantity in the placement

Number of unitload or mixed pallet within the replacement
The Stop for the placement

Total cube usage of each placement

Percentage cube usage for each placement

Total weight of each placement

Percentage weight for each placement
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R/

% Mixed Pallets: This report is only available for Truck Manifest. It
lists the contents of various mixed pallets in the container
including SKU Number and quantity, total cube and weight for the
SKUs and the stop number for the pallet load.

[ Gracery drder (ston- 01 Mar20,2013 Page 1 of 1
viehicle (Truck) (2 #2); 48 Ft Dry Cargo Capacty: 3520 (1)
o B %8 %0167 (1) i Welght: 42000000 (1b)
Hame =1 Cube gt stop
MP-1
Tissue Paper B 200 B0 (L) 3
MP-2
Toilet Tissue 7 BOHD 0408 3
MP-3
Salines 1 T (M 28(k) 2
P-4
Cookies Ed 21 (1) 0006 1
Hand Tomels 3 B3 150 () 1
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% UnitLoad: This view is only active after an SKU has been created
as a unitload from the Define>SKU>Create UL screen. It prints an
enlarged view of a unitload with the following details:

e SKU number and description

e Properties of SKU including length, width, height, weight
and loading preference

e Pallet used for the unitload

e TiHi information: Cases per layer, number of layers on the
pallet and total number of cases on the pallet.

e Dimension and weight of the unitload

e Area and cubic efficiency for the unitload

g MaxLoad - SKU Cive 2 Tha, War 212013
Palel. OMA Nolched d0x40x5
i
e
~

=
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% Truck Summary: Prints a breakdown of SKUs and piece count in
each vehicle.

Truck Summany: Grocery Order (stop-Off) Mar 20,2013 Page 1 of 1
.”‘. Wehicle (Truck) - 48 1. Dry Cargo Capacty, 3520 (13)
‘h“ Dimensions: 48 x 8 x 91867 () Max Weight: 48000000 (1)
#1 #2 Total __(Piece)
Cookiss 105 105 (105)
Hand Tomets 63 63 63
Palet #1 3 3 @
Palet #2 2 2 @
Potato Chins 200 200 (200
Saines 155 155 (155)
Tissue Paper 72 8 a0 (&0
Tollet Tissue 55 55 55
Cube((13)) 309 21913
% Cube (%) 10 62
Wit (b)) s 82
LR 3 ==
[

«+ Totes: Prints a breakdown of SKU’s included in a tote.
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s Load Summary: Similar to the Load List, this report prints a
detailed load summary of the current vehicle with details about the
SKU'’s stacking and loading preference:

e SKU Number and Description

e Quantity of SKU in the placement

e Cube and Weight of the SKU placement

e Dimension of the SKU

e Amount of overhang allowed for the SKU during stacking

e Dimension of the SKU that allowed to be stacked vertical
and the preferred allowed vertical dimension

e Stacking preference for the SKU

e Loading preference for the SKU — by length, width or best

e Maximum stack height (on base and side) and stack weight
Load Detail Summary: Grocery Order qu‘m Mar 21,2013 Page 1 of1
Vet (Tnck) (111). 487 lL:’L rgu iy M3)/73 % UsedFloor. 4%

D xB 9 1667 %) M w ght a‘r 7 (k) B % Unused Flaor: 37 {in)
Max Max  Max
Package Mo Overhang  Allow Verficll  Prefe  Stack  Loading Stack Stack  Stack
Oty Cube Wat B @ @) M) W DG iH W D Vertical Prefer Prefer  Hgt  onSide Wit
1100 0880 100 0000000000 ¥ ¥ ¥ Any 100 20
1100 0850 100 DOOODOODOOODD ¥ Y ¥ Any 100 n
24001600 200 0000000000 ¥ Y ¥ Any 100 [l
2400 1600 200 DOODOODOOODD ¥ Y ¥ Any 100 75
S500 4100 420 DOO00OOO0NND ¥ N M Hat 100 an
000 4200 500 0000000000 ¥ N M Hat 100 250
1000 1600 240 DODODOODODOODD ¥ N M Hgt 100 10
1600 1950 40 0000000000 ¥ N N Hat 100 100
1600 1980 240 00000000000 ¥ N M Hat 100 100
1710 1640 224 DOODOOOOOODD Y Y ¥ Hagt 100 125
1710 1640 224 0O00OO00000 ¥ Y ¥ Hgt 100 125
1950 1000 240 DOODOQODOOODD ¥ N M Any 100 10
1950 1000 240 00000000000 ¥ N M Any 100 10
— =

To print Load Summary for all vehicles in the manifest, use the
Multi Print or Multi Preview function.
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% Load By Placement Edge: Similar to the Load By Leading Edge
report, this prints the load showing each successive placement edge,
together with the placement information including SKU number,
quantity and arrangement of SKU in that placement.

% Customized Reports: Allows users to select the data to be
included in the graphical and summary reports in MaxLoad and
will be discussed in more details in the next section.
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Customized Reports

This print option leads to a submenu so you can customize the data to be

included in the Graphics (Load) Report or the Summary Report.

Note: If the manifest consists of multiple vehicles, the customized report

will only report on the current vehicle.

Graphics Report

Customized Graphical Report Dptions x|
—Header Details
¥ Report Header W Compary Loge W Date [V Load Header Cancel |
¥ Load Details ¥ Page Mumber Fant |
— Summary Details
Select Options Length Select Options Length
I Report Summary [# sk Mame |15 'I IV valume |5 'I
Report Size (%) ¥ Mum of SKls |3 "l ¥ Percent Cube IlD vI
65 w7 .
I nhum of LLs |1 vl [ weight |1 vI
—List Options
™ Pricrity |1 vI [ Percent “Weight |1 vI
" Load List
w il v i i -
% Placement List 7 Stop OFF |1 I [v Dimensions 20
™ Order Mumber |1 'I |¥ Pisce Count Il 'I
— Graphical Wiew Details
—I;Lint (_Zolor ) Report Typels)
Print Black. White 30 Viewi(Front)
¢ Print Color {Solid) - .
€ Prink Color {Outline) 3D View(Back)
— Load Caolors ' Top View
Loads Current Load 30 Fronk Back Yiew? Side By Side)
ISDlid Color ﬂ ICDlDr Outline ﬂ & 30 Fronk Back iew( Up and Down)
ANEENEEEENEENEENEENEENEENEENENNENNEEEEEN B

K/

£ %4

B

*

Header Details: Allows users to select what data to be included in
the Summary report in MaxLoad.

Summary Details: This section gives users control over what
portion of the page will be used for summary and what data go into

that section.

If you uncheck the Report Summary, the graphics

report will only give the 3D Load view of the vehicle, without any

data.

Report Size: Specify what percentage of the page will be
used for summary data. Select the percentage from the drop
down list. The bigger the number, the more the page will be
made available for the summary.
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List Option: Specify whether the report will contain Load
summary or Placement summary.

Select Options: Check against the data you’d like to be
included in the summary.

Length: Click the drop down list to specify the field
length for the selected data.

+« Graphical View Details: Specify the options for the graphics

section of the summary. This portion is placed on the left side of
the report.
e Print Color: Specify if the report will be in color or black
and white.
e Load Colors: Select the color option to be used for the
load.
e Report Types: Specify the graphics view to be included in

the summary report.

+ Usage Status Bar: Provide a summary on how much of the space

assigne

d to the summary section has been used up by the current

selections.

« Font: Select the font to be used for the custom report.

%,

Masibfost : Gracary Ouder fstop () Thu, Mar 21, 2013 Pagatof 1
Vehicle (Truck] (1/1) 48 F1, Dry Cargo Capatiy 2552 AT % Used Floor, S4'%
Drmrision 4328 £ 91667 () Max Weight S00377 ()/8%  Unise 7 i)

Y

SKU

Tissus Paper
Tisu

Dty

=
5 F]
Tola 2
B
0

“EDRES

w3 255222 (MIF251 N

Note:

Before you print, use the printer’s properties to specify the

printout to be in portrait or landscape format.
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Summary Report

E
- List Optians Load Lisk Option: Placement List Option: )
:; Load List 5 22|:c|\5;):::n5 1Lengthv I_S;::cctn::::ns 1\.:ngthv 5 ;&;::;i::;z:n 3LEngthv '75;\::: Optinns ;Er\gthv p—
Placement List Bloesims [f jv % Front l__I5 :Iv ~ side l__l5 :Iv Font
—SKU Options General Option:
T [T e G —
e s = I Length = Fomofis o =] F# percentCube  [10 x|
~Max OverHang Options ~Max Stack Options T riocy ! :I' FZlsente B j'
Select Gptions Length Select Options Length ¥ stop oFF m ™ Percent Weight m
I Heiht 1 - I Heighi 1 = I~ stackPrefer [T <] ¥ LoadngPrefer 6 =
I~ width 1 - ™ onside 1 -
™ Length m ™ weight m W e ! jv
AENEENNEENENEENEENENEENNENNENEENEENENEENNENNNNENNENNNNNNNERE LILTLIL]]] 82%

% List Options: Specify whether the report will contain the Load
summary or Placement summary.

% Load List Options: Available only when Load List is selected,
this allows you to specify the data to be included in the report and
the filed length to accommodate the data:

e Sequence Number
e Order Number
e Description

% Placement List Options: Available only when Placement List is
selected, this allows you to specify the data to be included in the
report and the filed length to accommodate the data:

e Placement Number

e Front - distance of placement from the front of the vehicle

e Floor - distance of placement from the floor of the vehicle

e Side - distance of placement from the side of the vehicle

+ SKU Options

e Package Options: Include the selected dimensions for the
SKUs in the custom load reports.

e Allow Vertical Options: Show the Allow Vert setting, as
Y for yes and N for no, of the selected dimension for the
SKUs in the custom load reports.

e Maximum OverHang Option: Show the Maximum
Overhang settings of the selected dimension for the SKUs
in the custom load reports.
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R/
A X4

K/
L4

K/
L4

e Maximum Stack Options: Show the Maximum Stack
Height and Weight settings of the selected dimension for
the SKUs in the custom load reports.

General Options: This section allows you to select additional
details regarding the SKU placements inside the vehicle to the
Load or Summary List.

SKU Name

Load Dimension: dimension of the SKU placement
Number of SKUs: total number of SKUs in the placement
Number of Unitloads: total number of unitloads in the
placement

Priority

Stop Off

Volume

Percent Cube

Weight

Percent Weight

Rotation: preferred Vertical setting for the SKU
Stack Preference

Loading Preference

Usage Status Bar: Provide page usage summary for the current
selections and field lengths.

Font: Select the font to be used for the custom report. Select a
smaller font to accommodate more information on the report.

Databases

The various databases that can be printed from MaxLoad Pro are as
follows:

K/
L4

Manifest: Prints all saved manifests in MaxLoad Pro. Data
includes manifest names and names of the user who created the
manifests.

SKUs: Prints all the saved SKUs from the database including
shipcases, drums, tote SKUs, pallet SKUs, and palletloads. Data
include the SKU number, description, dimensions and weight.

Pallets: Prints the names of all the saved pallets from the database
including slipsheets, europallets, strings, etc.
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% Vehicles: Prints the various containers saved in the databases.
Including trucks, sea vans, rail cars, etc and their dimensions and
weights.

o,

% Totes: Prints the possible totes saved in the database with both
inside and outside dimensions.

To print the MaxLoad Pro databases, follow these instructions:

1. From the File menu, click Print Databases.

2. Select the database to be printed. The Print dialog box appears.
3. Select the printer and click OK.

Note: Unlike reports, the MaxLoad Pro database cannot be previewed
before printing.
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Print Preview

As with most other Windows programs, MaxLoad Pro allows you to
preview your work before you actually print it. From the Print Preview
screen, you can add annotations to your printout and customize your work.
Remember, a diagram or report will print out exactly as it appears in the
Print Preview screen.

To access the Print Preview screen, follow these instructions:

1. From the Menu Bar, open the File menu and select Print Preview or
Multi Preview, respectively.

2. Select the type of report or diagram view you want to display a print
preview. Please to the section “Report Types” for a description of the
different reports available.

Note: The print preview displays either in color or in black-and-white,
depending on the selected printing method.

ManLuad - Preview: Appliance Load =]

Lo Poge | Zovmln | Zoon Dul Luem Helg I

Manifest Appilance Load Mon. Mae 1. 3013

ehice L Doy Conge (Trosk} (171) CangoCobu 3002 (13 /83 %

Urusea Floor: 2in) c 0200 i) / 33 %
= x5a0e

WagrE - King Pn - 7T (B A 1. SR A

Ceaptaarar

TEIS [ nminaasina
275 W Campball Rd, Richaedicn T 75080

10.26 MaxLoad Pro (V3.6) User’s Guide



Notice the Toolbar, pictured below, at the top of the Print Preview screen.

FPrrint

| ﬂextF’agel F'regF'agel IwnF’agel Zoom [n | Zu:u:mgutl LCloze | Edit | Help

The Toolbar contains the following buttons:

K/
A X4

K/
L4

K/
L4

K/
L4

Print: Prints the diagram/report.

Next Page: Displays the second page of the printout. If there is
no next page, this button will be grayed out. The total number of
pages for the preview is indicated on the top right hand corner of
the report.

Previous Page: Displays the previous page of the printout as you
view the second page. If there is no previous page, this button will
be grayed out.

Two Page: Displays a split-screen view of a multi-page printout
to show two pages at a time. If there is only one page, this button
will be grayed out.

One Page: Converts back to the one-page view if you are
currently on the Two Page view.

Zoom In: Displays a magnified view of the previewed document.
MaxLoad Pro allows you to zoom in twice.

Zoom Out: Displays a reduced view of the previewed document.
This feature works if you’ve zoomed in.

Close: Closes the Print Preview and returns you to the point where
you initiated the preview process.

Edit: Initiates the annotation process and makes your mouse
pointer “live.”

Help: Opens the on-line Help document within MaxLoad.

Report Exports

Under the Export Menu in the Print Preview screen, you have these export
options:

K/
A X4

Export JPG: Automatically generates JPEG files with filename
ManifestNamel.jpg, ManifestName2.jpg, ManifestName3.jpg, etc
in the specified file location, one file for each page of the reports.
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% Export BMP: Automatically generates JPEG files with filename
ManifestNamel.bmp, ManifestName2.bmp, ManifestName3.bmp,
etc in the specified file location, one file for each page of the
reports.

K/

< Export PDF: Creates a single PDF file with name
ManifestName.pdf in the specified location. The file will include
all pages of the selected reports.

E-Mail Reports

Under the E-Mail Menu in the Print Preview screen, you have these
options:
% E-Mail JPEG: Launches your default e-mail application and
attached the current reports in JPEG format. This allows you to e-
mail any of the print reports directly from MaxLoad.

« E-Mail PDF: Launches your default e-mail application and
attached the current reports in PDF format. This allows you to e-
mail any of the print reports directly from MaxLoad.

Annotate Printouts

MaxLoad Pro allows you to annotate printouts by letting you add text and
arrows thus making it easy to add last-minute notes to your diagram.

Adding Text

To add text to the output, start from the Print Preview panel and follow
these instructions:

1. Click on the Edit button.

2. Click on the area of the output where you want to enter text. MaxLoad
Pro displays a four-cornered entry field with the cursor positioned
inside the field. Notice that you can "drag" the entry field to any
position on the screen.

3. Enter the text that you want to appear in the selected area. At this time,
you cannot mix fonts within a single annotation.
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4. To change the font and/or font size, open the Format menu and select
Font. The Font dialog box appears.

5. Use the Font dialog box to select the font, font style and/or size, and
then click on OK. This closes the Font dialog box and returns to the
Print Preview panel.

6. Drag the text fields so they're positioned where you want them.

7. If the added text is correct, click on the Print button. MaxLoad Pro
sends the analysis output to the printer.

Adding Arrows

From time to time, you might want to enhance a printout with some well-
placed arrows. In MaxLoad Pro, inserting an arrow on a printout involves
a little-known keyboard trick — using the Alt key and the numeric keypad
to insert keystrokes that are not usually available. This method offers an

advantage over using bitmaps - these arrows have transparent
backgrounds and won't obliterate the area on the printout where they're
placed.

Most fonts have more symbols than the normal 26 letters, 10 numbers and
punctuation symbols. A font often includes arrows, trademark symbols,
accented characters, etc. In most word processors, you use the
application's Insert Symbol feature and selecting from a range of symbols.
Microsoft Word also allows you to choose which font symbols you want
to use.

At this time, MaxLoad Pro does not have an Insert Symbol feature, so in
lieu of that you'll use the Alt-keypad routine. In Microsoft Word, if you
open the Insert menu and select Symbol, the Symbol dialog box appears,
as pictured on the next page. You can also use the Windows Character
Map feature, located in the Accessories folder.
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If you highlight a symbol — such as the right arrow (—) — a number
appears on the status bar; for example, 174. This number represents the
ASCII code for the selected symbol and the selected font.

The following steps allow you to insert these characters into most
programs, even if they don't have an Insert Symbol feature. To insert
characters into a MaxLoad Pro printout, follow these instructions:

1.

2.

Go to the Print Preview Screen and zoom in.

Click on the screen to insert text.

Make sure the keyboard's Num Lock light is on.

Open the Text menu and select Font to display the Font dialog box.
Select the font you want to use.

Note: To insert arrows onto the printout, you'll probably want to use
the Symbol or Wingdings font. If you want to simply bold or italicize
the text, the active font should be sufficient.

Hold down the Alt key on your keyboard.

While holding down the Alt key, type the ASCII number for the

symbol you want to insert with a zero (0) in front; for example, type
0172. Use the table on the next page as a guide.
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0171
0172
0173
0174
0175
1076

Symbol Font

“ 4 -1 3

Common Ascii Codes for Symbols

0219
0220
0221
0222
0223
0226
0227
0228

© @ < =01 ¢

0223
0224
0225
0226
0227
0228
0229
0230

L R N 2 € > ¢ A

Wingdings Font

0231
0232
0233
0234
0235
0236
0237
0238

€«

¥ R 3N 7 € > VJ

0239
0240
0241
0242
0245
0246
0247
0248

v R & A & = 0 1@

Note: To change the font, you must first key in a letter or any text, and
then highlight it. Then you'll be able to change the font for that text and
any additional text.

8. After you type in the ASCII number, release the Alt key.

MaxLoad Pro inserts the selected symbol onto the printout. You might

need to adjust the font size to make it more legible.
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Configuration

Introduction

This chapter discusses how to define the configuration of the MaxLoad
Pro System. Configuration features are subject to certain authorizations.
Most Configuration features can be accessed and changed by any user.
Global configuration parameters are the only parameters that can be
accessed and changed by the Supervisor alone.

This chapter is organized in to following topics:
+«+ Configuration Settings

% Global Settings/Supervisor Functions

¢ Properties

Lists

Measurement Input Fields
Non-Measurement Input Fields
Radio Buttons

Check Boxes

« Example 1: Changing the Default VVehicle Type
s Example 2: Adding a Default Selected Vehicle

« Example 3: Changing the Default Mixed Pallet Height
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Configuration Settings

MaxLoad Pro can be configured as per user needs from the MaxLoad
Configuration dialog box. The MaxLoad Configuration dialog box
displays a range of options that define the way MaxLoad Pro performs its
work. This dialog box allows you to turn on and off each of these options.
To access the Configuration dialog box, start from the Menu Bar and
follow these instructions:

1.

Open the Tools menu and select Configuration. The MaxLoad
Configuration dialog box appears, as pictured below.

MaxLoad Configuration
™ Wiew On Open IEninsh j oK I
IV Snap Tight in Edit ~ Placement Mumberting—————

[+ Show next vehicle dialag N1 T — - Cancel |
¥ Show Flfaps ; ; & Use SKU Mumber Glabal |
¥ Show Dimensions On Solutions o ks Bt Mumdiz
IE g:ow Cent:.r DF Gravity " Use Custom Label Defaults |
W Show graphics -
¥ Transparent Labels - Print Fonts

F . £ Black & Whis
¥ Show Pallst details )

) ' Calor [Salid) Hel
¥ Show Unitioad's SKUs ] P
" Color (Dutling)

[~ Estended key mode
™ Mumber Grid Lines  Printer Resolutio
[ Save to Libram Coarze .E Fine
[™ Use Euwopean Date
Graphics Screen Color |
G.0.0. sereen color I
I Shaw gridines Grid interval (i) I'I 2.000

As you can see, this dialog box contains a large array of options for
you to work through. This section discusses each of these options in
detail.

After you've made changes on the Configuration dialog box, you'll
want to save your work. Click on OK. MaxLoad Pro saves your
Configuration changes and returns you to the previous screen.

To exit the box without saving changes, click on the Cancel button.
MaxLoad Pro ignores any Configuration changes and returns you to
the previous screen.

View On Open: If this box is checked, MaxLoad Pro will take you
directly to the Manifest Solution screen upon opening the last saved
version of the existing analysis, bypassing the Manifest Pick List
screen.

If this box is not checked, MaxLoad Pro will open the Manifest Pick
List screen first, regardless of whether or not the solution has been
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previously calculated. You can then click the View button to see the
previously saved solution. If you click on the Calculate button,
MaxLoad Pro will redo the solution for the opened manifest.

X/

% Snap Tight in Edit: This option controls the default setting for the
Snap button in the Edit screen. When this button is checked, the Snap
button will be “on” and will assist you in placing cargo when editing a
load. During the edit process, when you drag and drop an SKU into a
vehicle or onto a pallet/slipsheet, MaxLoad Pro places that object into
the nearest corner (i.e., as far forward and as far left as possible). The
corner must always be forward and to the left of the selected
placement.

X/
L X4

Show next vehicle Dialog: This option applies when you're loading
items from the Cut List onto another container or click the ReCalculate
button in the View Screen. When you do that, you have the option to
change the type of container that was used initially. When the option
is checked, the Next Truck dialog box will appear that allows you to
make another selection.

Next Truck

Avallable Vehicles Selected Vehicles
48 Ft. [Marrow] 48 Ft. Dy Cargo Cancel |
48 Ft. Dy Wan ;

B0 Ft. Rail Car —Wehicle Type

53 Ft. [Marrow) % Truck

53 Ft. Drop Deck e

53 Ft Dry Van Seatfan

53 Ft. Dual Drop Deck " Rail Car

57 Ft. Dy Wan .

ED Ft. Rail Car . Rl Wagon
L11 .{-\ir Fl,eight " Mulii Zone
t[;i ?!&F'E'ghth " Double Trailer

-4 Air Freight
LD Air Freight € U
LTL Pup " SideBay
I4-1 &ir Freight ™ Flatbed
M-2 &t Freight A8e
Truck with *wheel Well

™ Don't Show This &gain

If this option is not checked, MaxLoad Pro assumes you would use the
same type of vehicle. You can also check the option “Don’t Show This
Again” in the above dialog to disable the Show Next Vehicle Dialog.

+« Show Flaps: When this option is selected, all shipcases will appear
with a case flap that designates the top of the box. The case flap
always runs parallel to the length of the box, thus giving you an easy
reference point when viewing the solution. The line on the box runs
parallel with the length dimension of the box.

The SKUs appear as cubes when this option is unchecked.
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X/
L X4

Show Dimensions On Solutions: When this option is selected,
MaxLoad Pro displays dimensions of the container or pallet in the
Manifest View screen. The container dimensions appear exactly as
you entered them when defining a vehicle.  However, the
pallet/slipsheet dimensions — when viewing a mixed pallet manifest —
are displayed using the actual dimensions of the pallet plus any
overhang. If no overhang is utilized, the pallet’s actual dimensions are
displayed. The height displayed is the actual height of the mixed-
pallet load.

No dimensions are displayed on solution, if this option is unchecked.

Show Center of Gravity: If checked, the center-of-gravity (COG)
will be displayed in the g.0.d. window with red triangular markers in
addition to the numeric display in the load statistics section, in the
View Screen.

Show Graphics: When this option is selected, MaxLoad Pro displays
any graphics that have been assigned to a shipcase, SKU, tote, etc.

Transparent Labels: When this box is checked, meaning to use
transparent labels, MaxLoad Pro places the label texts directly onto the
SKUs and placements (as below left), overlapping SKU outlines and
flap indicators.

If this box is not checked, MaxLoad Pro places the text of the
placement numbering reference on a label with background of the
same color as the SKU, then onto the object, therefore making it easier
to see (figure on right).
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°e

Show Pallet Details: Depending on how complicated your load may
be, MaxLoad Pro is required to draw a very detailed solution on screen.
As a result, you may find the amount of time it takes to display the
solution to be unacceptable. To speed things up, MaxLoad Pro allows
you to turn off pallet details, which is one of the most common culprits
when a solution takes a long time to draw.

When this option is selected, MaxLoad Pro draws all pallet details
when displaying the solution (as left). These details include all deck
boards, stringers, etc. Else, the pallet will be illustrated in a simpler
format as on the right.

This option only applies to unitloads or mixed pallets drawn in a
transit vehicle. It does not apply to mixed-pallet manifests.

+ Show Unitload’s SKUs: When this option is selected, MaxLoad Pro
displays the individual SKUs that comprise a unitload (below left).

Else, the unitloads appear as one large shipcase of pallet size (below
right).

« Extended Key Mode: This option controls the way that you enter
information when building a load in the Manifest Pick List screen.
You have two options: Standard Mode and Extended Key Mode.

Standard Mode provides a quick and easy way to key in gquantities
only. When you select an SKU from the SKU List, that SKU will
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appear in the Manifest List with the cursor flashing in the Quantity
field. After you key in a quantity, pressing Enter returns the cursor to
the SKU List, where you can select another SKU. Repeat this process
until you've entered quantities for all SKUs in your manifest.

Extended Key Mode routes the cursor through all fields in the
Manifest List, as follows:

1.

After you select an SKU from the SKU List, the cursor moves to
the Quantity field of the Manifest List.

In the Quantity field, enter a quantity. Press Enter.
The cursor moves to the Priority/Stop-Off field.

In the Priority/Stop-Off field, enter a value (if applicable). Press
Enter.

The cursor moves to he UL (Unitload) column (if the column is
turned on in Configuration).

In the Unitload (UL) field, tap the space bar to toggle this field on
and off; the box shows an “X” when it’s on and is blank when it’s
off. Press Enter.

The cursor moves to the MP (Mixed Pallet) column, which works
the same way as the UL column.

In the Mixed Pallet field, tap the Space Bar to toggle this field on
and off; the box shows an “X” when it’s on and is blank when it’s
off. Press Enter.

The cursor moves to the Order Number column.

In the Order Number field, enter an order number (if applicable).
Press Enter.

The cursor moves back to the SKU List, where you can select
another SKU and start the process all over again.
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In Extended Key Mode, if you don't need to enter information — a
particular field is not applicable to your manifest — pressing Enter in
that field automatically moves the cursor to the next field. Pressing
Enter does not change any information in the field.

For instance, the Priority field will always show a default of “1.” If
this is acceptable and you don’t need to change this priority value,
simply press Enter to move to the next field. The priority value will
remain as “1.”

Check the Extended key mode option in the Configuration dialog box
for extended key mode, else leave it unchecked for Standard Mode.

+« Number Grid Lines: Gridlines are markers in the container spaced at
a user-defined interval. Gridlines provide a quick and easy reference
point for determining how much floor space remains in a loaded
vehicle. This option automatically numbers gridlines on a truck to
mark specific distances on the floor space. Gridlines apply only to
vehicles, not to pallets or slipsheets.

Note: This option works only if the Show gridlines option is checked.

+« Save to Library: This feature gives the user the flexibility to save
edited loads to library. If later they replicate a load, MaxLoad Pro will
show the saved edited load in the Sol List.

When enabled, you will see this feature as a check box option in the
File | Save As dialog box.

« Use European Date: Check this option to use the European date
format DD/MM/YYYY within MaxLoad Pro.

+« Graphics Screen Color: MaxLoad Pro allows you to control the
background color of the solutions graphics screens.
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To change the color of the solution and edit screens, follow these
instructions:

1.

Click on the color box in the Configuration dialog box to open the
Color dialog box.

G EE|

Basic colors:

Define Custom Colors »» |

Ok I Cancel |

Using the mouse pointer, select a new color and click on OK to
confirm.

To exit the screen and negate any changes, click on the Cancel
button.

% g.0.d. Screen Color: MaxLoad Pro even allows you to control the
color of all graphic-online-drawing (g.0.d.) windows.

To change colors, follow these instructions:

1.

2.

Click on the color box in the Configuration dialog box.
Using the mouse pointer, select a new color.
When you're finished, click on OK.

To exit the screen and negate any changes, click on the Cancel
button.
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% Show Gridlines: This option turns gridlines on and off in a vehicle.
Gridlines are markers in the vehicle spaced at a user-defined interval.
Gridlines provide a quick and easy reference point for determining
how much floor space remains in a loaded vehicle. Gridlines apply
only to vehicles, not to pallets or slipsheets. An example of a vehicle
with gridlines is pictured on the next page.

Note: Check the Number Grid Lines option to sequentially number
the gridlines.

20Ft Sea%an

X/
°e

Grid Interval: Once you've decided to show gridlines, you must
decide at what interval they will be spaced. You can control this
through the Grid Interval field. Simply key in a value that represents
the desired interval.

« Measurement Units: This field allows you to control the
measurement unit defaults. Whenever you begin a new manifest, the
measurement units that initially appear in the Manifest Pick List screen
will be controlled by this field.

To display the list — your only options are English and Metric — or
change units, click on the down-arrow on the right side of the box.
Use the mouse to click on the new selection.

For this change to be effective logout and log back into the software.

+ Placement Numbering: Placement numbering is an arbitrary method
to identify SKUs or groups of SKUs in the View Screen for easy
identifications. The four placement numbering options available are as
follows:

m Use Reference Number: Refers to a computer-selected number
that helps you determine which SKU is which, when viewing or
printing a solution. Each SKU is assigned a reference number
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when the load is calculated. When viewing a solution, the
Placement List contains a column that displays a key to the
numbering system.

m  Use SKU Number: Tells MaxLoad Pro to use SKU Number as a
placement number.

m Use Placement Number: Assigns each placement a unique
number. Because there may be multiple placements for different
SKU Numbers, you'll often notice that SKU Numbers are assigned
different placement numbers as you view the load.

m  Use Custom Label: Tells MaxLoad Pro to use the custom label
that you designated when defining an SKU.

Print: Print defaults can be set with one of these three options:

m Black & White: For non-color printer users, this option allows
you to print a black-and-white outline of the loaded vehicle, as
opposed to a gray-scaled printout. If you work with a color printer,
MaxLoad Pro will print a black-and-white printout when the
option is checked. If the option is not checked, the solution
diagram will print using the colors assigned when defining an SKU.

m  Color (Solid): In Print Preview, this option draws items on the
screen in solid colors, with the lines on the items drawn in black.

m  Color (Outline): In Print Preview, this option draws items on the
screen with only the outline of the item. The body of the item is
white, with the outline of the item drawn in color.

Note: Any changes you make to the Print defaults, become active
only once you log out of the software and then log back in again.

Printer Resolution: In an effort to speed up the printing process,
MaxLoad Pro gives you a choice as to how “coarse” or “fine”
printouts will appear. To change the setting, simply use the mouse
pointer to slide the handle in one direction or the other.

You will receive printouts faster when the setting is closer to “coarse.”
Printouts will take longer when you set this option closer to “fine.”
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Global Settings (Supervisor
Functions)

Only supervisor can enter and update global settings for the MaxLoad Pro
configuration. This section presents the Global Settings dialog box and
each of the global configuration options.

Global Settings
To enter and update the MaxLoad Pro global settings:

1. Login to MaxLoad Pro as a Supervisor. The password for supervisor
is “tops software”.

2. At the Control Center, go to the Tools menu and select Configuration.
The MaxLoad Configuration Screen appears.

3. Click on the Global button to access the Global Settings Screen
appears, as pictured below.

Global settings | X|

™ Show license information SkU Field

™ User Passwords Load Fulss

¥ User Modify SKU

¥ User Modify Contairers Diebault Print Layout:

[ User Modify Defaults -

[ Costing IManlfest j

W] [Leferer Loading railcar

¥ CaletlTrucks " Use 143

¥ Share MFT % |lze sidedoaor

[™ &uto replace same user

orce Carner Support clor Stop

™ Force Comer S ™ Caolor Stop Off

¥ Show Stopaff Dividers
Suppart Len IU Cancel |
Support i ID Help |

The Global Settings Screen contains the following options:

< Show license information: This switch turns off the license
information found in the bottom right hand corner of the Control
Center screen. When this box is checked, the license information will
appear.

When this box is unchecked, the license information will remain
hidden.

However, you can always access this information from the Menu Bar:
Open the Help menu and select About MaxLoad.
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User Passwords: Protects user logins with passwords. If checked,
users will be prompted for a password at the login screen.

User Modify SKU: Allows all users to modify, add or delete SKUs
from the database.

User Modify Containers: Allows all users to modify, add or delete
containers from the database.

User Modify Defaults: Allows all users to modify defaults set up in
the system.

Note: If any of the above User Modify feature is turned off then only
a user logged in as a Supervisor can make changes to SKUSs,
Containers, or Defaults, respectively.

Costing: Activates a decision-making tool for SKU/item costing in a
given manifest.

Labor Cost: Activates a decision-making tool for costing man hours
and labor involved in a given manifest.

Note: Costing and Labor Cost is undocumented features reserved for
specific customers. Contact TOPS Technical Support for details.

CalcAllTrucks: Activates the Calculate All Trucks feature, which
calculates solutions using as many trucks (the same truck currently
selected) as necessary to load a manifest. With this option enabled,
you can quickly tell the total quantity of VVehicles or Pallets (for Pallet
Manifest) needed to fulfill an order, as represented by the PicL.ist.

Share MFT: Allows all users to see all files. If this feature is turned
off, users can only see their own manifests.

Auto Replace Same User: Allows the supervisor to log out a user,
then automatically log in the same user.

Force Corner Support: Allows you to activate corner support when
placing SKUs on top of other SKUs. This involves defining the length
and width of the corner support.

m  Support Len: If you turn on the Force Corner Support option, this
field allows you to enter the length of the corner post in inches or
millimeters, depending on the Units selected.

m Support Wid: If you turn on the Force Corner Support option,
this field allows you to enter the width, or thickness, of the corner
post in inches or millimeters, depending on the Units selected.
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+«+ Show Stopoff Dividers: If this option is checked, MaxLoad Pro will
draw lines/ dividers to separate different stop offs.

If the overlapping between stop offs is allowed, the divider is placed at
the beginning of the next stop as illustrated below.

+ SKU Field Button: Displays the SKU List dialog box, which allows
you to display dimensions, weight and SKU information in the SKU
List on the Manifest Pick List Screen. If these fields are turned off, the
startup of MaxLoad will be much faster.

x

Select the fields in SKEU list
¥ Dimenzions
¥ gt

¥ SEU Info

Canicel |

+ Load Rules: In order to create customized solutions, MaxLoad Pro
makes use of specific loading algorithms or parameters saved in a text
file named “loadrules.ini” in the \Max2Pro\Data\folder. If such a file
is present, clicking on the Load Rules button will open this file and
displays its contents in the Load Rules dialog box.

Please contact TOPS for the use of load rules if MaxLoad Pro does not
provide the solution you are for.

¢ Default Print Layout: Select from the drop list the default MaxLoad
report that will be printed whenever the generic print command is
issued within MaxLoad.

+« Loading Railcar: Select an option — either Use 1/3 or Use Sidedoor —
to specify how a railcar will be loaded.
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Color Stop Offs: Color distinction for stop offs, thus making them
easily identifiable.

X/
°e

OK Button: Saves the changes made and closes the Global Settings
dialog box.

+«+ Cancel Button: Closes the Global Settings dialog box.

Defaults

The Defaults button opens the Defaults dialog box, as pictured below,
where you can easily select default unit of measure, the language and the
location for a graphical logo to be used in all reports within MaxLoad Pro.

Defaults
Urits lm
Language I.-’-‘«melican j
Logo Path IC:'\F'lngram Files\TOPSAPPS A anZProhtop: Browse |
[~ &pply to existing Lzers ¥ &pply to new users
’T‘ Cancel |

« Units: Globally selects the unit of measure for MaxLoad Pro.

X/
°e

Language: Selects from the drop list, one of the many languages
supported by MaxLoad Pro.

X/
°e

Logo Path: Allows you to specify the location for the graphical logo
to be printed on each of the report types from MaxLoad Pro.

« Apply to existing users: Check this box if the current default settings
are to be applied to the all existing users.

< Apply to new users: Check this box if the current default settings are
to be applied to all new users. These two boxed are not mutually
exclusive, you can check both options to have the new defaults apply
to all users.
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Fonts

The Fonts button opens the MaxLoad Fonts dialog box, pictured below,
where you can choose from multiple fonts to use when printing or viewing
a solution. MaxLoad Pro allows you to assign different fonts to 10
different heading/text types located throughout system.

MaxLoad Fonts E2
Small Font M axload Pro: Your Load Planning E xpert. Change |
Reqular Fant MaxLoad Pro: our Load Planning Expert. Change
Dialog Fomt Mauload Pro: our Load Planning Espert. Change
List Font M axload Pro: Your Load Planning E xpert. Change
List Header Font axLoad Pro: vour Load Planning Expert. Change
Statiztics Font MaxLoad Pro: Your Load Planning Expert. Change
Pririt Fiarit MaxLoad Pro: Your Load Planning Change
Prirt Header Font Maz=Load Pro: Your Load Plannina Change
Frirt List Header Font MaxLoad Pro: Your Load Plannina Change
Labels Fant Change |

RA mrsl amal
Ok I Cancel |

To change a font, follow these instructions:

1. Click on the Change button next to the text/heading style that you
want to modify.

A standard Windows Font dialog box appears. This Font dialog
box is similar to that found in most major word processing/spread-
sheet programs.

Font
Font shyle: Size:
S Sans Serif IHeguIar Ig oK, I
r- i = |
MS Serif Italic 10 Cancel
M5 SystemEx Bold 12
B WS Ul Gothic: Bold Italic 14
% MT Extra - 15
k' Boli 24
B Markisim d =l
r Effects Sample
[ Stikeout
AaBbY
™ Underline SEEL
Calar:
I Elack - Script:
IWestern |
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2. Make the appropriate changes, then click on OK.

3. To exit the MaxLoad Fonts dialog box without saving any changes,
click on Cancel.

Note: As a suggestion, we've found that the Arial Bold font are the
easiest to view.

Properties

In addition to the Configuration dialog box, MaxLoad Pro provides a
number of Properties Sheets that allow you to define the various defaults
and properties in the system. All users have access to these Properties
Sheets.

Each field is linked to a Properties Sheet dialog box, which allows you to
change both defaults and/or properties for the specific field. This provides
a general overview of the defaults/properties functions in MaxLoad Pro.

Similar fields have similar Properties Sheets. In MaxLoad Pro, the various
fields fall into one of four categories:

% Lists: A collective display of various fields. For example SKU List.

% Measurement Input Fields: Fields that contain a dimension or
weight.

% Non-Measurement Input Fields: Fields that contain numeric values,
but don’t measure anything.

% Radio Buttons: Fields that contains radio buttons.
<+ Check Boxes: Fields that contain check boxes.

Regardless of field type, all fields allow you to change their Control Label
(name). You’ll use the Properties Sheet to change a field’s Control Label.

To access the Properties Sheet dialog box, use one of two options:
Option 1
1. Click on the field whose properties you want to change.

2. From the Menu Bar, open the Edit menu and select Properties. The
Properties Sheet dialog box appears.
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Option 2

1. Right click on the name of the field that you wish to change properties.
A Properties button appears.

2. Left click on the Properties button. The Properties Sheet dialog box
appears.

Lists

Working in the software you will notice that there are various lists, like
SKU List, Manifest List, Sol List, Placement List, displaying important
information about SKUs, unitloads, mixed pallets, solutions, etc. The
type of information displayed in these lists can be controlled by the
Properties feature. The Properties dialog box for Lists can only be
accessed by the Edit menu.

For example, to view the Properties for the SKU List follow these
instructions:

1. Select any column header in the SKU List, by clicking on the tab for
SKU, Description, etc.

2. From the Menu Bar, open the Edit menu and select Properties. The
Properties dialog box appears. Here you can check and uncheck as to
what needs to be visible in the SKU List.

Properties l_

-
¥ skEL Cancel

¥ Description —l
¥ Dims

v wigt

[ SKUlInfa 1

[~ SEU Infa 2

™ SKEUInfo 3
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Measurement Input Fields

All Define Screens (for example, Define SKU) contain measurement input
fields. You’ll use this type of field type to input the dimensions or weight
of an object.

When you access the Properties Sheet for a measurement input field,
you’ll notice that it’s comprised of two tabs: Defaults and Properties.
Both tabs contain nearly identical information, except that the Defaults tab
also allows you to change the name of the field (the Control Label) and
has a Default Value field. The Defaults and Properties tabs are pictured
below.

Urits——————
™ English
 Metric
C |
= Global _ Caneel |

Default Value n.oa

Decimal places [English] |2
Decimal places (Metric) |2

Units bppe [Englizh) in -

Urits type [k etric) mm -

I Twncate zeros

I Show hractions

Contral label Length

i

Uritg—————
™ English
" Metric
C |
' Global s

Decimal places [English) |2
Decimal places [Metric) I2

Urits type [English) in -

Urits tupe [Metric) T -

™ Truncate zeros
I Show hractions
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% Defaults Tab: Changes made to the Defaults tab affect all future
SKUs, pallets or vehicles that you define, including the one that you
are currently defining.

For instance, suppose you’re in the Define SKU screen and you
change how MaxLoad Pro reports length — from inches to feet, under
the Defaults Tab. Not only will this affect the SKU you’re editing,
this action will also affect all future SKUs that you define.

% Properties Tab: Changes made to the Properties tab will only affect
the individual SKU, pallet or vehicle that you’re currently defining,
and will not affect any future records. .

Principally, the Properties Sheet allows you to set the measurement
units for a particular field.

The Properties Sheet dialog box also allows you to do the following:

+« Change the measurement units for the field that you are making
changes to. There are three choices in regards to measurement units;
English, Metric, or Global. English and Metric are self-explanatory.
But if you choose Global, MaxLoad Pro uses the measurement units
selected in the toolbar.

% Set a default value for that parameter. This field is only available
under the Defaults Tab.

% Set the number of decimal places, in both English or Metric, to be
displayed for each field.

% Change the Unit Type — inches, feet/millimeters, centimeters, etc.

% Check whether or not you want MaxLoad Pro to truncate zeroes (i.e.,
display zeroes after the decimal point).

% Input fractions rather than decimals with the Show Fractions feature.

+«+ Change the name of the Control Label for each field. For example
change the name of height to depth. This field is only available under
the Defaults Tab.
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Non-Measurement Input Fields

Non-measurement input fields are not as common as measurement input
fields. You’re most likely to run across these fields only when you’re
defining stacking relationships.

The Define SKU screen provides a good example of this type of field.
Under the Stacking tab, the fields labeled Maximum Stack Height (On
Base and On Side) are considered Non-measurement input fields. In the
Define Pallet screen, the field labeled Total Deck Boards is another
example of a non-measurement input field.

A Non-Measurement Input screen accepts only whole numbers and is
generally used when answering the question “How many?” These fields
accept a maximum of three characters.

Propetrties Sheet x|
Defaults I
Cancel |
Default Yalue 100

Contral label IMax Stack Height

Notice that there’s only one tab in this dialog box: Defaults. When you
make a change in this field, it will not affect any previously defined items
but it will affects all future SKUs, pallets or vehicles, including the one
you’re currently defining. You can also change the name of this field
using the Control Label feature.

Radio Buttons

Radio buttons contain their own default behavior. Remember that radio
buttons are mutually exclusive, meaning that you can choose only one
option; you cannot select multiple options. Because radio buttons are
unique in behavior, they also must have a unique Properties Sheet.

Regardless of which field you click on in a radio button box, you’ll always
access a common Properties Sheet; in other words, all buttons tie into the
same sheet. As with non-measurement input fields, this dialog box only
contains a Defaults tab, meaning that changes made to the Properties Sheet
will affect the item you’re currently defining, as well as any future items
that you define.
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Propetties Sheet

Defaults I
Default Value Contral Label
" Load By Length ILUad By Length
" Load By width ILoad By width
% Best Fit IBest Fit

Check Boxes

Check boxes allow you to turn certain MaxLoad Pro features on and off.
Unlike radio buttons, check boxes are not mutually exclusive, meaning
that each one behaves independently of the other. Because of this
behavior, check boxes are considered unique enough to warrant unique
Properties Sheet. There’s one exception: the check boxes in the Allowed
Vertical Column, whose Properties Sheet behaves in much the same
fashion as a radio button.

Properties Sheet =
Defaults I
I Default Yalug Cancel |
Contral label IUSE UritLoads

To change a check box default, access the Properties Sheet for the specific
field that you want to change. Unlike a radio button Properties Sheet,
each field has its own separate Properties Sheet. Use your mouse to click
on or off the Default Value for that field. Notice too that you can change
the Control Label for the field in question. When you’re finished making
changes, click on OK to exit the Properties Sheet.
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Examples

Below are some examples illustrating how to change the defaults for some
common functions and features within MaxLoad Pro:

Example 1: Changing the Default Vehicle Type

If you use mostly sea vans or sea containers for your loads, you can
change the vehicle type from the current default of Truck to Sea Van by
following these steps:

1. At the Manifest Pick List Screen, place the mouse cursor anywhere in
the Vehicle Type section and right click the mouse button. The
Properties button appears.

2. Click on the Properties button. The Properties Sheet for the Defaults of
the current field (\Vehicle Type) appears as shown here, showing the
current default of “Truck”.

Properties Sheet
Defaults |

Default Walue Cantral Label
* Truck ITruck
{" SeaVan ISeaVan
" Rail Car |F|ail Car
" Railwagon IHaiIW’agnn
" Multi Zone IMultiZone
" Double Trailer IDguble Trailer
" ULD IULD
" SideBay ISideBa_l,l
" Flatbed IFIatbed
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3. Click on “Sea Van”, making it the new default vehicle type. The radio
button for Sea Van is now selected.

4. Click on OK to use the new default. The Confirm dialog box appears

as below.

Canfirm save changes to default,

Yes Mo |

5. Click on Yes to confirm the change.

This new default will take effect when you do a new Truck or Single SKU
Manifest.

Example 2: Adding a Default Selected Vehicle

When you do a new Truck or Single SKU Manifest, you will have to
select a vehicle from the Available Vehicles list. If all your loads only go
into 53 Ft Dry Van, you can set this as the Default Selected Vehicle so you
don’t have to specify the vehicle every time you create a new manifest.
The following steps illustrates how to add a default selected vehicle.

1. At the Manifest Pick List Screen, place the mouse cursor anywhere in
the Selected Vehicle section and right click the mouse button. The
Properties button appears.

2. Click on the Properties button. The Properties Sheet for Selected
Vehicle appears as shown here, showing the current default of “None”.

Defaults I
Cancel |
Default Y alue Mok j
Control label ISeIected Wehicles

3. Click on the drop list (¥) and then move the scroll bar until you see
53 Ft Dry Van on the list.
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Properties Sheet E

Defaults I

Cancel |

Default Y alue lm j

A0 Ft. Zone Loading -

B3 Ft. [Marrow]

B3 Ft. Drop Deck —

B3 Ft. Dwal Drop Deck k

57 Ft. Dy Wan

B0 Ft Bomcar 4
Contral label ISeIected Wehicles

4. Click on “53 Ft Dry Van” to make it the current selection and then
click on the OK button.

5. You will see a Confirm dialog box as in the previous example. Just
click on the Yes button to confirm.

You will see the “53 Ft Dry Van” as the Selected Vehicle whenever you
create a new Truck or Single SKU Manifest.

Example 3: Changing the Default Mixed Pallet Height

When you create a Pallet Manifest or placing mixed SKUs on a pallet, you
can specify how high the pallet can stack (Maximum Height Incl Pallet).
The default value in MaxLoad Pro for this parameter is 55 inches. To
change this default value, please follow these steps:

1. At the Manifest Pick List Screen for Mixed Pallet, place the mouse
cursor at the text “Maximum Height Incl Pallet” and right click the
mouse button. The Properties button appears.

Mired Pallet I Optians | Comments |

Pallet | GMa Notched =l [ven

Calculate |
b awirurm Height Incl Pallet rialEn
bd axirnuin ‘wieight Incl Pall

bd amirnuim Length Overhang (img{1.00

b awirnuin width Overhang firg{1.00
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2. Click on the Properties button. The Properties Sheet, with Properties
tab as the active tab, appears.

3. Click on the Defaults tab. The Defaults tab, as shown here, appears.

Properties Sheet [ %]
Defaults | Properties |

Units————
i Englizh
" Metric
C |
& Global _ Carcel |

Default Yalue |55.EIEI
Decimal places [Englizh) I2
Decimal places [Metric) |2

Units type [Englizh) in -

Urits type [Metric) mm -

[ Truncate zeros
[ Show fractions

Contral label b awirnum Height [ncl Pallet

4. Change the “Default Value” from 55.00 to 60 and click on the OK
button.

5. You will see a Confirm dialog box as in the previous example. Just
click on the Yes button to confirm.

You will see the new default value in the Maximum Height Incl Pallet
field when you create a new Pallet Manifest or under the Mixed Pallet tab
in a new Truck Manifest.

You can follow this example to change the default Overhang Values for
pallets.
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Import/Export Functions

Introduction

Customers often need to import bulk amounts of data and MaxLoad Pro
can accommodate this need. If the product's name, weight and dimensions
can be collected, this data can then be properly arranged in an Excel
document for import into MaxLoad Pro. Most ERP systems, like SAP, for
example, can export product data in a comma delimited ASCII format,
which can be transferred to an Excel document for import. You can find
an example of such a file in your Max2Pro (or Max2Demo) folder and the
file name is Import.xls.

The various Import and Export options available in MaxLoad Pro are:
% Import (Generic)

= MaxLoad Pro ASCII Interface
= Import Command Entries

= |Import Record Entries

= Units Data Field

«» Import - XML
«» Import Tops Data
% Custom Import

= |mport SKU

= Config SKU Import

= |Import Picklist

= Config Picklist Import

+« Export Databases

« Export - XML

%+ Export by Placement

%+ Custom Export (Solution, Placement List, Load List)

«» Export - Summary
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Export - Mixed Pallets
Export — UnitLoads
Export Manifest
Email Manifest

Ftp Import
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Import (Generic)

Use the Generic Import function to import data which conforms to
MaxLoad Pro’s ASCII Interface Format as described in the following

section.
import:

1. Login to MaxLoad Pro.

Once the import file is created, follow these instructions to

2. From the Menu Bar, open the Tools menu, select Import. A sub menu

appears.

3. Select Import (Generic) which opens the Import File dialog box as

shown below.

Import a file

Laak ir: I I Data

E;Jr:f

©

zkhop

4

My Documents

iy Cannputer

'ﬁ File: narne:
-

7] x]
[ I = e =

E:I b @=Pro bt
[Z] test.tat

I“.T:-ct j Open I
Files of type: I[_T:-:t] j Cancel |

[.C5Y)

00 7

4. Highlight the file to be opened and click on the Open button. Then

click Import.

MaxLoad Pro will start importing the data. You will see the status of
the process in the pop-up Importing dialog box.
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MaxLoad Pro ASCII Interface

MaxLoad Pro ASCII interface is flexible and easy to implement. The
ASCII file which gets imported into MaxLoad Pro should comply with the
import template. A sample IMPORT.XLS file (import template) has been
included with the software. This file is accessible through the Start Menu
Shortcuts under “TOPS for Windows APPS” menu and can even be found
in the Max2Pro/Max2Demo directory.

As Maxload Pro accepts files with both .TXT and .CSV extensions, the
data can be exported from another system in comma delimited text file and
then triggered as per the import template or created in Microsoft Excel and
then saved as CSV file (Comma Separated Values). The resulting file is
readable by MaxLoad Pro. The import file can contain Import Commands
that force the software to execute additional functions such as deleting
other manifests, exiting after import, chaining to another import file, etc.

The import file is then imported into MaxLoad Pro either using the Import
function in the Tools Menu or a command line parameter for automatic
import. When importing from ASCII MaxLoad Pro fills in any fields that
are missing or incomplete. It does not perform this error checking during
regular operation. Any field that is left blank gets filled during the import
using the system defaults (as if the user had been entering the information
from the keyboard).

Import Command Entries

[Version] Every MaxLoad Pro import/export file begins with the
header [Version]. The next line denotes the MaxLoad
Pro software version from which the data is being
exported or being imported into. When creating an
import file, this information is listed on the first two

lines.

[English]/ When exporting/importing, one of these two “flags” is

[Metric] included after the [Version] section to indicate the
current default units in the software.

[Delete] After import or before chaining, delete the imported
file.

[Rename To] After import or before chaining, rename this file to the

name indicated on the next line. If both [Delete] and
[Rename To] are indicated, [Delete] takes precedence.

[Chain To] After importing the current file, import the file listed
on the next line, deleting or renaming this file as
previously specified.

ll::Q:e:c’ill’ SKU Delete all SKU’s from the SKU database.
ile
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[Clear Truck
MFT]/[Clear
Vehicle MFT]

Delete all Truck/Vehicle Manifests for all users.

[Clear Pallet

Delete all Mixed Pallet Manifests for all users.

MFT]

[Clear Tote Not implemented.

MFT]

[CI:eIar Single Delete all Single SKU Manifests for all users.
MFT

[Clear ALl MFT]

Delete all manifests for all the users.

[Exit]

After completion of import, exit the program.

Import Record Entries

[ContainerList]

This is an optional section and indicates what vehicles
(containers) the manifest should attempt to load its
SKUs into. If this section is not included then no
default container is assigned to the manifest and the
user has to manually select a container before
calculating the manifest.

[Manifest]

Manifest even referred as “order” or “shipment”
describes the type of container to be loaded, what
loading patterns will be used. Use subsequent
[PickList] records to define what SKU’s will be
loaded.

[Pallet]

Descriptions of the pallets a SKU can be loaded onto.

[PickList]

The PickList section lists the SKUs to be loaded to a
manifest. It includes manifest fields like - SKU
guantities, priority, order #, whether to unitize it, etc.

[PlaceList]

Use by calculated loads to record the location of each
loaded item in a container/pallet.

[SKU]

Each record describes a SKU and includes SKU type,
SKU name, descriptions, dimensions, orientation
preference, piece count and other related information.

[Stack]

A list of the current stack codes and their default states.
Does not contain a complete description of the
stackability matrix.

[Tote]

Not implemented.

[UnitLoad]

Describes which pallet to use for a given Manifest,
SKU, or Mixed Pallet. Also specifies what overhang,
underhang, etc. to use instance.

[User] record

Individual user settings including, Name, Stackmatrix
path, and other settings found under the Configuration”
menu.

[Vehicle] Descriptions of the vehicles that may be loaded.
un lfg Data Anytime a distance, weight, area, volume, or percent is
Fie

exported it is formatted/described using the Units Data
Field format. (See the next section.)
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Units Data Field

The following information is the breakdown of the units’ field used by
MaxLoad Pro while exporting and importing. The following types of
Units fields are used in MaxLoad Pro: Dimensions, Weight, Volume,
Area, and Percent (English/Metric is ignored).

When a field is a numerical floating point value, such as a distance (inches)
or weight (kilograms), it will be stored as a Units field. This includes all
the formatting data required to display in either English or Metric units.
Internally, the value is stored as a standardized English value. A Units
field contains a number of sub-fields. The entire set is exported as a
character string enclosed in quotes. The sub-fields are space-delimited
inside this string.

“12 (in) GN N O 0 2 3”

Subfield: |1 2 3 4 5 6 7 8 9
Name: [value |units |english/metric |fractions |zeros [english convert |metric convert |#decimals |#decimals
Example: |12 (in) (G N 0 0

Subfield Descriptions

1. Value: This value will be translated to its internal English
representation upon import. Fields 3, 6, and 7 are used to convert
this number to its internal English representation. If this is the only
field entered for a unit, it need not be in quotes. In that case, all
other fields will be imported as the current system defaults. When
MaxLoad exports this value from the program it will adhere to all
the display parameters that were set, this means that exporting and
re-importing could loose a few significant digits or end up rounded
to the nearest 64™.

2. Units: Textual representation of the type of units, (in), (gr), (1bs), etc.
This field is currently ignored by the import parser and may be any
value. It is exported to ease the reading of ASCII file.

3. English/Metric: Instructs the program to convert units.

m E - English, convert using sub-field 6

m M - Metric, convert using sub-field 7
G - Global, during a normal export the current global state is
exported so that the appropriate state can be “assumed” on re-
import. See the [English] and [Metric] sections
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4. Fractions:

= Y - Display with fractional parts rounded to the nearest 1/64"
m N - AsDecimals with the appropriate number of decimal places

5. Zeros:

m Y - Show significant figures after the decimal point.
N - Truncate trailing digits after the decimal

6. English Convert: An index into the English multiplier table. The
multiplier is used to convert the internal value to and from the
displayed value. Each type of Units field has its own multiplier
tables.

7. Metric Convert: An index into the Metric multiplier table.

8. English Decimals: The maximum number of significant digits after
the decimal to show when displayed in English.

9. Metric Decimals: The maximum number of significant digits after
the decimal to show when displayed in Metric.

All sub-fields except sub-field 1 are optional when creating your own
import file. However, you may not skip one and enter the next. This
would confuse the parser. For example, you may enter 12, “12”,
“12 (in) G”,or “12 (in) G Y N O O, but not 12 (in) G
O 0. The missing sub-fields will be filled by the defaults for the
particular field (ex: the weight field for an SKU or the Length field of a
pallet). Careful coordination must be used if you skip these sub-fields.
Know your defaults.

In the following few pages we will discuss some of the Import Record
Entries in detail. Please follow this key to better understand Record Entry
Tables for each Entry:

Note: A ‘Y’ indicates that the mentioned pallet pattern is allowed.
Patterns switches only apply to Single SKU Manifests and UnitLoads.

Reserved: These fields are reserved for future use. Items may have
values when exported but should not be constructed by the user for import.
Allow the system to fill them in during import.

Italics: Items in italics are not currently implemented. Leave these blank.

(#): On some of the string values below, a number can be found in
parentheses. This number represents the maximum field width.
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[SKU] Record

This record field is used to define SKUs. Each record describes a SKU.

Column | Name Type Description
A SKU Type Numeric 0 — Unknown
1 - Carton
2 - Tray
3 — Shipcase
4 - Bag
5-Tub
6 — Drum
7 — Bottle
9 — Tote SKU
10 — Pallet SKU
11 - Unitload / Pallet Load
13— L Shape SKU
B Name String (32) SKU Number
C Description String (50) SKU Description (Optional)
D MFT
E Pallet String (32) Name of the pallet to Unitize this SKU
onto.
F SubType Numeric 0 — Unknown
1 - Single Ended bags
2 — Double Ended Bags
3 —Round Drum
4 - Ovals
5 — Rectangular
6 — Mixed Pallet
G Length Distance SKU length or SKU diameter for drum
style SKUs.
H Width Distance SKU width
| Height Distance SKU height.
J Weight Weight SKU weight.
K-M Reserved Reserved — Distance
N Max Stack Weight Maximum weight allowed to be
Wgt stacked on this SKU
O Length Vert Y/N Y - Length is allowed Vertical (End
Stack)
P Width Vert Y/N Y - Width is allowed Vertical (Side
Stack)
Q Height Vert Y/N Y - Height is allowed Vertical (Bottom
Stack)
R Unitize Y/N Y —MaxLoad Pro will use this SKU as

a unitload whenever possible.
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S Mixed Pallet Y/N Y - This SKU may be placed on a
pallet with other SKU’s after as many
full pallets of this SKU as can be have
been constructed (that is, put leftovers
on mixed pallets).

T Tote

U Has UL Y - A UnitLoad Record exists for this
SKU. If the user indicated that he
wants the SKU unitized, it will use this
pre-defined UnitLoad for full pallets of
the SKU instead of generating one on
the fly.

V Stagger Y/N Mostly used for cylindrical shape
SKUs.

W Preferred Vert | Numeric 0 - Length
1 - Width
2 - Height
3 - No Preference

X Label Surface | Numeric 0 - Length
1 - Width
2 - Height

Y Dead Stacking | Numeric 0 - Must be stacked floor

Rules 1 - Must not be stacked on floor
2 — Best Fit
3 — Prefer on Floor
4 — Prefer on Top
Z Load Into Numeric 0 - Length
vehicle 1 - Width
2 - Best Fit
AA Stack Code String (20) Stack Code from stack matrix.
AB Max Stack Numeric Maximum number of cases allowed
Height (On high (of Self) when upright.
Base)
AC Max Stack Numeric Maximum number of cases allowed
Height (On high when on side or on end.
Side)

AD Color Numeric Decimal representation of a 4 Byte
RGB value (see values on the next
page)

AE Label String (20) Another name for the SKU besides
SKU Number

AF Top Graphic String (255) | Full path to the paste on graphic file to
be shown on top of the SKU.

AG Side Graphic | String (255) | Full path to the paste on graphic file to
be displayed on the side of the SKU

AH Front Graphic | String (255) | Full path to the paste on graphic file to
be pasted on the front of the SKU

Al SKU Info 1 String (64) Additional notes fields for SKU. This
info gets displayed in the SKU List and
the Manifest List but not on reports.
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Al SKU Info 2 String (64) Same as SKU Info 1
AK SKU Info 3 String (64) Same as SKU Info 1
AL — AX | Reserved Reserved
AY Piece Count Numeric This reflects the quantity of items
going in the SKU.
AZ No Stack Side | Y/N Nothing can stack on top of this SKU
if it’s side loaded
BA Bundle Count | Numeric Number of items in a bundle (first
1 preference)
BB Bundle Count | Numeric Number of items in a bundle (second
2 preference)
BC Bundle Count | Numeric Number of items in a bundle (third
3 preference)
BD Load Location | Numeric 0 - Load in front
1 - Load in middle
2—Load in rear

Color Values for SKU Import

Use the decimal value on the far right to represent the color of SKU when
doing a generic import of SKU as explained in the previous section.

Red RGB(255,0,0) 255
Maroon RGB(128,0,0) 128

Light yellow RGB( 255, 255, 128) 8454143
Yellow RGB( 255, 255, 0) 65535
Light Orange RGB( 255, 128, 64) 4227327
Orange RGB( 255, 128,0) 33023
Olive/brown RGB(128,128,0) 32896
Light green RGB( 128, 255, 128) 8454016
Neon Green RGB( 128, 255, 0) 65408
Green RGB( 0, 255,0) 65280
Medium Green RGB( 0, 255, 128) 8453888
Aqua/Teal RGB( 0, 128, 128) 8421376
Light Cyan RGB( 128, 255, 255) 16777088
Cyan RGB( 0, 255, 255) 16776960
Blue RGB( 0, 0, 255) 16711680
Dark blue RGB(0, 0, 128) 838608
Pink RGB( 255, 128, 255) 16744703
Magenta RGB( 255, 0, 255) 16711935
Rose RGB( 255, 0, 128) 8388863
Purple RGB( 128, 0, 255) 16711808
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[UnitLoad] Record

UnitLoad Records are used to describe the parameters needed to display
items grouped together on a pallet. This includes unitloads for individual
SKUs, the mixed pallet parameters for truck Manifests, and the parameters
for mixed pallet manifests.

Column | Name Type Description

A Type Numeric 0 - UnitLoad
1 - Mixed Pallet on a Truck
2 - Mixed Pallet Manifest

B Name String (64) Name of SKU or Manifest, depending
on type. SKU names are limited to32
characters while Manifest Names can
be up to 64 characters.

C Pallet String (32) Name of Pallet being used.

D Stack Code String (20) Stack code (from Stack Matrix) to use
when loading into vehicle.

E-N Reserved Reserved

0 Stack Height Numeric Number of SKUs/loads allowed to be
stacked on one another.

P Stack Rules Numeric 0 - Must be stacked on floor
1 - Must not be stacked on floor
2 - Best Fit

Q Load Into Numeric 0 - Load By Length

vehicle 1 - Load By Width
2 - Best fit.

R-T Reserved Reserved

U Corner Posts Y — Place corner posts on the unitloads

V-Z Reserved Reserved

AA Block 1 Y/N Note 1 - One Block (Columnar)

AB Block 2 Y/N Note 1 - Two Block (Interlock)

AC Block 3 Y/N Note 1 - Three Block (TriBlock)

AD Block 4 Y/N Note 1 - Four Block (Spiral, Pinwheel)

AE Block 5 Y/N Note 1 - Five Block (Filled Spiral)

AF Block 5P Y/N Note 1 - Five Block Plus (Double
spiral with Fill)

AG Soldier Y/N Note 1 - Soldiered

AH Diagonal Y/N Note 1 - Diagonal

Al Reserved Reserved

Al Multi-Dim Y/N Note 1 - Allow each layer to have a
different case dim vertical.

AK Multi-Surface | Y/N Note 1 - Using the one through four
blocks, load as though gravity were
pulling toward the wall.

AL Multi-Layer Y/N Note 1 - Allow top layer to be any

dimension vertical regardless of
dimensions allowed vertical for this
SKU (because it’s on top).
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AM Stagger Y/N Note 1 - Allow staggered patterns for
round objects.

AN Max. Len. Distance Distance cases are allowed past edge of

Overhang pallet.
AO Max. Wid. Distance Distance cases are allowed past edge of
Overhang pallet.

AP Max Height Distance Maximum unitload height.

AQ Max Weight Weight Maximum unitload weight

AR Corner Posts Distance Thickness of material for corner posts.

Support
Length
AS Corner Posts Distance Width of corner posts.
Support Width
AT Max Stack Weight Maximum weight of items allowed
Wat being stacked on top of this UL.

AU Max Vert Gap | Distance Maximum height difference between
adjacent mixed pallet items to be
considered level when loading items
onto them.

AV - AY | Reserved Reserved

AZ Block 1 Y/N Note 2 - One Block (Columnar)

BA Block 2 Y/N Note 2 - Two Block (Interlock)

BB Block 3 Y/N Note 2 - Three Block (TriBolck)

BC Block 4 Y/N Note 2 - Four Block (Spiral, Pinwheel)

BD Block 5 Y/N Note 2 - Five Block (Filled Spiral)

BE Block 5P Y/N Note 2 - Five Block Plus (double spiral
with fill)

BF Solider Y/N Note 2 - Soldiered

BG Diagonal Y/N Note 2 - Diagonal

BH Reserved Reserved

BI Multi-Dim Y/N Note 2 - Allow each layer to have a
different case dim vertical.

BJ Multi-Surface | Y/N Note 2 - Using the one through four
blocks, load as though gravity were
pulling toward the wall.

BK Multi-Layer Y/N Note 2 - Allow top layer to be any
dimension vertical regardless of
dimensions allowed vertical for this
SKU (because it’s on top).

BL Stagger Y/N Note 2 - Allow staggered patterns for
round objects.

BM Len Overhang | Float Distance cases are allowed past edge of
pallet.

BN Width Float Distance cases are allowed past edge of

Overhang pallet.

BO Max Height Float Maximum Height for calculating
UnitLoad.

BP Max Weight Float Maximum Weight for calculating

UnitLoad
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BQ Corner Post T | Float Thickness of material for Corner Posts

BR Corner Post W | Float Width of corner posts.

BS Max Stack Float Maximum weight of items allowed to

Wat be stacked on top of this UL.

BT Max Vert Gap | Float Maximum height difference between
adjacent mixed pallet items to be
considered level when loading items
onto them.

BU Length Float Reserved. Calculated length of loaded
UnitLoad .

BV Width Float Reserved. Calculated width of loaded
UnitLoad.

BW Height Float Reserved. Calculated height of loaded
UnitLoad.

BX Weight Float Reserved. Calculated weight of loaded
UnitLoad.

Notes

1. The Decimal representation of a bit field defining the layers that are to
be rotated. Bit 1 = bottom layer. Max of 32 bits.

2. A ‘Y’ indicates that the mentioned pallet pattern is allowed. Patterns
switches only apply to single SKU UnitLoads (Not Mixed Pallet

Loads).

3. Reserved Items may have values when exported but should not be
constructed by the user for import. Allow the system to fill them in

during import
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[Manifest] Record

Manifest even referred as “order” or “shipment” describes the type of
container to be loaded, what loading patterns will be used. Use
subsequent [PickList] records to define what SKU’s will be loaded.

Column | Name Type Description

A Name String (64) Name of the manifest.

B User Name String Name of user creating this manifest. If
left blank and user logins are active,
only Supervisor will be able to open.

C Manifest Type | Numeric 0 - Vehicle
1 - Pallet
2-Tote
3 - Single SKU

D Units E/M E - English
M - Metric
G - Global Setting to be put into place
when opening this manifest

E-G Reserved Reserved.

H Show Flaps Y/N Y - Show Flaps on cases.

I Vehicle Type | Numeric 0 - Truck
1 - Sea van
2 - Railcar
Vehicle manifests only.

J Use YIN Y - Put SKU’s on pallets (unitize) -

UnitLoads Vehicle manifests only.
K Use Mixed Y/N Y - Put SKUs on mixed pallets -
Pallets Vehicle manifests only.

L Reserved Reserved

M Group Orders | Y/N Y - Attempt to keep items with the
same stop off or priority and the same
order number near each other in the
load. This may cause a loss of
efficiency.

N Group Like Y/N Y - Attempt to keep SKUs with the

SKUs same stop off or priority clustered in
the load.

o] Load Frontto | Y/N Y - Use the standard front to back

Back algorithm.
P Load Floorto | Y/N Y - Use the optional floor to ceiling
Ceiling algorithm. This algorithm does not
handle multiple stop off’s or priorities.

Q Load by Y/N Use the priority system rather than the

priority stop off system.

R Load by stop | Y/N Use the stop off system rather than the

off priority system. Do not set both load
by priority and load by stop off to ‘Y’
S-U Reserved Reserved
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Column | Name Type Description

\Y Max Cargo Weight Maximum weight allowed in load.
Wat

w Min Vert Distance For vehicles only. The amount of
Clearance ceiling clearance required.
X Max Vert Gap | Distance Maximum height difference between
adjacent items to be considered level
when loading items onto them.
Y Max Overlap | Distance The distance down the length of the
vehicle one priority or stop off can
overlap the previous priority or stop
off.
Z Reserved Reserved
AA Block 1 Y/N Note 1 - One Block (Columnar)
AB Block 2 Y/N Note 1 - Two Block (Interlock)
AC Block 3 Y/N Note 1 - Three Block  (TriBlock)
AD Block 4 Y/N Note 1 - Four Block (Spiral, Pinwheel)
AE Block 5 Y/N Note 1 - Five Block (Filled Spiral)
AF Block 5P Y/N Note 1 - Five Block Plus (Double
Spiral with fill)
AG Soldier Y/N Note 1 - Soldiered
AH Diagonal Y/N Note 1 - Diagonal
Al Reserved Reserved
Al Multi-Dim Y/N Note 1 - Allow each layer to have a
different case dim vertical.
AK Multi-Surface | Y/N Note 1 - Using the one through four
blocks, load as though gravity were
pulling toward the wall.
AL Multi-Layer Y/N Note 1 - Allow top layer to be any
dimension vertical regardless of
dimensions allowed vertical for this
SKU.
AM Stagger Y/N Note 1 - Allow staggered patterns for
round objects.
AN Reserved Reserved
AO Load Layers Y/N Y - For mixed pallet manifests,
Attempt to load complete layers of
SKUSs, as defined in the individual
UnitLoads for those SKUs, before
loading loose cases.
AP Reserved Reserved
AQ Mixed Pallet Numeric Number of mixed pallets generated by
Count this Vehicle Manifest.

AR - AU | Reserved Reserved

AV Load Space Y/N Y - Load using the Space evenly
Evenly algorithm

AW Load using Y/N Y - Apply Left to right optimization to
L/R the other algorithms when loading

AX MFT String (128) | An optional comment field that appears
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Column | Name Type Description
Comment 1 on reports.
AY MFT String (128) | An optional comment field that appears
Comment 2 on reports.
AZ MFT String (128) | An optional comment field that appears
Comment 3 on reports.
BA Report Type Numeric Indicates which views to print
1 - 3D Front
2 - 3D Back
4-Top
8 - Side
16 - Front.
BB Show Y/N Print cases with Paste on
Graphics
BC Print Style Numeric 0-B/W
1 - Color Outline
2 - Color throughout
BD Resolution Numeric Integer between 50 and 100. 100 -

Fine print using the largest Bitmap we
can make, AKA fine. 50 - Course.

[ContainerList] Record

The ContainerList Record indicates the vehicle(s) to be loaded by this
manifest. Mixed pallet manifests do not use this record and Single SKU

manifests use exactly one container.

Column | Name Type Description
A MFT Name String Manifest that this vehicle is being used
(64) in for. Must already exist.

B Vehicle Name | String As found in the vehicle database. Must
already exist.

C Number Numeric Which truck should this vehicle be
assigned to? If there are multiple
trucks of SKUs, then this would
specify that the vehicle was for the nth
truck. Normally should be 1 for new
manifests.

D Current Y/N Used when “View” is clicked. The
current vehicle is the one displayed.

E MFT Type Numeric 0 - Vehicle

1 - Pallet
2 - Tote
3 - Single SKU onto Vehicle.
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[PickList] Record

The PickList section lists the SKUs to be loaded to a manifest. It includes
manifest fields like - SKU quantities, priority, order #, whether to unitize

it, etc.
Column | Name Type Description
A SKU Name String Name of the SKU as found in the SKU
(32) file.
B MFT Name String Name of the Manifest this record
(64) belongs to.
C Number Numeric All Pick records for a given single
Manifest are numbered sequentially.
D SKU Type Numeric See Type in the SKU Record
definition.
E SKU Subtype | Numeric See Subtype in the SKU Record
definition.
F Reserved Reserved
G Quantity. Numeric SKU quantity to be loaded.
H Order String Use as you will. The “Keep Like
Number Orders Together” switch makes use of
this.
I Priority Numeric Lowest priority is loaded first.
J Use Y/N Y - Build unitloads of this SKU before
UnitLoads loading into container.
K Reserved Reserved
L Use Mixed Y/N Y - Load loose items of this SKU on
Pallets Mixed Pallets.
M Stop Off Numeric Load Last Stop First. Never load a
partial stop. Base 1. Stop off’s of zero
“0” never get loaded.
N-O Reserved Reserved
P MFT Type Numeric 0 - Vehicle
1 - Pallet
2-Tote
3 - Single SKU onto Vehicle.
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[Tote] Record

The Tote is where you describe the Tote Container types.

Column | Name Type Description
A Style Numeric Use 0
B Name String Name of Tote
C Group Numeric Not used
D Outside Length Distance Outside Length
E Outside Width Distance | Outside Width
F Outside Height Distance Outside Height
G Inside Length Distance Inside Length
H Inside Width Distance Inside Width
[ Inside Height Distance Inside Height
J Weight Weight Weight of this Tote
K Special Length Distance Not Used
L Special Width Distance Not Used
M Special Height Distance Not Used
N Maximum weight | Weight Maximum Weight that can be loaded
in this Tote
o] Maximum Stack Weight Maximum Weight that can be put on
Weight top of this Tote
P Orientation Numeric | O - Load into Vehicle by Length
1 - Load into Vehicle by Width
2 - don’t care
Q Stack Rules Numeric 0 - Must be stacked on floor
1 = Must not be stacked on floor
R Stack Code Numeric | Stack code to use for the Tote
S Stack Height Distance Number of these UnitLoads allowed
to be stacked on one another.
T Manifest Type Numeric | O - Vehicle
1 — Pallet
2-Tote
3 - Single SKU onto Vehicle
U Color Numeric | Decimal representation of a 4 Byte

RGB value.
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[Pallet] Record

The Pallet record section contains descriptions of the pallet a SKU can be

loaded onto.
Column | Name Type Description
A Type Numeric Type — 10 for Pallet
B Name String(32) Name of the Pallet
C Style Numeric Pallet Style
1 = None;
2 = Stringer;
3 = Notched Stringer;
4 = Block;
5 = Block Stringer;
6 = Euro;
7 = Slip-Sheet
D Total Deck Numeric Number of deck boards in the Pallet
boards
E Auto Size Y/N Y = Slip-sheet is trimmed to outside
dimensions of the unit load
F Length Tab Y/N Y = Tab added to length
G Width Tab Y/N Y = Tab added to width
H Both sides YIN Y = Tab added on both sides
I Construction | Numeric Pallet construction style
0 = Single Face
1 = Double Face
2 = Reversible
J Alignment Numeric Refers to how the stringer is positioned
in relation to the deck boards.
0 =Flush
1 = Single Wing
2 = Double Wing
K Length Distance Length of Pallet or Slip sheet
L Width Distance Width of Pallet or Slip sheet
M Height Distance Height of Pallet or Slip sheet
N Weight Weight Weight of Pallet or Slip sheet
0] Wing Offset | Distance Distance that the stringers will be
offset from the edge of the pallet. O if
alignment is Flush
P Deck board Distance Deck board thickness
Thickness
Q Inside Deck | Distance Width of the inside deck board
board Width
R Outside Deck | Distance Width of the outside deck board
board Width
S Center Deck | Distance Width of the center deck board
board Width
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Column | Name Type Description
T Stringer Distance Width of the stringer
Width
U Tab Width Distance Width of Tabs
\Y Color Numeric Decimal representation of a 4 Byte
RGB value
w Number of Numeric Number of stringers on the Pallet
Stringers
[Vehicle] Record
The Vehicle record section contains descriptions of the vehicle types.
Column | Name Type Description
A Type Numeric Use 12
B Name String (64) Name of vehicle
C Style Numeric 0 = Truck
1 = Sea van
2 = Railcar
3 = Rail wagon
4 = Multi zone
5 = Double Trailer
6 =ULD
7 = Side bay truck
8 = Flatbed
9 = Tractor
D Rail Car style | Numeric 0 = Split
1 = Side Door
E Length Distance Loadable inside length of vehicle
F Width Distance Loadable inside width of vehicle
G Height Distance Loadable inside height of vehicle
H Max. Weight | Weight Maximum loadable weight for the
vehicle
I Distance to Distance Distance of drop deck at the front of
Drop off the vehicle
(Front)
J Front Drop off | Distance Depth of drop deck at the front of the
Depth vehicle
K Distance to Distance Location of drop deck at the rear of the
Drop off vehicle (distance from front of vehicle)
(Rear)
L Rear Drop off | Distance Depth of drop deck at the rear of the
Depth vehicle
M Side Door Distance (For rail car only) Location of side
Distance door from the front of the car.
N Side Door Distance (For rail car only) Width of the side
Width door.
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0 King Pin Distance Distance of king pin from the front of
Distance the vehicle.
P Axle Count Numeric Axle count for the vehicle.
Q Axle 1 Numeric Distance of first axle from the front of
the vehicle.
R Axle 2 Numeric Distance of second axle from the front
of the vehicle.
S Axle 3 Numeric Distance of third axle from the front of
the vehicle.
T Tare Weight Weight Tare weight of the vehicle.
U Color Numeric Color of the vehicle.
V King Numeric Specify whether it is a king pin or axle
Pin/Front at the front of the trailer
Axle 0 = King Pin
1 = Front Axle
W Front Ceiling | Distance Distance of ceiling drop from front of
Drop/Outside the vehicle
Ceiling Width (For Rail Wagon, this is the outside
(rail Wagon) width of the raised ceiling)
X Front Ceiling | Distance Depth of the ceiling drop at the front of
Drop the vehicle
Distance/ (For Rail Wagon, this is the outside
Outside height of the raised ceiling)
Ceiling height
(rail Wagon)
Y Rear Ceiling Distance Location of ceiling drop at the rear of
Drop/ Inside the vehicle (distance is from front of
Ceiling Width the vehicle).
(rail Wagon) (For Rail Wagon, this is the inside
width of the raised ceiling)
Z Rear Ceiling Distance Depth of the ceiling drop at the rear of
Drop the vehicle
Distance/ (For Rail Wagon, this is the inside
Inside Ceiling height of the raised ceiling)
Width (rail
Wagon)
AA Split Distance (For Split Rail Car only) The thickness
Thickness of the divider running along the length
(Rail car when of the rail car.
split)
AB Trailer 1 String (64) Name of vehicle used as first trailer
(Double
Trailer)
AC Trailer 2 String (64) Name of vehicle used as second trailer
(Double
Trailer)
AD Bay Count Numeric Number of total bays in the side bay

truck
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AE Short Bays Numeric, The location of short bays separated by
Numeric commas (MaxLoad assumes short bays
on both side of the vehicle)
AF Split Bays Y/N Should be blank
AG Short Bay Distance Loadable height of each short bay
Height
AH Split Bay Distance Not used
Height
Al Bay Split Distance Not used
Thickness
Al Bay Width Distance Width of each bay (along length of
truck)
AK Bay Depth Distance Depth of each bay (along width of
truck)
AL Wheel Well Distance Location of wheel wells from the front
Distance of the vehicle
AM Wheel Well Distance Length of wheel wells of the vehicle
Length
AN Wheel Well Distance Width of wheel wells of the vehicle
Width
AO Wheel Well Distance Height of wheel wells of the vehicle
Height
AP Corner Boxes: | Distance Location of first set of corner boxes
Distance from from the front of the vehicle
front -
Locationl
AQ Corner Boxes: | Distance Location of second set of corner boxes
Distance from from the front of the vehicle
front -
Location2
AR Corner Boxes: | Distance Length of defined corner boxes (apply
length to for both sets of corner boxes)
AS Corner Boxes: | Distance Width of defined corner boxes (apply
width to for both sets of corner boxes)
AT Corner Boxes: | Distance Height of defined corner boxes (apply
height to for both sets of corner boxes)
AU # of Axles for | Numeric Number of axles for Axle 1
Axle 1
AV # of Axles for | Numeric Number of axles for Axle 2
Axle 2
AW # of Axles for | Numeric Number of axles for Axle 3
Axle 3
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XML

XML (eXtensible Markup Language) is a widely used standard that
facilitates the interchange of data between computer applications. Import
of data in XML format is flexible and not tied to any operating system or
hardware type. It is a fairly easy way for external data to be imported into
MaxLoad Pro.

1. From the Menu Bar, open the Tools menu, select Import, then XML.
The Open File dialog box appears, as pictured here.

2. The file filter in the dialog box displays only XML files. Highlight the
file you’d like to import and click on the Open button.

Open
Laok in: I ) Data j = EF '

2] Orcler1 071 4L
2] SKLIData. ML

File name: |

Files of type: |><ML File:s [*.xmil]

Note: Contact TOPS tech Support for further assistance.
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Import Tops Data

This feature is available for MaxLoad Pro 2.70 or later and TOPS Pro 5.05
or later. It allows case sizes and most pallet patterns created from TOPS
Pro (TOPS’ Package Design and Palletization Software) to be imported
into MaxLoad Pro.

In MaxLoad Pro 2.70 or later, the software comes with an INI file,
Tops2Max.ini, found in Windows system folder. This text file specifies
the paths where the two programs (TOPS and MaxLoad Pro) are located
as well as the location where MaxLoad Pro will look for the data to be
exported from TOPS Pro. Below is an example of the file.

Tops2Max.ini

[TopsPro]

AppPath=C:\Program Files\TOPSAPPS\TOPSPRO
ExportPath=C:\Program Files\TOPSAPPS\TOPSPRO\Export
AutolLoad=

[Maxload]
AppPath= C:\Program Files\TOPSAPPS\Max2Pro

From the Menu Bar, open the Tools menu; select Import, then Import
Tops Data.

System Response: MaxLoad will go to the location specified in the
ExportPath of the Tops2Max.ini file and import all files. When importing
is done, it will display a message “Import Complete”.

Note: To export analyses from TOPS Pro (which will be placed in the
folder referenced in the Tops2Max.ini file), open the File menu from
Menu Bar and select Save As. After entering the filename, check the
“Export to MaxLoad” option and click on Save. Please also refer to the
TOPS Pro User’s Guide for more information.
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Custom Import

The Custom Import function allows you to import SKU and Picklist
(include truck, pallet and tote manifests) details stored in other database
into MaxLoad Pro for load optimization. The data to be imported needs to
be saved in a comma separated value (CSV) file as in an Excel
spreadsheet or a pure text file.

With the Custom Import functions, you can specify what fields in your
existing file you would like to be imported into MaxLoad and where in the
file (which columns) the fields are located.

Config SKU Import

Before you can start importing custom data, you have to tell MaxLoad Pro
how the incoming data are formatted in the csv or text files. This involves
specifying what data each column in the csv file represents via a field
selection screen as described below.

From the Menu Bar, open the Tools menu, select Import and then Config
(or Setup) SKU Import. The SKU Select Fields dialog box appears, as

shown here.
5
Uit I English - l Delirmiter I lgnare ID Lines
Field & =y Field I Skip vl
Field B ISkiD vl Field ISkiD vl
Field C ISkiD vl Figld = ISkiD vl
Field O ISkiD vl Field v’ ISkiD vl
Field E ISkiD vl FieldZ ISkiD vl
Field F ISkiD vl Field &2 ISkiD vl
Field G ISkip vl Field 4B Iskip vl
Field H ISkiD vl Field AC ISkiD vl
Field | ISkiD vl Field 4D ISkiD vl
Feldd [sp = FekdE [p -]
Field K. ISkiD vl Field &4F ISkiD vl
Field L ISkiD vl Field 4G ISkiD vl
Field M ISkiD vl Field AH ISkiD vl
Field M Iskip vl Field & ISkiD vl
Field O ISkiD vl Field &) ISkiD vl
Field P ISkiD vl Field &K ISkiD vl
Feld@ [k, 7] Fiekdl [p 7]
Field A ISkiD vl Field &k ISkiD vl
Field 5 ISkiD vl Field &M ISkiD vl
Field T ISkiD vl Field A0 ISkiD vl
Field LI Skip - Field 4P Skip -
Browse Sample Data | Clear Al
0K I Cancel | Help |
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A X4

Unit: Specify the unit measure for the imported data.

K/
A X4

Delimiter: Enter the character that is used to separate the
individual field for each record in the text file. Commonly used
characters include *,”,”|”, and ”;”. If the data is in an CSV file, the

delimiter will be “,”.

+«+ Ignore Lines: Indicates the number of lines at the beginning of the
file that MaxLoad Pro should ignore during the import process.
These are likely to be dates, column headings and information
other than the actual records.

% Fields: Defines which columns or fields from the external data file
will be imported into MaxLoad Pro. The field number (from A
through AF) corresponds to the columns in your data file. Click on
the down (v) arrow at the corresponding field to open the drop-
down list and select the item to be imported.

For example, if your data file contains SKU Name in column A
and SKU Description in column B, select SKU Name from the
drop-down list in Field A and Description in Field B. The rest of
the fields can be left as “Skip”, meaning not imported into
MaxLoad Pro.

The data which can be imported are the same data that you can
define for each SKU, can described in Chapter 3 under DKU
Database.

X/

% Browse Sample Data File: This opens the “Import a File” dialog
box as shown in Figure 12.1 where you can specify the external
file to be imported. After you have provided a filename, the first
record of the file to be imported will be displayed next to the field
so you can verify the data import is properly configured.

% Clear All: Click this button to clear all current settings.

Import SKU

1. From the Menu Bar, open the Tools menu, select Import and then
Import SKU. The Import File dialog box appears.

2. MaxLoad Pro accepts ASCII files with both .txt and .CSV extension.
Specify the file in the Files of type field. You can also select All to
display all files in the selected folder.
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3. Highlight the file to be opened and click on the Open button. If you
have previously configure the SKU Import function (see previous
section), MaxLoad Pro will start importing the data. Otherwise,
MaxLoad Pro will open a SKU Select Fields dialog box as described
earlier section.

Config Picklist Import

From the Menu Bar, open the Tools menu, select Import and then select
Config Picklist Import. You can import Truck, Pallet or Tote manifests.

The Picklist Select Fields dialog box appears, as pictured here.

Select Fields
Delimiter I_ lgnare |-|_ lines
Field & lm Field S lh
FieldB  [gry = Feld T [sp =]
FieldC [y, - Field U lh
Field O Ih Field Ih
Figld E lh Figld w lh
Field F Ih Field Ih
Field G m Figld Y lh
Field H Im Field = Ih
Field | lh Figld & lh
Field J lh Field 4B lh
Figld K lh Figld AT lh
Field L W Field AD lh
Field M h Figld AE lh
Field N g?ﬁ [ Feld&F [ske =]
Figld 0 E";ﬂifESl Field &G lh
Fied E[sloe”t}llnitLoads i e Ih
FENEI Pt On fixed Pallet Field &1 Ih
Stop Off

Field A Field &) lh

Field &k, Ih

Browse Sample D ata File |
’TI Cancel |

« Delimiter: Enter the character that is used to separate the
individual field for each record in the text file. Commonly used
characters include “,”,”|”, and ”;”. If the data is in a CSV file, the

delimiter will be “,”.

+« Ignore: Indicates the number of lines at the beginning of the file
that MaxLoad Pro will ignore during the import process. These are
likely to be dates, column headings and information other than the
actual records.
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¢ Fields: Defines which columns or fields from the external data file
will be imported into MaxLoad Pro. The field number (from A
through AK) corresponds to the columns in your data file. Click on
the down (v) arrow at the corresponding field to open the drop-
down list and select the item to be imported. Select Skip if the
data is not to be imported into MaxLoad.

For example, if your data file contains Manifest Name, SKU,
Quantity, Priority and Order Number in columns A, B, C, G & H
respectively, you should select the corresponding item from the
drop-down list in the same Field number. The rest of the fields can
be left as Skip, meaning not being imported into MaxLoad Pro.

Your external data file must contain the column “manifest” which
corresponds to the name of the manifest inside MaxLoad Pro.
After import, you should see this manifest name in the File Open
dialog box.

X/

% Browse Sample Data File: This opens the “Import a File” dialog
box as shown in Figure 12.1 where you can specify the external
file to be imported. After you have provided a filename, the first
record of the file to be imported will be displayed next to the field
so you can verify the data import is properly configured.

For definition of the different Picklist fields and their assigned values,
please refer to the record format on pages 12.15.

Import Picklist
To import Picklist into MaxLoad Pro, follow these instructions:

1. From the Menu Bar, open the Tools menu, select Import and then
Import PickList. The Import a File dialog box appears.

2. MaxLoad Pro accepts ASCII files with both .txt and .CSV extension.
Specify the file in he Files of type field. You can also select All to
display all files in the selected folder.

3. Highlight the file to be opened and click on the Open button.

If you have previously configured the PickList Import function (see
previous section), MaxLoad Pro will start importing the data.
Otherwise, MaxLoad Pro will open a PickList Select Fields dialog
box.
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Note: If you want to remove the pre-existing SKU and Manifest databases
from MaxLoad Pro, import the file PURGEALL.TXT first. You will find
this file under the \Max2Pro\ or \Max2Demo\ folders. This is a simple file
with four lines telling MaxLoad Pro to delete existing SKU and Manifest
data.

Note: As MaxLoad Pro’s internal data structure is generated through
DAO, it is possible to directly manipulate MaxLoad Pro’s data (through
Microsoft Access for instance). However, this manipulation should be
limited to extracting information from the MaxLoad Pro tables.
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Export Databases

As in the same way you prepare data to be imported into MaxLoad Pro,
you can export data from MaxLoad Pro and use them in other applications.
The export file created will be in the comma delimited format.

To export databases from MaxLoad Pro, follow these instructions:

1. From the Menu Bar, open the Tools menu, select Export. A submenu
appears with a list of Export options — Export Databases, XML, Export
By Placement, and Custom Export.

2. Select Export Databases to open the Export dialog box.

Expoit t: I’S.&F‘F’S M asZProhDATAMM axProtst | Browse |

—Select data to export
™ Annotations ™ Stack Matriz
¥ ContainerList ™ Tate
I Cut List [ Unitoad
IV Manifest ™ User
™ Pallet [ Vehicle
™ PickList [T Messages
™ Placement List ™ Defauls
v SEL ™ Fonts
™ Labor Cost

Cancel |

3. The Export dialog box lets you browse to a location, where you want
to save the exported database. By default the exported file gets saved
to the Data folder, under the Mx2Pro directory. The Export dialog box
lets you export over 15 databases.

4. Once the selection is made, click OK.

The software will create the file and export the selected data. During
export an export dialog box will appear on the screen. Once the
export is complete, the dialog box will be closed automatically.
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XML

MaxLoad Pro can export the currently opened manifest to an XML file.
The output can be easily read by other applications for further processing.

To export MaxLoad Pro data in XML format, follow these instructions:

1. From the Menu Bar, open the Tools menu and select Export. The Save
As dialog box appears, as pictured below.

Save As 7 | x|
Save i I 3 Data j = l-:jg -
2] Order1 07.5ML
2] SKUData <ML
File narne: I.-'-‘n.pplianu:e_Lu:uad
Save az lype: IXML Files [*.=ml] j Cancel |/
o

2. Type the file name that will be used for the selected export in the File
name field and click Save. MaxLoad Pro will create an XML file in
the specified directory path.
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Export by Placement

The Export by Placement function generates step-by-step JPEG images to
illustrate the loading procedure to a transit container for the currently
opened manifest. The export images are the same as the ones in the Load
by Placement report.

To Export by Placement, follow these instructions:
1. From the Menu Bar, open the Tools menu and select Export, then

Export by Placement. The Save As dialog box appears, as pictured
below.

Save As E m
Save in: I ) Appliance Load j = ¢ E-
File name: IL.;.ad
Save a5 type: [JPeq Fies [“ipg) = ancel |
S

2. Type in the name of the image file that will be used to save the
placement images in the File name field and click Save.

Depending on the number of placement steps for the manifest,
MaxLoad Pro will generate a series of JPG images in the specified
directory path.

Note: The images will be named Filenamel-1.jpg, Filenamel-2.jpg, and
so on. In the example illustrated in the above dialog box, the placement
images will be named Load1-1.jpg, Load1-2.jpg... Load1-10.jpg.
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Custom Export

The Custom Export function allows you to export load summaries to an
ASCII comma delimited text file. With custom export you can specify
which fields in summary you would like to export from MaxLoad Pro and
where to place the fields in the output file. The output file(s) can then be
easily imported into other applications for further processing. The various
load summaries that can be exported using this feature are as follows:

X/

« Solution
« Placement List
+ Load List

To custom export a summary, follow these instructions:

1. From the Menu Bar, open the Tools menu and select Export. A
submenu appears with a list of Export options — Export Databases,
XML, Export By Placement, and Custom Export.

2. Cursor over Custom Export and another sub menu appears. Select one
of the three options — Solutions, Placement List or Load List. The
Export dialog box appears, as pictured below.

Export 7| x|
Lok in: Il‘f}Data j = ¥ E3-

|0 Appliance Load
Ej b axPro.tat

[£] Load List. Tut
Ej Salution. Tst

by Documents

by Computer

"ﬁ File name: IPIacement
-
Files aof type: |[.Txt]

L Lo

Cancel |

I Open as read-only

4

2. Type the file name that will be used for the selected export in the File
name field and click Open. The Select Fields dialog box appears.
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Select Fields [ x|

Cantainer

’7 Al £ Current
[ehicle =l
ICube j
[ Cube =l
Skip |
Wieight -
gt
(At o
CutList Crit hd
Skip =l
[ skip =l
[ skip |
[ Skip |

[ ExportJPG
Ok I Cancel |

4. Select Fields dialog box allows you to specify the data to be included
in the data file.

K/

+« Containers: If your load solution uses more than one container,
click All to export data for all containers else click Current to
export data for the current container only.

X/
°e

Export Fields: For each field, click the down-arrow (¥) to view
the list of data you can export for the selected report type (Solution,
Placement List or Load List). The data available is similar to the
data available under the same report name within the MaxLoad
Pro’s Manifest View Screen.

% Export to JPG: Check this box instruct MaxLoad Pro to also
create a JPG output for the selected report.

5. Once the selection is made, click OK. The software will create the file
and export the selected data.
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Custom Export File

The first export field in the custom export file corresponds to the first
column of the comma delimited file, the second field to the second column,
respectively. Select Skip if you’d like to keep a blank column in the output
file.

Below is a sample Placement list output with data as specified in Figure
12.9. The data are in the sequence of SKU, Quantity, Unitload Count,
Cube, %Cube, X Front, X Side and X Floor for all containers.

Truck #1

Deepfreezer, 16, 0, 723.3 (ft3), 20.5 %, 0 (in), O (in), O (in)
Deepfreezer, 14, 0, 632.9 (ft3), 18.0 %, 0 (in), 0 (in), 35 (in)
TV, 15, 0, 332.5 (ft3), 9.4 %, 0 (in), O (in), 70 (in)

Stereo, 17, 0, 58.2 (ft3), 1.7 %, 0 (in), 42 (in), 70 (in)
Stereo, 7, 0, 24.0 (ft3), 0.7 %, O (in), 42 (in), 82 (in)
Stereo, 76, 0, 260.2 (ft3), 7.4 %, O (in), 62 (in), O (in)
Refrigerator, 19, 0, 663.2 (ft3), 18.8 %, O (in), 62 (in), 24 (in)
Computer, 9, 0, 88.2 (ft3), 2.5 %, 0 (in), 62 (in), 89 (in)
Computer, 1, 0, 9.8 (ft3), 0.3 %, 480 (in), 0 (in), 70 (in)
Computer, 12, 0, 117.5 (ft3), 3.3 %, 504 (in), O (in), 35 (in)

Computer, 4, 0, 39.2 (ft3), 1.1 %, 504 (in), 0 (in), 87 (in)
Computer, 2, 0, 19.6 (ft3), 0.6 %, 551 (in), 62 (in), 0 (in)
Computer, 1, 0, 9.8 (ft3), 0.3 %, 551 (in), 62 (in), 52 (in)
Computer, 1, 0, 9.8 (ft3), 0.3 %, 551 (in), 62 (in), 78 (in)
Truck #2

TV, 81, 0, 1795.5 (ft3), 51.0 %, O (in), O (in), O (in)

Stove, 8, 0, 295.0 (ft3), 8.4 %, 378 (in), 0 (in), 0 (in)
Refrigerator, 10, 0, 349.1 (ft3), 9.9 %, 378 (in), 37 (in), 0 (in)
TV, 4, 0, 88.7 (ft3), 2.5 %, 378 (in), 37 (in), 65 (in)

Stove, 2, 0, 73.7 (ft3), 2.1 %, 538 (in), 37 (in), 0 (in)
Refrigerator, 1, 0, 34.9 (ft3), 1.0 %, 542 (in), 0 (in), 0 (in)

Truck #3
Stove, 40, 0, 1474.9 (ft3), 41.9 %, O (in), O (in), O (in)
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Export Summary

The Summary export function allows you to export load summary to an
ASCII comma delimited text file. The export include manifest name,
truck type, truck number, SKU name, SKU description, quantity, and load
priority as in the example below:

Appliance Load,48 Ft. Dry Cargo,1/2,Computer,Pentium 200 mhz.,20,20,1,0,
Appliance Load,48 Ft. Dry Cargo,1/2,Deepfreezer,Arctic Plus Model,b27,27,1,0,
Appliance Load,48 Ft. Dry Cargo,1/2,Refrigerator,Model 363-2,24,24,1,0,
Appliance Load,48 Ft. Dry Cargo,1/2,Stereo,Surround Sound,34,34,1,0,
Appliance Load,48 Ft. Dry Cargo,1/2,TV,Surround Sound Plus,33,33,1,0,
Appliance Load,48 Ft. Dry Cargo,2/2,Deepfreezer,Arctic Plus Model,1,1,1,0,
Appliance Load,48 Ft. Dry Cargo,2/2,Refrigerator,Model 363-2,2,2,1,0,
Appliance Load,48 Ft. Dry Cargo,2/2,Stove,5 Burner,30,30,1,0,

Appliance Load,48 Ft. Dry Cargo,2/2,TV,Surround Sound Plus,5,5,1,0,

Export Mixed Pallets

The Mixed Pallets Report output a text file in the specified location,
providing details on the contents of each mixed pallet in the current
manifest. If there is no mixed pallets in the current manifest, the output
file will only contain the first title row but with no data.

Mixed Pallet, SKU, Qty

Mixed Pallet 6, Hand Towels, 5
Mixed Pallet Saltines, 1
Mixed Pallet Saltines, 2
Mixed Pallet Toilet Tissue, 7
Mixed Pallet Saltines, 4
Mixed Pallet Tissue Paper, 8
Mixed Pallet Cookies, 11
Mixed Pallet Saltines, 4
Mixed Pallet Toilet Tissue, 8
Mixed Pallet Cookies, 17
Mixed Pallet Potato Chips, 20

RPERPNNNWWADMOO

Export UnitLoads

The UnitLoads Export allows you to output all unitloads created for each
SKU in the MaxLoad Pro database to an XML file. The export file will be
in the format as provided below, giving dimension of the SKUs and TIHI
details (number of cases per unitload layer and number of layers on the
pallet) and overall dimension of the unitload.

- <maxout units="English">
- <UnitLoadList>
- <UnitLoad>
<SKUNumber>Bulk Frozen Yogurt</SKUNumber>
<SKUDescription>Swirl Flavor Yogurt</SKUDescription>
<SKULength>10.00 (in)</SKULength>
<SKUWidth>10.00 (in)</SKUWidth>
<SKUHeight>12.00 (in)</SKUHeight>
<SKUWeight>0.08 (Ib)</SKUWeight>
<CasePerLayer>20</CasePerlLayer>
<LayerPerUL>4</LayerPerUL>
<CasePerUL>80</CasePerUL>
<ULLength>50.00 (in)</ULLength>
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<ULWidth>40.00 (in)</ULWidth>
<ULHeight>53.00 (in)</ULHeight>
<ULWeight>71.40 (Ib)</ULWeight>
</UnitLoad>

- <UnitLoad>
<SKUNumber>Case 1</SKUNumber>
<SKUDescription>Sample Case 1</SKUDescription>
<SKULength>23.00 (in)</SKULength>
<SKUWidth>19.00 (in)</SKUWidth>
<SKUHeight>15.00 (in)</SKUHeight>
<SKUWeight>10.00 (Ib)</SKUWeight>
<CasePerLayer>4</CasePerLayer>
<LayerPerUL>3</LayerPerUL>
<CasePerUL>12</CasePerUL>
<ULLength>48.00 (in)</ULLength>
<ULWidth>40.00 (in)</ULWidth>
<ULHeight>50.00 (in)</ULHeight>
<ULWeight>185.00 (Ib)</ULWeight>

</UnitLoad>
- <UnitLoad>

Export Manifest

The Export Manifest function allows you to export the current manifest to
a comma separated text file in a specified location. The output text file
contains all data pertaining to the current manifest including SKU, vehicle
and load solution details. Use this function to export all relevant data for a
manifest so it can be directly imported in MaxLoad Pro as in the case for
sending the information to TOPS Engineering for technical assistance.

Email Manifest

The Email Manifest function combines the steps of exporting the current
manifest and adding it as an attachment in your email client so it can be
sent off to another party.

The receiving party needs to have MaxLoad Pro to view the manifest.
Upon receipt of the manifest (txt file), they should go to the Tools Menu,
select Import and then Import (Generic). The manifest should now appear
in the File Open dialog box.
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Ftp Import

The Ftp Import function allows you to import a file from an ftp site.

1. From the Menu Bar, open the Tools menu and select Ftp Import. The
FTP Get dialog box opens.

2. Enter the address for the ftp site where data is to be imported or select
from the drop list if previous ftp addresses have been used. Enter the
User name and Password for site access and click on the Connect button.

Once connected, the contents of the site will be displayed in the File
List as shown here.

FTP Get
Site |ft|3:h’www.t0pseng.com ﬂ
User I UserlD
Password I xxxxxxxxxx
— File List

E|EI / =
wE Order_07182008 txt
B Order_07192008.txt

.E Order_07202008.txt
B Order_07222008.txt
E-B3 June2008

Impart |

|

Connected to wewiw topzeng, com as User|D

Cloze |

3. Select the file to be imported from the list and click on the Import button.
You will see a process window which will close automatically when the
import process is complete. If this is a manifest you are importing, you
should see it in the File Open dialog box. For SKU import, they will
appear in the SKU list in the PickList screen.

4. Click on the Disconnect button and then the Close button to exit the Ftp
Import function.
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Command

L Ine Parameters

MaxLoad Pro supports the following command line options:

Command

Description

-DBPath=<path>

Allows users to override the .ini file and specify a
different location for the software to find its data.
Use the Maxload.mdb in the specified path instead
of checking in the path indicated in the Maxload2.ini
file.

-Import=<path>

This command automatically imports the specified
file when the software starts. For example, an order
processing system could first export an order file and
then when Maxload Pro is launched, the data would
automatically be imported. Imports the specified file
on startup if it exists.

-Ini=<path> Allows users to specify the location of the specific
topspro.ini file that they want to use. Use the
specified INI file instead of the one in
C:\Windows\maxload2.ini file.

-MultiDb=0n With this option, users can specify multiple database

paths (dbpath) in the Maxload2.ini file. With this
feature activated, the user will be prompted on
startup, for which database to use.

-User=<username>

Automatically logs the user into the software as a
specified user. This allows the user to skip the login
screen.

-View

Starts the program in view only mode. View only
mode prevents the user from being able to modify
any data in the program.

Note: User names, paths, and filenames that contain spaces or other
delimiters should be enclosed in double quotation marks like “this”.
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Glossary

Algorithm: Mathematical rule or rules that specify how to solve a given
problem

Allow Loose fills on sides: This feature will first fill the container with as
many unitloads as possible, and then it looks at any SKUs in the Cut List
to see if they will fit in any of the open spaces remaining.

Allowed Vertical: Dimension of the SKU (length, width, and/or depth)
that is allowed to be loaded vertical. See also Preferred Vertical.

Axles: A transverse bar or shaft connecting the opposite wheels of a
trailer or railcar.

Bundle: Two or more SKUs held together with a strap or a rope to form a
shipping unit.

Button Bar: A bar at the top of the screen comprised of icons that control
certain functions (such as print, open, save, etc.) and give you instant
access to those functions.

Case: An SKU defined as a square or rectangle.

Check Box: A check box turns an option on or off. If the check box
contains an X or check mark, the option is turned on.

Clampable: Ability of a palletload to be handled by squeezing both sides
of the load. A pallet pattern is suitable for being clamped if any void
between SKU’s does not exceed 0.5” inches.

Clipboard: Areas of memory where text and commands can be stored to
wait for further action, such as importing into a report. The contents of
the Clipboard are erased when you exit Windows.

COG: Center of Gravity

Column Loading: Loading a mixed pallet by building full columns of
each SKU.

Column Stack Loading: Loading a straight pallet by building full
columns of an SKU. Also called row or column loading.
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Command Line Parameter: An instruction or a switch, issued to
MaxLoad Pro, to execute a particular action when the executable is
launched. Example —user will automatically login a specified user.

Control Center: This the first screen when the user logs into to software.
This screen has four buttons — Truck, Pallet, Tote, Single SKU - that
allow the user to launch various parts of MaxLoad Pro.

Control Label: The name of a specific field. For example, in the Define
SKU screen, SKU Name and Description represent the Control Label for
those particular fields.

Constraint Message: A warning message that appears when you've
violated a stacking or placement rule while manually editing a manifest.
This message always displays in the Status Bar at the bottom of the Edit
screen.

Corner Posts: Edge protectors found on the corner of unitloads, used to
force corner support. MaxLoad Pro allows you to define the length and
thickness of corner posts for a unitload.

Creating a Unitload: The process of loading a SKU onto a pallet or a
slipsheet. This procedure takes into account various parameters, including
the maximum height, weight and overhang of the unitload you're creating.
MaxLoad Pro also allows you to analyze various pallet patterns when
creating a unitload.

Cubic Efficiency %: The cubic efficiency of a transit vehicle load is
calculated by multiplying the (individual SKU cube) by (the number of
shipping cases per transit vehicle load), then dividing this product by the
available cube of the transit vehicle. The available cube of the transit
vehicle is (the transit vehicle length) times (the transit vehicle width)
times (the transit vehicle height). When calculating the cubic efficiency %
of a unitload or mixed-pallet load, MaxLoad Pro will use the absolute
outside dimensions (including the pallet) of the loaded unitload.

Cut List: After calculating a manifest the SKUs which cannot fit in the
specified container or a pallet are listed in the Cut List

Deck Boards: Wooden planks that make up the surface of a pallet. When
you define a pallet in MaxLoad Pro, you're required to define the number
of deck boards, as well as the deck board width and height.

Dead Stacking / Floor Loading: Loading an SKU loosely in to a vehicle
without the use of pallets or slipsheets. Also known as hand stacking.
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Dead Stacking Rules: Stacking rules for SKU’s that are loaded loosely
into a vehicle rather than as part of a unitload or mixed pallet.

Default: A setting or value automatically provided by MaxLoad Pro
unless an alternative is specified. Many MaxLoad Pro defaults can be
changed for all future analysis by going into the Configuration section and
changing them. Other options may change a default for the active analysis
only, and will reset when you exit MaxLoad Pro.

Double-Face Pallet Construction: A pallet style that has both a top and
bottom deck.

Double Trailer: A single tractor may pull more than one trailer at one
time. MaxLoad Pro can calculate the contents of both trailers at the same
time.

Double-Wing Alignment: A type of pallet alignment that has overhangs
on both decks.

Drop Deck: A goose-neck trailer that has a drop-off for both the front
and rear of the trailer.

Drum: An SKU that is defined as a cylinder.

End Gap: The distance between the last loaded SKU the end of the
container.

Euro-Pallet: A commonly used pallet style in Western European
countries. The Euro-Pallet is usually 1200 mm in size and utilizes a block
construction to allow for four-way entry.

Floor to Ceiling: A specific algorithm used by MaxLoad which loads a
layer of SKUs across the entire floor before it allows to create a second
layer.

Floor loading: See Dead Stacking.
Flush Alignment: A pallet style that has no wings.

Footprint-Shipcase: The area of the horizontal surface (base) touching
an item below it (another SKU or the floor). This value can be referred to
either in square inches/ centimeters or by the length and width of an
SKU’s base.

Footprint-Pallet Load: The area of the physical pallet plus any defined
overhang.
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Front to Back: A specific algorithm used by MaxLoad Pro which will
stack a vertical layer at the front of the truck before proceeding with
further vertical layers moving towards the back of the truck

Global Configuration: A configuration that applies to all aspects of the
program. For instance, Maximum Overhang is defined in the Vehicle
Loading Options screen, and applies to all SKU’s loaded in a manifest, as
opposed to a separate value for each individual SKU.

King Pin: Vertical rod sticking out of the bottom-forward portion of a
vehicle that connects the trailer to a tractor.

Layer Loading: Loading a mixed pallet by building full layers of an
SKU.

Leading Edge Loading: Loading method whereby each new placement
that touches the far wall of the vehicle is considered to be a new leading
edge.

Load By SKU Ratio: This algorithm gives the user an option to a
container with a specified ratio of SKUs in the Manifest List.

Load By Priority: A number assigned to a SKU as it is loaded into a
transit vehicle that denotes its importance of loading order in relation to
other items in the load.

Load List: Displays the list of SKUs which are loaded on the truck. This
shows the SKU quantity, the priority, the cubic usage and relative weight.

Manifest: All the relevant information regarding the building of a load.
A manifest is comprised of vehicle information, as well as the type and
quantity of SKU’s to be loaded into a vehicle.

Maximize Button: A small box at the right of a window title bar that
contains an upward-pointing triangle. When clicked, a window that has
been at a medium size will expand to the screen.

Maximum Overhang: Maximum amount of space an SKU is allowed to
hang over the edge of a pallet. This figure is defined individually for both
the length and width of the pallet.

Maximum Priority Overlap: Maximum amount of space SKU’s of two
separate load priorities are allowed to “mix” together when being loaded
into a transit vehicle. For example, if the maximum priority overlap is
defined as 48 inches, items given a priority of “2” would be loaded on top
of items with a priority of “1” by no more than the 48 inches defined.
This figure is based on the front (leading edge) of the SKU.
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Maximum Vertical Gap: The maximum difference in height between
two surfaces that can still be considered level or flat. Older versions of
MaxLoad Pro refer to this as amalgamation distance.

MaxLoad Pro Control Panel: A screen that provides the initial interface
with MaxLoad Pro. This screen contains various “hotkeys” that allow you
to launch into various parts of the program.

Menu: A list of commands that can be applied to the active window or
application.

Menu Bar: The area at the top of a window containing the main headings
for all menu items available for that window.

Minimize Button: A small box containing a downward-pointing arrow,
which is located next to the maximize button at the right of a window’s
title bar. Clicking on this button shrinks the window to an icon. See also
Maximize Button.

Minimum Ceiling Clearance: Minimum amount of required space
between the top of the cargo and the ceiling of the transit vehicle.

Mixed Pallet: A palletload consisting of multiple kinds of SKU’s and
isn’t made up of full SKU layers.

Mixed Pallet for Display: Mixed pallet or unitload used for end-of-aisle
display purposes at warehouse clubs and other wholesale and retail
outlets. Usually multiple products are arranged in eye-pleasing layers that
allow consumers to pick items off the pallet for purchase.

Nest: A group of cylindrical SKUs like cans, drums or pipes that fit one
within the other

Offset: The figure that represents how far a wing extends beyond a
stringer on a pallet.

Optimize Height for Top Layer: This algorithm lets the software load
partial unitloads in a container. This is only true for Truck Manifest.

Pallet: A low platform of wood, metal or fiberboard used to stack smaller
units of product for transportation or storage.

Pattern Styles: MaxLoad Pro assigns a name to a pallet pattern type to
assist in visualizing the basic pattern. For more information on pallet
patterns, including graphic images, please refer to Appendix C, Pallet
Patterns.
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Pinwheel Optimization: This algorithm will load unitloads onto the
truck in a pinwheel layout as opposed to loading by length or width.

Placement: A block of SKU’s loaded with the same dimension vertical
and oriented in the same direction in the vehicle.

Plan View / Top View: Overhead view of a diagram.
Picklist: List of all loaded SKU’s from the Manifest List.
Piece Count: Number of items contained within a given SKU.

Preferred Vert: Due to stacking strength requirements, every SKU will
have both an “allowed” and “preferred” vertical orientation. The
preferred vertical dimension is assumed to be the dimension with the
greatest stacking strength. Unless it is physically not possible, the
preferred vertical dimension will always be used when floor-loading an
item within a vehicle.

Priority: Sets the relative importance of a SKU. SKUs with the lowest
number gets greater importance than higher numbered SKUs and will be
loaded on the container or pallet in sequential order.

Properties: Properties are similar to defaults (defined earlier). They
represent a specific setting for a particular field. However, they differ
from defaults in that a Property applies only to one record (i.e., one
specific SKU) rather than all records. For example, when you change the
properties from inches to feet for the length field of SKU # 12345, only
SKU # 12345 will be affected. If you want that change to affect all future
SKU'’s that you define, you will need to make the change in the Defaults
field.

Rail Car: Standard container behind a train engine

Rail Wagon: Container pulled behind a train engine which has a curved
roof.

Record: MaxLoad Pro stores much of its information in an Access
database within the system. The database consists of various records,
which represent various pieces of stored information. For example, when
you define a vehicle, all the information you input to define that vehicle
makes up the record for that vehicle. The same goes for an SKU or pallet.
Information for each individual SKU or pallet is considered the record for
that SKU or pallet.

Reversible Pallet Construction: A pallet style that has a similar top and
bottom deck, both capable of carrying a load.

14.6

MaxLoad Pro (V3.6) User's Guide



Sea Van: Any end-loading container capable of being transported via an
ocean carrier.

Single Face Pallet Construction: A pallet style that only has a top deck.

Single-Wing Alignment: A type of pallet alignment in which the
overhang is only on the top deck.

Sizing Handle: The small solid squares that appear on the borders of
certain list boxes. You can drag these handles to size the box and its
contents.

SKU: Stock Keeping Unit. Any individual shipcase, unitload or drum
that is loaded onto a pallet or into a container.

Smart Pallet Placement: Regular pallet placement sees the unitload as a
single block and does not consider how level the top layer is. Smart Pallet
Placement ensures the top layer will be suitable for other items to stack
upon looks at the stability of the unitload to determine which should be on
top and which should be loaded on the floor.

Space Evenly: This algorithm spreads the load over the entire surface
area of the container in order to make a more secure load.

Sol List: Based on the algorithms selected, Maxload Pro will typically
display several solutions and these are listed in the solution list or sol list.

Soldiered: Type of pallet loading where a SKU can be slipped down
turned on its edge between the pallet pattern seams in order to create a
more efficient palletload.

Stack Code: User-defined label that determines how items are stacked
within a load. Items with similar stacking characteristics should be
defined with the same stack code.

Stack Matrix: The row/column matrix that allows you to define stacking
relationships among groups of SKU’s. The stack matrix can be accessed
either through the Define SKU screen or through the Tools/Stackability
menu option.

Staggered Patterns: Allows the user to nest/stagger cylindrical objects.

Stop-Off: Same as Drop-Off. This is a load that will have items
delivered to multiple destinations.

Straight Pallet: A palletload consisting of a single type of SKU.

Tare Weight: Empty weight of a container.
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Title Bar: The part of a window or dialog box that contains its title.

Tote: A master pack carton into which SKU’s of various sizes and shapes
are loaded for transit.

Unitized: The placing of a SKU onto a pallet.

Unitload: The product created when MaxLoad Pro develops a palletload
of SKU’s. A unitload differs from a mixed pallet in the sense that a
unitload is comprised of identical SKU’s, while a mixed pallet is
comprised of multiple kinds of SKU’s.

Unitload Height: The overall unitload including pallet height. For
example, most transit vehicles allow for approximately 108-110 inches of
vertical clearance height. Therefore, a good Unitload Height will not
exceed 54 inches (to allow for double stacking in the transit vehicle).

UL: UL stands for unitload. It represents a loaded pallet or slipsheet with
one size of SKU’s.

Unitload Length: The length of the pallet plus any allowable overhang.
For example, if the pallet length is 48 inches and there's one inch of
overhang allowed on each side of the pallet, the Unitload Length is 50
inches.

Unitload Width: The width of the pallet plus any allowable overhang.
For example, if the pallet width is 40 inches and there's one inch of
overhang allowed on each side of the pallet, the Unitload Width is 42
inches.

Viewer: A utility program that allows users to view completed manifests.
The viewer doesn’t actually perform any work, and therefore is not limited
to the number of concurrent users. Used primarily for integrating
MaxLoad Pro with document management systems, the Viewer also
allows loaders to view, on screen, the results of a completed manifest as
well as sending the manifest to a printer or an e-mail program.

Weight Efficiency %: The weight efficiency of a transit vehicle load is
calculated by multiplying (the individual SKU weights) by (the number of
shipcases per transit vehicle load), and then dividing this product by the
maximum allowable weight of the transit vehicle.

Weight Limit: Represents the maximum amount of weight which may be
loaded in a given container or UL.
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